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પ્રસ્િાિનાાઃ 
 પહરિિસનના પગથિયાાં ચડીન ેજ પ્રગતિના રાજમાગસ સ ધી પિોંચી શકાય છે. 

પ્રગતિના પીયૂર્ પીિા માટે પહરિિસન આિશ્યક છે. આ બાબિને અન લક્ષીન ે

પ્રાિતમક વશક્ષક પ્રવશક્ષણ પ્રભાિી બનાિિા માટે સમયાાંિરે િેના અભ્યાસક્રમમાાં 

ફેરફાર કરિાની જરૂહરયાિ ઊભી િિાાં ક્રમશાઃ પ નાઃરચના કરિામાાં આિી િિી.  

 પ્રાિતમક વશક્ષક પ્રવશક્ષણ અભ્યાસક્રમની પ નાઃરચનાના ઇતિિાસમાાં ડોવકય ાં 

કરીએ િો ઈ.સ. 1995માાં રાજ્યવ્યાપી અમલી બનલે ક્ષમિાકેન્દ્રી  અભભગમન ે

અન લક્ષીને ક્રમશાઃ ઈ.સ. 1999 અને 2002માાં અભ્યાસક્રમની પ નાઃરચના કરિામાાં 

આિી. ત્યારબાદ રાષ્ટ્ર ીય અભ્યાસક્રમ માળખ ાં (NCF)-2005ની જાિેરાિ અન્દ્િય ે

રાજ્યની પ્રાિતમક શાળાઓના પાઠ્યક્રમમાાં પહરિિસન આિિાાં િમેજ અભ્યાસક્રમમાાં 

પ નરાિિસન પામિી ક્ષમિાઓ દૂર કરિાના િેિ સર ઈ.સ. 2008-09માાં 

અભ્યાસક્રમને પ નગસહિિ કરિામાાં આિેલ. 

 િિસમાન સમયના પહરપે્રક્ષ્યમાાં ગ જરાિ રાજ્યમાાં NCF-2005, RTE-2009 

અને NCTE દ્વારા પ્રસસિ કરિામાાં આિલે NCFTE-2009 િિા 12મી પાંચિર્ીય 

યોજનાની ભલામણોને ધ્યાને લઈને પ્રાિતમક વશક્ષણ કે્ષતે્ર િયેલ ફેરફારોના 

અન સાંધાને પ્રાિતમક વશક્ષક પ્રવશક્ષણ અભ્યાસક્રમન ાં પ નાઃગિન ઈ.સ. 2014માાં 

કરી િેન ાં નિ ાં નામાભભધાન ડી.એલ.એડ્. (D.El.Ed.) રાખિામાાં આિેલ છે. નિા 

અભ્યાસક્રમમાાં ક્ષમિાઓન ેબદલ ે અધ્યયન વનષ્પવિઓ (Learning Outcomes)ન ે

સ્િાન આપિામાાં આિેલ છે.  

 ડૉ. રિીન્દ્રભાઈ દિે સાિેબના અધ્યક્ષપણા િેિળ રચિામાાં આિલે 

અભ્યાસક્રમ સતમતિ અન ે ડી.એલ.એડ્. કોર ટીમના માગસદશસનને અાંિ ે

ડી.એલ.એડ્. (D.El.Ed.) અભ્યાસક્રમન ાં ઘડિર કરિામાાં આિેલ છે.   

 આ બે િર્ીય ડી.એલ.એડ્. અભ્યાસક્રમ ત્રણ વિભાગોમાાં વિભાવજિ છે. 

જનેા પ્રિમ વિભાગમાાં સાિ અધ્યયન કે્ષત્રો, બીજા વિભાગમાાં પાાંચ કાયસ કૌશલ્ય 

કે્ષત્રો અને ત્રીજા વિભાગમાાં પાાંચ પ્રતિબિિા કે્ષત્રો સમાવિષ્ટ્ છે.   

 આ િિસમાન ડી.એલ.એડ્. (D.El.Ed.) અભ્યાસક્રમને અન લક્ષીને િૈયાર 

િયેલ મૉડ્યૂલની સાંરચનામાાં જીસીઇઆરટી-ગાાંધીનગર, વજલ્લા વશક્ષણ અન ે

િાલીમ ભિનો, અધ્યાપન માંહદરો અને વિર્ય િજજ્ઞશ્રીઓ િેમજ સમીક્ષકશ્રીઓનો 

સિયોગ પ્રાપ્ત િયલે છે. આ ઉપરાાંિ, UNICEF નો પણ આર્થિક િમેજ શૈક્ષવણક 

સિયોગ પ્રાપ્ત િયો છે. પ્રસ્િ િ અભ્યાસક્રમ ડી.એલ.એડ.્ (D.El.Ed.) 

પ્રવશક્ષણાિીઓને ઉપયોગી બનશે િેિી શ્રિા છે. 

 આ મૉડ્યૂલ િધ  સમૃિ અને ક્ષતિરહિિ બને િે માટે રાજ્યની િમામ 

ડી.એલ.એડ્. સાંસ્િાઓ પાસિેી સૂચનો મળેિીને િેને આખરી સ્િરૂપ આપિામાાં 

આિેલ છે. આમ, પ્રસ્િ િ મૉડ્યૂલ ઉપયોગી અને અસરકારક બને િે માટે 

જીસીઇઆરટી દ્વારા પૂરિી કાળજી લેિામાાં આિી છે, િમે છિાાં િેની ગ ણિિા િધારે 

િેિાાં સૂચનો જીસીઇઆરટી સદાય આિકારે છે. 
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પ્રકરણ-1 

ઈ-ટ્યુટોરરયલ 

 
1.1   પ્રસ્તાવના 

મિત્રો, પ્રથિ વર્ષિાાં તિે ઇ-કન્ટેન્ ટની સાંકલ્ પના તેના સ્ વરૂપ અને નનિાષણની પ્રનિયાનાાં સોપાનો વગેરે 

નવશે નવસ્ તૃત િારિતી િેળવી છે. આજના િારિતી અને ટૅકનોલોજીના યુગિાાં ઇ-કન્ટેન્ ટની જરૂરરયાત સાંદર્ભ ેપણ 

તિે સ્ પષ્ ટ બન્ યા િશો. આજનો નવદ્યાથી િારિતી અને ટૅકનોલોજીના યુગિાાં કદિ ર્ભરી ૨હ્યો છે, પોતાને શીખવાની 

નવર્યવસ્તુ અને િારિતી િળેવવા િાટે ઈ-લર્નનગનો ઉપયોગ ક૨તો થયો છે. પ્રવતષિાન સિયિાાં જુદાજુદા કે્ષત્રિાાં 

નવનવધ પ્રકારની તાલીિ િાટે અસરકારક ઇ-ટ્યુટોરરયલ તૈયાર કરી તેના વડે ઈ-લર્નનગની પ્રનિયા થઇ રિી છે. 

િાલિાાં ઇન્ ટરનેટ પર નવનવધ બાબતોના સ્ વ-અધ્ યયન િાટે અનેક પ્રકારના ઇ-ટ્યુટોરરયલ ઉપલબ્ ધ છે. આ 

પ્રકરણિાાં આપણે ઇ-ટ્યટુોરરયલની સાંકલ્ પના, ઇ-ટ્યુટોરરયલનુાં સ્ વરૂપ, ઇ-ટ્યુટોરરયલના પ્રકારો, ઇ-

ટ્યુટોરરયલ નનિાષણના તબક્કાઓ તથા ઇ-ટ્યુટોરરયલના ફાયદાઓ અને િયાષદાઓ નવશે સાંક્ષક્ષપ્ ત અભ્ યાસ 

કરીશુાં.  

 

ઉદે્દશો 

પ્રનશક્ષણાથી.... 

1. ઇ-લર્નનગની વ્યાખ્યા લખી શકશે. 

2. ઇ-ટ્યુટોરરયલની વ્ યાખ્ યા આપી શકશે. 

3. ઇ-ટ્યુટોરરયલની સાંકલ્ પના સ્પષ્ ટ કરી શકશે.   

4. ઇ-ટ્યુટોરરયલના પ્રકારો જણાવી શકશે. 

5. ઇ-ટ્યુટોરરયલ નનિાષણ પ્રનિયાના સોપાનો િિશઃ લખી શકશે.  

6. ઇ-લર્નનગના ફાયદાઓ અને િયાષદાઓ જણાવી શકશે. 

 

1.2 ઇ-ટ્યટુોરરયલની સાંકલ્પના 

 મિત્રો, તિારે કોઇ નવર્યવસ્તુ શીખવી િોય અને તિારી પાસે કોઇ શીખવનાર ન િોય તો શુાં કરશો? તિ ે

ચોક્કસ કિેશો કે ઇન્ટરનેટર પરથી શોધી કાઢીશુાં, ઇ-લર્નનગ કરીશુાં. બરાબરને...! ખૂબ જ સરળ ર્ભાર્ાિાાં કિેવુાં 

િોય તો કિી શકાય કે ઇ-લર્નનગ એટલે “શીખવાની નવર્યવસ્તુ નડનજટલ સ્વરૂપિાાં િેળવી તેનો ઉપયોગ શીખવાની 

પ્રનિયા િાટે કરવો”. કેટલીક સરળ વ્યાખ્યાઓનો આપણે અભ્યાસ કરીએ. 

‘‘અધ્યયન-અધ્યાપન  પ્રનિયાના સિૃનિકરણ િાટે કે તેને આધાર આપવા િાટે ઇલેકટર ોનનક તકનનકીનો ઉપયોગ 

એટલે ઇ-લર્નનગ’’          (Mobbs, 2007) 
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‘‘ઇ-લર્નનગ એટલે કોઇપણ સ્થળે અને કોઇપણ સિયે લોકોને અધ્યયન િાટે સક્ષિ બનાવવા િાટે ટેકનોલોજીનો 

ઉપયોગ’’         (commlabindia.com, 2015) 

‘‘ઇલેકટર ોનનક સ્વરૂપિાાં આપવાિાાં આવતી તાલીિ કે નશક્ષણ એટલે ઇ-લર્નનગ.’’      (Kuhlmann, 2015) 

પરાંપરાગત અધ્યયન-અધ્યાપન પિમતિાાં અધ્યાપક, વગષખાંડિાાં અધ્યેતાને જ્ઞાન આપવા િાટે નવનવધ 

પ્રયુનતતઓનો ઉપયોગ કરે છે. અધ્યેતા સાાંર્ભળે છે, જુએ છે, આાંતરનિયા કરે છે. જ્યારે ઇ-લર્નનગિાાં અધ્યેતા 

અધ્યયન િાટે કમ્પપ્યૂટર, ટેબલેટ કે સ્િાટષફોન િારફત ઇ-કન્ટેન્ટનો ઉપયોગ કરે છે. ઇ-લર્નનગ િાટેનુાં આવુાં ઇ-

કન્ટેન્ટ નવનવધ સ્વરૂપોિાાં િોઇ શકે છે. જિે કે િમિક સ્લાઇડ્સની શ્રેણી, PDF, નવડીયો, સ્િીનકાસ્ટ, સોફ્ટવેર 

સીમ્પયુલેશન (કમ્પપ્યૂટરિાાં વાસ્તનવક પરરસ્થમત જવેો આર્ભાસ ઉર્ભો કરવો) અથવા એક પૂણષપણે આાંતરનિયાત્િક 

સ્લાઇડ આધારરત કોસષના સ્વરૂપિાાં િોઇ શકે છે. ઇ-લર્નનગ િાટેનુાં આ ઇ-કન્ટેન્ટ જ્યારે અધ્યયન-અધ્યાપન 

પ્રનિયા સાથે જોડાય છે ત્યારે ઇ-ટ્યુટોરરયલ બને છે. ઇ-ટ્યુટોરરયલને આ િુજબ વ્યાખ્યાનયત કરી શકાય. 

 ‘‘ઇ-ટ્યુટોરરયલ એ એવો કમ્પપ્યૂટર પ્રોગ્રાિ છે જનેો િેતુ ઉપર્ભોતતાને નવર્યવસ્તુના અધ્યયનિાાં િદદરૂપ 

થવાનો છે’’  

 એવુાં કિેવાય કે, ઇ-લર્નનગ અધ્યયનની પ્રનિયા છે, જ્યારે ઇ-ટ્યુટોરરયલ એ આ પ્રનિયા પૂણષ કરવા િાટેનુાં 

િાધ્યિ છે. 

તિારી પ્રગમત ચકાસો : 

1. ઇ  -લર્નનગની વ્ યાખ્ યા તિારા શબ્ દોિાાં લખો . 

2. ઇ  -ટ્યુટોરરયલની વ્ યાખ્ યા તિારા શબ્ દોિાાં લખો . 

3. ઇ  -લર્નનગની વ્ યાખ્ યાને આધારે ઇ  -લર્નનગની લાક્ષનણતતાઓ તારવો . 

1.3 ઈ-ટ્યટુોરરયલનુાં સ્વરૂપ 

ઇ-ટ્યુટોરરયલ એ શીખવાની પ્રનિયાના ર્ભાગરૂપે ઉપયોગિાાં લેવાતી જ્ઞાન પરરવિનની એક પિમત છે.  

જિેાાં પુસ્ તક અથવા વ્ યાખ્ યાનને બદલે ઇલેકટર ોનનક િાધ્યિોનો ઉપયોગ થાય છે. નવનવધ સ્વરૂપોના ઇ-

ટ્યુટોરરયલિાાં જોવા િળતી સાિાન્ય લાક્ષનણકતાઓ નીચે િુજબ છે.  

1.3.1 સ્વ-ગમતએ અસિકાનલક અધ્ યયન 

 સ્વ-ગમતએ અધ્ યયન અને અસિકાનલતતા એ ઈ-ટ્યુટોરરયલનુાં સૌથી સારાં  લક્ષણ છે. એટલ ે કે 

સાિાન્ય રીત ેઆ િાધ્ યિથી શીખવા િાટે કોઇ ચોક્કસ સ્થળ કે સિયનુાં બાંધન િોતુાં નથી. ઇ-લર્નનગ કોઇપણ 

સિય ેઅને અધ્યેતાની પોતાની ગમતથી થઇ શકે છે. તેિ છતાાં કેટલીક વખત કોસષ પૂણષ કરવા િાટેનો સિયગાળો 

નનનિત કરવાિાાં આવે છે અને તયારેક વેબ કોન્ફરન્સ કે ઇન્ટરનેટ ચેટના સ્વરૂપિાાં સિકાનલક અધ્ યયન અનુર્ભવો 

પણ આપવાિાાં આવે છે. પરાં તુ િહ્દઅાંશે અધ્ યયન-અધ્ યાપન સિકાનલક િોય છે.  

1.3.2 આાંતરનિયાત્િતતા  

 જનેે આકર્ષક કિી શકાય તેવા ઈ-ટ્યુટોરરયલ િોટાર્ભાગે આાંતરનિયાત્િક િોય છે. પરાંપરાગત પિમતઓિાાં 

અધ્યેતા િૂક શ્રોતા બની રિે છે. જ્યારે આાંતરનિયાત્િક ઇ-લર્નનગિાાં અધ્યેતા સનિય ર્ભાગીદાર બને છે. ત ે
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નવવેચનાત્િક ચચતન કરવા પ્રેરાય તેવી ઓનલાઇન પ્રવૃનિઓિાાં જોડાય છે. જિે કે શૈક્ષનણક ગેિ, નતવઝ ઉપરની 

નિયા-પ્રમતપોર્ણની પ્રમતનિયા  વગેરે.. 

1.3.3 િાધ્યિોની સિનૃિ 

એક અસરકારક ઈ-ટ્યુટોરરયલિાાં નવનવધ િીનડયાનો સિાવેશ થતો િોય છે. મિત્રો, જિેાાં િુદ્દાઓ કે ફકરા 

સ્વરૂપે િાત્ર લખાણ િોય તેવી પાવરપોઈન્ટ સ્લાઇડ્સની શ્રેણી િારફત ઇ-લર્નનગ કરવુાં ઘણીવાર કાંટાળાજનક 

લાગતુાં િોય છે. િકીકતિાાં જ ેશીખનારિાાં રસ જાગૃત કરે, તેનુાં ધ્યાન આકર્ે અને વાસ્તવિાાં તેને પ્રવૃિ રાખે તથા 

અધ્યેતાની સાંકલ્પના સ્પષ્ટ કરે તે અસરકારક ઈ-ટ્યુટોરરયલ બને છે. આથી જ ઘણા ઈ-લર્નનગ અભ્યાસિિો 

એનનિેશન, ઓનડયો અને નવનડયો જવેા નવનવધ િાધ્યિોથી સિૃિ િોય છે. 

1.4 ઇ-ટ્યટુોરરયલના પ્રકારો  

 ઈ-ટ્યુટોરરયલનો િેતુ અધ્ યેતાને પોતાનુાં જ્ઞાન રચી શકે તેવા અધ્ યયન અનુર્ભવો પુરા પાડવાનો કે 

અપેક્ષક્ષત વતષન પરરવતષનનો િોય છે. આ િેતુઓને ધ્ યાને લઇ સાિાન્ય રીત ેઈ-ટ્યુટોરરયલના િુખ્ય ત્રણ પ્રકાર 

પાડી શકાય. 

1.4.1 નવડીયો ટ્યટુોરરયલ 

આ પ્રકારના ટ્યુટોરરયલ કોસષ િોટેર્ભાગે િારિતીના પેકેજ સ્વરૂપે િોય છે. જ ેઅધ્યેતાને જાણકારી પુરી 

પાડવા િાટે ઉપયોગિાાં લેવાય છે. આ ટ્યુટોરરયલ નવડીયો સ્વરૂપે િોય છે, જનેે અધ્યેતા િાત્ર જુએ છે, પણ તિેાાં 

કોઇ આાંતરનિયા કરી શકતો નથી. ઇન્ટરનેટ પર આવા ઘણા ટ્યુટોરરયલ ઉપલબ્ધ છે. દા.ત. 

www.gyanyagya.info પર સરળ રિન્ દી ર્ભાર્ાિાાં આવા ટ્યુટોરરયલ ઉપલબ્ ધ છે.    

1.4.2  આાંતરનિયાત્િક ઈ-ટ્યટુોરરયલ  

આ પ્રકારના ટ્યુટોરરયલિાાં અધ્યેતા ઓનસ્િીન સૂચનાઓને અનુસરે છે. નવનવધ પ્રવૃનિઓ કરે છે અને 

પ્રમતપોર્ણ િેળવે છે. આ પ્રકારના ટ્યુટોરરયલિાાં નવનવધ પ્રકારના સ્ વાધ્ યાય િોય છે. અધ્યેતા પોતાની ગમતથી 

િિશઃ તેિાાં આગળ વધી શકે છે. નવડીયો ટ્યુટોરરયલ કરતા આ સ્વરૂપ વધુ સાર અને અસરકારક છે. દા.ત. 

ર્ભાર્ા શીખવા િાટેની Duolingo જવેી િોબાઇલ એપ. 

1.4.3  Webinars  (Web based Seminars) 

વેબબનાર એ વેબ આધારરત સેમિનારનુાં સાંક્ષક્ષપ્ ત છે. આ પ્રકારના ટ્યુટોરરયલિાાં અધ્યેતા ‘રીઅલ ટાઇિ 

લેતચર’ અથવા વેબ કોન્ફરન્સીંગ સોફ્ટવેરનો ઉપયોગ થતો િોય તેવી વેબકોન્ફરન્સ કે સેિીનારિાાં સિર્ભાગી બને 

છે, તજજ્ઞો સાથે પ્રશ્નોિરી કરે છે અને પોતાને િુાંજવતા પ્રશ્નોના ઉકેલ િેળવે છે. ઇ-લર્નનગના અન્ય પ્રકારો કરતાાં 

આ ઝડપી પિમત ગણાય છે. કોરોના કાળ અને તે પછીના સિયિાાં ઘણી સાંસ્થાઓ દ્વારા આવા વેબીનારનુાં 

આયોજન થતુાં રહ્યુાં છે. 

www.edweek.org, www.edtechteacher.org, edweb.net, cambridgeenglish.org, scholastic.com 

વગેરે વેબસાઇટ પર નશક્ષકો િાટે આવા સેમિનાર થતા િોય છે. જિેાાં સેમિનારનો નવર્ય અને સિય અગાઉથી 

આપવાિાાં આવતો િોય છે. સાિાન્ ય રીતે તે િાટે રજીસ્ ટરેશન કરાવવુાં પડે છે. 
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આકૃમત-1.1 

તિારી પ્રગમત ચકાસો : 

1. ઇ-ટ્યુટોરરયલની લાક્ષનણતતાઓ તિારા શબ્ દોિાાં લખો . 

2. ઇ-ટ્યુટોરરયલના જુદા-જુદા પ્રકારો િાટે ઉપયોગી વેબસાઇટની યાદી તૈયાર કરો . 

3. ઇ-ટ્યુટોરરયલનુાં કયુાં સ્ વરૂપ વધુ અસરકારક બની શકે ?શા િાટે ? 

1.5 ઈ-ટ્યટુોરરયલનુાં પ્રકાશન 

મિત્રો, તિે ઇ-ટ્યુટોરરયલ નવશે જરૂરી િારિતી િેળવી છે. ખરાં  ને ! િવે આપણે ઇ-ટ્યુટોરરયલના નનિાષણની 

પ્રનિયા તરફ આગળ વધીએ. આપણે ઇ-લર્નનગના િેતુસર ઇ-ટ્યુટોરરયલનુાં નનિાષણ કરીએ છીએ. આ નનિાષણ 

પ્રનિયા િાટેના સોપાનો સિજીએ તે પિેલા એ પણ નવચારી લેવુાં જોઇએ કે કેવી અધ્યયન સાિગ્રીને ઇ-ટ્યુટોરરયલ 

ન કિેવાય.  

એક સાર પાવરપોઇન્ટ પ્રેઝન્ટેશન બનાવી તેને ઓનલાઇન વઝષનિાાં રૂપાાંતરરત કરી દેવાિાાં આવ ેતો એ સાર 

ઇ-ટ્યુટોરરયલ બની જતુાં નથી. જો આ બાબત સ્પષ્ટ બને, તો જ ગુણવિાસર્ભ૨ અને અસ૨કા૨ક ઇ-

ટ્યુટોરરયલનુાં નનિાષણ થઇ શકે. એક યોગ્ય ઇ-ટ્યુટોરરયલ બનાવવા િાટે અઘ્યયન ક્ષસિાાંતો અને અઘ્યાપન 

યોજનાઓનો આધા૨ લઇ ચોક્કસ તબક્કાઓિાાંથી પસાર થવુાં પડે છે.  

ઇ-ટ્યુટોરરયલ નનિાષણ િાટેના તબક્કાઓ આ િુજબ છે. 

1.5.1 નવશ્લરે્ણ અન ેિેત ુનનધાષરણ  

આ તબક્કા દરમિયાન ઇ-ટ્યુટોરરયલના નનિાષણ િાટેના ઉદે્દશો નક્કી કરવાિાાં આવે છે. જ ે િાટે 

લક્ષ્ યજૂથની જરૂરરયાતો, લક્ષ્ યજૂથની કક્ષા, અધ્ યયન નનષ્ પનિઓ, સિયગાળો, નવર્યવસ્ તુનુાં ઊાંડાણ, વગેરે 

બાબતો ધ્ યાનિાાં લેવાિાાં આવે છે. ઉદે્દશો નક્કી કરવા િાટે આ તબક્કાિાાં અધ્યેતાના જ્ઞાન અને કૌશલ્યની 

પ્રવતષિાન નસ્થમત શુાં છે અને તેનાિાાં કેવા વતષન-પરરવતષનની અપેક્ષા છે, તે બે કક્ષાઓ વચ્ચેના અવકાશનુાં 
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નવશ્લેર્ણ (gap anaysis) કરવાિાાં આવે છે. આ નવશ્લરે્ણના આધારે લક્ષ્ યજૂથની જરૂરરયાતોને ઓળખી કોસષનો 

સિયગાળો, નવર્યવસ્ તનુુાં ઊાંડાણ, નવર્યવસ્ તનુી રજૂઆતની શૈલી વગેરે જવેી લાક્ષનણતતાઓ નવશે ઊાંડાણપૂવષક 

નવચારણા કરી ઇ-ટ્યુટોરરયલના િેતુઓ નનધાષરરત કરવાિાાં આવે છે. 

1.5.2 વ્ યિૂરચના નક્કી કરવી  

ઈ-ટ્યુટોરરયલની અસરકારતતા અને સફળતાનો આધાર આ તબક્કા પર રિેલો છે. પ્રથિ તબક્કાિાાં 

નનધાષરરત કરેલા િેતુઓ અને કરેલા નવશ્લેર્ણના આધારે પિેલાની અને પછીની કક્ષાઓ વચ્ચેનો અવકાશ દૂર 

કરવા િાટેની યોજના ઘડવાિાાં આવે છે. જિેાાં કેવા પ્રકારના કોસષની જરૂરરયાત રિેશે, તે િાટેની નવર્યવસ્ ત ુતથા 

તેિાાં સિાવેશ કરવા િાટેના નવનવધ િાધ્ યિો વગેરે િાટેનુાં આયોજન કરવાિાાં આવે છે. આ ઉપરાાંત િલૂ્યાાંકન 

યોજના િાટે પણ વ્યૂિરચના ઘડવાિાાં આવે છે.  

1.5.3 કોસષનુાં આયોજન  

બીજા તબક્કાિાાં ઘડાયેલી વ્યૂિરચનાના આધારે કાચી અધ્યયન સાિગ્રી જવેી કે લખાણ, ક્ષચત્રો, 

ઓનડઓ, નવડીઓ, એનનિેશન વગેરે આ તબક્કાિાાં એકત્ર કરવાિાાં આવે છે. એકત્ર કરેલી સાિગ્રીને યોગ્ ય તાર્કકક 

િિિાાં ગોઠવી તેનુાં પ્રથિ સ્ વરૂપ (story board) નવચારવાિાાં આવ ેછે. જિેાાં બ્રેઇન સ્ટોર્મિગ, િાઇન્ડ િેપપગ, 

ગિન ચચતન અને નતવઝ વગેરે જવેી સજષનાત્િક પ્રયુનતતઓનો સિાવેશ કરવાિાાં આવે છે. 

1.5.4 ઈ-ટ્યટુોરરયલનુાં નનિાષણ 

ત્રીજા તબક્કાિાાં એકત્રીત કરેલી કાચી સાિગ્રી અને નક્કી કરેલી કોસષ ડીઝાઇન અને સ્ ટોરીબોડષના આધારે 

ઈ-ટ્યુટોરરયલનુાં નનિાષણ કરવાિાાં આવે છે. આ તબક્કો નવર્યવસ્ તુ અને તેને સાંબાંનધત કોસષની રજૂઆતનો 

તબક્કો િોવાથી ઘણો જ અગત્ યનો તબક્કો ગણવાિાાં આવે છે. આ તબક્કાિાાં અગાઉ એકત્ર કરેલા છૂટાછવાયા 

નવર્યવસ્ તુને જોડવાિાાં આવે છે. અિીં ત્રીજા તબક્કાિાાં બનાવેલી નડઝાઇન િુજબ જુદા જુદા િાધ્ યિોિાાં રિેલ 

નવર્યવસ્ તુનુાં તેિજ ઓનલાઇન સાંસાધનોનુાં સાંકલન કરી, જરૂરી ઓનડયો ઉિરેી યોગ્ય નેવીગેશન ડીઝાઇન કરી 

એક સાંપૂણષ કોસષનુાં નનિાષણ કરવાિાાં આવ ેછે.  

1.5.5 ઈ-ટ્યટુોરરયલની અજિાયશ 

 નનિાષણ કરેલ નવર્યવસ્ તનુી અસરકારકતાની ચકાસણી િાટે નાના સિૂિ પર તેની અજિાયશ આ 

તબક્કાિાાં કરવાિાાં આવે છે. ઉપયોગકતાષના પ્રમતપોર્ણને આધારે ઈ-ટ્યુટોરરયલિાાં રિેલી રૂ્ભલો, કચાશો, યાાંમત્રક 

િુશ્ કેલીઓ વગેરે તારવવાિાાં આવ ે છે. આ ઉપરાાંત ઈ-ટ્યુટોરરયલિાાં િૂકવાિાાં આવેલાાં ગ્રાનફતસ, ક્ષચત્રો, 

િલ્ટીમિનડયા વગેરે વબેપેજ પર યોગ્ ય રીતે કાયષરત છે કે કેિ તેની ચકાસણી પણ કરવાિાાં આવ ેછે.  

1.5.6 ઈ-ટ્યટુોરરયલ પનબ્લશ કરવુાં  

અજિાયશના તબક્કા દરમ્પ યાન જોવા િળતી ત્રૂટીઓને દૂર કરી ઉપયોગકતાષઓના પ્રમતપોર્ણને ધ્ યાને 

લઇ જરૂરી સુધારાવધારા કરી ઈ-ટ્યુટોરરયલને આખરી સ્ વરૂપ આપવાિાાં આવે છે. િવે આ અભ્યાસ સાિગ્રી (ઈ-

ટ્યુટોરરયલ) સૌને સરળતાથી ઉપલબ્ ધ બને તે િાટે વબે સવષર પર િૂકવાિાાં આવે છે. 
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1.5.7 ઈ-ટ્યટુોરરયલની અસરકારકતાની ચકાસણી 

ઈ-ટ્યુટોરરયલ નનિાષણ પ્રનિયાનો આ અાંમતિ તબક્કો છે. તેિાાં એ બાબતની ખાતરી કરવાિાાં આવે છે કે 

નનિાષણ પાિેલ સાિગ્રી અધ્યેતાની જરૂરરયાતો પૂણષ કરવાિાાં સફળ રિી કે નિીં, આ સાિગ્રી િાટે નક્કી કરેલા 

િેતુઓ પરરપૂણષ થયા કે નિીં. આ બાબતોની ચકાસણી િાટે કોસષ પૂણષ કરનાર અધ્યેતાઓનુાં પ્રિાણ, કોસષના અાંતે 

આપવાિાાં આવતી કસોટીિાાં સફળ થનાર અધ્યેતાઓનુાં પ્રિાણ, સવે દ્વારા કોસષ નવશે િેળવેલા અબર્ભપ્રાયોનુાં 

નવશ્લેર્ણ વગેરે પ્રનિયાઓ કરવાિાાં આવ ેછે. આિ, નનિાષણ પાિેલ ઇ-ટ્યુટોરરયલની અસરકારકતાનુાં િલૂ્યાાંકન 

કરવાિાાં આવ ેછે. જરૂર જણાય તો િળેલા પ્રમતર્ભાવોને આધારે તો ઇ-ટ્યુટોરરયલિાાં ફેરફાર કરવાિાાં આવ ેછે.     

આિ, અસરકારક ઇ-ટ્યુટોરરયલનુાં નનિાષણ એ ઘણી જ િિેનત િાાંગી લે તેવી પ્રનિયા છે. 

તિારી પ્રગમત ચકાસો. 

1. ઇ-ટ્યૂટોરીઅલ રચાનાનાાં સોપાનો જણાવો.  

2. ઇ-ટ્યૂટોરીઅલની રચના કરતાાં પિેલા કઇ બાબતો ધ્યાનિાાં લેવી જરૂરી છે? 

1.6 ઇ-ટ્યટુોરરયલના ફાયદાઓ 

• તે ઓછી ખચાષળ પ્રનિયા છે . 

• અધ્યેતા પોતાની ગમતથી શીખી શકે છે . 

• તે સ્થળ અને સિયના બાંધનોથી િુતત છે. 

• તેિાાં અધ્યેતા સનિય રિે છે . તેને ત્ વરરત પ્રમતપોર્ણ િળે છે . 

• ઇ-ટ્યુટોરરયલ દ્વારા ઇ-લર્નનગ કરવા િાટે ટેબ્લેટ અને સ્િાટષફોનનો પણ ઉપયોગ કરી શકાય છે . 

• ઇ-ટ્યુટોરરયલ અન્ય ઉપયોગકતાષને શૅઅર (share) કરી શકાય છે.   

• ઇ-લર્નનગ િાટે ઇ-ટ્યુટોરરયલનુાં એક જ વાર નનિાષણ કરી તેને વારાંવાર ઉપયોગિાાં લઇ શકાય છે . 

• તેિાાં સુધારો કરવો શતય છે. આથી અદ્યતનીકરણ અને સિૃનિકરણ ઝડપી બને છે. 

• અધ્યેતાનુાં ઓનલાઇન િૂલ્યાાંકન કરી શકાય છે . 

• ઇ-લર્નનગ કરનાર અધ્યેતાનો રેકોડષ  અને પ્રગમત અિેવાલ સાચવી રાખી શકાય છે . 

1.7 ઇ-ટ્યટુોરરયલની િયાષદાઓ 

• ઇ-ટ્યુટોરરયલનો ઉપયોગ કરવા િાટે કોઇ પ્રકારનુાં ઇલકેટર ોનનક િાધ્યિ જરૂરી છે . 

• ઇ-ટ્યુટોરરયલની નનિાષણ પ્રનિયા િાટે યોગ્ય કૌશલ્યો િોવા જરૂરી છે. 

• અધ્ યેતા પાસે પાયાના તકનનકી કૌશલ્ યો િોવા જરૂરી બને છે. 

• જો ઇ-ટ્યુટોરરયલની ડીઝાઇન યોગ્ય ન િોય તો અસરકારક રિેતુાં નથી. 

• નવનવધ મિડીયા યોગ્ય રીતે ચાલી શકે તે િાટે યોગ્ય સોફ્ટવેર ઇન્સ્ટોલ િોવા જરૂરી બને છે. 
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સ્વાધ્યાય 

નીચનેા પ્રશ્નોના નવસ્તતૃ જવાબ આપો. 

1.  ઈ-ટ્યુટોરીયલની અસરકારકતાની ચકાસણી કરવી શા િાટે જરૂરી છે? 

2. ઈ-ટ્યુટોરીયલના પ્રકારો નવર્ે નવસ્તૃત નોંધ લખો. 

3. ઈ-ટ્યુટોરીયલ પ્રકાનશત કરવાનો િેતુ શુાં િોય છે? 

4. ઈ-ટ્યુટોરીયલના ફાયદાઓ જણાવો.  

5. ઈ-ટ્યુટોરીયલની િયાષદાઓ જણાવો. 

 

 

 

 

 

 
 
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પ્રકરણ-2 

પરરવર્તન પામર્ા વબેસાઈટ્સના સ્વરૂપો  
 

2.1 પ્રસ્ર્ાવના  

રાષ્ટ્ર ીય શિક્ષણ નીતર્ 2020 શિક્ષણમાાં આર્ટીશિશિયલ ઇન્રે્ટશલજન્સના ઉપયોગની રિમાયર્ કરે છે. વેબ 

3.0 એ આર્ટીિીશિયલ ઇન્રે્ટશલજન્સનો ઉપયોગ કરર્ ાં પ્લેર્ટિોમત છે. આપણે જાણીએ છીએ કે વેબસાઈર્ટોનો કાળક્રમે 

શવકાસ થયો. પ્રથમ પેઢીની વેબસાઈર્ટો વબે 1.0 ર્રીકે ઓળખાર્ી જ ેસ્રે્ટરર્ટક પ્લેર્ટિોમત ધરાવર્ી િર્ી. આ પ્રકારની 

વેબસાઈર્ટોના સ્વરૂપમાાં કે મારિર્ીમાાં જરૂરી િેરિારો પણ માત્ર ર્જજ્ઞો દ્વારા જ થઇ િકર્ા િર્ા. વેબ 2.0ના 

આગમન સાથે વેબ 1.0ની પ્રથમ પેઢીની વેબસાઈર્ટોમાાં પરરવર્તન આવય ાં. આ પ્રકારની વેબસાઈટ્સ દ્વારા 

ઉપયોગકર્ાતને વેબસાઈર્ટ પર મારિર્ી મ કવા, િેરિાર કરવા કે જરૂરી આાંર્રશક્રયા કરવા મારે્ટન ાં એક ઉપયોગી 

પ્લેર્ટિોમત પૂરાં  પાડ્ ાં. કૃતત્રમ બ શિમર્ા (આર્ટીિીશિયલ ઇન્રે્ટશલજન્સ)ના ઉપયોગમાાં વધારો થર્ાની સાથ ેધીરે 

ધીરે વેબ 3.0ના ઉપયોગની િરૂઆર્ પણ થઇ છે.  

પ્રસ્ર્ ર્ પ્રકરણમાાં વેબ 2.0નો અથત અને લાક્ષશણકર્ાઓ, વેબ 2.0ની ઉપયોગીર્ા, વેબ 2.0ના માધ્યમો, 

વેબ 3.0નો અથત , વેબ 2.0 અને વેબ 3.0 વચ્ચેનો ર્િાવર્ અને વેબ 2.0 અને વબે 3.0ના ઉપયોગથી શિક્ષણને 

કેવી રીર્ે સમૃિ બનાવવ ાં ર્ેની ચચાત કરવામાાં આવી છે.  

 

ઉદે્દિ  

• વેબ 2.0નો અથત અને લાક્ષશણકર્ાઓ જણાવી િકિે.   

• વેબ 2.0ની ઉપયોગીર્ા જાણી િકિે.  

• વેબ 2.0ના માધ્યમોથી પરરચચર્ થિે.  

• વેબ 3.0નો અથત આપી િકિે.  

• વેબ 2.0 અને 3.0 વચ્ચેનો ર્િાવર્ આપી િકિે. . 

• વેબ 2.0 અને વેબ 3.0ના ઉપયોગ દ્વારા શિક્ષણ સમૃશિકરણ શવષે જાણી િકિે. 

2.2  વબે 2.0નો અથત  

વેબ 2.0 િબ્દ ઓ રેલી મીશિયા વેબ 2.0 સાંમેલનમાાં Tim O’ Reiley (ર્ટીમ ઓ રેલી) અને Dale 

Dougherty (િેલ િોરર્ટી) દ્વારા ૨૦૦૪માાં પ્રયોજાયો િર્ો. આ પિેલા આ િબ્દનો ઉપયોગ ૧૯૯૯માાં  Darcy 

DiNucci (િાસી િીનક્કી) દ્વારા કરવામાાં આવયો િર્ો.  

વેબ 2.0એ બીજી પેઢીની World Wide Webન ાં સ્વરૂપ છે જ ેઈન્ર્ટરનેર્ટના ઉપયોગ દ્વારા  ઉપયોગકર્ાતઓને 

વેબસાઈર્ટમાાં ઓનલાઈન મારિર્ી એકતત્રર્ કરવી, મારિર્ીન ાં સજતન કરવ ાં, પ્રતર્ભાવો  આપવા કે રે્ને 

િૅઅર(Share) કરવાની સ શવધા પૂરી પાિે છે. વેબ 2.0 જ દા જ દા ઉપયોગકર્ાતને એવ ાં પ્લેર્ટિોમત પૂરાં  પાિે છે કે 

જયાાં ઉપયોગકર્ાત ઓનલાઈન મારિર્ી સિળર્ાપૂવતક આાંર્રક્રીયાત્મક રીર્ે આપલે કરી િકે. વેબ 2.0ની કોઈ 

સવતસ્વીકૃર્ વયાખ્યા નથી.  પરાંર્  રે્નો સામાન્ય અથત નીચે આપવામાાં આવયો છે.  
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‘‘વેબ 2.0એ કોઈ સોફ્ર્ટવેર નથી પરાંર્  રે્ એવી સ શવધાઓ મારે્ટ વપરાર્ો િબ્દ છે જ ે ઈન્ર્ટરનેર્ટના 

માધ્યમથી ઉપયોગકર્ાતને પોર્ાની મારિર્ી મ કવા દે, સામ રિક રીરે્ મારિર્ીન ાં સજતન કરવા દે કે પછી મારિર્ી પર 

પ્રતર્ભાવ આપવા દે.’’ 

 વેબ 2.0માાં વબે આધારરર્ વેબ પ્રોગ્રામ્સ (Web Programmes), સોશિયલ નેર્ટવર્કકગ (Social 

Networking), ઇન્ર્ટરેશટર્ટવ સાઈટ્સ (Interactive sites), શવિીયો િૅરીંગ સાઈટ્સ (Video sharing sites), વબે 

કમ્ય શનર્ટી (વેબ સમ દાયો), િોસ્ર્ટ સર્વવસ (Host Service), શવશકઝ (Wikis), બ્લોગ્સ (Blogs), મિેપ 

(Mashup – બે કે ર્ેથી વધ  સ્રોર્ોનો ઉપયોગ કરી બનાવવામાાં આવેલ વેબપેજ) ર્થા િોટસોનોમી (Folksonomy 

– Contentને રે્ટગગગ કરી વગીકૃર્ કરવ ાં) વગેરેનો સમાવેિ થાય છે. 

2.3 વબે 2.0ની મ ખ્ય લાક્ષશણટર્ાઓ 

વેબ 2.0માાં નીચ ેમ જબની લાક્ષશણટર્ાઓ જોવા મળ ેછે.  

• વેબ 2.0 િોટસોનોમીનો ઉપયોગ કરે છે.  િોટસોનોમીનો સામાન્ય અથત આવો કરી િકાય કે લોકો દ્વારા 

ઈન્ર્ટરનેર્ટ પર ઓનલાઇન મારિર્ીઓન ાં વગીકરણ કરી અને ગોઠવણી કરવાની પ્રશક્રયા, જથેી જરૂરરયાર્ 

મ જબ મારિર્ી પ્રાપ્ત કરી િકાય. 

• વેબ 2.0 રૅ્ટકનોલોજીના શવકાસે વેબસાઈર્ટના માળખાને આાંર્રશક્રયાત્મક બનાવય ાં અને એક સમૃિ 

આાંર્રશક્રયાત્મક માળખ ાં પૂરૂ પાડ્ ાં. આ માળખામાાં ઉપયોગકર્ાતને વેબસાઈર્ટમાાં અમ ક અાંિે િેરિાર કરવાની 

ર્ક પણ પૂરી પાિવામાાં આવી. 

• વેબ 2.0માાં ઉપયોગકર્ાત એજ સિયોગકર્ાત છે. િરૂઆર્ની વેબસાઈર્ટો સામાન્ય રીર્ે કોઈ વયાવસાશયક 

વયશટર્ઓ પાસે ર્ૈયાર કરાવવામાાં આવર્ી. ર્ૈયાર થયેલ વેબસાઇર્ટને ઉપયોગકર્ાત માત્ર જોઇ િકે ર્ેવી 

વયવસ્થા આ પ્રકારની વેબસાઈર્ટોમાાં જોવા મળર્ી. વબે 2.0માાં શદ્વપક્ષીય શક્રયાઓ ધરાવર્ ાં માળખ ાં બન્ય ાં 

જમેાાં ઉપયોગકર્ાત પણ પોર્ાના પ્રતર્ભાવો આપી િકે ર્ેવી વયવસ્થા અશસ્ર્ત્વમાાં આવી . 

• આ પ્રકારની વેબસાઈર્ટ ઉપયોગકર્ાત પર પૂણત શવશ્વાસ મ કે છે. વેબ 2.0માાં વેબસાઇર્ટને િૅઅર કરવી, ર્ેનો 

િરી ઉપયોગ કરવો, િરીથી શવર્રરર્ કરવી કે રે્માાં સ ધારાવધારા કરવા જવેી છૂર્ટ ઉપયોગકર્ાતને આપવામાાં 

આવે છે. 

• વેબ 2.0 ખૂબ ઝિપથી શવકસર્ી રૅ્ટકનોલોજીન ાં સ્વરૂપ છે. જોિાય સાથે એકબીજા વેબસાઈર્ટો બધી ઘણી  

છે. જ દી જ દી વબેસાઈર્ટોની સ શવધાઓ એક જ વેબસાઈર્ટમાાંથી ઉપયોગ કરવાની સગવિ પણ પ્રાપ્ત થાય 

છે.  

ર્મારી પ્રગતર્ ચકાસો 

1. વેબ 2.0 આધારરર્ િૈક્ષશણક એપ્લીકેિન્સ કે વેબસાઈર્ટની યાદી ર્ૈયાર કરો.  

2. વેબ 2.0ની એપ્લીકેિન્સ કે વેબસાઈર્ટનો શિક્ષણમાાં ટયાાં શવશનયોગ િટય છે ? ર્ે શવચારીને નોંધો. 

2.4 વબે 2.0ની ઉપયોતગર્ા 

 સોશિયલ વેબસાઈર્ટો વેબ 2.0ન ાં અગત્યન ાં માધ્યમ છે. સોશિયલ વેબ એ એવ ાં ઓનલાઈન રૂ્ટલ કે પ્લેર્ટિોમત 

છે કે જ ેલોકોને પોર્ાના અભભપ્રાયો, ર્કત , યોજનાઓ, શવચારો, કે અન ભવો િૅઅર કરવાની ર્ક આપે છે. વબે 

2.0 અાંતર્મ ઉપયોગકર્ાત સ ધી પિોચવાની ર્ક પણ પૂરી પાિે છે. જયાાં ઉપયોગકર્ાત માત્ર વેબસાઈર્ટ કે ર્ેની 
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એપ્લીકેિન સાથે નરિ પણ ર્ેની અન્ય સ શવધાઓ જવેી કે પોિકાસ્સ્ર્ટગ (PodCasting), બ્લોગગગ (Blogging), 

રે્ટગગગ (Tagging), આરએસએસ િીિ (Rss Feed), સોશિયલ બ ક માર્કકગ (Social Book Marking), સોશિયલ 

નેર્ટવર્કકગ (Social Networking) કે પછી વેબ કન્રે્ટન્ર્ટ વોર્ટીંગ (Web Content Voting) સાથે જોિાય છે.  

અધ્યેર્ા અને અધ્યાપકોને વેબ 2.0 રૅ્ટકનોલોજી નીચનેી જવેી બાબર્ોમાાં ઉપયોગી બને છે.  

• શિક્ષકો દ્વારા ર્ૈયાર કરવામાાં આવેલ િૈક્ષશણક સારિત્ય, જવે ાં કે શવષયને લગર્ા પાવરપોઈન્ર્ટ પ્રેઝેન્રે્ટિન 

ઈન્ર્ટરનેર્ટના ઉપયોગ દ્વારા ઓનલાઈન મૂકી શવદ્યાથીઓ મારે્ટ પ્રાપ્ય બનાવી િકાય છે.  

• અસાઇનમેન્ર્ટ (સ્વાધ્યાય) કે રે્ટસ્ર્ટ પેપર શિક્ષક સરળર્ાથી ઓનલાઈન મૂકી િકે છે અને શવદ્યાથીઓ દ્વારા 

આ પ્રકારના સારિત્ય પર જરૂરી પ્રતર્ભાવો આપી િકાય છે.  

• શવદ્યાથીઓ ર્ૈયાર કરેલ અસાઇનમેન્ર્ટસ ઓનલાઈન મૂકે જથેી અન્ય શવદ્યાથીઓ પણ આ અસાઇનમેન્ર્ટસ 

જોઈ િકે અને ર્ેના પર પ્રતર્ભાવો આપી િકે છે.  

• શવદ્યાથીઓ દ્વારા િૈક્ષશણક શવિીયો કે ઓશિયો પ્રકારન ાં સારિત્ય ર્ૈયાર કરવામાાં આવેલ િોય, ર્ો ર્ ેપણ 

ર્ે સરળર્ાથી પોર્ાના શિક્ષકો અને શવદ્યાથી તમત્રો સાથે ઓનલાઈન િૅઅર કરી િકે છે અને રે્માાં જ દા 

જ દા પ્રકારની કોમેન્ટ્સ પણ આપી િકે છે.  

• શિક્ષકો પોર્ાના વયાખ્યાનો ઓનલાઈન મૂકી િકે છે અને શવદ્યાથીઓ ર્ે ઓનલાઈન શનિાળી ર્ેના પર 

પ્રતર્ભાવો આપી િકે છે.  

• શિક્ષકો પોર્ાના શવષયોના બ્લોગ્સ કે શવશકઝ બનાવી પોર્ાના શવષયને લગર્ી મારિર્ીઓ િૅઅર કરી િકે 

છે.  

ર્મારી પ્રગતર્ ચકાસો. 

1. વેબ 2.0 શિક્ષકોને વિીવર્ટી કામગીરીમાાં ટયાાં ઉપયોગી થઇ િકિે ર્ેની નોંધ ર્મારા આધ્યાપક સાથે ચચાત 

કરી ર્ૈયાર કરો. 

2.5 વબે 2.0ના માધ્યમો  

વેબ 2.0 એ પોર્ે જ એક માધ્યમ છે. પરાંર્  રે્ મારિર્ીન ાં અસરકાર સાંચાલન કરવા મારે્ટ જ દા જ દા પ્રકારના 

ઉપકરણોનો ઉપયોગ કરે છે. ર્ો ચાલો અત્રે આવા ઉપકરણોની ચચાત કરીએ. 

2.5.1 મીશિયા િરૅીંગ (Media Sharing)  

શિક્ષકો  દ્વારા જ દા જ દા પ્રકારન ાં િૈક્ષશણક સારિત્ય રૈ્યાર કરવામાાં આવે છે. શિક્ષકો દ્વારા રૈ્યાર થયેલ 

આવા જ દા જ દા પ્રકારના િૈક્ષશણક િોટય મેન્ટ્સ, ઓશિયો અને શવિીયો જવેા સ્વરૂપની િાઈલો વેબ 2.0 

રૅ્ટકનોલોજી ધરાવર્ી વેબસાઈર્ટો પર ઈન્ર્ટરનેર્ટના માધ્યમ દ્વારા ઓનલાઈન મૂકી િૅઅર કરવામાાં આવે છે. વર્તમાન 

સમયમાાં મીશિયા િૅરીંગ મારે્ટ google drive, youtube, teachertube અને slideshare જવેી વેબસાઈર્ટો ખૂબ જ 

પ્રચશલર્ બનેલી છે.   

2.5.2 બ્લોગગગ (Blogging) 

 જ દી જ દી વેબસાઈર્ટો ઉપયોગકર્ાતને બ્લોગ્સ ર્ૈયાર કરવા મારે્ટ પયાતપ્ત જગ્યા રે્મજ જ દા જ દા ર્ૈયાર રૂ્ટલ્સ 

પ રા પાિે છે. સામાન્ય રીર્ે શિક્ષકો દ્વારા બનાવવામાાં આવર્ા બ્લોગમાાં ર્ે પોર્ાના શવચારો, ર્ૈયાર કરવામાાં આવેલ 

િૈક્ષશણક સારિત્ય, અને ર્ેના િૈક્ષશણક અન ભવો મ કે છે. જનેો ઉપયોગ શવદ્યાથીઓ ર્ેમજ અન્ય શિક્ષકો કરે છે. 
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શિક્ષકો અને શવદ્યાથીઓ આવા ર્ૈયાર થયેલ બ્લોગ્સ પર પોર્ાના પ્રતર્ભાવો આપે છે જ ેબ્લોગને વધ  દિતનીય 

બનાવે છે  

2.5.3 શવકીઝ (Wikis) 

Wikis એ Website નો જ પ્રકાર છે જયાાં એક સાથે ઘણા Users ઓનલાઇન થઇ િકે છે અને રે્ના પર જ દા 

જ દા શવષયોને લગર્ી મારિર્ીને વાાંચી િકે છે રે્મજ રે્માાં જરૂરી સ ધારાવધારા કરી િકે છે. િાળા અને કૉલેજના 

શિક્ષકોને પણ Wikis ઉપયોગી થાય છે. શિક્ષક તમત્રો પોર્ાના શવષયોને લગર્ા Wikis બનાવી પોર્ાના જ્ઞાનને 

વધ  સમૃિ બનાવે છે. આમ છર્ાાં, શવશકપીશિયા એ માન્ય સ્રોર્ ગણાર્ો નથી. 

2.5.4 સોશિયલ નરે્ટવર્કકગ (Social Networking) 

સામાન્ય રીર્ે સોશિયલ નેર્ટવર્કકગની વેબસાઈર્ટો શવચારો અને નાવાચારોને િૅઅર કરવા ર્ેમજ ચચાત કરવા 

મારે્ટન ાં પ્લેર્ટિોમત પૂરાં  પાિર્ી િોય છે. રે્ટગગગ અને કોમેન્ર્ટીંગ જવેી સ શવધાઓ આ પ્રકારની વેબસાઈર્ટોને વધ  

આકષતક બનાવે છે. http://www.facebook.com, http://learnhub.com અને  http://www.linkedin.com 
જવેી  વેબસાઈર્ટો ર્ેના ઉદાિરણો છે. 

2.6 વબે 3.0 નો અથત : 

વેબ 3.0 એ વબે 2.0 ન ાં બદલાય રિેલ ાં સ્વરૂપ છે. વેબ 3.0 િબ્દ સૌપ્રથમ 2006માાં ન્યૂયોકત  ર્ટાઇમ્સના 

જિોન માકોિ દ્વારા ઉપયોગમાાં લેવામાાં આવયો િર્ો અને વષત 2006ની િરૂઆર્માાં જિેરી ઝેલ્િમેન દ્વારા લખાયેલ 

"શક્રરર્ટકલ ઓિ વેબ 2.0 અને એજટેસ જવેી સાંબાંશધર્ રૅ્ટકનોલોજી" નામના બ્લોગ પરના લેખમાાં ર્ેનો ઉલે્લખ જોવા 

મળ્યો િર્ો.  

શનષ્ણાર્ો અને સાંિોધકો ભાશવ વેબસાઈર્ટ મારે્ટના આવા શવકસી રિેલા શવશવધ અભભગમોને રે્ટકો આપે છે. 

વેબ 3.0 કેવી રીર્ે શવકચસર્ થિે ર્ે અાંગે શનષ્ણાર્ોમાાં એક મર્ એવો પ્રવર્તર્ રહ્યો છે કે આ વબે 3.0ની વેબસાઈર્ટસ 

‘ચસમેન્ર્ટીક વબે’ (Semantic Web)ના સ્વરૂપે શવકાસ પામી રિી છે. 

‘ચસમેન્ર્ટીક’ એર્ટલ ે‘અથતપૂણત’. સરળ ભાષામાાં કિીએ ર્ો ‘ચસમેન્ર્ટીક વેબ એર્ટલ ેવેબ પરની વસ્ર્ ઓ 

વચ્ચેના સાંબાંધને એવી રીર્ ેવણતવો કે મિીન અને લોકો ર્ેને સરળર્ાથી સમજી િકે.’     

‘ચસમેન્ર્ટીક વેબ’ એ  વેબ ઉત્ક્રાાંતર્ન ાં ઝિપથી શવકસી રિેલ ાં સ્વરૂપ છે. ‘ચસમેન્ર્ટીક વેબ’ એ વેબસાઈર્ટ પર િેર્ટા 

(Data) ર્ેમજ દસ્ર્ાવેજો (Documents) રાખવાની શવિેષ પ્રશક્રયા છે. ર્ે િેર્ટા ર્ેમજ દસ્ર્ાવેજો પર  યોગ્ય 

રે્ટકશનકલ પ્રશક્રયાઓ કરી ર્મેાાં પરરવર્તન કરી અને િેર્ટા કે િોટય મેન્ર્ટસને જરૂરરયાર્ મ જબ ઉપયોગમાાં લઇ િકાય 

ર્ેવી શનણાતયક શસ્થતર્માાં લાવવાની સ શવધા આપર્ ાં વબેસાઈર્ટન ાં પ્લેર્ટિોમત છે. 

2.7  વબે 2.0 અન ે3.0 વચ્ચનેો ર્િાવર્ 

વબે 2.0 વબે 3.0 

‘વેબ 2.0એ કોઈ સોફ્ર્ટવેર નથી પરાંર્  રે્ એવી 

સ શવધાઓ મારે્ટ વપરાર્ો િબ્દ છે, જ ે ઈન્ર્ટરનેર્ટના 

માધ્યમથી ઉપયોગકર્ાતને પોર્ાની મારિર્ી મ કવા દે, 

સામ રિક રીરે્ મારિર્ીન ાં સજતન કરવા દે કે પછી મારિર્ી 

પર પ્રતર્ભાવ આપવા દે.’   

 

વેબ 3.0ની વેબસાઈર્ટસ ‘ચસમેન્ર્ટીક વબે’ (Semantic 

Web)ના સ્વરૂપે શવકાસ પામી રિી છે. ‘ચસમેન્ર્ટીક’ 

એર્ટલે ‘અથતપૂણત’. સરળ ભાષામાાં કિીએ ર્ો 

‘ચસમેન્ર્ટીક વેબ એર્ટલે વબે પરની વસ્ર્ ઓ વચ્ચેના 

સાંબાંધને એવી રીર્ે વણતવો કે મિીન અને લોકો ર્ેને 

સરળર્ાથી સમજી િકે.’     
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િેર્ટાની આાંર્રશક્રયાત્મકર્ા દિાતવે છે.  િેર્ટા વચ્ચે રિેલા આાંર્રસબાંધો દિાતવે છે.  

િેર્ટાના માધ્યમ ર્રીકે મીશિયા િૅરીંગ, બ્લોગગગ, 

શવકીઝ, સોશિયલ નેર્ટવર્કકગ વેબસાઈર્ટ જવેા 

માધ્યમોનો ઉપયોગ કરે.  

િેર્ટાના શવશ્લેષણ મારે્ટ સીમેન્રે્ટક વેબ સર્વવસ, 

આર્ટર્ટશિશિયલ ઈન્રે્ટલીજન્સ (AI), િેર્ટા માઈનીંગ 

(DM), સ્લકિ િેર્ટા (LD), નેચરલ લેંગ્વેજ પ્રોસેસસગ 

(NLP) જવેી ર્કશનકીનો ઉપયોગ કરવામાાં આવે છે.   

સમાન્ય રીર્ે િેર્ટા િૅરીંગ પ્લેર્ટિોમત સાથે સબાંશધર્ િોય, 

િેર્ટા શવષેના ચોક્કસ અન માનો કરવામાાં બિ  ઉપયોગી 

થર્ ાં નથી.  

આર્ટર્ટશિશિયલ ઈન્રે્ટલીજન્સ (AI) અને  િેર્ટા માઈનીંગ 

(DM) જવેી શવશવધ રૅ્ટકનોલોજીના ઉપયોગથી િેર્ટા 

શવશ્લેષણ જવેી પ્રશક્રયામાાં સિાયભૂર્ થર્ ાં િોવાથી 

ચોક્કસ અન માનો કરવામાાં સિાયભૂર્ થાય છે.  

વેબ 2.0 એ વેબ 1.0 ન ાં અદ્યર્ન સ્વરૂપ છે જ ે 

વેબસાઈર્ટની આાંર્રશક્રયાત્મટર્ા વધારવા મારે્ટના 

માધ્યમો અને રૅ્ટકનોલોજી દિાતવે છે.  

વેબ 3.0 એ વેબ 2.0ન ાં અદ્યર્ન સ્વરૂપ છે જ ેિેર્ટાના 

જ દા જ દા શવશે્લષ્ણ મારે્ટની રૅ્ટકનોલોજી દિાતવે છે. 

2. 8 વબે 2.0 અન ેવબે 3.0 ના ઉપયોગથી શિક્ષણન ાં સમશૃિકરણ   

વેબ 2.0ના ઉપયોગથી છેલ્લા થોિા વષોથી શિક્ષણમાાં જ ેપરરવર્તનો આવયા છે, ર્ે ખરેખર નોંધનીય રહ્યાાં 

છે. ગ ર પ્રણાલીથી ચાલર્ ાં શિક્ષણ ઈ-લર્કનગની વયાખ્યામાાં ધીરે ધીરે આકાર લઇ રહ્ય ાં છે. શિક્ષણમાાં વેબ 2.0 

અને વેબ 3.0ના ઉપયોગ ે શિક્ષણને સ્થળ અને સમયના બાંધનોથી મ ટર્ બનાવય ાં છે. િેર્ટાના આાંર્રસબાંધો 

જાણવાના અભ્યાસોએ િેર્ટા સબાંશધર્ શનણતયો લેવામાાં સરળર્ા ઉભી  કરી છે.    

2.8.1 મારિર્ીન ાં સરળ આદાન પ્રદાન  

વેબ 2.0 રૅ્ટકનોલોજી ધરાવર્ી વેબસાઈર્ટો કે બ્લોગ્સના ઉપયોગથી મારિર્ીન ાં આદાનપ્રદાન ખૂબ જ સરળ 

અને આાંર્રશક્રયાત્મક બન્ય ાં છે.  

વેબ 3.0 રૅ્ટકનોલોજીથી જ દી જ દી મારિર્ી વચ્ચે કેવા પ્રકારના સબાંધો છે રે્ ખૂબ સરળર્ાથી જાણી િકાર્ ાં 

િોવાથી િેર્ટા  સાથે જોિાયેલા ચોક્કસ શનણતયો લઇ િકાય છે. ગ જરાર્ રાજયમાાં શિક્ષણ શવભાગ દ્વારા િર કરવામાાં 

આવેલ ‘શવદ્યા સમીક્ષા કેન્ર (VSK)’ આ પ્રકારની રૅ્ટકનોલોજીસનો ઉપયોગ કરીને જ દા જ દા પ્રકારના િેર્ટા એકતત્રર્ 

કરે છે. આવો િેર્ટા શનણતયો લેવામાાં ઉપયોગી થાય છે.  

2.8.2 મ ટર્ શિક્ષણ સાથ ેશનણતયોની ત્વરરર્ર્ા અન ેસરળર્ા  

 વેબ 2.0 આધારરર્ વેબસાઈર્ટોના ઉપયોગથી શિક્ષણ સ્થળ અને સમયના બાંધનોથી મ ટર્ બન્ય ાં છે. 

શિક્ષણ વગતખાંિની ચાર દીવાલોમાાંથી બિાર નીકળી અને શવસ્ર્ૃર્ બન્ય ાં છે. વબે 3.0 આધારરર્ રૅ્ટકનોલોજીના 

ઉપયોગથી િેર્ટા વચ્ચે રિેલા આાંર્રસબાંધો જાણી િકાય છે. આ આાંર્રસબાંધોના અભ્યાસો જ દા જ દા પ્રકારના 

ત્વરરર્ શનણતયો સરળર્ાથી લેવામાાં ખૂબ ઉપયોગી બને છે. 

2.8.3 શવશવધ િેર્ટા આધારરર્ રૅ્ટકનોલોજીનો વયાપક ઉપયોગ  

 વેબ 2.0 રૅ્ટકનોલોજી િેર્ટાના વાિક ર્રીકે મીશિયા િૅરીંગ, બ્લોગગગ, શવશકઝ, સોશિયલ નેર્ટવર્કકગ 

વેબસાઈર્ટ જવેા માધ્યમોનો ઉપયોગ કરે છે જયારે વબે 3.0 રૅ્ટકનોલોજી િેર્ટાના શવશ્લેષણ મારે્ટ સીમેન્રે્ટક વેબ 

સર્વવસ, આર્ટર્ટશિશિયલ ઈન્રે્ટલીજન્સ (AI), િેર્ટા માઈનીંગ (DM), સ્લકિ િેર્ટા (LD), નેચરલ લેંગ્વેજ પ્રોસેસસગ 
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(NLP) જવેી ર્કશનકીનો ઉપયોગ કરે છે. ઉપરોટર્ રૅ્ટકનોલોજીના ઉપયોગથી શિક્ષણની વયાપકર્ા ર્ેમજ 

અસરકારકર્ામાાં વધારો થાય છે. 

2.8.4 આાંર્રશક્રયાત્મક શિક્ષણ અન ેર્નેા પરરણામોના અન માનો   

 વેબ 2.0ના ઉપયોગથી શવદ્યાથીઓ અને શિક્ષકો એકબીજાના સાંપકતમાાં આવી ચેર્ટ, િાઈલ િૅરીંગ, 

કમ્ય શનકેિન વગેરે ખૂબ જ સરળર્ાથી કરી િકે છે અને વધ ને વધ  આાંર્રશક્રયાઓ કરી િકે છે ર્ેમજ સોશિયલ 

તમશિયાના પ્લેર્ટિોમતને લીધ ેપોર્ાના શવચારોને અભભવયટર્ કરવાની પૂરર્ી ર્ક મળે છે.   

 વેબ 3.0 રૅ્ટકનોલોજી આર્ટર્ટશિશિયલ ઇન્રે્ટશલજન્સ ર્મેજ મિીન લર્કનગ જવેી શવશવધ રૅ્ટકનોલોજીના 

ઉપયોગથી પ્રાપ્ત થયેલ િેર્ટા આધારરર્ પરરણામોના અન માનો કરવામાાં મદદરૂપ બનિે.  

  

ર્મારી પ્રગતર્ ચકાસો. 

1. વેબ 2.0 અને વેબ 3.0નો વગતશિક્ષણ સ ધારાણામાાં ર્મે િ ાં ઉપયોગ કરી િકિો ર્ેની ર્મારા અધ્યાપક 

સાથે ચચાત કરો. 

2.9 પ્રકરણ સાર  

 વેબ 2.0 અને વેબ 3.0  શદ્વમાગી મારિર્ી અને પ્રત્યાયન મારે્ટની ર્ક પૂરી પાિે છે. વેબ 2.0 અને વેબ 

3.0ના પ્લેર્ટિોમ્સતના ઉપયોગ દ્વારા ઘણી આાંર્રશક્રયાત્મક રીર્ ેમારિર્ીન ાં આદાન પ્રદાન િટય બને છે ર્ેમજ િેર્ટાના 

આાંર્રસબાંધોને જાણી િકાય છે. જ દી જ દી વેબસાઈર્ટોના સ્વરૂપમાાં જોવા મળર્ ાં વબે 2.0 અને વેબ 3.0 પ્લેર્ટિોમત 

વર્તમાન સમયમાાં ખૂબ જ ઉપયોગી સાભબર્ થઇ રહ્ય ાં છે.   

 

સ્વાધ્યાય  

નીચનેા પ્રશ્નોના રૂ્ટાંકમાાં જવાબ આપો.  

1. વેબ 2.0 અને વેબ 3.0નો અથત સમજાવો. 

2. સીમેન્ર્ટીક વેબ એર્ટલે િ ાં ? 

3. સીમેન્ર્ટીક વેબમાાં સમાશવષ્ટ્ થર્ી કોઈ પણ બે રૅ્ટકનોલોજી શવષે જણાવો ? 

નીચનેા પ્રશ્નોના શવસ્ર્રૃ્ ઉત્તરો આપો. 

1. વેબ 2.0ની સાંકલ્પના સ્પષ્ટ્ કરો.  

2. વેબ 2.0ની મ ખ્ય લાક્ષશણકર્ાઓ જણાવો. 

3. વેબ 2.0 ના માધ્યમો જણાવો.   

4. વેબ 3.0ની સાંકલ્પના સ્પષ્ટ્ કરો.  

5. વેબ 2.0 અને વેબ 3.0 વચ્ચે િ ાં ર્િાવર્ જોવા મળે છે? 

6. ‘વેબ 2.0 અને 3.0 એ શિક્ષણના સમૃશિકરણના માધ્યમ છે.’ – શવધાનની શવસ્ર્ૃર્ ચચાત કરો.  
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પારરભાતષક િબ્દો 

વબે પ્રોગ્રામ્સ (Web Programms) : વેબ રૅ્ટકનોલોજીનો ઉપયોગ કરીને બનાવામાાં આવેલ કમ્પ્યૂર્ટર પ્રોગ્રામ્સ, 

કે જ ેઈન્ર્ટરનેર્ટ બ્રાઉઝરને સપોર્ટત  કરર્ા િોય.  

સોશિયલ નરે્ટવર્કકગ (Social Networking): સોશિયલ નેર્ટવર્કકગ એ એવ ાં ઓનલાઈન પ્લેર્ટિોમત છે કે જયાાં સમાન 

રસ, રૂચી કે પ્રવૃતર્ઓ ધરાવર્ા લોકો મળી િકે અને પોર્ાના અન ભવો ઓનલાઈન િૅઅર કરી િકે.  

ઇન્ર્ટરેશટર્ટવ સાઈટ્સ (Interactive sites): ઇન્ર્ટરેશટર્ટવ સાઈટ્સ એ એવા પ્રકારની વેબસાઈર્ટોન ાં સ્વરૂપ છે જમેાાં 

ઉપયોગકર્ાત માત્ર મારિર્ીને જોઈ િકવાને બદલ ેર્ેમાાં કોમેન્ટ્સ કે પ્રત્ય ર્ર આપી િકે ર્ેવી સ શવધા િોય.  

શવિીયો િરૅીંગ સાઈટ્સ (Video sharing sites) : શવિીયો િૅરીંગ સાઈટ્સ એ એવા પ્રકારની સ શવધાઓ પૂરી 

પાિર્ી વેબસાઈર્ટો છે કે જયાાં ઉપયોગકર્ાત પોર્ાના શવિીયો અપલોિ કરી િકે ર્ેમજ િાઉનલોિ કરી િકે ર્ેમજ 

અન્ય વયશટર્ના શવિીયોને પણ અપલોિ ર્ેમજ િાઉનલોિ કરી િકે.  

વબે કમ્ય શનર્ટી (વબે સમ દાયો) : વબે કમ્ય શનર્ટી એ ઇન્ર્ટરનેર્ટ પર લોકો દ્વારા રચવામાાં આવેલ વાસ્ર્શવક લાગે 

ર્ેવા સમૂિો છે, કે જયાાં લોકો ઓનલાઈન મળી  િકે, વાર્ો કરી િકે અને િાઈલો િૅઅર કરી િકે. 

િોસ્ર્ટ સર્વવસ (Host Service) : િોસ્ર્ટ સર્વવસ એ ઇન્ર્ટરનેર્ટ પરન ાં એવ ાં સવતર છે, જ ેવયશટર્ કે સાંસ્થાને World 

Wide Web પર રે્મની વેબસાઈર્ટો બનાવવા રે્મજ વાપરવાની છૂર્ટ આપે છે.   

શવકીઝ (Wikis) : કોઈ વયશટર્ કે સમ દાય દ્વારા બનાવવવામાાં આવેલ ર્ેવો ઓનલાઈન દસ્ર્ાવેજ  કે જ ેઅન્ય 

વયશટર્ઓ વાાંચી િકે ર્ેમજ ર્ેમાાં જરૂરી સ ધારાઓ કરી િકે.   

બ્લોગસ (Blogs) : બ્લોગ એ વેબસાઈટ્સન ાં જ એક સ્વરૂપ છે, જ ેકોઈ વયશટર્ દ્વારા કે સાંસ્થા દ્વારા શનયતમર્ રીર્ે 

અપિેર્ટ કરવામાાં આવે છે. સામાન્ય રીર્ ેઆવા બ્લોગ્સ મારિર્ી િૅઅર કરવા મારે્ટ ઉપયોગમાાં લેવામાાં આવર્ા િોય 

છે.  

મેિપ (Mashup) : મેિપ એ એક કરર્ા વધ  વેબસાઈર્ટોને જોિીને બનાવવામાાં આવર્ ાં બ્લોગ કે વેબસાઈર્ટન ાં 

સ્વરૂપ છે. જમેાાં એક કરર્ા વધ  સ્લકસ ર્ેમજ પેજનો ઉપયોગ કરવાની સ શવધા પૂરી પાિવામાાં આવે છે.  

પોિકાસ્સ્ર્ટગ (PodCasting) : સામાન્ય રીર્ે ઓશિયો સ્વરૂપની િાઈલને ઈન્ર્ટરનેર્ટ પર ઓનલાઈન સાાંભળવાની 

સ શવધા પૂરી પાિર્ી વયવસ્થાને પોિકાસ્સ્ર્ટગ ર્રીકે ઓળખવામાાં આવે છે. દા.ર્ રેશિયો પર થર્ ાં બ્રોિકાસ્સ્ર્ટગ    

રે્ટગગગ (Tagging) : સામાન્ય ભાષામાાં રે્ટગગગ એર્ટલે ઓળખ દિાતવર્ો િબ્દ આપવો. ઇન્ર્ટરનેર્ટની પરરભાષામાાં 

િોર્ટો, િોટય મેન્ર્ટ, કે રશ્ય-શ્રાવય િાઈલોને ઓળખ આપવા મારે્ટ કરવામાાં આવર્ી પ્રશક્રયા.  

આર.એસ.એસ િીિ (Rss Feed) : RSS િીિ ને Really Simple Syndicationના નામે ઓળખવામાાં આવે છે. 

ઇન્ર્ટરનેર્ટ પર સોશિયલ નેર્ટવર્કકગ સાઈટ્સ પર થયેલા અપિેર્ટની મારિર્ી RSS feed પૂરી પિે છે.  

સોશિયલ બકૂ માર્કકગ (Social Book Marking) : સોશિયલ બૂક માર્કકગ એ ઉપયોગકર્ાતને વેબ િોટય મેન્ર્ટમાાં 

રિેલા બૂકમાટસત ઉમેરવા, સ ધારવા કે િૅઅર કરવા મારે્ટની સ શવધા છે.  

વબે કન્રે્ટન્ર્ટ વોરર્ટાંગ (Web Content Voting) : વબે કોન્રે્ટન્ર્ટ વોરર્ટાંગ એ વેબ સાઈર્ટ પર રિેલા પેજ ર્ેમજ ર્ેમના 

કન્રે્ટન્ર્ટ (શવષયવસ્ર્ ) પર પોર્ાના મર્ દિાતવવા મારે્ટની પ્રશક્રયા છે.  

આર્ટર્ટશિશિયલ ઇન્રે્ટશલજન્સ (Artificial Intelligence): કોઈ એવ ાં મિીન કે જ ેબ શિપૂવતક અને મન ષ્યની જમે વર્ે 

ત્યારે ર્ેને આર્ટર્ટશિશિયલ ઈન્રે્ટલીજન્સનો ઉપયોગ કરે છે ર્ેમ કિેવાય. 
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મિીન લર્કનગ (Machine Learning) : એવી ર્કશનક કે જનેા દ્વારા કમ્પ્યૂર્ટર શવશવધ શનયમોના જરર્ટલ સમૂિનો 

ઉપયોગ કયાત વગર િેર્ટામાાંથી િીખી િકે છે. આ અભભગમ મ ખ્યત્વે િેર્ટા સેટ્સમાાંથી મોિેલને ર્ાલીમ આપવા પર 

આધારરર્ છે. 

નચેરલ લને્ગવેજ પ્રોસસેસગ (Natural Language Processing) : નેચરલ લેંગ્વેજ પ્રોસેસસગ (NLP) એ અાંગ્રજેી 

જવેી ક દરર્ી ભાષા (Natural Language)નો ઉપયોગ કરીને બ શિિાળી ચસસ્ર્ટમો સાથ ેવાર્ચીર્ કરવાની AI 

આધારરર્ પિતર્ છે. જયારે ર્મે ર્મારી સચૂનાઓ અન સાર રોબોર્ટ જવેી બ શિિાળી ચસસ્ર્ટમ પાસે કાયત કરાવવા 

માાંગો છો ત્યારે NLP ઉપયોગી બને છે. 

િેર્ટા માઈનીંગ (Data Mining) : િેર્ટા માઇસ્નગ એ પેર્ટનત અને સાંબાંધોને ઓળખવા મારે્ટ મેર્ટા િેર્ટા (બિોળો 

િેર્ટાસેર્ટ)ના ઉપયોગ  દ્વારા િેર્ટાને શવશ્લેતષર્  કરવાની પ્રશક્રયા છે, જ ે શવશવધ પ્રકારના િેર્ટા શવશ્લેષણ દ્વારા 

િૈક્ષશણક રે્મજ વયવસાશયક સમસ્યાઓ ઉકેલવામાાં મદદ કરે છે. િેર્ટા માઇસ્નગ વયશટર્ને જ દી જ દી ર્કશનકો અને 

સાધનોના ઉપયોગથી  ભશવષ્યના વલણોની આગાિી કરવા અને શનણતયો લેવા સક્ષમ કરે છે. 

સ્લટિ િેર્ટા (Linked Data):  કમ્પ્યૂર્ટર કે્ષત્રે, સ્લટિ િેર્ટા એ સ્ર્ટરટચિત  િેર્ટા (વગીકૃર્) છે, જ ેઅન્ય િેર્ટા સાથે 

આાંર્રરક રીર્ે જોિાયેલો છે. આ પ્રકારના િેર્ટાના ઉપયોગથી જરર્ટલ િેર્ટાન ાં શવશે્લષણ કરી િકાય છે.  

બ્લોક ચઈેન (Block Chain) : બ્લોક ચેઈન એ પીઅર ર્ટ  પીઅર નેર્ટવકતમાાં જોિાયેલા ઘણા કમ્પ્ય ર્ટસત પર 

ભબર્ટકોઇન અથવા અન્ય શક્રપ્ર્ટોકરન્સીમાાં થયેલા વયવિારોનો રેકોિત  જાળવવામાાં મદદ કરે છે.  
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પ્રકરણ -૩  

શિક્ષણમ ાં ઉપયોગી ICT ટૂલ્સ 
3.1 પ્રસ્ત વન :  

કોરોન  મહ મ રીન  સમય દરમમય ન અને ત્ય રબ દ કમ્પ્યૂટર અને ઇન્ટરનેટનો શિક્ષણમ ાં બહોળ  

પ્રમ ણમ ાં ઉપયોગ થવ  લ ગ્યો છે. શવષયવસ્તુની અસરક રક રજૂઆત મ ટે પ્રેઝન્ટેિન તૈય ર કરવ , 

શવષયવસ્તુની રજૂઆતને અસરક રક બન વવ  શવડીયો તૈય ર કરવ , ઓશડયો રેકોર્ડડગ કરવ  મ ટે, શિક્ષણ 

સબાંશિત મ હહતી એકમિત કરવ  મ ટે, ઓનલ ઈન પરીક્ષ  લેવ  મ ટે, પોતે તૈય ર કરેલ સ હહત્યને ક્લ ઉડ 

સ્ટોરેજમ ાં સ ચવવ  કે પછી ઓનલ ઈન શિક્ષણ આપવ  વગેરે ક યો મ ટે શિક્ષકો કમ્પ્યૂટર અને ઈન્ટરનેટનો 

ઉપયોગ કરે છે. ઉપરોક્ત ક યય કરવ  મ ટે શિક્ષકો જૂદ  જૂદ  ટૂલ્સનો ઉપયોગ કરે છે. શિક્ષક તરીકે ઉપરોક્ત ક યય 

કરવ  મ ટે ઉપયોગી બને તેવ  ટૂલ્સ શવિે જાણક રી પ્ર પ્ત કરવી જરૂરી છે. પ્રસ્તતુ પ્રકરણમ ાં આપણે શિક્ષણમ ાં 

ઉપયોગી કેટલ ક ICT ટૂલ્સનો અભ્ય સ કરીિુાં.  

ઉદે્દિ :  

1. શવડીયો એશડહટાંગ ટૂલ (OpenShot)નો ઉપયોગ કરી િકિે. 

2. ઓશડયો એશડહટાંગ ટૂલ (Audacity)નો ઉપયોગ કરી િકિે. 

3. સહ યક ટૅકનોલોજી શવિે જાણી િકિે. 

4. સહ યક ટૅકનોલોજી તરીકે વોઇસ ટ ઈપીંગ ટૂલ્સ અને ટેકસ્ટ-ટૂ-સ્પીચ ટૂલ્સની સમજ પ્ર પ્ત કરી િકિે. 

 

3.2 OpenShot (ઓપનિોટ) શવડીયો એશડટર સોફ્ટવરે 

3.2.1 શવડીયો એશડટર સોફ્ટવરે પહરચય 

જુદ  જુદ  ફોટોગ્ર ફ્સ અને શવડીયોનો ઉપયોગ કરી જરૂહરય ત મુજબનો કોઇ નવો શવડીયો બન વવ  મ ટે 

અને તેમ ાં સુિ ર વિ ર  કરવ  મ ટે ઉપયોગી સોફ્ટવરે શવડીયો એશડટીંગ સોફ્ટવેર તરીકે ઓળખ ય છે.  તમ ે

રેકોડય  કરેલ  જુદ  જુદ  શવડીયો અને ફોટોગ્ર ફનો ઉપયોગ કરી જો તમે એક સ રો  શવડીયો બન વવ  મ ગત  હોય 

તો તમ રે શવડીયો એશડટર સોફ્ટવેરની જરૂહરય ત રહેિે. બજારમ ાં હ લ ઘણ ાં શવડીયો એશડટર સોફ્ટવેર ઉપલબ્િ 

છે. પરાં તુ તેમ ાંન  કેટલ ાંક મય યહદત સવલતોવ ળ  હોય અથવ  તેની કકમત ચૂકવવી પડે તેમ હોય ખરીદવ  પરવડે 

તેમ નથી. પરાં તુ ઓપનિોટ એક શનિઃિૂલ્ક ઓપન સોસય શવડીયો એશડટર સોફ્ટવેર છે. જ ે Linux, Mac અને 

Windows જવેી શવશવિ ઓપરેહટાંગ સસસ્ટમ મ ટે ઉપલબ્િ છે.  

OpenShotમ ાં એશડહટાંગ મ ટેની ઘણી સુશવિ  હોવ થી તેની મદદથી સરળત થી સરસ શવડીયો તૈય ર કરી 

િક ય છે. OpenShotનો ઉપયોગ કરવ  મ ટે તમ રે સૌ પ્રથમ તમ ર  કમ્પ્યૂટરમ ાં આ સોફ્ટવેર ડ ઉનલોડ કરી 

ઇન્સ્ટોલ કરવો પડિે. ઇન્ટરનેટ પર આ સોફ્ટવેર સહજત થી ઉપલબ્િ છે. આપણે OpenShot ડ ઉનલોડ કરી 

તેને ઇન્સ્ટોલ કરી તેમ ાં શવડીયો શનમ યણ કરવ ની પ્રશિય  જોઇિુાં. 

3.2.2 OpenShot ડ ઉનલોડ અન ેઇન્સ્ટોલિેન  

1. સૌ પ્રથમ તમ ર  બ્ર ઉઝરન  એડરેસ બ રમ ાં http://www.openshot.org/download/ ટ ઇપ કરી કી-

બોડયમ ાંથી Enter કી પ્રસે કરો. (ગૂગલ સચયની મદદથી પણ સચય કરી િક ય.). જથેી આકૃમત-3.1 

મુજબની શવન્ડો જોવ  મળિે. 
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આકૃમત : 3.1 

2. Download v2.6.1 બટન પર શક્લક કરો. (ઓપરેટીંગ સસસ્ટમ  મુજબ તેની ઇન્સ્ટોલર ફ ઇલ ડ ઉનલોડ 

કરી િક ય). આ ડ ઉનલોડ થયેલ ફ ઇલ (OpenShot-v2.6.1-x86_64, અહીં કમ્પ્યૂટર OS 64 bitનુાં છે 

તે પ્રમ ણેનુાં ઇન્સ્ટોલેિન બત વેલ છે.) કમ્પ્યૂટરમ ાં ઇન્સ્ટોલ કરવ  મ ટે તેન  પર ડબલ શક્લક કરો. 

આકૃમત-3.2 મુજબ િમિિઃ ઇન્સ્ટોલેિન શવઝ ડય  જોવ  મળિે. 

  

  
આકૃમત : 3.2 
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3. શવઝ ડયમ ાં મળતી સૂચન  મુજબ િમિિઃ આગળ વિત  જાવ. શવઝ ડય ને અાંતે ઇન્સ્ટોલેિન પૂણય થત  

ડેસ્કટોપ પર OpenShot Video Editor આઇકોન રચ િે. તેન  પર ડબલ શક્લક કરો. નીચે મુજબ મુખ્ય 

શવન્ડો જોવ  મળિે. જમે ાં File, Edit, Title, View અને Help જવે  મેનુ જોવ  મળિે.  

આકૃમતમ ાં ઓપન િોટ શવન્ડોન  શવશવિ ભ ગો દિ યવેલ  છે.  

 
આકૃમત : 3.3 

4. OpenShot Video Editorની મદદથી શવડીયો, ઇમજે અને ઓશડયો ફ ઇલ જવે  શવશવિ મ ધ્યમોન  

સાંયોજન દ્વ ર  શવડીયો બન વી િક ય છે. ચ લો આપણે એક સરળ શવડીયો શનમ યણ કરવ ન  પગલ ાંઓ 

જોઇએ. 

3.2.3 OpenShot દ્વ ર  શવડીયો શનમ યણ  

1. OpenShot દ્વ ર  શવડીયો બન વવ  મ ટે સૌ પ્રથમ તેમ ાં જરૂરી શવડીયો, સચિો અને ઓશડયો ફ ઇલ 

ઇમ્પપોટય  કરવી પડિે. તે મ ટે આકૃમત-3.4 મ ાં દિ યવ્ય  મુજબ Tool Bar મ ાંથી import media બટન પર 

શક્લક કરો. Import media ડ યલોગ બોક્ષ ખૂલિે.  

   
આકૃમત : 3.4 

2. Import media ડ યલોગ બોક્ષમ ાંથી જરૂરી ફ ઇલ પસાંદ કરી Open બટન પર શક્લક કરો. આકૃમત-3.5 

મુજબ પ્રોજકે્ટ ફ ઇલ્સ શવન્ડોમ ાં મીશડય  ફ ઇલ ઇમ્પપોટય  થયેલી જોવ  મળિે. 
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આકૃમત : 3.5 

3. પ્રોજકે્ટ ફ ઇલ્સ શવન્ડોમ ાં મીશડય  ફ ઇલ ઇમ્પપોટય  કય ય બ દ તમ રી જરૂહરય ત મુજબની ફ ઇલ્સને 

આકૃમત-3.6 મ ાં દિ યવ્ય  મુજબ timeline પર ડરેગ કરી િમ નુસ ર અને જરૂરી સમય અવિી મુજબ 

ગોઠવો. Edit Toolbar પર જોવ  મળત  Add Track બટન () પર શક્લક કરી એકથી વિુ ટરેક ઉમેરી 

િક ય છે.  

 
આકૃમત : 3.6 

4. Timeline પર ગોઠવેલ શવશવિ શવડીયો/ઇમેજ ફ ઇલને અનેક ટર  ન્ઝીિન ઇફેક્ટ અને શવડીયો ઇફેક્ટ 

આપી એક સળાંગ શવશડયો બન વી િક િે. Function Tab મ ાં જોવ  મળતી Transitions અને Effect 

ટેબમ ાંથી શવશવિ ઇફેકટ આપી િકો છો. બે સચિો કે શવડીયો શક્લપ વચ્ચે ટર  ન્ઝીિન ઇફેક્ટ મૂકી િક ય 
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છે. ઇમેજ અને શવડીયોને શવશવિ દેખ વમ ાં જોવ  મ ટે શવડીયો ઇફેક્ટ ઉપયોગી બને છે. ટ ઇમલ ઇનમ ાં 

તમે મૂકેલી ઇમેજ અને શવડીયો શક્લપને જરૂહરય ત મુજબ ફરીથી ગોઠવી િકિો, મ િ drag and drop 

પ્રશિય  દ્વ ર  આ ક યય કરી િક ય છે. 

5. જો શવડીયો શક્લપન  કોઇ ભ ગને દૂર કરવો હોય તો પણ કરી િક િે. ત ેમ ટે શવડીયોનો જટેલ  ભ ગ કટ 

કરવો હોય તે જગ્ય એ િરૂઆતમ ાં અને અાંતે રુલરને વ ર ફરતી મૂકી સીઝર સસલકેટ કરી કટ આપો. કટ 

કરેલ ભ ગને સસલેક્ટ કરો. Delete બટન પ્રસે કરી એટલો ભ ગ ડીલીટ કરો. પ છળ વિત  શવડીયોન  

ભ ગને ડરેગ કરી આગળન  શવડીયો સ થે જોડી દો. આ રીતે બબનજરૂરી શવડીયોનો ભ ગ કટ કરી 

એશડહટાંગ કરી િક ય છે.  

6. ચ લો, હવે આ પ્રોજકે્ટમ ાં ઓશડયો ફ ઇલ ઉમરેીએ. આ મ ટે પણ તમ ેપ્રોજકે્ટ ફ ઇલ્સ શવન્ડોમ ાં ઇમ્પપોટય  

કરેલી મીશડય  ફ ઇલને ડરેગ કરી ટ ઇમ લ ઇન પર ઇશચ્છત સ્થ ન પર ડર ોપ કરી િક ય છે તેમજ તેની 

જમણી કે ડ બી બ જુને Grab કરી જરૂહરય ત મુજબ સ ઇઝમ ાં ફેરફ ર કરી ઉપયોગમ ાં લઇ િક ય છે, 

તેમજ ઉપયોગમ ાં લીિેલી ફ ઇલને કોપી કરી પુન: ઉપયોગ કરી િક ય છે. ઓશડયો ફ ઇલન  વોલ્યુમ 

લેવલને જરુહરય ત મુજબ વિ રી કે ઘટ ડી િકવ ની સુશવિ  પણ આ સોફ્ટવેરમ ાં મળે છે. 

7. તમે ઉપરોક્ત રીતે શવશવિ મીશડય  ફ ઇલ ઉમરેી તમ રો પ્રોજકેટ તૈય ર કરી તેને સાંગૃહહત કરી િકો છો. 

તમે તૈય ર કરેલી પ્રોજકે્ટ ફ ઇલની યોગ્યત ની ચક સણી કરવ  તેનો પ્રીવ્યુ પણ જોઇ િક ય છે. આ મ ટે 

તમે preview windowની નીચે આપેલ Jump to start, Rewind, Play/Pause, Fast forward તેમજ  

Jump to End (આકૃમતમ ાં ડ બેથી જમણે િમમ ાં) બટનનો ઉપયોગ કરી િકો છો. 

 
8. તૈય ર થયેલ પ્રોજકે્ટની યોગ્યત ની ખ તરી થય  બ દ તેને શવડીયો સ્વરૂપમ ાં રૂપ ાંતહરત કરવો પડે છે, 

જથેી તે અન્ય શડવ ઇસમ ાં ચલ વી િક ય. આ મ ટે Toolbarમ ાં છેલ્લે જોવ  મળત  Record બટન () 

પર શક્લક કરો અથવ  File → Export Video પર શક્લક કરો. આકૃમત-3.7 મુજબ Export Video 

ડ યલોગ બોક્ષ જોવ  મળિે. 

         
આકૃમત : 3.7        આકૃમત : 3.8 
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9. Export Video ડ યલોગ બોક્ષમ ાં File name ટેક્ષ્ટ બોક્ષમ ાં તમ રી ફ ઇલનુાં ન મ આપો. Folder path 

ટેક્ષ્ટ બોક્ષમ ાં તમ રી ફ ઇલને સાંગૃહહત કરવ  મ ટેનો યોગ્ય પ થ આપો. Video Profile ડર ોપડ ઉન 

બોક્ષમ ાંથી તમ રે જરૂરી ગુણવત્ત ની યોગ્ય પ્રોફ ઇલ પસાંદ કરો. (તમે પસાંદ કરેલ પ્રોફ ઈલ મુજબ 

શવડીયોની ગુણવત્ત ની અને ફ ઈલની સ ઈઝમ ાં વિ રો ઘટ ડો થઇ િકે છે). ત્ય ર બ દ Export Video 

બટન પર શક્લક કરો. તમ રી શવડીયો ફ ઇલ તૈય ર થવ  લ ગિે. (આકૃમત : 3.8)  

10.તૈય ર થયેલ શવડીયો ફ ઇલ અન્ય કમ્પ્યૂટરમ ાં કે સ્મ ટય  ફોનમ ાં જોઇ િક િે. મમિો, આ રીતે તમે તમ ર  

રેકોડય  કરેલ  શવડીયો તથ  ફોટોગ્ર ફનો ઉપયોગ કરી એક સ રો શવડીયો તયૈ ર કરી તમ ર  મમિોને િૅઅર 

કરો. 

3.3 Audacity ઓશડયો એશડટર સોફ્ટવરે 

3.3.1 ઓશડયો એશડટર સોફ્ટવરે પહરચય 

ઓશડયોને રેકોડય  કરવ  કે તમે રેકોડય  કરેલ ઓશડયોમ ાં જરૂરી સુિ ર વિ ર  કરવ  મ ટે ઉપયોગી સોફ્ટવેર 

ઓશડયો એશડટીંગ સોફ્ટવેર તરીકે ઓળખ ય છે.  તમે અવ જ રેકોડય  કરી તેમ ાં સાંગીત ઉમેરવ  મ ગત  હોય તથ  

અન્ય ઓશડયો ફ ઇલને મીક્ષ કરી એક નવી ઓશડયો ફ ઇલ બન વવ  મ ગત  હોય તો તમ રે ઓશડયો એશડટર 

સોફ્ટવેરની જરૂહરય ત રહેિે. બજારમ ાં હ લ ઘણ ાં ઓશડયો એશડટર સોફ્ટવેર ઉપલબ્િ છે. પરાં તુ તેમ ાંન  કેટલ ાંક 

મય યહદત સવલતોવ ળ  અથવ  મૂલ્યવર્ધિત હોય છે. પોત ન  િૈક્ષશણક ક યય મ ટે ઓશડયો એશડહટાંગ કરવ  મ ટે 

કકમત ચૂકવવી દરેકને પરવડે તેમ ન પણ હોય. પરાં તુ Audacity એક શનિઃિૂલ્ક ઓપન સોસય ઓશડયો એશડટર 

સોફ્ટવેર છે. જ ેLinux, Mac અને Windows જવેી શવશવિ ઓપરેહટાંગ સસસ્ટમ  મ ટે ઉપલબ્િ છે.  

Audacityની મદદથી સરળત થી ઓશડયો રેકોડય  કરી િક ય, તેમ ાં સિુ ર વિ ર  કરી િક ય, એકથી વિ ુ

ઓશડયોને મમક્ષ કરી િક ય, ઓશડયોમ ાં શવશવિ ઇફેક્ટ આપી િક ય તેમજ તૈય ર થયેલ ઓશડયોને શવશવિ 

સ્વરૂપમ ાં સાંગૃહહત કરી િક ય છે. આ મ ટે તમ રે સૌ પ્રથમ તમ ર  કમ્પ્યૂટરમ ાં Audacity સોફ્ટવેર ડ ઉનલોડ 

કરી ઇન્સ્ટોલ કરવો પડિે. ઇન્ટરનેટ પર આ સોફ્ટવરે સહજત થી ઉપલબ્િ છે. આપણે Audacity ડ ઉનલોડ 

કરી તેને ઇન્સ્ટોલ કરી તેમ ાં ઓશડયો એશડહટાંગ કરવ ની પ્રશિય  જોઇિુાં. 

3.3.2 Audacity ડ ઉનલોડ અન ેઇન્સ્ટોલિેન  

1. સૌ પ્રથમ તમ ર  બ્ર ઉઝરન  એડરેસ બ રમ ાં https://www.audacityteam.org/download/ ટ ઇપ કરી 

કી-બોડયમ ાંથી Enter કી પ્રસે કરો. જથેી આકૃમત-3.9 મુજબની શવન્ડો જોવ  મળિે. 

 
આકૃમત : 3.9 
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2. Download for Windows (32 and 62 bit) શવકલ્પ પર શક્લક કરો. (ઓપરેટીંગ સસસ્ટમ  મુજબ તેની 

ઇન્સ્ટોલર ફ ઇલ ડ ઉનલોડ કરી િક ય). આકૃમત-3.10 મુજબ ઇન્સ્ટોલર ફ ઇલ ડ ઉનલોડ થતી 

જોવ  મળિે.  

  
આકૃમત : 3.10 

3. આ ડ ઉનલોડ થયેલ ફ ઇલ (audacity-win-3.1.3-64bit) કમ્પ્યૂટરમ ાં ઇન્સ્ટોલ કરવ  મ ટે તેન  પર 

ડબલ શક્લક કરો. આકૃમત-3.11 મુજબ િમિિઃ ઇન્સ્ટોલેિન શવઝ ડય  જોવ  મળિે. તેમ ાં મળતી સૂચન  

મુજબ િમિિઃ આગળ વિત  જાવ. 

 

   
 

   
આકૃમત : 3.11 
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આકૃમત : 3.11 (Contd.. ) 

4. શવઝ ડય ને અાંતે ઇન્સ્ટોલેિન પૂણય થત  ડેસ્કટોપ પર Audacity આઇકોન રચ િે. તેન  પર ડબલ શક્લક 

કરો. નીચેની આકૃમત મુજબ મુખ્ય શવન્ડો જોવ  મળિે. જમે ાં File, Edit, Select, View, Transport, 

Tracks, Generate, Effect, Analyze, Tools અને Help જવે  મેનુ જોવ  મળિે. આકૃમત-3.12 મ ાં 

Audacity ની મુખ્ ય શવન્ ડોન  શવશવિ ભ ગન  ન મ િમ સ મે દિ યવેલ છે. 

 
આકૃમત : 3.12 

 
1. Menu Bar    2. Transport Toolbar    3. Tools Toolbar    

4. Recording Meter Toolbar    5. Playback Meter Toolbar    6. Mixer Toolbar  

7. Edit Toolbar    8. Play-at-Speed Toolbar    9. Device Toolbar    

10. Unpinned Play/Recording Head  11. Timeline    12. Scrub Ruler   

13. Track Control Panel    14. Audio Track    15. Label Track    

16. Selection Toolbar    17. Time Toolbar    18. Status Bar   
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5. Audacity સોફ્ટવેરની મદદથી રેકોડય  કરેલ અવ જ, તૈય ર મ્પયુશઝક, સ ઉન્ડ ઇફેક્ટ જવે  શવશવિ ટરેકન  

સાંયોજન દ્વ ર  જરૂહરય ત મજુબનો ઓશડયો બન વી િક ય છે. ચ લો આપણે એક ઓશડયો રેકોડય  કરી ત ે

ઓશડયોનુાં એશડટીંગ કરત  િીખીએ.  

3.3.3 Audacity દ્વ ર  ઓશડયો રેકોર્ડડગ  

 ઓશડયો રેકોર્ડડગ મ ટે કમ્પ્યૂટરમ ાં મ ઇિોફોન જોડવુાં પડિે. રેકોર્ડડગ કરવ  મ ટે નીચેન  પગલ ાં અનુસરો. 

1. સૌ પ્રથમ File ➔ New પર શક્લક કરી નવો પ્રોજકે્ટ િરૂ કરો. (અહીં એશડહટાંગ મોડમ ાં બનતી ફ ઇલને 

પ્રોજકે્ટ ફ ઇલ તરીકે ઓળખીિુાં.)  

2. મ ઇિોફોન તૈય ર ર ખો. Transport ટૂલબ રમ ાંથી Record બટન () પર શક્લક કરો. તમને Track 

Control Panel સશિય થયલે જોવ  મળિે. 

3. રેકોર્ડડગ િરૂ કરો. તમને Track Control Panelન  એક ટરેકમ ાં બાંને ચેનલમ ાં તરાંગ સ્વરૂપમ ાં તમ રો 

અવ જ રેકોડય  થતો જોવ  મળિે. 

 
આકૃમત : 3.13 

4. રેકોર્ડડગને અિવચ્ચ ેઅટક વવ  મ ટે Transport ટૂલબ રમ ાંથી Pause બટન () નો ઉપયોગ કરો. 

રેકોકડગ પૂણય થયે Stop બટન () પર શક્લક કરી રેકોર્ડડગ પૂણય કરો. 

5. પ્રોજકેટને Save કરવ  મ ટે File → Save Project → Save Project પર શક્લક કરો. Save Project 

ડ યલોગ બોક્ષ જોવ  મળિે. તેમ ાં પ્રોજકે્ટને અનુકૂળ ન મ આપી યોગ્ય લોકેિન સીલેક્ટ કરો, Save 

પર શક્લક કરી પ્રોજકે્ટ Save કરો. 

 
આકૃમત : 3.14 
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3.3.4 Audacity દ્વ ર  ઓશડયો એશડટીંગ  

1. તમે રેકોડય  કરેલ  ઓશડયોમ ાંથી બબનજરૂરી ભ ગને દૂર કરવ  રેકડય  કરેલી ફ ઈલને ઓપન કરી જ ેભ ગને 

દૂર કરવો છે તે ભ ગને મ ઉસ પોઇન્ટર ડરેગ કરી સીલેક્ટ કરો. 

 
આકૃમત : 3.15 

2. કી-બોડય  પરથી ડીલીટ કી દબ વો અથવ  મેનુબ રમ ાંથી Edit → Delete પર શક્લક કરો અથવ  

Ctrl+K િોટયકટ કીનો ઉપયોગ કરો. પસાંદ કરેલો ભ ગ દૂર થઇ જિે. 

 
આકૃમત : 3.16 

3.  આ રીતે પસાંદ કરેલ ભ ગને Cut કે Copy કરીને અન્ય સ્થ ને Paste પણ કરી િક ય છે. આ 

ઓશડયોમ ાં શવશવિ ઇફેક્ટ આપવ  મ ટે પણ ઓશડયો ટરેકન  ભ ગને Select કરવો પડે છે. જટેલો ભ ગ 

પસાંદ કરેલો હોય તેટલ  ભ ગમ ાં પસાંદ કરેલી ઇફેક્ટ લ ગુ પડે છે. મેનુબ રન  Effect મેનુન  શવશવિ 

શવકલ્પોની મદદથી રેકોડય  કરેલ સ ઉન્ડને અનેક ઇફેક્ટ આપી િક ય છે. આપણે સૌ પ્રથમ રેકોડય  કરેલ 

ઓશડયોમ ાંથી બીનજરૂરી ઘોંઘ ટ (Noise) દૂર કરવ ન  પગલ ાં જોઇએ. 

4. Noise દૂર કરવ  મ ટે Audacity સોફટવેરને Noise profile ઓળખ વવી પડે છે. તે મ ટે તમ ર  

ઓશડયો ટરેકને ધ્ય નપૂવયક સ ાંભળી લો. જય ાં ઘોંઘ ટ જણ ય તેટલ  ભ ગને સસલેક્ટ કરી લો. જથેી તેન  

જવેી આવૃમત િર વતો ઘોંઘ ટ  દૂર કરી િક ય. 

5. મેનુબ રમ ાંથી Effect → Noise Reduction પર શક્લક કરો. નીચે મુજબ Noise Reduction ડ યલોગ 

બોક્ષ જોવ  મળિે. 
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આકૃમત : 3.17 

6. Get Noise Profile બટન પર શક્લક કરો. આ ડ યલોગ બોક્ષ અદ્રશ્ય થઇ જિે. હવે આખો ટરેક પસાંદ 

કરવ  કી-બોડય  પરથી Ctrl+A બટન પ્રેસ કરો અથવ  મેનુબ રમ ાંથી Select → All પર શક્લક કરો. 

7. ફરી મેનુબ રમ ાંથી Effect → Noise Reduction પર શક્લક કરો. જોવ  મળત  Noise Reduction 

ડ યલોગ બોક્ષમ ાંથી OK બટન પર શક્લક કરો. આખ  ટરેકમ ાંથી પ્રોફ ઇલ મુજબનો Noise દરૂ થિે.( 

અહી તમે Noice reduction sensitivity વગેરે સેટ કરી િકો છો.) 

8. આ જ પ્રમ ણ ેટરેકન  પસાંદ કરેલ ભ ગમ ાં શવશવિ ઇફેક્ટ આપી િક ય છે. અન્ય ઇફેક્ટ લ ગુ પ ડત  

પહેલ  તેનો 3 સેકન્ડનો Preview પણ સ ાંભળી િક ય છે. 

Effect મેનુન  કેટલ ાંક ઉપયોગી શવકલ્પો નીચે મુજબ છે. 

• Repeat last effect: છેલ્લે આપેલી effect ને પુનર વર્તતત કરવ  મ ટે આ શવકલ્પ ઉપયોગી છે. 

• Amplify: પસાંદ કરેલ ઓશડયોનો ધ્વશન વિ રવ  (ધ્વશનવિયન) મ ટે આ શવકલ્પ ઉપયોગી છે. 

• Bass Boost: પસાંદ કરેલ  ઓશડયોમ ાં Bass આવૃશત્ત વિ રવ  મ ટે. 

• Change pitch: પસાંદ કરેલ  ઓશડયોનો tempo વગે બદલ્ય  વગર Pitch/આવૃશત્ત બદલવ  મ ટે આ 

શવકલ્પ ઉપયોગી છે. Pitch બદલ ત  અવ જ ઘેરો કે તીણો થઇ િકે છે.  

• Change speed: પસાંદ કરેલ ઓશડયોની ઝડપ વિ રવ  ઘટ ડવ  ઉપયોગી શવકલ્પ. 

• Change tempo: પસાંદ કરેલ ઓશડયોની Pitch બદલ્ય  વગર ઓશડયોની ઝડપ વિ રવ  ઘટ ડવ  મ ટે 

ઉપયોગી. 

• Compressor: પસાંદ કરેલો ઓશડયોની ગમતિીલ Rangeને સાંકુસચત કરે છે, જથેી ઓશડયોનો ઘોંઘ ટીયો 

(loud) ભ ગ સોફ્ટ બને છે, જય રે સોફ્ટ ભ ગ જમેન  તેમ રહે છે. 

• Echo: આ શવકલ્પની મદદથી પસાંદ કરેલ ઓશડયોમ ાં ઇકો (પડઘ ) ઇફેક્ટ આપી િક ય છે.  

• Fade in: પસાંદ કરેલ ઓશડયો િરૂ થત  fade in અસર ઉમેરવ . 

• Fade out: પસાંદ કરેલ  ઓશડયો પૂણય થત  fade out અસર ઉમેરવ . 

• Invert:  Waveform ને સમસક્ષમતજ હદિ મ ાં Flip કરે છે. 
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• Normalize: પસાંદ કરેલ  ઓશડયોન ેસ મ ન્ય offset આપવ  ઉપયોગી. 

• Repeat: પસાંદ કરેલો ઓશડયોને એકથી વિ ુવખત પુનર વર્તતત Play કરે છે. 

• Reverse: પસાંદ કરેલ ઓશડયોને શવપરીત હદિ મ ાં સાંભળ વે છે. 

3.3.5 Audacity દ્વ ર  ઓશડયો મમક્ષક્ષગ  

  Audacity સોફટવેર દ્વ ર  એકથી વિ ુટરેકને મમક્ષ કરી િક ય છે. જો તમ રે તમ ર  રેકોડય  કરેલ  ઓશડયોમ ાં 

મ્પયુશઝક ટરેક ઉમેરવો હોય તો સરળત થી ઉમેરી િક ય છે. આ મ ટે નીચેન  પગલ ાંઓને અનુસરો. 

1. સૌ પ્રથમ તમે રેકોડય  કરેલ પ્રોજકે્ટ ફ ઇલ ખોલો (File → Open અથવ  Ctrl+O). એક ટરેક જોવ  મળિે, 

જમે ાં Left અને Right બાંને ચેનલન  તરાંગ સ્વરૂપ જોવ  મળિે.    

2. મેનુબ રમ ાંથી File → Import → Audio પર શક્લક કરો. નીચેની આકૃમત મુજબ ‘Select one or more 

files’ ડ યલોગ બોક્ષ જોવ  મળિે.  

 
આકૃમત : 3.18 

3. યોગ્ય લોકેિન પરથી તમ રી મ્પયશુઝક ફ ઇલ/અન્ય ઓશડયો ફ ઇલ પસાંદ કરો → Open બટન પર 

શક્લક કરો. નીચ ેમુજબ બીજો ટરેક ઉમેર યેલો જોવ  મળિે. 

 
આકૃમત : 3.19 
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4. આમ એક કરત  વિ ુ ટરેક કોઇપણ પ્રોજકે્ટ ઉમેરી િક ય છે. આખ  ટરેકને સીલકે્ટ કરી તેને મ ઉસની 

મદદથી ડરેગ કરી કોઇપણ સ્થ ને મૂકી િક ય છે. વ્યશક્તગત રીતે કોઇપણ ટરેકમ ાં ફેરફ રો કરી િક ય છે. 

આ રીતે તૈય ર થયેલી ફ ઇલ પ્રોજકે્ટ સ્વરૂપે હોય છે. અાંતે તે ફ ઈલનુાં એક્સટેન્િન અલગ હોય છે  તેને 

અન્યિ ઉપયોગમ ાં લેવ  મ ટે તેને મ ન્ય સ્વરૂપ (.WAV, .MP3, .AMR, .M4A વગેરે)મ ાં ફેરવવી 

પડિે. 

3.3.6 Export Audio  

  તમે તૈય ર કરેલ ઓશડયો ફ ઇલને ઉપયોગી બન વવ  યોગ્ય સ્વરૂપમ ાં તેને Export કરવ ની રહે છે. િ રો 

ક. તમ રે તમ રી ઓશડયો ફ ઇલ MP3 ફોમેટમ ાં બદલવી છે. આ મ ટે નીચેન  પગલ ાંઓને અનુસરો. 

1. તમ રી પ્રોજકે્ટ ફ ઇલ Open કરો.  

2. મેનુબ રમ ાંથી File → Export → Export as MP3 પર શક્લક કરો. નીચ ેમુજબ Export Audio ડ યલોગ 

બોક્ષ જોવ  મળિે. 

 
આકૃમત : 3.20 

3. ફ ઇલને યોગ્ય ન મ આપો → યોગ્ય લોકેિન પસાંદ કરો → Save બટન પર શક્લક કરો. નીચે મુજબ 

ડ યલોગ બોક્ષ જોવ  મળિે. 

 
આકૃમત : 3.21 

4. OK બટન પર શક્લક કરો. નીચે મુજબ Edit Metadata ડ યલોગ બોક્ષ જોવ  મળિે. 
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આકૃમત : 3.22 

5. તેમ ાં જરૂરી મેટ ડેટ  ઉમેરી (ફરજીય ત નથી) OK બટન પર શક્લક કરો. તમ રી ફ ઇલ Save થતી જોવ  

મળિે. 

આ રીતે કોઇપણ ઇશચ્છત ઓશડયો ફોમેટમ ાં ફ ઇલ Save કરી િક ય છે. Audacityની મદદથી ઓશડયો 

રેકોર્ડડગ અને વ્ય વસ શયક કક્ષ નુાં એશડહટાંગ થઇ િકે છે. તે મ ટે ઘણ ાં શવકલ્પો ઉપલબ્િ છે. અહીં 

આપણે કેટલીક પહરચય ત્મક સવલતોની ચચ ય કરી છે. આ સોફ્ટવેરનો યોગ્ય મહ વરો વિ ુશવકલ્પોનો 

ઉપયોગ કરવ  પ્રેરિે.  

 

3.4 સહ યક ટૅકનોલોજી 

ઘણ  શવદ્ય થીઓ આાંશિક બહેર િ, નબળી દ્દષ્ટિ, રાંગ અાંિત્વ જવેી િ રીહરક અક્ષમત ઓ િર વત  હોય 

છે. આવ  શવદ્ય થીઓને અધ્યયનમ ાં ટેકનોલોજી મદદરૂપ થ ય છે. િ રીહરક અક્ષમત ઓમ ાં મદદરૂપ થન ર 

આવી ટેકનોલોજી (હ ડયવરે કે સોફ્ટવેર)ને સહ યક ટેકનોલોજી કહે છે.  

જઓે નબળી દ્રષ્ટિ કે શ્રવણ િશક્ત િર વે છે કે પછી જઓેને ટ ઈપ કરવ નુાં ગમતુાં નથી કે વ ાંચવુાં પસાંદ 

નથી એવ  લોકો મ ટે વોઈસ ટ ઈપીંગ ટૂલ કે ટેકસ્ટ ટુ સ્પીચ ટૂલ ઉપયોગી બની રહે છે. વોઈસ ટ ઈપીંગ ટૂલ 

અને ટેકસ્ટ ટુ સ્પીચ ટૂલનો પહરચય મેળવીએ 

3.4.1 વોઈસ ટ ઈપીંગ ટૂલ 

જ ેલોકોને લખ ણ ટ ઈપ કરવ નુાં ગમતુાં નથી કે આવડતુાં નથી તેમન  મ ટે વોઈસ ટ ઈપીંગ ટૂલ ઉપયોગી 

બને છે. વોઈસ ટ ઈપીંગ ટૂલની મદદથી કોઈપણ વ્યશક્ત બોલીને લખ ણને ટ ઈપ કરી િકે છે. તમ ે
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WhatsAppમ ાં વોઈસ ટ ઈપીંગ કરો છો તે વોઈસ ટ ઈપીંગ ટૂલ જ છે. એ જ રીતે તમે ગૂગલ ડોક્યુમેન્ટમ ાં પણ 

વોઈસ ટ ઈપ કરી િકો છો.  

આ મ ટે...  

▪ ગૂગલ ડોક્યુમેન્ટ Open કરી સૌ પ્રથમ બ્લેન્ક ડોક્યુમેન્ટ પર શક્લક કરો. 

▪ ત્ય ર બ દ Tool મેનુમ ાં Voice typing પર શક્લક કરો. 

▪ તમને ડ બી તરફ મ ઈિોફોનનુાં સચિ દેખ િે જમે ાં દિ યવેલ ડર ોપડ ઉન એરોની મદદથી ભ ષ ને પસાંદ 

કરો. 

▪ ત્ય રબ દ મ ઈિોફોનન ાં સચિ પર શક્લક કરી બોલવ નુાં િરૂ કરો. 

▪ તમે જ ેબોલિો તે ડોક્યુમેન્ટમ ાં ટ ઈપ થતુાં જિે. 

ગૂગલ ડોક્યુમેન્ટમ ાં વોઇસ ટ ઇપીંગ શવિે શવગતે ચચ ય પ્રકરણ-4 મ ાં કરવ મ ાં આવેલી છે.  

3.4.2 ટેકસ્ટ  ટુ સ્પીચ ટૂલ :  

જ ેલોકોને વ ાંચવુાં ગમતુાં નથી કે જ ેલોકો વ ાંચી િકત  નથી અથવ  જ ેલોકો પ્રજ્ઞ ચકુ્ષ છે તેન  મ ટે ટેકસ્ટ 

ટુ સ્પીચ ટૂલ ઉપયોગી બને છે. આ મ ટે ઘણ ાં સોફ્ટવરે ઉપલબ્િ છે. ટેકસ્ટ ટુ સ્પીચ સોફ્ટવેર કમ્પ્યૂટર સ્િીન 

પરન  લખ ણને વોઈસ (સ્પીચ)મ ાં ફેરવી આપે છે. I speech સોફ્ટવેર કોઈ પણ અાંગ્રેજી ટેકસ્ટ ને વોઈસમ ાં 

ફેરવી આપે છે. Play.ht સોફ્ટવેર ગુજર તી ટેકસ્ટ ને સ્પીચમ ાં ફેરવી આપે છે. આ ઉપર ાંત Google Lens દ્વ ર  

ઇમેજ ફ ઇલમ ાં રહેલી ટેકસ્ટ ને સ્પીચમ ાં ફેરવી િક ય છે. ટેકસ્ટ  ટુ સ્પીચ મ ટે ઘણ  online સોફ્ટવેર મળી રહે 

છે. ઉદ હરણ તરીકે text2speech.org, Natural reader (જ ેGoogle Chrome Addin છે). Google Lens એપ 

દ્વ ર  ઇમેજ ફ ઇલમ ાં રહેલી અનેક ભ ષ ની ટેકસ્ટ ને સ્પીચમ ાં ફેરવી િક ય છે. Google Lens એપ પણ ટેકસ્ટ ટુ 

સ્પીચ ટૂલ તરીકે ક યય કરે છે. 

 
આકૃમત : 3.23  
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આકૃમત : 3.24 

 

3.5 પ્રકરણ સ ર:  

  વગયખાંડ અધ્ય પન અને શવદ્ય થીઓન  અધ્ય પન મ ટે મ હહતી અને પ્રત્ય યન તકશનકીનો ઉપયોગ 

કરન ર શિક્ષક તરીકે કેટલ ાંક ટૂલ્સ જાણવ  જરૂરી છે. જ ેઇ-કન્ટેન્ટ શનમ યણ અને ઇ-લર્ડનગ મ ટે ખૂબ ઉપયોગી 

બની િકે. આ પ્રકરણમ ાં આપણે આવ  કેટલ ાંક ટૂલ્સનો ઉપયોગ જાણ્યો. આ તમ મ ટૂલ્સનો મહ વરો કરવ થી 

જ શનપૂણત  પ્ર પ્ત થઇ િકે.   

 

સ્વ ધ્ય ય 

નીચને  પ્રશ્નોન  જવ બ ટૂાંકમ ાં આપો. 

1. Openshot મ ાં નવો ટરેક ઉમરેવ  કય  ટૂલબ રનો ઉપયોગ કરિો? 

2. Audacityમ ાં ઘોંઘ ટ (Noise) દૂર કરવ ન  સ્ટે્સ જણ વો. 

3. Openshotમ ાં તૈય ર થયેલ  શવશડયોનો મપ્રવ્યુ કઈ શવન્ડોમ ાં જોવ  મળિે? 

4. સહ યક ટેકનોલોજી એટલે િુાં? 

5. Google docs મ ાં Voice typing કરવ ન  સ્ટેપ જણ વો. 

6. Audacityમ ાં કેટલ  મેનુ જોવ  મળે છે? કય  કય ? 

નીચને  પ્રશ્નોન  જવ બ શવગત ેઆપો. 

1. Openshotની લ ક્ષશણકત ઓ જણ વો. 

2. Audacityની લ ક્ષશણકત ઓ જણ વો. 

3. ટૂાંક નોંિ લખો : Voice typing tools. 

4. ટૂાંક નોંિ લખો : text to speech tools. 
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પ્રકરણ - 4  
શિક્ષણમ ાં ઉપયોગી Google ટૂલ્સ 

 

4.0 પ્રસ્ત વન : 

મ હિતી અને પ્રત્ ય યન તકશનકીની ક્ષક્ષતતજો શવસ્ તરી રિી છે, તેમ શિક્ષણમ ાં પણ તેનો ઉપયોગ વધતો 

રહ્યો છે. વગગખાંડન  પ્રત્ યક્ષ શિક્ષણની સ થે િવે ઓનલ ઇન ટીચિંગ ટૂલ્ સ અને વર્ચ યયગઅલ ક્લ સરૂમે લીધયાં છે. 

શિક્ષકો િવે અધ્ યયન-અધ્ ય પન અને મૂલ્ ય ાંકન ક યગ મ ટે ઓનલ ઇન પ્ લેટફોર્મસગનો ઉપયોગ કરવ  લ ગ્ ય  છે. 

ગૂગલ કાંપનીએ પણ શિક્ષણક યગમ ાં શિક્ષકોને ઉપયોગી બની િકે તેવ  અનેક શનિઃિૂલ્ ક ટૂલ્ સ આપ્ ય  છે. પ્રસ્તયત 

પ્રકરણમ ાં આપણે શિક્ષણમ ાં ઉપયોગી કેટલ ક ગૂગલ ટૂલ્સનો પહરિંય મેળવીએ.  

ઉદે્દિ : 

1. ક્લ ઉડ સ્ ટોરેજ તરીકે ગૂગલ ડર  ઇવ (Google Drive) નો ઉપયોગ કરી િકિે. 

2. સિભ ગી અને સિ યક ટૂલ તરીકે ગૂગલ ડોક્સ (Google Docs) નો ઉપયોગ કરી િકિે. 

3. વેબ કોન્ફરન્સીંગ ટૂલ તરીકે ગૂગલ મીટ (Google Meet) નો ઉપયોગ કરી િકિે. 

4. મ હિતી પ્ર શિ અને મૂલ્ ય ાંકન ટૂલ તરીકે ગૂગલ ફોર્મ સગ (Google Forms)નો ઉપયોગ કરી િકિે. 

 

4.1 Google Drive 

પ્રવતગમ ન સમયમ ાં મોટ  ભ ગન  લોકો પોત ન ાં વ્ય વસ શયક અને િૈક્ષશણક ક યો કરવ મ ાં કર્મપ્યૂટરનો 

ઉપયોગ કરે છે. આ ક યોમ ાં કોઈ ક યગનો અિેવ લ તૈય ર કરવો, શવષયવસ્તયની રજૂઆત મ ટે પ્રેઝન્ટેિન તૈય ર 

કરવયાં, શવદ્ય થીઓનયાં પહરણ મ તૈય ર કરવયાં વગેરે િોઇ િકે. કર્મપ્યૂટરમ ાં કરેલ ક યગ કર્મપ્યૂટરની િ ડગ શડસ્કમ ાં સેવ થ ય 

છે. જો કોઈ ક રણસર કર્મપ્યટૂરને ફોમેટ કરવ ની અશનવ યગત  ઉભી થ ય તો કર્મપ્યૂટરની િ ડગ શડસ્કમ ાં ફ ઈલ સ્વરૂપે 

સ િંવીને ર ખેલ તમ મ ક યગ ડીલીટ થઈ જાય છે. આવ  સમયે ડીલીટ થયેલ જરૂરી ફ ઈલને ફરીથી તૈય ર કરવી 

પડે છે, જ ેપ્રમ ણમ ાં મયશ્કેલ છે. આ સમસ્ય નયાં શનર કરણ છે, તૈય ર કરેલ ફ ઈલને ઈન્ટરનેટ ઉપર કોઈ ક્લ ઉડ 

સ્ટોરેજમ ાં સાંગૃહિત કરવી. ગૂગલ ડર  ઇવ (Google Drive) તમ ર  ક યગને સાંગૃહિત કરવ  મ ટેનયાં આવયાં જ ક્લ ઉડ 

સ્ટોરેજ પ્લેટફોમગ છે. ગૂગલ ડર  ઇવ એ ગૂગલ દ્વ ર  શવકક્ષસત ફ ઇલ સ્ટોરેજ અને સીંક્રોન ઇઝેિન સેવ  છે. ગૂગલ 

ડર  ઇવ તમને ગૂગલ સવગર પર ફ ઇલોને સ િંવવ ની અને ફ ઇલોને િૅઅર કરવ ની સયશવધ  આપે છે. ડેટ ને સ્ટોર 

કરવ ની સ થ ેતેમ ાં ઘણાં બધયાં ઓનલ ઈન ક મ પણ કરી િક ય છે. આમ, ગૂગલ ડર  ઇવ એક ક્લ ઉડ સ્ટોરેજ 

પ્લૅટફૉમગ છે. જમે ાં તમે પોત ન  ડેટ  ઓનલ ઇન સ્ટોર કરી િકો છો અને તેને બધ  સ થે િૅઅર પણ કરી િકો છો. 

ગૂગલ ડર  ઇવમ ાં તમે પોત ન  ફોટ , શવડીયો, ઓશડયો, ડોક્યયમેન્્સ વગેરે ફ ઇલ ફોમેટને અપલોડ કરીને સયરક્ષક્ષત 

સ િંવી િકો છો. ગૂગલ ડર  ઇવમ ાં ગૂગલ એક ઉન્ટ સ થે જ સ્ટોરેજની સયશવધ  મળ ેછે, જમે ાં તમને ફ્રી પ્લ નમ ાં 15 

GB સયધીનો ડેટ  સાંગ્રિ કરવ ની સવલત શનિઃિૂલ્ક મળે છે. 

• Google Drive ઉપયોગ કરવ ની રીત : 

1. ગૂગલ ડર  ઇવમ ાં મ હિતીને અપલોડ કરવ  મ ટે સૌ પ્રથમ આકૃતતમ ાં બત વ્ય  પ્રમ ણે Google Apps 

આઇકોન પર શક્લક કરી Google Driveન ાં આઇકોન પર શક્લક કરો. 

https://www.techzword.com/2021/05/what-is-download-and-upload-in-gujarati.html
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Figure - 1 

2. ગૂગલ ડર  ઇવન ાં આઇકોન પર શક્લક કરત  આકૃતત-2 પ્રમ ણે ગૂગલ ડર  ઇવની શવન્ડો ખયલિે, જમે ાં Go to 

Drive એવયાં લખેલયાં જોવ  મળિે તેન  પર શક્લક કરો.  

   
Figure - 2        Figure - 3 

3. Go to Drive પર શક્લક કરત  ગૂગલ એક ઉન્ટમ ાં Log in થવ  મ ટે કિેિે. અિીં તમ રે તમ ર  ગૂગલ 

એક ઉન્ટની મદદથી Log in થવ નયાં છે. ગૂગલ એક ઉન્ટમ ાં Log in થવ થી આકૃતત-3 મયજબની સ્ક્રીન 

જોવ  મળિે. જમે ાં તમે સાંગૃહિત કરેલી તમ મ ફ ઇલો જોવ  મળિે. 

4. તમ રી ફ ઈલ કે ફોલ્ડરને ગૂગલ ડર  ઇવ પર અપલોડ કરવ  મ ટે New બટન પર શક્લક કરો. ત્ય રબ દ 

ફ ઈલ અપલોડ કરવ  મ ટે File upload પર શક્લક કરો અથવ  ફોલ્ડરને અપલોડ કરવ  મ ટે Folder 

upload પર શક્લક કરો. 

5. ધ રો કે તમ રે File અપલોડ કરવી છે, તો File upload પર શક્લક કરો. આકૃતત-5 મયજબ Open ડ યલોગ 

બોક્ષ ખૂલિે.  
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    Figure – 4           Figure - 5 

6. ફ ઇલન  લોકેિન પર જઈ જ-ેતે ફ ઇલ ક્ષસલેક્ટ કરો. Open બટન પર શક્લક કરો. તમે પસાંદ કરેલ ફ ઇલ 

અપલોડ થતી જોવ  મળિે અને અપલોડ પૂણગ થત ાં ફ ઇલ ડર  ઇવમ ાં જોવ  મળિે. 

      
Figure - 6        Figure – 7 

આ જ પગલ ાં અનયસરી તમ ેફોલ્ડર પણ અપલોડ કરી િકિો. ગૂગલ ડર  ઇવ પર અપલોડ કરેલ ફ ઇલને 

તમે કોઈપણ સ્થળેથી કર્મપ્યૂટરની મદદથી ખોલી િકો છો કે ડ ઉનલોડ કરી િકો છો. ગૂગલ ડર  ઇવ પર અપલોડ 

કરેલ કોઈપણ ફ ઇલ કે ફોલ્ડરને તમે અન્ય લોકોને િૅઅર પણ કરી િકો છો.  

7. આ મ ટે જ ેફ ઇલ કે ફોલ્ડરને િૅઅર કરવ નયાં છે, તેન  પર ર ઈટ શક્લક કરી Get Link → Copy Link પર 

શક્લક કરો. જથેી લલક Copy થઇ જિે જ ેતમે કોઈને પણ WhatsApp, ઇ-મેઇલ કે અન્ય સોશિયલ 

મીશડય  દ્વ ર  મોકલી િકો. જનેી પ સે તે Link િિે તે ફ ઇલ કે ફોલ્ડરને જોઈ િકિે કે ડ ઉનલોડ કરી 

િકિે. (આકૃતત-7)  

 

4.2 Google Docs  

Google docs એ Microsoft Word એપ્લિકેશન જવેી સવિતવાળી ઓનિાઈન એપ્લિકેશન છે કે જ ેએક 

સહભાગી ઉપકરણ તરીકે ઉપયોગી છે, જમેાાં એક સાથે એક કે વધુ યુઝર એક જ ફ ઈલમ ાં કાયય કરી શકે છે. Google 

Docsમાાં નવી ડોક્યયમેન્ટ ફાઈિ બનાવી શકાય તેમજ બન વેલી ફાઈિને મમત્રો, તજજ્ઞો કે ઉપયોગકતાય સાથે 

ઓનિાઈન િૅઅર કરી ડોક્યયમેન્ટમાાં સધુારાવધારા કરી શકાય, તેને સાચવી શકાય તેમજ તેની PDF કોપી બનાવી 
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શકાય છે. Google Docsમાાં તૈયાર થયેિ ફાઈિ/ડોક્યમુેન્ટ ઓનલ ઇન સાચવી શકાય છે, જરૂર પડે્ય તેની મિન્ટ 

િઇ શકાય છે તેમજ ડાઉનિોડ પણ કરી શકાય છે. આ ફાઈિને અન્યો સાથે િૅઅર પણ કરી શકાય છે.  

Google Docs એ ગૂગલ તરફથી આપવામાાં આવેિી એક એવી સવિત છે, જ ેજુદા જુદા સ્થળોએ રહેિી 

વ્યપ્ક્તઓ ઓનલ ઇન સાથ ેમળી સાંયુક્ત રીત ેઅહેવાિો િખવા, િોજકે્ટ કે દરખાસ્તો બનાવવા, દસ્તાવજેો તયૈાર 

કરવા કે તબક્કાવાર મીહટાંગોની નોંધ િખવી અને સાચવવા પ્વગેરે માટે ઉપયોગી છે.  

4.2.1 Google Docs પહરિંય :  

Google Docs એ ગૂગલ દ્વારા આપવામાાં આવેિ ઓનિાઈન વડય  િોસેસરની સવિત છે કે જ ે વેબ 

આધારરત ગૂગલ ડોક્સ એશડટસય સ્યુટનાાં ભાગરૂપે સામેિ છે.  

Google Docsનો ઉપયોગ કરવા મ ટે ગૂગલ એકાઉન્ટ (gmail એકાઉન્ટ) હોવુાં જરૂરી છે  

Google Docsન ેિરુ કરવ ની રીત  

Google Docs ખોિવા માટે સૌ િથમ ઈન્ટરનેટનાાં વબે બ્રાઉઝરમાાંથી Google Apps નાાં  ચચહ્ન પર 

શક્લક કરી તેમાાં દાખિ થાઓ. જમેાાં Docsનાાં આઇકોન પર પ્ક્િક કરતાાં Google Docs શરૂ થશે અને આકૃતત-8 

મુજબની સ્ક્રીન જોવ  મળિે.  

 
Figure - 8 

Start New Document → Blank પર પ્ક્િક કરતાાં નવી ફાઈિ/ડોક્યુમેન્ટ ખુિશે.  

Start New Documentમાાંથી રરઝ્યુમ, િેટર, િોજકે્ટ િપોઝિ, બ્રોિર પ્વગેરે ડોક્યયમેન્ટના તૈયાર 

Format/Wizard શરૂ કરી શકાય છે. ટેર્મપ્લેટની Help માાં જઈ નવુાં ડોક્યયમેન્ટ શરૂ કરવા માટે મદદ િઇ શકાય છે. 

નવુાં Document તૈયાર થતા કોઈપણ સમયે તમ ે બીજા વ્યપ્ક્તઓને આ ડોક્યયમેન્ટ બતાવવા, અભભિાયો 

મેળવવા, ચચાય કરવા કે સાંપારદત કરવા માટે આમાંમત્રત કરી િકો છો. 

જો તમારાં  કોઈ ડોક્યયમેન્ટ Google driveનાાં કોઈ ફોલ્ડરમાાં તૈયાર હોય તો તે ફોલ્ડરને બ્ર ઉઝ કરી ફાઈિને 

ખોિી શકાય છે. તમ ેતૈયાર કરેિ અથવા તમને િૅઅર કરવ મ ાં આવેલ કોઈપણ ડોક્યયમેન્ટનયાં ન મ Serch Boxમાાં 

િખી તેને ખોિી શકાય છે.  
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Figure - 9 

Google Docsની Blank ફાઈિ ખોિવા આકૃમત-8 મુજબનાાં પગથથયાાં અનુસરવા. Google Docsની Blank 

ફાઈિ ખુિતા તેમાાં પ્વપ્વધ િકારનાાં મેનૂ જવેા કે File, Edit, View, Insert, Format, tools, Extension અને 

Help જોવા મળે છે. જનેો ઉપયોગ તમે પ્રથમ વષગમ ાં િીખેલ  M.S.Wordન ાં મેનયાંન  ઉપયોગ મયજબ કરી િકિો.  

4.2.2 Voice Typing:  

 Google Docs નાાં પ્વપ્વધ Menu પૈકી Tools મેનુમાાં Voice Typing શવકલ્પ આવેિ છે, જનેી મદદથી 

વોઇસ ટ ઇપપગ કરી શકાય છે. અિીં ગુજરાતી, રહન્દી, અાંગ્રેજી જવેી અનેક ભ ષ મ ાં તમે ઉર્ચિં રેલ  િબ્દોને 

લખ ણમ ાં ફેરવી િક ય છે. ગૂગલ ડોક્સની મદદથી વોઇસ ટ ઇપપગ કરવ  નીિંેન  પગલ ાં અનયસરો. (નોંધ : 

Voice Typing Tools ન ાં ઉપયોગ મ ટે Google Chrome બ્ર ઉઝરનો ઉપયોગ કર વી ફરજીય ત છે) 

1. Tools → Voice Typing પર શક્લક કરો. અથવા કી-બોડય  પરથી Ctrl+Shift+S કી એકસાથે પ્રસે કરો. 

આકૃતત-10 મયજબ સ્ક્રીનની ડાબી બાજુન  ભ ગમ ાં Voice Typing Tool જોવા મળશે.  

 
Figure -10  

2. Voice Typing Toolની મદદથી ગુજરાતી, રહન્દી કે અાંગ્રજેી જ ેભાષામ ાં ટાઈપપગ કરવુાં હોય, તે ભાષા પસાંદ 

કરવ ની રિે છે. તે મ ટે તેમ ાં જોવ  મળત  ભ ષ ન  ડર ોપ ડ ઉન લીસ્ટમ ાંથી ભ ષ  પસાંદ કરો. 



37 
 

3. Click to Speak બટન પર શક્લક કરો, Voice Typing શરૂ થશે. હવ ેતમ ેજ ેભાષા પસાંદ કરી હશે તે ભાષામાાં 

બોિશો તે બધયાં જ Google Docમાાં આપમેળે ટ ઇપ થતયાં જિે તેમજ Google Doc ઓનલ ઇન એપ્લીકેિન 

િોવ થી આ ફ ઇલ આપમળેે તમ રી ગૂગલ ડર  ઇવમ ાં સાંગૃહિત થતી જિે. 

4.2.3 Google Docs Sharing Mode: 

Google Docs એક સિભ ગી ઉપકરણ તરીકે પણ ઘણાં ઉપયોગી છે. તેમ ાં એકસ થે એકથી વધય વ્યશક્ત 

સિભ ગીદ રીથી ક યગ કરી િકે છે. Google Docsમાાં નવી ફાઈિ બનાવી તેમાાં મમત્રો/તજજ્ઞો/સહકમીઓ સાથે 

સાંયુક્ત રીત ેકામગીરી કરવા માટે નીચે મયજબન  પગલ ાં અનયસરો. 

1. સૌ પ્રથમ અગ ઉ જણ વ્ય  મયજબ Google Docs ફ ઇલ િરૂ કરો. નીિંેની આકૃતત-11 મયજબ Google Docs 

શવન્ડોમ ાં જમણી બાજુએ જોવ  મળત  Share બટન પર શક્લક કરો. 

   
Figure – 11        Figure - 12 

2. જો તમ ેડોક્યયમેન્ટને ન મ ન આપ્યયાં િોય ‘Name before sharing’ સાંદેિ જોવ  મળિે.  

3. ડોક્યયમેન્ટને નામ આપી Save કરો. આકૃતત-13 મુજબની windows જોવા મળશે.  

 
Figure - 13 

4. ડોક્યયમેન્ટને િૅઅર કરવા માટે Add People and Groups મ ાં સિયોગીઓન  ઇ-મેઇલ એડરેસ દ ખલ કરો. 

ત્યારબાદ તેની જમણી બાજય  આવેિ ડર ોપ ડ ઉન બોક્ષમાાંથી સિયોગીઓને Viewer, Commenter અથવા 
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Editorની માંજય રી તેમના role મુજબ આપો. તેમને આ બાબતની જાણ કરવી હોય તો ‘Notify People’ 

િંેકબોક્ષ પર શક્લક કરી તેની નીચ ેમેસેજ િખો. Massageની નીચ ેCopy Link બટન હોય છે. તેન  પર શક્લક 

કરી લલક સાચવી રાખવી જોઈએ, જ ેસોશિયિ મીપ્ડયા, ઈ-મેઈિ કે અન્ય માધ્યમોથી બીજા વ્યપ્ક્તઓને 

ડોક્યયમેન્ટ િૅઅર કરવ મ ાં મદદરૂપ થશે.  

5. ત્યારબાદ િખેિ Send બટન પર શક્લક કરો. ‘Sending Invitation’ સાંદેિ દ્વ ર  ડોક્યયમેન્ટ િૅઅર થતયાં જોવ  

મળિે. તમે પસાંદ કરેિ તમામ વ્યપ્ક્તઓને આ ડોક્યયમને્ટમ ાં જોડ વ નયાં આમાંત્રણ મળી જિે.  

6. ડોક્યયમેન્ટને િૅઅર કરતાાં પહેિા ડોક્યયમેન્ટનાાં Settingsમાાં જઈ ‘Editor can change permission and share’ 

તથા ‘Viewers and commenters can see the option to download, print and copy’ શવકલ્પો ન  

િંેકબોક્ષ પસાંદ કરી જરૂહરયાત મુજબન  સેટીંગ કરી િક ય છે.  

Google Docsમાાં મમત્રો સાથે િૅઅર કરેિ ડોક્યયમેન્ટ માટે View મેનુમાાં આવેિ ‘Mode’ શવકલ્પ ખૂબ 

ઉપયોગી છે. જમેાાં Editing, Suggesting તથા Viewing જવેા ત્રણ મોડ જોવા મળ ેછે. િૅઅર કરેિા ડોક્યયમેન્ટમાાં 

જરૂહરયાત મુજબના મોડમાાં સરળતાથી કાયય કરી શકાય છે. 

4.3 Google Meet : વબે કોન્ફરન્સીંગ ટૂલ 

પ્રવતગમ ન સમયમ ાં ટેકનોલોજીનો ઉપયોગ વ્ય પકપણે શવશ્વમ ાં થઇ રહ્યો છે. વશૈ્વશ્વક મિ મ રીન  સમય 

દરર્મય ન શવશ્વમ ાં મ હિતીન  આદ ન-પ્રદ ન મ ટે પ્રિંશલત મ ધ્યમ તરીકે વેબ કોન્ફરન્સનો ઉપયોગ વધ્યો છે. 

વેબ કોન્ફરન્સનો ઉપયોગ વ્યવસ યની સ થે સ થે શિક્ષણ જગતમ ાં પણ ખૂબ થઇ રહ્યો છે. વતગમ ન સમયમ ાં 

વેબ કોન્ફરન્સ મ ટે Zoom, Microsoft teams, Cisco WebEx, google Meet જવે  અનેકશવધ ટૂલ્સ ઉપલબ્ધ 

છે. આવ  ટૂલ્સન  ઉપયોગથી તમ મ સવલતો સ થેની વેબ કોન્ફરન્સ કરવ  મ ટે લ યસન્સ ખરીદવયાં પડતયાં િોય 

છે. પરાંતય Google meet ટૂલ ઉપયોગમ ાં લેવ  મ ટે લ યસન્સ લેવ ની જરૂર પડતી નથી. Google Meet બધ ન ે

સરળત થી ઉપલબ્ધ છે અને તેનો ઉપયોગ પણ એકદમ સરળ છે. તેની મદદથી અલગ અલગ સ્થળેથી વેબ 

કોન્ફરન્સન  મ ધ્યમથી વ્યશક્તઓ ઓનલ ઈન જોડ ઈને સૂિંન ઓ અને મ હિતીનયાં અદ ન-પ્રદ ન સરળત થી 

કરી િક ય છે.  

4.3.1 Google Meetનો ઉપયોગ કરવ  મ ટેન  પગલ ાં : 

1. બ્ર ઉઝરન  એડરેસ બ રમ ાં https://meet.google.com ટ ઇપ કરી એન્ટર આપો. નીિંે મયજબ Google 

Meetનયાં િોમ પેજ ખયલિે. તેમ ાં બે પ્રક રે મીહટાંગ કરી િક ય છે તે મ ટેન  New meeting અને Enter a 

code or link બટન જોવ  મળે છે. 

 
Figure - 14 
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2. િવે િોમ પેજમ ાં જમણી બ જય  ઉપરન  ખૂણે જોવ  મળત  લોગીન બટન વડે gmail એક ઉન્ટથી લોગીન 

કરો. 

3. કોઈ અન્ય વ્યશક્ત દ્વ ર  મીહટાંગનયાં આયોજન થયેલ િોય અને તેમન  દ્વ ર  તમને લલક િૅઅર કરવ મ ાં 

આવેલ િોય તો તે લલક ને Enter a code or link બટન પર શક્લક કરી તે લલક દ ખલ કરત ાં જ-ેતે 

ઓનલ ઈન મીહટાંગમ ાં જોડ ઈ િકો છો.  

4. તમ રે મીહટાંગનયાં આયોજન કરવયાં િોય તો New Meeting બટન પર શક્લક કરો. નીિંે મયજબ ત્રણ શવકલ્પો 

જોવ  મળિે.  

 
Figure - 15 

5. Create a meeting for later પર શક્લક કરત ાં આગળની ત રીખ અને સમય મયજબ મીહટાંગ િેડ્યયલ કરવ ની 

લલક મળિે. મીટીંગ અઠવ ડીય ન  િંોક્કસ હદવિે રીપીટ મોડમ ાં કે દરરોજ િંોક્કસ સમયે સીડ્યયલ કરી 

િક ય. જ ેવ્યશક્તઓને તમ ેમીહટાંગમ ાં જોડવ  મ ાંગો છે તેને આ લલક િૅઅર કરી િક ય છે. Start instant 

meeting પર શક્લક કરત ાં તયરાંત એ જ સમયે મીહટાંગનયાં આયોજન કરી િક ય છે. Schedule in google 

calendar પર શક્લક કરત ાં ગૂગલ કેલેન્ડરમ ાં િંોક્કસ ત રીખે અને સમયે મીહટાંગ િેડ્યયલ કરી િક િે અને 

શનધ ગરીત સમય કરત  થોડ  સમય પિેલ  તમને મીહટાંગનયાં નોટીફીકેિન પ્ર િ થિે. 

6. પ્ર િ કરેલ/તમે રિંેલ લલક વડે મીહટાંગમ ાં જોડ ઈ ગય  બ દ આપને નીિંે મયજબની શવન્ડો જોવ  મળિે. 

 
Figure - 16 

7. અિીં શવન્ડોઝની નીિં ેતરફ મધ્યભ ગમ ાં તમને વેબ કોન્ફરન્સને ઓપરેટ કરવ  મ ટેન  શવશવધ બટન 

જોવ  મળિે. જમે ાં ડ બી બ જયથી પ્રથમ બટન ઓશડયો િં લય-બાંધ કરવ  મ ટે, બીજય ાં બટન શવડીયો 
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િં લય-બાંધ કરવ  મ ટે, ત્રીજય  બટન કલોઝ કેપ્િન મ ટે તથ  િંોથયાં બટન વેબ કોન્ફરન્સ દરર્મય ન 

ઓનલ ઈન પ્રેઝેન્ટેિન કરવ  મ ટે તમ રી કર્મપ્યૂટર સ્ક્રીન િૅઅર કરવ  મ ટેનયાં છે.  

8. સ્ક્રીન િૅઅર કરવ  મ ટે તમને ત્રણ શવકલ્પો મળિે. (1) તમે તમ રી આખી સ્ક્રીન િૅઅર કરવ  મ ાંગો 

છો? (2) કોઈ િંોક્કસ શવન્ડો ઓપન કરેલ િોઈ તે બત વવ ાં મ ાંગો છો? અને (3) કોઈ સ્પેશિયલ ટેબ 

ઓપન કરેલ પ્રેઝેન્ટ કરવ  મ ાંગો છો ? આ ઉપરોક્ત પૈકી કોઈ એક શવકલ્પ પસાંદ કરી, વેબ કોન્ફરન્સ 

દરર્મય ન મ હિતી િૅઅર કરી િક ય છે. 

9. શવન્ડોઝન ાં જમણી બ જયન  ભ ગમ ાં બીજા આઇકોનની મદદથી મીહટાંગમ ાં કઈ વ્યશક્ત જોડ ઈ છે તે જોઈ 

િક ય છે. તે આઈકોનની મદદથી તમે અન્ય કોઈને મીહટાંગમ ાં જોડ વવ  મ ટેની પરવ નગી આપી િકિો 

અને મીટીંગ મ ાં ખલેલ પિોિં ડન ર કોઈ વ્યશક્તને મીહટાંગમ ાંથી દૂર કરી િકો છો.  

10. વેબ કોન્ફરન્સન  અન્ય સહેટાંગમ ાં જરૂરી ફેરફ ર કરી િક ય છે, જ ેતમે નીિંેની આકૃતતમ ાં જોઇ િકો છો.  

 
Figure - 17 

• મધ્ય ભ ગમ ાં રિેલ  પ ાંિંમ ાં બટનને શક્લક કરત  શવશવધ શવકલ્પો જોવ  મળ ે છે. જમે ાં Whiteboard 

શવકલ્પનો ઉપયોગ કરી વબે કોન્ફરન્સ દરર્મય ન જરૂરી શવગતો લખીને સમજાવી િક ય છે.  

• Change layoutની મદદથી તમ રી સ્ક્રીનમ ાં જોડ યેલ વ્યશક્તઓની સ્ક્રીનને અનયકૂળત  મયજબ સેટ કરી 

િક ય છે. 

• Full screenની મદદથી સ્ક્રીનને Full layout modeમ ાં જોઈ િક િે.  

• Apply visual effectsની મદદથી શવડીઓન  બેકગ્ર ઉન્ડમ ાં યોગ્ય ઈફેક્ટ આપી િક ય છે.  

• Setttingમ ાં જઈ વેબ કોન્ફરન્સમ ાં અન્ય જરૂરી ફેરફ ર કરી િક િે.  

• નીિંે લ લ કલરમ ાં દેખ ત  છેલ્લ  આઇકોન પર શક્લક કરત ાં મીહટાંગને બાંધ કરી િક િે. 

Google meet ટૂલની મદદથી કોઈપણ સમય ેવેબ આધ હરત કોન્ફરન્સ કરી િક ય છે. એક સમયે Google 

meet મ ાં 100 જટેલ  વ્યશક્તઓ સરળત થી જોડ ઈ િકે છે. Google Workplace સેવ  િં લય િોય તો મીહટાંગનયાં 

રેકોડીંગ પણ કરી િક ય છે તથ  તેને િૅઅર કરી િક ય છે. Google meet ટૂલનો ઉપયોગ એકદમ સરળ છે.  

તમ રી પ્રગતત િંક સો : 

આપ આપન  સિપ ઠી સ થે google meet ટૂલનો ઉપયોગ કરી કોઈ એક શવષય અથવ  મયદ્દ ને આધ હરત વબે 

કોન્ફરન્સનયાં આયોજન કરો અને અિેવ લ તૈય ર કરો. 
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4.4 ગૂગલ ફોમગ : 

ગૂગલ ફોમગ એ ગૂગલ કાંપનીની એક ઉપયોગી એપ્લીકેિન છે જનેી મદદથી તમે ઓનલ ઈન સવે અને 

ઓનલ ઈન શક્વઝ તૈય ર કરી િકો છો અને તૈય ર થયલે ઓનલ ઈન સવે અને ઓનલ ઈન શક્વઝને Real Time 

(તે જ ક્ષણે)મ ાં લોકો સયધી પિોંિં ડી પ્રતતિં ર મેળવી િકો છો. તમે ગૂગલ ફોમગનો ઉપયોગ કરી િ ળ ની િૈક્ષશણક 

ગયણવત્ત  સયધ રણ  મ ટેન ાં સૂિંનો સમ જ પ સેથી મેળવી િકો છો. શવદ્ય થી, વ લી અને સમ જ પ સેથી તમ રી 

િ ળ  શવિેન  અભભપ્ર યો ઓનલ ઇન મેળવી િકો છો. ગૂગલ ફોમગની મદદથી તમે શક્વઝ તૈય ર કરી શવદ્ય થીનયાં 

વ્યશક્તગત મૂલ્ય ાંકન કરી િકો છો. ઉપરોક્ત તમ મ ક યો ઈન્ટરનેટન ાં મ ધ્યમથી ઝડપથી કરી કરી િકો છો.  

4.4.1 ગૂગલ ફોમગ (સવ,ે શક્વઝ) તયૈ ર કરવ  મ ટેન  પગથીય ાં  

1. સૌ પ્રથમ ઈન્ટરનેટ સ થે જોડ ણ કરી કોઈપણ વબે બ્ર ઉઝરની મદદથી ગૂગલ સિંગ એન્જીન ઓપન કરો 

ત્ય રબ દ sign in પર click કરી તમ ર  ગૂગલ એક ઉન્ટની મદદથી log in થ ઓ. 

 
Figure - 18 

2. ત્ય રબ દ google app પર click કરી google drive પર click કરો. 

 
Figure – 19  
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3. આથી google drive open થિે. િવે my drive → more → google form પર click કરો. આથી ગૂગલ 

ફોમગ ખૂલિે. ( આ ઉપર ાંત ગૂગલ એપ્સ પર શક્લક કરી ગૂગલ ફોમગ ટૂલ્સ િોધી તેન  પર શક્લક કરવ થી 

પણ ગૂગલ ફોમગ ખયલિે.) 

 
Figure - 20 

4. િવે Untitled Form પર click કરી તમ ેજ ેમ હિતી એકત્ર કરવ  મ ગત  િોય તેને અનયરૂપ િીષગક લખો અને 

form descriptionમ ાં તમ ેમ હિતી એકત્ર કરવ  અાંગેની જ ેસિૂંન  કે િેતય અાંગે જણ વવ  મ ગત  િોય તેની 

શવગત લખો. 

 
Figure - 21 

5. િવે Untitled Question પર click કરી તમે ત ેમ હિતી એકત્ર કરવ  મ ગત  િોય તેને અનયરૂપ પ્રશ્ન લખો 

(પ્રશ્ન અનયરૂપ વધ ર ની મ હિતી પણ તમે () મ ાં લખી િકો) અને પ્રશ્નનો જવ બ લખવ  મ ટે પ્રશ્નને 

અનયરૂપ જવ બનયાં format બ જયમ ાં આપેલ ડર ોપ બોક્ષમ ાંથી પસાંદ કરો. 
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Figure - 22 

6. એક પ્રશ્ન પૂરો થઇ ગય  બ દ િવે નવો પ્રશ્ન ઉમેરવ  મ ટે આકૃતતમ ાં બત વ્ય  મયજબ  ક્ષિંહ્ન પર શક્લક 

કરો. આથી નવો પ્રશ્ન તમ ર  google formમ ાં ઉમેર ઇ જિે. િવે ઉપરોક્ત પ્રશક્રય  (પગથીય -5) અનયસરી 

પ્રશ્ન તૈય ર કરો. જો આપ જ ેતે પ્રશ્ન સાંદભે ફરજીય ત પ્રતતશક્રય  ઇર્ચછત  િોય તો Required શવકલ્પને ON 

કરો.  

 
Figure – 23 

7. આપનયાં ફોમગ તૈય ર થઇ ગય  બ દ તયૈ ર કરેલ ફોમગને અન્ય વ્યશક્ત (ઈશર્ચછત વ્યશક્ત) સયધી પિોંિં ડવ  

મ ટે ગૂગલ ફોમગમ ાં ઉપર જમણી તરફ દેખ ત  Send બટન પર શક્લક કરો. 
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Figure -24 

8. Send બટન પર શક્લક કરત  આપને આકૃતત-25 મયજબની શવન્ડો દેખ િે. 

 
Figure-25 

9. િવે આપ ઈ મેઈલ દ્વ ર  ગૂગલ ફોમગ અન્ય વ્યશક્તને પિોંિં ડવ  મ ગત  િો તો આકૃતત-25મ ાં દિ ગવ્ય  

મયજબ To લખેલ છે ત્ય ાં જ ેવ્યશક્તને ગૂગલ ફોમગ મોકલવ  મ ગત  િો તે તમ મ વ્યશક્તન  ઈ મેઈલ એડરેસ 

ટ ઈપ કરી સેન્ડ બટન પર શક્લક કરત  તમ મ વ્યશક્તને ગૂગલ ફોમગ ઈ મેઈલ દ્વ ર  પિોંિંી જિે. જો આપ 

કોઈ સોશિયલ મીશડય  થકી લલક મોકલવ  મ ગત  િો તો ઈ મેઈલન ાં બટનની બ જયમ ાં આપેલ લલકન ાં 

બટન પર શક્લક કરત  આકૃતત-26 મયજબ તમને દેખ તી લલક કોપી કરી કોઈપણ સોશિયલ મીશડય  થકી 
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અન્ય વ્યશક્તને ગૂગલ ફોમગની લલક પિોંિં ડી િકો. (shorten linkન ાં િંેક બોક્ષ પર ટીક કરી તમે link 

ટૂાંકી કરી મોકલી િકો છો.) 

 
figure- 26 

તૈય ર કરેલ ગૂગલ ફોમગને અન્ય વ્યશક્ત સયધી પિોંિં ડવ ની એક અન્ય રીત પણ છે. જ ેનીિંે મયજબ છે. 

 
Figure - 27 

સૌ પ્રથમ google drive મ ાં તમે તૈય ર કરેલ google form ની ફ ઈલ પર Right શક્લક કરો. ત્ય રબ દ get 

shareable link પર શક્લક કરો. તમને આકૃતત-28 મયજબની screen દેખ િે. જમે ાં દિ ગવેલ link તમે copy કરી 

લો. આ link તમે કોઈને પણ WhatsApp, email, blog, website દ્વ ર  અન્ય સયધી પિોંિં ડીન ેતમ ર  પ્રશ્ન 

સાંદભે લોકોન  અભભપ્ર ય મળેવી િકિો. 

 
Figure - 28 
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10. આપન  આયોજન મયજબન  તમ મ પ્રશ્નો તૈય ર થઇ ગય  બ દ google formમ ાં મયકેલ પ્રશ્નો/અભભપ્ર યો 

પર મળેલ પ્રતતિં ર જોવ  મ ટે google formમ ાં આવલે Responses બટન પર શક્લક કરો અને પછી 

create spreadsheet પર શક્લક કરો. 

 
Figure - 29 

11.Create Spreadsheet પર શક્લક કરત  તમે આકૃતત-30 મયજબની સ્ક્રીન જોઈ િકિો. 

 
Figure - 30 

12.િવે Create પર શક્લક કરો. આથી google driveમ ાં તમ ર  google formન ાં ન મની response sheet 

તૈય ર થઇ જિે જમે ાં તમે google form મ ાં મયકેલ પ્રશ્નો/અભભપ્ર યો પર મળેલ પ્રતતિં ર જોઈ િકિો. 

13.તમે google form અને response sheet google drive મ ાં જોઈ િકિો. 

 
Figure - 31 
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સ્વ ધ્ય ય 
નીિંને  પ્રશ્નોન  ટૂકમ ાં જવ બ આપો. 

1. ફ ઈલને સાંગ્રિ કરવ  મ ટે કયયાં ગૂગલ ટૂલ્સ ઉપલબ્ધ છે? 

2. દસ્ત વેજ તૈય ર કરવ  મ ટે કયયાં ગૂગલ ટૂલ્સ ઉપયોગી બનિે.? 

3. ગૂગલ ફોમગ ટૂલનો તમે ક્ય  ક્ય  ઉપયોગ કરિો? 

4. શવડીયો કોન્ફરન્સ કરવ  મ ટે તમે ગૂગલન  કય  ટૂલ નો ઉપયોગ કરિો? 

5. વોઈસ ટ ઈપીંગ ટૂલ્સ એટલે િયાં? 

6. ગૂગલ ડર  ઈવમ ાં વધયમ ાં વધય કેટલ  GB મ હિતી ફ્રીમ ાં સાંગ્રિ કરવ  મળિે? 

7. ગૂગલ મીટ િરુ કરવ ની રીત જણ વો. 

નીિંને  પ્રશ્નોન  સશવસ્ત ર જવ બ આપો. 

1. ગૂગલ ડર  ઈવ શવિ ેશવસ્તૃત નોંધ લખો. 

2. ગૂગલ ડોક્સ શવિે સશવસ્ત ર નોંધ લખો. 

3. ગૂગલ ફોમગ િૈક્ષશણક ક યગમ ાં કેવી રીતે ઉપયોગી બનિે. સશવસ્ત ર જણ વો. 

4. ટૂાંક નોંધ લખો: ‘ગૂગલ મીટ’ ટૂલ  

5. ગૂગલ ડર  ઈવમ ાં ફ ઈલ સાંગ્રિ કરવ  મ ટેન  સ્ટેપ જણ વો. 

6. ગૂગલ ડોકમ ાં વોઈસ ટ ઈપીંગ ટૂલ્સની મદદથી ગયજર તી ભ ષ મ ાં ટ ઈપ કરવ ન  પગથીય ાં જણ વો. 

7. ગૂગલ ડોકની ફ ઇલને અન્ય તમત્રો સ થે commenterની માંજય રી સ થેન  sharingન ાં પગથીય ાં જણ વો. 

8. ગૂગલ મીટ ટૂલન  શવશવધ બટન્સનો ઉપયોગ જણ વો.  

9. ગૂગલ મીટમ ાં screen share કરવ  મ ટેન  શવકલ્પો જણ વો. 
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પ્રકરણ – 5 
દરૂવર્તી શિક્ષણ (Distance Education) 

5.1 પ્રસ્ર્તાવના 

શિક્ષણની પ્રશિયામાાં જ્ઞાનપ્રાશિ અને જ્ઞાનસર્જન એ પાયાની અને આવશ્યક ર્રૂરરયાર્ત ગણવામાાં આવે 

છે. ખાસ કરીને આર્ના મારિર્તી અને પ્રત્યાયન ર્તકશનકી (ICT)ના યુગમાાં મારિર્તી મેળવી ર્તેના થકી પ્રત્યાયન 

દ્વારા શનશિર્ત કરેલ ધ્યયે કે લક્ષ્ય સધુી પિોંચવાના કૌિલ્યને િીખવાની વાર્ત પર ભાર આપવામાાં આવે છે. 

ઔદ્યોગગકીકરણ, જ્ઞાન-શવજ્ઞાનનો પ્રસાર, બિુ પ્રસરેલ ર્નસમૂિ, વગેરે કારણોસર વ્યશતર્ત માટે સ્વ-અધ્યયન 

શિક્ષણ યોર્નાનો અભભગમ દૂરવર્તી શિક્ષણ (Distance Education)ના પાયામાાં છે. િૈક્ષશણક ર્તકશનકી દ્વારા ર્તે 

વધુ ફૂલ્યોફાલ્યો છે.  

આપણે સૌ ઔપચારરક શિક્ષણ પ્રણાલી (Formal Education System)ના વગજ વ્યવિારથી પરરચચર્ત 

છીએ. સામાન્ય વગજશિક્ષણના મુખ્ય પાાંચ ઘટકો છે. અધ્યેર્તા (શવદ્યાથી), અધ્યાપક (શિક્ષક), મારિર્તી 

(શવષયાાંગ), પ્રત્યાયન (વગજ વ્યવિાર) અને વગજ (કાયજસ્થળ). આમાાં, શવષયના સાંદભજમાાં શિક્ષકનાાં 

વગજવ્યવિારનુાં શવિેષ મિત્ત્વ િોય છે. ર્મે ર્મે શવજ્ઞાન અને ટેતનોલોજીનો શવકાસ થર્તો ગયો ર્તેમ ર્તેમ શિક્ષણની 

પ્રશિયામાાં આધુશનક સાધનોનો ઉપયોગ વધર્તો ગયો. ર્મે કે, લેખન, મુદ્રણ, ટેલીકોમ્યુશનકેિન (દૂરભાષ), 

ટેલીશવઝન, અભભિગમક અધ્યયન, ટીચીંગ મિીન, કમ્્યૂટર, ઇન્ટરનેટ, સેટેલાઇટ વગેરેનો શિક્ષણમાાં ઉપયોગ 

થવા લાગ્યો. આ માધ્યમોએ ઉપર ર્ણાવેલ વગજના પાાંચ ઘટકો પૈકીના મોટાભાગના ઘટકોને સાંકશલર્ત બનાવ્યા. 

આમ, મુખ્ય ત્રણ બાબર્તો દ્વારા શિક્ષણકાયજનો શવચાર અશસ્ર્તત્વમાાં આવ્યો, ર્મેાાં અધ્યેર્તા, અધ્યાપક અને િતય 

ર્તેટલા માધ્યમોની મદદથી શવષય કે મારિર્તી એકબીજાને પિોંચાડવી ર્તેનો સમાવેિ થયો. આ દૂરવર્તી શિક્ષણની 

પાયાની બાબર્ત છે. ર્નેા થકી નીચેની બાબર્તો સ્પષ્ટ થાય છે. 

5.2 ઉદે્દિ 

1. દૂરવર્તી શિક્ષણની સાંકલ્પના અને ર્તેના સ્વરૂપો ર્ણાવી િકિે. 

2. દૂરવર્તી શિક્ષણમાાં ઉપયોગમાાં લેવાર્તા માધ્યમોની શવગર્ત ર્ણાવી િકિે. 

3. દૂરવર્તી શિક્ષણ આપર્તી સાંસ્થાઓની જાણકારી આપી િકિે. 

4. દૂરવર્તી શિક્ષણના લાભાલાભ ર્ણાવી િકિે. 

 

5.3 દરૂવર્તી શિક્ષણ – અથજ અન ેસ્વરૂપ 

ર્મેાાં િીખનાર અને િીખવનાર (અધ્યેર્તા અને અધ્યાપક) એકબીજાના સીધા કે પ્રત્યક્ષ સાંપકજમાાં ન િોય, 

પરાં રુ્ત પત્રવ્યવિાર, રેશડયો કે ટેશલશવઝન દ્વારા એકબીજા સાથે શવચાર-શવમિજ (communicate) કરે ર્તે પ્રકારનુાં 

શિક્ષણ (કે અધ્યાપન) એટલે દૂરવર્તી શિક્ષણ. 

 Ref. િૈક્ષશણક પરરભાષા અને શવભાવના, યુશનવર્સસટી ગ્રાંથ શનમાજણ બોડજ, ગુર્રાર્ત રાજ્ય, પાન નાં, 79 

(નોંધ: પ્રવર્તજમાન સમયમાાં ઈન્ટરનેટનો પણ દૂરવર્તી શિક્ષણ આપવાના માધ્યમ ર્તરીકે બિોળા પ્રમાણમાાં ઉપયોગ 

થાય છે.)  
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   ‘‘દૂરવર્તી શિક્ષણએ અધ્યયન-અધ્યાપનની શવશવધ પ્રકારની ગોઠવણી ધરાવર્તી સ્વર્તાંત્ર અભ્યાસ વ્યવસ્થા છે 

કે ર્મેાાં અધ્યેર્તા અને અધ્યાપક પોર્તાના આવશ્યક કાયો અને ફરજો એકબીજાથી અલગ રિીને બજાવે છે અને 

શવશવધ માગે પ્રત્યાયન કરે છે.’’                          – Charles A. Wedemeyer 

‘‘દૂરવર્તી શિક્ષણ એ શવશવધ પ્રકારનો ર્તમામ કક્ષા કે સ્ર્તર માટેનો અભ્યાસિમ છે કે ર્ ેસર્તર્ત, ર્તાત્કાશલક શનરીક્ષક 

કે એક ર્ સ્થાન પર શવદ્યાથી સાથે વગજખાંડમાાં શિક્ષકની િાર્રીમાાં નથી થર્તો, ર્તેમ છર્તાાં સાંસ્થાના આયોર્ન અને 

માગજદિજન દ્વારા ર્તે ફાયદાકારક છે.’’                          – Borye Holmbery 

‘‘દૂરવર્તી શિક્ષણ એ આયોશર્ર્ત ર્તાંત્ર શસ્થર્ત િૈક્ષશણક પ્રવૃશિ છે, કે ર્ ેઅગાઉથી ચાલ્યા આવર્તા ઔપચારરક 

શિક્ષણ વ્યવસ્થાર્તાંત્રને બદલે સ્વીકારવામાાં આવેલ છે. ર્તે સ્વર્તાંત્ર રીર્તે કાયજરર્ત કે ચોક્કસ વ્યશતર્તઓ 

(અધ્યેર્તાઓ)ની અધ્યયન માાંગને પરરપૂણજ કરવા માટે શવશિષ્ટ મોડેલ સ્વરૂપે શવિાળ પ્રવૃશિઓને સાાંકળે છે. 

આમ, ઉપરોતર્ત શવશવધ વ્યાખ્યાઓ પરથી કિી િકાય કે –  

દૂરવર્તી શિક્ષણ એ…  

• અધ્યેર્તાકેન્દ્રી વૈયશતર્તક અભ્યાસ વ્યવસ્થા છે . 

• અધ્યયન કાયજ અને ર્તે માટેના સારિત્યનુાં સ્વ -શવશવધર્તા ધરાવે છેઅધ્યયન સ્વરૂપ છે ર્તથા  .  

• અધ્યેર્તા અને અધ્યાપક એ પરોક્ષ રીર્તે શવશવધ પ્રકારના પ્રત્યાયન પદ્ધગર્તઓથી જોડાય છે, ર્મેાાં અધ્યેર્તા 

અને અધ્યાપક બાંનેને એકબીજાથી અલગ કરવામાાં આવ્યા  .ર્તેમર્ અ ધ્યેર્તા ર્તનેા વગજ કે સમૂિથી અલગ 

કરવામાાં આવ્યા . 

• અધ્યયન-અધ્યાપન પ્રશિયા માટેની એક ર્તાંત્રગર્ત વ્યવસ્થા છે. 

• ર્તે સમયગાળો, સ્થાન, િૈક્ષશણક વ્યવસ્થાર્તાંત્રના સાંદભજમાાં લવચીક (flexible) છે .  

• સમય અને સ્થાનના સાંદભજમાાં શવદ્યાથીને સ્વર્તાંત્રર્તા (અનુકૂળર્તા) પૂરી પાડે છે.  

ર્તમારી પ્રગગર્ત ચકાસો... 

1. દૂરવર્તી શિક્ષણના લક્ષણો દિાજવો. 

2. ઔપચારરક શિક્ષણ અને દરૂવર્તી શિક્ષણનો ર્તફાવર્ત ર્ણાવો. 

3. દૂરવર્તી શિક્ષણના લાભાથીઓ કોણ િોઇ િકે છે?  

5.4  દરૂવર્તી શિક્ષણના માધ્યમો 

દૂરવર્તી શિક્ષણમાાં છેક છેવાડાના ગામડામાાં વ્યશતર્ત પોર્તાના ઘરે, ગામમાાં, પાંચાયર્ત, રૂ્થ સાંસાધન કેન્દ્ર 

કે ર્ ેિાળામાાં વ્યવસ્થા િોય ત્યાાં પોર્તાના સમયે અભ્યાસ કરી િકે છે. દૂરવર્તી શિક્ષણમાાં વગજખાંડમાાં, શિક્ષકની 

િાર્રીમાાં, શિક્ષકના સર્તર્ત શનરીક્ષણ િેઠળ અધ્યયન-અધ્યાપન થર્તુાં નથી. શિક્ષક અને શવદ્યાથી એકબીજાથી 

અલગ રિીને પણ શવશવધ માગે શવશવધ માધ્યમ થકી પ્રત્યાયન કરી અધ્યયન-અધ્યાપન કરી િકે છે. 

દૂરવર્તી શિક્ષણના માધ્યમો નીચે ર્ણાવ્યા મુર્બ છે. 
5.5.1 મરુદ્રર્ત સામગ્રી (Printed Material): 

આપણી પાસે ર્ ે માધ્યમો ઉપલબ્ધ છે ર્તેમાાં મુરદ્રર્ત સામગ્રી એ દૂરવર્તી શિક્ષણનુાં મુખ્ય માધ્યમ છે. 

માધ્યમોનો ગમે ર્તેટલો શવકાસ થયો િોય છર્તાાં પણ આપણા શિક્ષણમાાં મુરદ્રર્ત સામગ્રીની ભૂગમકા પાયાની અને 
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મિત્ત્વની રિેવાની ર્. દૂરવર્તી કેન્દ્રો દ્વારા મુરદ્રર્ત સામગ્રીનુાં શવર્તરણ પણ કરવામાાં આવે છે. દૂરવર્તી કેન્દ્રો દ્વારા 

મોકલાવવામાાં આવેલ મુરદ્રર્ત સામગ્રીનો ઉપયોગ કરી શવદ્યાથી જ્ઞાન પ્રાિ કરી િકે છે.  

5.5.2 રેશડયો :  

રેશડયોન ે મરુદ્રર્ત સામગ્રી પછી કદાચ સૌથી ઓછા ખચાજળ માધ્યમ ર્તરીકે ગણી િકાય, ર્નુેાં પ્રસારણ  

શવિાળ ભૌગોશલક શવસ્ર્તારમાાં થાય છે. આપણા દિેમાાં ઘણાાંબધા પ્રસારણ કેન્દ્રો આવેલા છે, ર્ ે િૈક્ષશણક 

પ્રસારણો પણ કરે છે. રેશડયો પર આપણી રાષ્ટર ીય રેશડયો ચેનલ All India Radio (AIR) દ્વારા પ્રાથગમક ર્તમેર્ 

માધ્યગમક કક્ષાના િૈક્ષશણક કાયજિમો પ્રસારરર્ત કરવામાાં આવે છે. ર્તદ્ઉપરાાંર્ત પત્રાચાર દ્વારા શિક્ષણ સાથે સાંબાંશધર્ત 

યુશનવર્સસટી કક્ષાના કાયજિમો અને પ્રૌઢશિક્ષણના કાયજિમો પણ પ્રસારરર્ત કરવામાાં આવે છે. ઉદા. ઇન્દીરા ગાાંધી 

નેિનલ ઓપન યુશનવર્સસટી (IGNOU)ના કાયજિમો.  

દેિના શવશવધ સ્થાશનક રેશડયો પ્રસારણ (FM Radio Channel) દ્વારા પ્રાદેશિક ભાષાઓમાાં િૈક્ષશણક 

કાયજિમો શનયગમર્ત રીર્તે પ્રસારરર્ત કરવામાાં આવર્તાાં િોય છે. IGNOUની ‘જ્ઞાનવાણી’, ગુર્રાર્ત યશુનવર્સસટી, 

અમદાવાદ ર્તેમર્ સરદાર પટેલ યુશનવર્સસટી, વલ્લભ શવદ્યાનગર ર્વેી યુશનવર્સસટીઓ પણ પોર્તાની સ્થાશનક રેશડયો 

ચેનલ ધરાવે છે અને ર્તેના દ્વારા શવશવધ પ્રકારના િૈક્ષશણક કાયજિમો પ્રસારરર્ત કરર્તા રિે છે. રેશડયો પરથી પ્રસારરર્ત 

થર્તાાં કાયજિમોનુાં રેકોર્ડડગ કરી અનુકૂળ સમયે પુનઃ ઉપયોગમાાં લઇ િકાય છે. રેશડયો પરથી વ્યાખ્યાન, ર્તર્જ્ઞનો  

વાર્તાજલાપ, મુલાકાર્ત, ચચાજ, રૂ્થચચાજ, વગેરે રરૂ્ થઇ િકે છે.  

5.5.3 દ્રશ્ય-શ્રાવ્ય (Audio-Video) માધ્યમ :  

ટેશલશવઝન એ િાલના સમયમાાં એક અગત્યનુાં દ્રશ્ય-શ્રાવ્ય સમૂિ માધ્યમ (Mass Media) છે. ભારર્તમાાં 

ર્તે 1959થી ઉપલબ્ધ છે. દ્રશ્ય-શ્રાવ્ય પ્રસારણ એક સાથે થર્તુાં  િોવાથી ટેશલશવઝન એ આકષજક અને શિક્ષણનુાં 

ખૂબ ર્ અસરકારક માધ્યમ છે.  

ઘણાાંખરાાં મુતર્ત શવશ્વશવદ્યાલયોમાાં ર્તો ટેશલશવઝન એ મિત્ત્વનુાં િૈક્ષશણક ઘટક છે. ર્રટલ અને ખચાજળ 

પ્રયોગો કે પ્રવૃશિઓ, ઔધોગગક પ્રશિયાઓ, શવશિષ્ટ કે્ષત્રમાાંથી ર્તર્જ્ઞ વ્યશતર્તઓની મુલાકાર્ત, વગેરે 

શવદ્યાથીઓને ઘરે બેઠા ટેશલશવઝન પ્રસારણ દ્વારા પૂરા પાડી િકાય. રાષ્ટર ીય સ્ર્તરે ઉચ્ચ શિક્ષણ માટે યુશનવર્સસટી 

ગ્રાન્ટ કગમિન (UGC) દ્વારા Country Wide Classroom ના કાયજિમો 1984થી શનયગમર્ત પ્રસારરર્ત થાય છે. આ 

ર્તમામ કાયજિમો ઉપગ્રિ અને ટેશલશવઝન નેટવકજની મદદથી પ્રસારરર્ત થાય છે.  

પ્રવર્તજમાન સમયમાાં ગુર્રાર્ત સરકાર દ્વારા વાંદ ેગુર્રાર્ત ચેનલ થકી ધોરણ 5 થી 12ના સાક્ષરી શવષયોના 

શવષયવસ્ર્તુની સમર્ આપર્તા કાયજિમો શનયગમર્ત રીર્ત ેપ્રસારરર્ત કરવામાાં આવ ેછે. ર્ ેઅાંર્તગજર્ત ધોરણ મુર્બ વાંદે 

ગુર્રાર્ત ચેનલની ફાળવણી કરવામાાં આવેલ છે. એટલે કે વાંદ ે ગુર્રાર્તની ચેનલ 5 એ ધોરણ-5ને સાંલગ્ન 

િૈક્ષશણક કાયજિમો પ્રસારરર્ત કરે છે. વાંદ ેગુર્રાર્તની ચેનલ 6 એ ધોરણ 6 ને સાંલગ્ન િૈક્ષશણક કાયજિમો પ્રસારરર્ત 

કરે છે. એ મુર્બ ૧૨ ધોરણ સુધીના િૈક્ષશણક કાયજિમો પ્રસારરર્ત કરવા ધોરણવાર ચેનલની ફાળવણી કરવામાાં 

આવેલ છે. ર્મેના ઘરે કે સાંસ્થામાાં વાંદે ગુર્રાર્ત ચેનલ દ્વારા થર્તા પ્રસારણને ઝીલવાની સુશવધા િોય, ર્તે 

ર્ગ્યાએથી શવદ્યાથી પોર્તાના ધોરણના પ્રસારરર્ત થર્તા કાયજિમો શનિાળી પોર્તાના જ્ઞાનમાાં વૃશદ્ધ કરી િકે છે. 

5.5.4 Interactive Television (ITV):   

• IGNOU દ્વારા જ્ઞાનદિજન – 2 ચેનલની મદદથી આાંર્તરશિયાત્મક શિક્ષણ (Interactive Education) રૂપે 

િૈક્ષશણક કાયજિમો પ્રસારરર્ત કરવામાાં આવ ે છે. ર્મેાાં, શદ્વ-માગી પ્રત્યાયનનો ઉપયોગ કરવામાાં આવ ે છે. આ 



51 
 

પ્રત્યાયનમાાં શિક્ષક અને શવદ્યાથી વચ્ચ ે સાંવાદ થઇ િકે છે. પરાં રુ્તાં, આ માટે બાંને પકે્ષ શવશિષ્ટ પ્રકારની 

ટેતનોલોજીનો ઉપયોગ કરવો પડે છે. 

5.5.5 પત્રાચાર દ્વારા શિક્ષણ (Education through Correspondence) : 

  મોટાભાગના દૂરવર્તી શિક્ષણ કાયજિમમાાં શવદ્યાથીઓને ર્ ેર્તે શવષય માટે ર્રૂરી વાાંચન કે અધ્યયન માટેની 

સામગ્રી ર્તેમને દૂરવર્તી કેન્દ્ર દ્વારા ર્તેમના રિેઠાણ કે અધ્યયન સ્થળે પત્રાચાર મારફર્ત મોકલવામાાં આવ ેછે. ર્તમેર્ 

શવદ્યાથીએ ર્તૈયાર કરેલ સ્વ-અધ્યયન કાયજ ર્ ેપ્રોર્તે્સ, એસાઇન્મેન્્સ, વગેરે સ્વરૂપે િોય ર્તેને દૂરવર્તી કેન્દ્ર 

ખાર્તે પત્રાચાર મારફર્ત પરર્ત મોકલવામાાં આવે છે, ર્નુેાં મૂલ્યાાંકન ર્ ેર્તે શવષયના ર્તર્જ્ઞ દ્વારા કરવામાાં આવે છે. 

આ પ્રકારનુાં પ્રત્યાયન ઓછુાં ખચાજળ અને પાયાગર્ત છે, ર્મેાાં અધ્યયન સામગ્રી શવદ્યાથી પાસ ેર્ રિે છે ર્તેમર્ ર્તેનો 

ર્રૂર પડે વારાંવાર ઉપયોગ કરી િકે છે.    

5.5.6 ઇન્ટરનટે (INTERNET):  

આર્ના યુગમાાં િૈક્ષશણક મારિર્તી પ્રસ્ર્તુર્ત કરવા માટે ઇન્ટરનેટ એક અગત્યનુાં માધ્યમ બની રહ્ુાં છે. 

ઇન્ટરનેટ દ્વારા વેબસાઇટ પર ર્ઇ જોઇર્તી મારિર્તી મેળવી િકાય છે. આ વ્યવસ્થાથી  અધ્યેર્તાને ર્તેની ર્રૂરરયાર્ત, 

સમય રે્તમર્ અધ્યયન ગગર્તથી અધ્યયન કાયજ કરવાની અનુકૂળર્તા મળી રિે છે. ઇન્ટરનેટ દ્વારા અધ્યેર્તાને ટેક્ષ્ટ, 

ઓશડયો, શવડીયો, ગ્રાશફતસ, એશનમેિન ર્વેા શવશવધ સ્વરૂપે મારિર્તી પ્રાિ થઇ િકે છે. દૂરવર્તી શિક્ષણમાાં 

ઓનલાઇન શિક્ષણ પણ ઇન્ટરનેટના માધ્યમ દ્વારા પ્રાિ થઇ િકે છે.  

ઇન્ટરનેટ મારફરે્ત ઇ-મેઇલ દ્વારા પત્ર વ્યવિાર થકી દરૂવર્તી શિક્ષણ અાંર્તગજર્ત મારિર્તીની આપ-લે કરી 

િકાય છે. આ ઉપરાાંર્ત, BAOU ના OMKAR (Open Matrix Knowledge Advancement Resource) પોટજલ દ્વારા 

ઇ-લર્ડનગની વ્યવસ્થા કરવામાાં આવેલ છે, જ્યારે IGNOUના વચ્યુજઅલ તલાસ દ્વારા શવશવધ સ્ટડી મટીરરયલ 

અપલોડ કરવામાાં આવેલ છે, ર્નેા થકી અધ્યેર્તા સ્વઅધ્યયન કરી િકે છે.  

ર્તમારી પ્રગગર્ત ચકાસો. 

1. દૂરવર્તી શિક્ષણમાાં ઉપયોગમાાં આવર્તાાં શવશવધ માધ્યમો પૈકી કોઇપણ એક માધ્યમનો પ્રત્યક્ષ અનુભવ 

મેળવી ર્તેની નોંધ ર્તૈયાર કરો. 

2. દૂરવર્તી શિક્ષણ સાંદભે ટેશલશવઝનમાાં દિાજવવામાાં આવર્તા કાયજિમોની યાદી ર્તૈયાર કરો. આવા એક 

ટેલીશવઝન પ્રસારણને જોઇ રે્તમાાં આવેલા મુદ્દાઓની રરૂ્આર્ત વગજમાાં કરો. 

5.5 દરૂવર્તી શિક્ષણ આપર્તી સાંસ્થાઓનો પરરચય અન ેBISAG-Nની ભગૂમકા 

Bhaskaracharya National Institute of Space Application and Geo-informatics ટૂાંકમાાં BISAG-N 

ર્તરીકે ઓળખાય છે. ર્નુેાં મથક ગાાંધીનગર ખાર્તે આવેલ છે. આ સાંસ્થાનુાં મુખ્ય કાયજ અવકાિમાાં છોડવામાાં આવેલ 

શવશવધ પ્રકારના ઉપગ્રિો દ્વારા મોકલવામાાં આવર્તી મારિર્તીને મેળવી ર્તેનુાં અથજઘટન કરવાનુાં છે. ર્તદ્ઉપરાાંર્ત 

મેળવેલ મારિર્તીને ર્તેની ર્રૂરરયાર્ત પ્રમાણેના શવભાગને પિોંચર્તી કરવામાાં આવ ે છે. શિક્ષણકે્ષત્રે આપણા દેિે 

EDUSAT નામે સેટેલાઇટ અવકાિમાાં ર્તરર્તો મૂતયો છે. આ સેટેલાઇટ દ્વારા દેિના અાંર્તરરયાળ શવસ્ર્તારમાાં રિેલા 

શવદ્યાથીઓને શિક્ષણ આપવા ર્તેમર્ શિક્ષણનુાં સાવજગત્રકરણ કરવા માટે શવશવધ િૈક્ષશણક ચેનલો િરૂ કરવાની 

સગવડ કરવામાાં આવેલ છે. આવી ચેનલોનુાં શનયમન BISAG-N સાંસ્થા ખારે્ત આવલે સ્ટૂશડયોમાાંથી કરવામાાં આવે 
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છે. BISAG-N ના સ્ટૂશડયોમાાં શવશવધ િૈક્ષશણક કાયજિમો રૈ્તયાર કરવામાાં આવે છે અને ર્તેનુાં પ્રસારણ શવશવધ ચનેલો 

દ્વારા કરવામાાં આવે છે. આવા ર્ કેટલાક કાયજિમોની અત્રે ચચાજ કરવામાાં આવેલ છે.   

5.5.1 દરૂવર્તી શિક્ષણ કાયજિમ 

શિક્ષણના સાવજગત્રકરણ એટલે કે ‘સૌના માટેના શિક્ષણ’ એ આદિજને પિોંચી વળવા સાવજગત્રક પ્રયાસો 

િાથ ધરવામાાં આવેલ છે. ગુર્રાર્ત રાજ્યમાાં KU-Band (ટેશલશવઝન પ્રસારણના િશતર્તિાળી ર્તરાંગોનો એક પ્રકાર) 

દ્વારા થર્તા પ્રસારણને જીલવાની સુશવધા છેક ગામડા સુધી શવસ્ર્તરેલી છે. ર્થેી ગામડાાંના બાળકો પોર્તાના ર્ 

ગામમાાં કે સી.આર.સી. ખાર્તે કે ઘરે બેઠાાં શિક્ષણ પ્રાિ કરી િકે છે. BISAG-N થી પ્રસારરર્ત થર્તાાં શિક્ષણના કાયજિમો 

સમગ્ર ગુર્રાર્તના બાળકો જોઇ િકે, સાાંભળી િકે, આ વ્યવસ્થાને ‘દૂરવર્તી શિક્ષણ’ (Distance Education) 

ર્તરીકે ઓળખી િકાય છે.  

શિક્ષણની સર્તર્ત ગુણવિા સુધારણા થાય ર્તે માટે શિક્ષણ શવભાગના માગજદિજનથી અને જી.સી.ઇ.આર.ટી. 

દ્વારા દૂરવર્તી શિક્ષણની અધ્યયન-અધ્યાપન ર્તરાિનો ઉપયોગ માચજ – 2009 થી િરૂ કરવામાાં આવેલ છે. આ 

વ્યવસ્થા થકી BISAG-N સ્ટુશડયો દ્વારા EDUSAT થકી ટૅતનોલોજીનો મિત્મ ઉપયોગ કરીન ે ર્તમામ શવષયના 

શિક્ષણને પ્રવૃશિમય બનાવી રાજ્યની ર્તમામ પ્રાથગમક િાળાના ધોરણ 5 થી 8 ના શવદ્યાથીઓમાાં ર્ ેર્તે શવષયની 

સાંકલ્પનાઓ સ્પષ્ટ કરવામાાં આવે છે. દૂરવર્તી શિક્ષણનો પ્રોર્તેટ નીચે ર્ણાવેલ િેર્તુઓને ચસદ્ધ કરવા િરૂ કરવામાાં 

આવેલ છે.  

• શવશવધ શવષયના ર્તજ્જ્ઞ શિક્ષકોનાાં જ્ઞાનનો લાભ રાજ્યના છેવાડાનાાં ગામડાાંઓની િાળા સુધી પિોંચે . 

• રાજ્યની ર્તમામ સરકારી પ્રાથગમક િાળાઓનાાં ધોરણ 5 થી 8 ના ર્તમામ બાળકો દૂરવર્તી શિક્ષણના  

માધ્યમથી શવષયવસ્ર્તુનુાં જ્ઞાન મેળવે. 

• શવજ્ઞાન અને ટૅતનોલોજીના માધ્યમ દ્વારા દૂરવર્તી શિક્ષણની પ્રશિયાથી મારિર્તગાર થાય . 

• કરઠન શવષયના શિક્ષણમાાં સમગ્ર રાજ્યમાાં એકસૂત્રર્તા ર્ળવાય . 

• પ્રાયોગગક અને પ્રવૃશિલક્ષી શનદિજન દ્વારા શવષયવસ્ર્તુનુાં જ્ઞાન મેળવે. 

• સ્થાશનક કક્ષાએ યોગ્ય િૈક્ષશણક સાઘન સામગ્રીની મયાજદાઓ દરૂ થાય છે . 

• રુ્દા રુ્દા શવષય શિક્ષણની શવશવધ પદ્ધગર્તઓ અને પ્રયુશતર્તઓથી રાર્યના શિક્ષકો વાકેફ થાય. 

• શિક્ષણની પ્રશિયાને વધુ અસરકારક બનાવવાનો અનુભવ મળે. 

આમ, શિક્ષણમાાં ટૅતનોલોજીના માધ્યમ દ્વારા રાજ્યના ર્તમામ ગામડાઓની પ્રાથગમક િાળાઓ સુધી 

પિોંચવાનો પ્રયત્ન કરવામાાં આવેલ છે.  

5.5.2 વચ્યુજઅલ તલાસરૂમ પ્રોર્તેટ (Virtual Classroom Project) 

શિક્ષણ કાયજમાાં ઈ-લર્ડનગનો ઉપયોગ વધારવા અને ર્તર્જ્ઞ શિક્ષકોનો પ્રત્યક્ષ લાભ શવદ્યાથીઓને આપવા 

વચ્યુજઅલ તલાસરૂમ પ્રોર્તેટની િરૂઆર્ત કરવામાાં આવેલ છે. વચ્યુજઅલ તલાસરૂમ પ્રોર્તેટના મુખ્ય િેર્તુ, ર્ ે

િાળાઓમાાં ભાષા શિક્ષક ર્તરીકે શનમણૂાંક પામેલ શિક્ષકનો મુખ્ય શવષય અાંગ્રેજી નથી ર્તેવી િાળાઓમાાં 

ગુણવિાસભર અાંગ્રેજી શિક્ષણ આપવાનો ર્તેમર્ રાજ્યના શ્રેષ્ઠ શિક્ષકોના જ્ઞાનનો લાભ શવદ્યાથીઓને પૂરો 

પાડવાનો છે. 

આ પ્રોર્તેટ અાંર્તગજર્ત અાંગ્રજેી શવષયલક્ષી કાયજિમોનુાં પ્રસારણ ર્ ે ર્તે િાળાઓમાાં દરરોર્ શનયર્ત સમય ે

બાયસેગ (BISAG-N)ના માધ્યમથી કરવામાાં આવે છે. આ કાયજિમને િાળાના ધોરણ 5 થી 8ના બાળકો દ્વારા 
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શનિાળવામાાં આવે છે ર્તેમર્ ર્તે ર્ સમયે ર્તેમને દિાજવવામાાં આવર્તી પ્રવૃશિઓ પણ કરવાની િોય છે. આ પ્રવશૃિઓ 

પૂણજ કરવા માટેનો સમય પણ ર્તેમને આપવામાાં આવે છે. 

5.5.3  NATIONAL INSTITUTE OF OPEN SCHOOLING (NIOS) 

રાષ્ટર ીય મુતર્ત શવદ્યાલય શિક્ષણ સાંસ્થા (NIOS), પિેલાાં રાષ્ટર ીય મુતર્ત શવદ્યાલય (National Open School)થી 

ઓળખાર્તુાં િરુ્તાં, ર્નેી સ્થાપના રાષ્ટર ીય માનવ સાંસાધન માંત્રાલય, નવી રદલ્િી દ્વારા ઇ.સ. 1989માાં કરવામાાં 

આવેલ િર્તી. મુતર્ત અને દૂરવર્તી શિક્ષણ આપર્તી આ સાંસ્થા માધ્યગમક અને ઉચ્ચર્તર માધ્યગમક શિક્ષણ કક્ષાનો 

િૈક્ષશણક અભ્યાસિમ ચલાવે છે. આ ઉપરાાંર્ત વ્યાવસાશયક શિક્ષણ, જીવન સાંવધજન ર્તેમર્ સમાર્લક્ષી અભ્યાિમો 

પણ ચલાવ ેછે. ઓપન બેશઝક એજ્યુકેિન (Open Basic Education) અાંર્તગજર્ત પ્રાથગમક શિક્ષણનો અભ્યાસિમ 

પણ િરૂ કરવામાાં આવેલ છે. 

આ સાંસ્થાનો મુખ્ય િેર્તુ દેિના આાંર્તરરક કે દૂગજમ શવસ્ર્તારમાાં વસર્તાાં બાળકો ર્તેમર્ ઔપચારરક શિક્ષણથી 

વાંચચર્ત બાળકોન ેર્તેમની ર્રૂરરયાર્ત, અનુકૂળ સમય ર્તથા સ્થળે મુતર્ત અને દૂરવર્તી અધ્યયન પ્રણાલી દ્વારા સર્તર્ત, 

સાંબાંશધર્ત અને સવાાંગગણ શિક્ષણ પૂરૂાં પાડવાનો છે. આ પ્રયાસ થકી રાષ્ટરમાાં િાળાશકય શિક્ષણનુાં સાવજગત્રકરણ 

કરવામાાં સિયોગ સાાંપડે છે. 

આ સાંસ્થાના અભ્યાિમમાાં દાખલ થયેલ બાળકોને રુ્દા રુ્દા શવષય માટે શવશિષ્ટ રીર્ત ેર્તૈયાર કરેલ મરુદ્રર્ત 

સ્વ-અધ્યયન સામગ્રી ર્તથા અન્ય સિાય સામગ્રી ટપાલ દ્વારા પિોંચાડવામાાં આવ ેછે. અભ્યાસમાાં મદદ કે ઉપચાર 

માટે શનશિર્ત કરેલ કેન્દ્રો પર રૂબરૂ સાંપકજ  કાયજિમો (Personal Contact Programmes)માાં ર્તર્જ્ઞો દ્વારા આધુશનક 

પ્રત્યાયન ર્તકશનકીના ઉપયોગ થકી શિક્ષણ આપવામાાં આવે છે. 

5.5.4 ઇશન્દરા ગાાંધી નિેનલ ઓપન યશુનવર્સસટી (IGNOU) ર્તમેર્ ડૉ. બાબાસાિેબ આાંબડેકર ઓપન યશુનવર્સસટી 

(BAOU)  

ઉચ્ચ શિક્ષણના વૈશ્વશ્વક પ્રવાિોમાાં વર્તજમાન સમય દૂરવર્તી શિક્ષણનો છે. સ્થળ અને સમયના બાંધનથી મુતર્ત 

એવી દરૂવર્તી શિક્ષણ વ્યવસ્થા ઉચ્ચશિક્ષણથી વાંચચર્ત એવા ગ્રામર્નો કે પોર્તાની િૈક્ષશણક લાયકાર્તમાાં અભભવૃશદ્ધ 

ઇચ્છર્તા શર્જ્ઞાસુઓ માટે ભારર્તમાાં સૌ પ્રથમ રાષ્ટર ીય કક્ષાએ ‘ઇશન્દરા ગાાંધી નેિનલ ઓપન યુશનવર્સસટી’ 

(IGNOU)ની સ્થાપના થઇ િર્તી, જ્યારે ગુર્રાર્ત રાજ્યમાાં રાજ્યકક્ષાની એકમાત્ર ઓપન યુશનવર્સસટી એટલ ે

‘ડૉ.બાબાસાિેબ આાંબેડકર ઓપન યુશનવર્સસટી’ (BAOU)ની સ્થાપના 1994માાં કરવામાાં આવેલ િર્તી. આ 

યુશનવર્સસટીના ઉદે્દશ્ય અને શવશિષ્ટર્તાઓ નીચે મુર્બ છેઃ 

• ગુણવિાયુતર્ત ઉચ્ચશિક્ષણ પ્રાિ કરવા માટે અનુકૂળ સમયે અને ઘરે બેઠાાં અભ્યાસ કરવાની સગવડ.  

• િિેર કે અાંર્તરરયાળ ગામડામાાં રિેર્તા સૌને સમાન ધોરણવાળુાં શિક્ષણ. 

• ર્રૂરરયાર્ત આધારરર્ત વ્યવસાયલક્ષી અને ભાશવ કારશકદીલક્ષી અભ્યાસિમો શવકસાવવાનો અભભગમ. 

• દેિની અન્ય ઓપન યશુનવર્સસટીઓ સાથેનાાં જોડાણોને લીધ ે રાષ્ટર ીય રે્તમર્ આાંર્તરરાષ્ટર ીય જ્ઞાન સરળ 

માધ્યમમાાં ઉપલબ્ધ કરવાની સગવડ. 

• જીવાંર્ત ‘ફોન ઇન રેશડયો કાઉન્સેલલગ’ ર્તથા ‘સૅટેલાઇટ ઓપન એન્ડ શડસ્ટન્સ લર્ડનગ’ દ્વારા પરામિજનની 

વ્યવસ્થા. 

5.5.5  SWAYAM (Study Webs of Active Learning for Young Aspiring Minds): 
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SWAYAM ભારર્ત સરકાર દ્વારા િરૂ કરવામાાં આવેલ એક કાયજિમ છે, ર્ ેશિક્ષણ નીગર્તના ત્રણ ચસદ્ધાાંર્તો 

ચસદ્ધ કરવા માટે િરૂ કરવામાાં આવેલ છે (૧) કોઈને પણ અભ્યાસિમમાાં પ્રવેિ લેવાનો િક (સિર્ પ્રા્યર્તા) 

(૨) ર્તમામ સાથે સમાન વ્યવિાર (સમાનર્તા) અને (૩) ગુણવિા.  

SWAYAM કાયજિમનો મુખ્ય િેર્તુ ઉિમ અધ્યયન અધ્યાપન સાંસાધનને બધા સુધી પિોંચાડવાનો છે. 

SWAYAM એવા શવદ્યાથીઓ માટે જોડાણનુાં કામ કરિે કે ર્ ે શડશઝટલ િાાંગર્તથી િરુ્ દૂર છે અને ર્ઓે જ્ઞાન 

અથજવ્યવસ્થાની મુખ્ય ધારાથી દૂર છે. 

ઉપરોતર્ત િેર્તુને ચસદ્ધ કરવા માટે સ્વદેિી આઈ.ટી. ્લેટફોમજનો ઉપયોગ કરવામાાં આવેલ છે, ર્ ેનવમા 

ધોરણથી અનુસ્નાર્તક સુધીના બધા અભ્યાસિમોને કોઈપણ માટે, કોઈપણ સમયે અને કોઈપણ સ્થળે પ્રા્ય 

બનાવે છે. આ ર્તમામ અભ્યાસિમો આાંર્તરશિયાત્મક (Interactive) છે અને દેિના શ્રેષ્ઠ શિક્ષકો અને ર્તર્જ્ઞો દ્વારા 

ર્તૈયાર કરવામાાં આવેલ છે અને દેિના કોઈપણ નાગરરક માટે શન:િૂલ્ક શિક્ષણ મળેવવાની સુશવધા પૂરી પાડે છે. 

SWAYAM દ્વારા ર્તૈયાર કરવામાાં આવેલ અભ્યાસિમ 4 ભાગમાાં િોય છે. (૧) શવડીયો વ્યાખ્યાન (૨) 

ખૂબ કાળજીપૂવજક ર્તૈયાર કરવામાાં આવેલ મુરદ્રર્ત અધ્યયન સામગ્રી કે ર્નેે સરળર્તાથી ડાઉનલોડ કરી િકાય (૩) 

સ્વમૂલ્યાાંકન માટે પ્રશ્નોિરી (Quiz) અને પરીક્ષા ર્તથા (૪) કોઈપણ પ્રશ્નો કે િાંકાનાાં સમાધાન માટે ઓનલાઇન 

વાર્તાજલાપ.  

ગુણવિાયુતર્ત શવષયવસ્ર્ત ુર્તૈયાર કરવા માટે અને અધ્યેર્તા સધુી પિોંચાડવા માટે 9 રાષ્ટર ીય સાંકલનકાર 

(સ્વગગર્તથી ચાલર્તા અભ્યાસિમ માટે AICTE, ઇર્નેરી િાખાના અભ્યાસિમ માટે NPTEL, અનુસ્નાર્તક કક્ષાના 

અભ્યાસિમ માટે UGC, સ્નાર્તક તક્ષાના અભ્યાસિમ માટે CEC, િાળા કક્ષાના અભ્યાસિમ માટે NCERT અને 

NIOS, િાળા બિારના શવદ્યાથી માટે IGNOU અને વ્યવસ્થાપન સાંલગ્ન અભ્યાસિમ માટે IIMB)ની શનમણૂક 

કરવામાાં આવેલ છે.  

SWAYAM દ્વારા ર્ ેઅભ્યાસિમ રરૂ્ (Offer) કરવામાાં આવ ેછે, ર્તે ર્તમામ શનઃિૂલ્ક િોય છે, પરાં રુ્ત ર્ ે

અધ્યેર્તા અભ્યાસિમનુાં પ્રમાણપત્ર લેવા ઈચ્છર્તો િોય ર્તનેે SWAYAM પોટજલ પર નોંધણી (Registration) કરાવવી 

પડે છે અને નજીવી ફી ભરવી પડે છે ર્તથા સફળર્તાપૂવજક અભ્યાસિમ પૂરો કયાજ બાદ ર્તેને પ્રમાણપત્ર આપવામાાં 

આવે છે. 

SWAYAM પોટજલ MHRD અન ે All India Council for Technical Education (AICTE) એ MICROSOFT 

કાંપની સાથે મળીને ર્તૈયાર કયુાં છે, ર્ ે૨૦૦૦ અભ્યાસિમને ધારણ (host) કરી િકે છે. ર્મેાાં િાળા, સ્નાર્તક, 

અનુસ્નાર્તક, ઇર્નેરી, કાયદા અને બીજા વ્યાવસાશયક અભ્યાસિમનો સમાવેિ થાય છે. 

SWAYAM portal પર ર્વા માટે ની link https://swayam.gov.in છે . 

ઉપરોતર્ત લીંક પર શતલક કરી SWAYAM પોટજલ પર ર્ઈ All Course ટેબ પર શતલક કરી SWAYAM portal 

પર ઉપલબ્ધ ર્તમામ કોસજ જોઈ િકાય છે અને રસ ધરાવર્તા કોસજમાાં જોડાઇ િકાય છે. 

ર્તમારી પ્રગગર્ત ચકાસો 

1. પ્રાથગમક િાળાઓમાાં િાળા સમય દરગમયાન પ્રસારરર્ત થર્તા દૂરવર્તી શિક્ષણ કાયજિમનુાં અવલોકન 

કરી, બાળકોને અધ્યયનમાાં થર્તી મદદ ર્તથા મુશ્કેલીઓનો  અભ્યાસ કરો. 

2. વચ્યુજઅલ તલાસરૂમ પ્રોર્તેટના વગજનુાં અવલોકન કરી ર્તેના લાભાલાભ વણજવો. 

3. ર્તમારા શર્લ્લામાાં આવેલ NIOS કેન્દ્રની મુલાકાર્ત લઇ ર્તેની મારિર્તીની ચચાજ ર્તમારા વગજમાાં કરો . 

https://www.aicte-india.org/
http://www.nptel.ac.in/
http://www.aicte-india.org/
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4. SWAYAM પોટજલ પર ર્ઈ આપના રસના શવષયના એક કોસજમાાં જોડાવ અને ર્તેને પૂણજ કરી પ્રમાણપત્ર પ્રાિ 

કરો. 

નોંધ : DIKSHA પોટજલ દ્વારા પણ દરૂવર્તી શિક્ષણ આપવામાાં આવ ેછે ર્નેી ચચાજ પ્રથમ વષજ ડી.એલ.એડ.્ના 
અભ્યાસિમમાાં કરવામાાં આવલે છે. 

5.6 દરૂવર્તી શિક્ષણના ફાયદાઓ અન ેમયાજદાઓ 

5.6.1 દરૂવર્તી શિક્ષણના ફાયદાઓ 

• લવચચક ર્તાંત્ર (Flexible System) - દૂરવર્તી શિક્ષણ સમય અને સ્થળના બાંધનોથી મુતર્ત છે. 

• સ્વગગર્તએ પ્રગગર્ત (Self Pace Learning) - દૂરવર્તી શિક્ષણમાાં શવદ્યાથી પોર્તાની ઝડપ અને અનુકૂળર્તાએ 

પ્રગગર્ત કરી િકે છે . 

• સ્વ અધ્યયન (Self Learning) - દૂરવર્તી શિક્ષણ સ્વશિક્ષણ અને સ્વ-સુધારણા ર્તરફ દોરી જાય છે . 

• કૌિલ્યવધજન (Skill Improvement) -   દૂરવર્તી  શિક્ષણનો ટેકશનકલ અને વ્યાવસાશયક કૌિલ્ય સધુારવા 

માટે પણ ઉપયોગ કરી િકાય છે . 

• અાંર્તરરયાળ શવસ્ર્તાર માટે ઉપયોગી - દૂરવર્તી શિક્ષણ કોઈપણ દૂરસ્થ અથવા અાંર્તરરયાળ શવસ્ર્તાર સુધી 

રેશડયો, ટેશલશવઝન અથવા ટપાલ સેવા મારફરે્ત પિોંચી િકે છે . 

• ભબન ખચાજળ પદ્ધગર્ત - દૂરવર્તી શિક્ષણ એ ઔપચારરક સીસ્ટમની સરખામણીમાાં શિક્ષણ મેળવવાની એક 

ઓછી ખચાજળ પદ્ધગર્ત છે . 

• કોઇપણ સ્ર્તરે ઉપયોગી - દરૂવર્તી શિક્ષણ પ્રાથગમક િાળાથી કોલેર્ કક્ષા સધુી ર્તેમર્ વ્યાવસાશયક શવકાસ 

માટે એમ કોઈપણ સ્ર્તરે ઉપયોગી બની િકે છે . 

• પૂરક પદ્ધગર્ત - દૂરવર્તી શિક્ષણ એ ઔપચારરક શિક્ષણ મેળવર્તા શવદ્યાથીઓ માટે અભ્યાસ માટેની પૂરક 

પદ્ધગર્ત પણ છે. 

• ઉચ્ચ શિક્ષણ માટે ર્તકો - દૂરવર્તી શિક્ષણ સમાર્ના ર્તમામ વગજ માટે ઉચ્ચ શિક્ષણ સુલભ બનાવે છે . 

5.6.2 દરૂવર્તી શિક્ષણની મયાજદાઓ 

• શિક્ષકોની ગેરિાર્રી - દૂરવર્તી શિક્ષણમાાં શિક્ષકની િાર્રી મોટેભાગે પ્રત્યક્ષ ન િોવાને કારણ ે

શવદ્યાથીઓની મૂાંઝવણ સાંદભે પૂરર્તુાં માગજદિજન પ્રાિ થર્તુાં નથી. 

• ચીલાચાલ ુઅભ્યાસિમો  – અભ્યાસિમોમાાં નવીનર્તા ન િોવાને કારણે અભ્યાસિમો ચીલાચાલ ુબની 

રિેલ છે . 

• નજીવો વ્યવિારુ અનુભવ - આ પ્રકારના શિક્ષણથી વ્યવિારુ અનુભવ માટેની ર્તક નગણ્ય ર્વેી છે . 

• મયાજરદર્ત જાગૃગર્ત - સમાર્ના લોકોમાાં દૂરવર્તી શિક્ષણને પરરચચર્ત બનાવવા માટે ખૂબ ર્ મયાજરદર્ત અવકાિ 

મળ્યો છે . 

• મયાજરદર્ત અભ્યાસ કેન્દ્રો  - અભ્યાસ કેન્દ્રો અને પુસ્ર્તકોની જોગવાઈ ખૂબ ઓછી છે. 

• વારાંવાર સમીક્ષાનો અભાવ - અભ્યાસિમોની સમીક્ષા સમયાાંર્તરે કરવામાાં આવર્તી નથી. 

• પ્રવૃશિઓનો અભાવ - શવદ્યાથીઓને પ્રવચનો સાાંભળવા ચસવાય અન્ય શવશવધ પ્રકારની પ્રવૃશિઓમાાં 

સિભાગી થવાની ર્તક સાંપકજ  કાયજિમો દરગમયાન મળર્તી નથી. 
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• સામાશર્કર્તા શવકસની ઓછી ર્તક - ર્ ેિાળા કે કોલેર્માાં શવકસી િકે છે ર્તેવી સામાશર્કર્તા શવકસર્તી નથી. 

• મૂલ્યાાંકનમાાં અધૂરપ - મૂલ્યાાંકનમાાં આત્માલક્ષીર્તા વધુ રિેવાની િતયર્તા િોય છે. ઉપરાાંર્ત સર્તર્ત અને 

સવજગ્રાિી મલૂ્યાાંકનની જોગવાઇ નિીવર્ત રિે છે. 

5.7 પ્રકરણ સાર 

આપણી શિક્ષણ વ્યવસ્થામાાં શિક્ષણના સાવજગત્રકરણ માટે ઔપચારરક શિક્ષણની સાથોસાથ મુતર્ત, દૂરવર્તી 

ર્તેમર્ ઓનલાઇન સ્વરૂપે પણ શિક્ષણ પ્રાિ કરવાની સગવડ ઊભી કરવામાાં આવેલ છે. નવીન ર્તકશનકીના સથવારે 

પ્રત્યક્ષ શિક્ષણની પણ જોગવાઇ થઇ િકે છે. શવશવધ િૈક્ષશણક સાંસ્થાઓ દ્વારા શવદ્યાથીઓને અદ્યર્તન મારિર્તી ર્ ે

ર્તે શવષયના ર્તર્જ્ઞો દ્વારા પ્રાિ થાય છે, માટે શવદ્યાથીઓ દૂરવર્તી શિક્ષણનો ભરપૂર ઉપયોગ કરર્તા થયાાં છે. આમ, 

દૂરવર્તી શિક્ષણ દ્વારા આપણે એક શિક્ષક ર્તરીકે વગજમાાં શવદ્યાથીઓને સચોટ મારિર્તી પૂરી પાડી િકીએ છીએ ર્તથા 

ગુણવિાલક્ષી શવષયવસ્રુ્તની રરૂ્આર્ત રે્તમની સમક્ષ કરી િકીએ છીએ.    

 

સ્વાધ્યાય 

નીચનેા પ્રશ્નોનાાં ટૂકમાાં ર્વાબ આપો. 

1. દૂરવર્તી શિક્ષણની કોઇપણ એક વ્યાખ્યા લખો . 

2. દૂરવર્તી શિક્ષણમાાં દૃશ્ય-શ્રાવ્ય માધ્યમની અસરકારતર્તા ર્ણાવો. 

3. દૂરવર્તી શિક્ષણમાાં BISAG-Nની ભૂગમકા વણજવો . 

4. NIOSની શવશિષ્ટર્તાઓ ર્ણાવો . 

નીચનેા પ્રશ્નોનાાં શવસ્ર્તૃર્ત ર્વાબ આપો. 

1. દૂરવર્તી શિક્ષણનુાં શિક્ષણકે્ષત્રે મિત્ત્વ ર્ણાવો. 

2. દૂરવર્તી શિક્ષણમાાં ઉપયોગમાાં લેવાર્તા શવશવધ માધ્યમો પૈકી કોઇપણ બે માધ્યમોનુાં ઉદાિરણ સિ વણજન 

કરો . 

3. પ્રાથગમક શિક્ષણમાાં પ્રસારરર્ત થર્તા દૂરવર્તી શિક્ષણ કાયજિમ અાંગે નોંધ ર્તૈયાર કરો . 

4. િાળાશકય શિક્ષણના સાવજગત્રકરણમાાં NIOSની ભૂગમકા સ્પષ્ટ કરો . 

5. દૂરવર્તી શિક્ષણના લાભાલાભ વણજવો. 

6. િાળાશકય શિક્ષણના સાવજગત્રકરણમાાં SWAYAMની ભૂગમકા સ્પષ્ટ કરો . 

 

સાંદભજઃ 

1. દેસાઇ ડી.બી. અને દેખર્તવાલા પી.બી. (૧૯૭૪). અભ્યાસિમ ચસદ્વાાંર્તો અને અભ્યાસિમ સાંરચના. યુશનવર્સસટી 

ગ્રાંથ શનમાજણ બોડજ, અમદાવાદ 

2. દવે ર્યેન્દ્ર અને પટેલ મોર્તીભાઇ (૧૯૯૮). શવકસર્તા ભારર્તમાાં શિક્ષક અને શિક્ષણ. િાિ પ્રકાિન, અમદાવાદ . 

3. િાિ રદપીકા બી. (૧૯૯૩) િૈક્ષશણક પ્રૌદ્યોગગકી. યશુનવર્સસટી ગ્રાંથ શનમાજણ બોડજ , અમદાવાદ 

4. Br. Babasaheb Ambedkar Open University, મારિર્તી-માગજદિજન પુશસ્ર્તકા, અમદાવાદ 

5. રાષ્ટર ીય મુતર્ત શવદ્યાલય શિક્ષણ સાંસ્થા મારિર્તી પુશસ્ર્તકા (૨૦૧૪). માનવ સાંસાધન શવકાસ માંત્રાલય, ભારર્ત 

સરકાર, નવી રદલ્િી.  
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પ્રકરણ- 6 

રરસોસસ સને્ટર (સસંાધન કેન્ર) 
 

6.1 પ્રસ્તાવના 

  મારિતી અને પ્રત્યાયન તકનનકીના નવકાસના કારણ ેદરેક કે્ષત્રમાં નવપુલ પ્રમાણમાં સંસાધનો પ્રાપ્ય બન્યા ં

છે. સંસાધનોનંુ આદાનપ્રદાન પણ સુલભ અને ઝડપી બન્યું છે. આ સંસાધનોના નિક્ષણકે્ષત્રે યોગ્ય ઉપયોગ થકી 

નિક્ષણને સરળ અને અસરકારક બનાવવું જરૂરી છે. નિક્ષકની નિક્ષણ પ્રનકયા અને નવદ્યાથીની નિક્ષણ મેળવવાની 

પ્રનકયા (સ્વ-અધ્યયન) અસરકારક બને તે માટે તમેને સંસાધનની ઉપલબ્ધતા અને તેમને દ્વારા તેનો યોગ્ય 

ઉપયોગ ખૂબ જરૂરી બની રિે છે. નિક્ષક અને નવદ્યાથી પોતાના અનુકૂળ સમય ેસતત નિક્ષણ મેળવતા રિે એ માટે 

સંસાધન કેન્રનંુ અનસ્તત્વ જરૂરી બને છે. સંસાધન સાથે આદાનપ્રદાન થકી (નિક્ષક-સારિત્ય, નિક્ષક- TLM, 

નવદ્યાથી- TLM, નવદ્યાથી-સારિત્ય) નિક્ષક અને નવદ્યાથી પોતાના જ્ઞાનને વધુ સમૃદ્ધ કરી િકે છે. આમ, નિક્ષકોની 

અધ્યાપન ક્ષમતા વધારવા માટે મદદરૂપ બનવા અને તેઓને નવષયવસ્તુમા ંપ્રભુત્વ પ્રાનિ માટે સિાયરૂપ થવા કે 

નિક્ષક અને નવદ્યાથી સ્વમળેે અભ્યાસ િાથ ધરી િકે તે માટે જરૂરી સનુવધા અને પયાસવરણ પુરુ પાડવા સંસાધન 

કેન્રનંુ મિત્ત્વ િવે સ્વીકારવું જ રહ્ું. 

ઉદે્દિો 

• સસંાધન કેન્રનો અથસ સમજાવી િકાિે. 

• સસંાધન કેન્રના િેતુ અને મિત્ત્વ જણાવી િકાિે. 

• અધ્યયન અધ્યાપન સમૃનદ્ધકરણ પ્રનકયામાં રરસોસસ સેન્ટરનો ઉપયોગ કરી િકાિે. 

• સંસાધન કેન્રની ગરજ સારતી અન્ય સુનવધાઓ (Virtual & Physical Library, E-library, Language Lab, 

Smart Class વગેરે)નો ઉપયોગ કરી િકિે. 

 

6.2 સસંાધન કેન્રનો અથસ 

સંસાધન કેન્ર (Resource Centre) એ પુસ્તકાલય કરતા કંઇક નવિેષ છે. Resource Center is a place 

which provides information, equipment & support (સંસાધન કેન્ર મારિતી, સાધન અને મદદ પૂરી પાડતી 

જગ્યા છે). સંસાધન કેન્રમાં નિક્ષણ માટે જરૂરી તમામ સાધનસામગ્રી િોય. જમેાં, પુસ્તકો, TLM, પ્રયોગના 

સાધનો, કમ્પપ્યૂટર, ઇન્ટરનેટ, પ્રયોગ કરવાની કે સાધન નનમાસણ માટેની સુનવધા, ઇ-સામગ્રી, (Video, e-book, 

એનનમેિન, ચિત્રો, નડનઝટલ એનસાઇકલોપપનડયા વગેરે) અને નિક્ષક-તજજ્ઞ આદાનપ્રદાનની સુનવધા આવી િકે. 

આમ, સંસાધન કેન્રનો મુખ્ય િેતુ અસરકારક અધ્યયન-અધ્યાપન માટે નવભભન્ન સિાયક સેવાઓ પુરી પાડવાનો 

અને તે માટે પ્રેરણા આપવાનો છે. સસંાધન કેન્રને નીિે મુજબ વ્યાખ્યાનયત કરી િકાય. 

‘‘નિક્ષક અને નવદ્યાથી પોતાના અનુકૂળ સમય ેઅધ્યયન માટેની સેવાઓ પ્રાિ કરી પોતાની સજ્જતા વધારી 

િકે તે માટેનંુ સ્થળ એટલે સંસાધન કેન્ર’’ 

‘‘નિક્ષકને પોતાના અધ્યાપન કાયસને અસરકારક બનાવવા માટે જરૂરી સુનવધાઓ પુરૂ પાડતું અને 

નવદ્યાથીને સ્વ-અધ્યયન માટે આવશ્યક સુનવધાઓ પુરૂ પાડતું કેન્ર એટલે સંસાધન કેન્ર’’ 
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‘‘નિક્ષક પોતાના અધ્યયન કાયસને અસરકારક બનાવવા માટે જરૂરી સુનવધાઓ જવેી કે નવષયવસ્તુ કે 

પદ્ધપતિાસ્ત્ર સંબનધત પોતાના જ્ઞાનને વધારતા પુસ્તકો, કમ્પપ્યૂટર અને ઇન્ટરનેટ, e-book, CD, િલચિત્ર, 

Animation, TLM ઉપયોગ કે રિના, તજજ્ઞ માગસદિસન કે પુરક અધ્યયન સામગ્રી પુરી પાડતી જગ્યા અને નવદ્યાથી 

માટે પોતાના િૈક્ષનણક જ્ઞાનને સમૃદ્ધ કરવા માટે કે નવું િૈક્ષનણક જ્ઞાન પ્રાિ કરવા માટે જરૂરી ઉપયોગી સનુવધાઓ 

સાથે સ્વ-અધ્યયન િૈક્ષનણક સામગ્રી પુરુ પાડતું કેન્ર એટલે સસંાધન કેન્ર.’’ 

 ‘‘A learning resource centre is a facility within a school, staffed by a specialist, containing 

several information source.’’ 

આમ, સસંાધન કેન્ર એ નિક્ષક અને નવદ્યાથીને નિક્ષણ માટે જરૂરી સિાય પુરુ પાડતું સ્થાન છે. 

તમારી પ્રગપત િકાસો. 

1. સંસાધન કેન્રના લક્ષણો તારવો અને અધ્યાપક સાથે િિાસ કરો. 

2. સંસાધન કેન્ર એ નિક્ષક્નો સિાયક છે - સમજાવો. 

6.3 સસંાધન કેન્રના િેતઓુ 

સંસાધન કેન્ર નીિે મુજબ િેતુઓને ધ્યાનમાં રાખી પ્રસ્થાપપત કરવામાં આવે છે. 

1. નિક્ષક અને નવદ્યાથીઓને યોગ્ય િૈક્ષનણક સાધન સામગ્રી સુલભ્ય કરવી. 

2. નવષય મુજબ નિક્ષકો માટે ગોષ્ઠી મંિ રિી નવિારોને આદાનપ્રદાન માટે જરૂરી પ્રોત્સાિન પુરુ પાડવું . 

3. સંસાધન કેન્ર થકી નાવીન્યપૂણસ કાયસને વેગ પુરો પાડવો. 

4. નિક્ષણ સિાયક વાતાવરણને સુનનનિત કરવું, જ ેઅધ્યતેા (નિક્ષક કે નવદ્યાથી)ને જુદા જુદા સસંાધનોથી 

લાભનન્વત કરે. 

6.4 સસંાધન કેન્રનુ ંમિત્ત્વ 

અધ્યયન અધ્યાપન પ્રનકયાને સરળ અને અસરકારક બનાવવા માટે સંસાધન કેન્ર નિક્ષક અને નવદ્યાથીને 

જરૂરી સિાય પુરી પાડે છે. િાલ મારિતી અને પ્રત્યાયન તકનનકીના નવકાસને જોતા સંસાધન કેન્રનંુ મિત્ત્વ ખુબ 

વધી જાય છે. 

1. નિક્ષક અને નવદ્યાથીને પોતાના અનુકૂળ સમય ેજ્ઞાન પ્રાિ કરવાની તક મળી રિે છે. 

2. નિક્ષક અને નવદ્યાથી નિક્ષણ સંબનધત પોતાની સમસ્યાનો ઉકેલ સસંાધન કેન્ર દ્વારા મેળવી િકે છે .

આવી સમસ્યાઓ સારિત્ય, ટી.એલ.એમ., ઇ-કન્ટેન્ટ કે તજજ્ઞ માગસદિસન સંબનધત િોય િકે . 

3. સંસાધન કેન્ર દ્વારા િલાવવામાં આવતા ગોષ્ઠી મંિ દ્વારા નવષય સંબનધત નાવીન્ય નવિારોનુ ં

આદાનપ્રદાન િકય બને છે  .આધનુનક નવિારોથી પરરચિત થવાય છે .  

4. નિક્ષક પોતાના અધ્યાપનને સંસાધન કેન્રની મદદથી અસરકારક બનાવી િકે છે. (જરૂરી સંદભસ પુસ્તકો, 

TLM, સાધન સામગ્રીની રિના માટેનંુ કાિું સારિત્ય વગેરે નિક્ષક સંસાધન કેન્રમાંથી પ્રાિ થઇ િકે.) 

5. નિક્ષક અને નવદ્યાથી પોતાના નવષય અનુરૂપ જરૂરી પૂરક અને વધારાની મારિતી સંસાધન કેન્રમાંથી 

મેળવી િકે છે. 

6. નવદ્યાથીને સ્વ-અધ્યયન માટે િીખવેલ જ્ઞાનના રઢીકરણ માટે સસંાધન કેન્ર ઉપયોગી બને છે . 

7. નવદ્યાથી સસંાધન કેન્રમા ંઉપલ્બધ સસંાધનો દ્વારા સ્વ અધ્યયન કરી નવું  જ્ઞાન પ્રાિ કરી િકે છે . 
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તમારી પ્રગપત િકાસો : 

1. નિક્ષક અને નવદ્યાથી માટે નિક્ષણ સંબનધત અવરોધોને દૂર કરવાનુ ં સાધન એટલે સંિાધન કેન્ર’-

સમજાવો . 

2. આપના મતે સંસાધન કેન્રમાં કઇ કઇ સુનવધા િોવી જોઇએ? 

6.5 અધ્યયન અધ્યાપન સમનૃદ્ધકરણ માટેના નવનવધ સસંાધનો. 

અધ્યયન અધ્યાપન સમૃનદ્ધકરણ માટે સંસાધન કેન્રમાં નીિે મુજબ નવભાગો અને તેના કાયોને નવિારી 

િકાય. 

6.5.1 પસુ્તકાલય 

દરેક સંિોધન કેન્રમા ં નવષય અનુરૂપ એક નાનું પુસ્તકાલય (એક કે બે કબાટ)  િોય કે જમેાં નવષય 

સંબપિત મોટાભાગના પુસ્તકો ઉપલબ્ધ િોય. એટલું જ નિીં પરંતુ ત્રણથી પાિં વ્યનકત સંસાધન કેન્રમાં બેસીને 

પુસ્તકો વાંિી િકે તે માટેની સુનવધાઓ પણ િોય. નિક્ષક કે નવદ્યાથી સંસાધન કેન્રમાં આવી, જરૂરી પુસ્તક 

કબાટમાંથી લઇ વાિંે કે તેમાંથી જરૂરી મારિતી નોંધી લે. આ માટે એક રજીસ્ટર પણ િોય જમેા ંલીધેલા પુસ્તકની 

નોંધ કરે. 

6.5.2 કમ્પપ્યટૂર અન ેઇન્ટરનટેની સનુવધા 

સંસાધન કેન્રમા ંઇન્ટરનેટ સાથે જોડાયેલ બ ેકે ત્રણ કમ્પપ્યૂટર પણ િોય, નિક્ષક કે નવદ્યાથી પોતાને જોઇતી 

મારિતી ઇન્ટરનેટ પરથી પ્રાિ કરી િકે, એટલું જ નિીં ઇન્ટરનેટ પરથી ડાઉનલોડ કરેલ મારિતી કે ઇન્ટરનેટ પરની 

વેબસાઇટ/બ્લોગની મારિતી કોપી કરી િકે તે માટેની સુનવધા પણ િોય. કમ્પપ્યૂટરમા ં નવષય સંબનધત સદંભસ 

સારિત્ય, નવડીયો, એનનમેિન, ઓનડયો, ચિત્રો વગેરે પિેલેથી મુકેલ િોય કે જથેી નિક્ષક કે નવદ્યાથી તેનો સીધો 

ઉપયોગ (ઇન્ટરનેટ વગર પણ) કરી િકે. 

6.5.3 સાધન સામગ્રી રિના અન ેઉપયોગ 

સંસાધન કેન્રમા ં નવષય અનુરૂપ TLM તૈયાર કરવા માટેની જરૂરી કાિી સામગ્રી િોવી જોઇએ, કે જથેી 

નિક્ષક તેનો ઉપયોગ કરી TLM જાતે તૈયાર કરી િકે. TLMની રિના કેવી રીતે કરવી તેની માગસદર્શિકા પણ તેમાં 

િોવી જોઇએ. આ ઉપરાંત નવષયને અનુરૂપ તૈયાર TLM પણ િોય, કે જથેી નિક્ષક તેને લોન પેટે લઇ જઈ વગસખંડમા ં

તેનો ઉપયોગ કરી પરત કરી િકે. જો જરૂર જણાય, તો TLM રિના કરવા અને તેનો ઉપયોગ કરવા સબનંધત 

માગસદિસન તજજ્ઞ દ્વારા મળી રિે તેવી વ્યવસ્થા િોવી જોઈએ. TLMની રિના કરવા માટે  જરૂરી સાધન સામગ્રીપણ  

િોવી જોઈએ.  

6.5.4 નિક્ષણ માટેનુ ંસ્થાન 

સંિાિન કેન્રમાં નિક્ષક કે નવદ્યાથીને નવષયવસ્તુ સંદભે જો કોઇ તકલીફ િોય, તો તેનંુ નનરાકરણ કરવા 

તજજ્ઞ દ્વારા નિક્ષણ આપી િકાય તેવી વ્યવસ્થા િોવી જોઇએ. આ માટે બે કે ત્રણ બેન્િ, કાળુ ંપાટીયું, િોક અને 

િકય બને, તો મલ્ટીમીનડયા પ્રોજકે્ટરની વ્યવસ્થા િોવી જોઇએ. નિક્ષક કે નવદ્યાથી સંસાધન કેન્રમાં આવી 

માગસદિસન મેળવી િકે. 
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6.5.5 અધ્યયન-અધ્યાપન સારિત્યની સાિવણી 

જ ેનવષયનંુ સંસાધન કેન્ર િોય, તે નવષય સબંનધત જરૂરી અધ્યયન-અધ્યાપન સારિત્ય સસંાધન કેન્રમા ં

િોવું જોઇએ. જમેા ંનવષયવસ્તુ અનુરૂપ પ્રેઝન્ટેિન્સ, નવષયવસ્તુની સમજ માટેનંુ લેચખત પુરક સારિત્ય, નવડીયો 

સી.ડી. અને ડેટા સી.ડી., નવષયવસ્તુ અનુરૂપ નવડીયો, ચિત્ર, નવષયવસ્તુ અનુરૂપ કસોટીઓ, નવષયવસ્તુ અનુરૂપ 

નવદ્યાથીના સ્વ-અધ્યયન માટેનંુ સારિત્ય (પાવરપોઇન્ટ પ્રેઝન્ટેિન અથવા અભભક્રમ), મનોનવજ્ઞાન કસોટીઓ 

અને  એનનમેિન વગેરે િોય, જનેે કમ્પપ્યૂટરમાં કે કબાટમાં રાખી િકાય. જરૂરરયાત મજુબ તેનો નિક્ષક અને નવદ્યાથી 

પોતાના જ્ઞાનના સમૃનદ્ધકરણ માટે ઉપયોગ કરે. 

6.5.6 મારિતી નવનનમયનુ ંસ્થાન (નવષય ફોરમ) 

સંસાધન કેન્ર ફકત નવષયવસ્તુ સાિવણીનંુ કેન્ર નથી, પરંતુ નવષયમાં રસ ધરાવતા વ્યનકતની 

મુલાકાતનંુ પણ કેન્ર છે. સસંાધન કેન્રમા ંનવષયમાં રસ ધરાવનાર કેટલાક વ્યનકતઓ નનયપમત રીતે બેઠક યોજતા 

િોય અને નવષયના સમૃનદ્ધકરણની િિાસ કરતા િોય છે. નવષયમાં થયેલ નવીન સંિોધનો નવષયવસ્તુ રજૂ કરવાની 

નવીન પદ્ધપતઓ, પોતે કરેલ નવીન કાયસ, નવષયને સમૃદ્ધ કરવાનાં કોઈ  નવા પ્રોજકેટ  વગેરે પર ભેગા મળી િિાસ 

કરે છે. સસંાધન કેન્ર થકી નવષય અનુરૂપ નાનુ મુખ પત્ર પણ બિાર પાડી િકાય. નવષયમા ં રસ ધરાવનાર 

વ્યનકતઓની િિાસ કરવા માટે એક ટેબલ અને થોડી ખુરિીની વ્યવસ્થા સંસાધન કેન્રમાં િોવી જોઇએ સાથે સાથ ે

નવષય અનુરૂપ સામનયકો અને મખુપત્ર સંસાધન કેન્રમાં નનયપમત આવતા િોય તે જરૂરી પણ છે. 

તમારી પ્રગપત િકાસો 

1. સંિોધન કેન્રનો તમ ેકેવી રીત ેિૈક્ષનણક પ્રનક્રયામાં ઉપયોગ કરી િકિો તેની િિાસ કરો . 

2. સંિોધન કેન્રમાં િાલતી ‘નવષય ફોરમ’નંુ નિક્ષણમાં મિત્ત્વ જણાવો. 

3. સંિાધન કેન્ર નવદ્યાથીને સતત નિક્ષણ માટેની તક પૂરી પાડે છે. કેવી રીતે? 

6.6 સસંાધન કેન્રની ગરજ સારતી િાળાની અન્ય સનુવધાઓ. 

િાળામાં ઉપલબ્ધ કેટલીક સુનવધાઓ સસંાધન કેન્રની ગરજ સારી િકે એમ છે. આ સુનવધાઓમા ં           

E-library (Virtual) & Physical library, Language lab અને Smart Class જવેી સનુવધાઓનો સમાવેિ થાય છે. 

આ સુનવધાઓ સંસાધન કેન્ર તરીકે કેવી રીતે ઉપયોગ કરી િકાય તેના નવિે નવિારવું જોઇએ. 

6.6.1 E-library & Physical Library 

પુસ્તકાલય એ નિક્ષણને સમૃદ્ધ કરવાનું એક મિત્ત્વનંુ સ્થાન છે. પુસ્તકાલય એ િાળા તંત્રનંુ એક મિત્ત્વનંુ 

અને અનનવાયસ અંગ છે. પુસ્તકાલયમા ંઉપલબ્ધ પુસ્તકોનો ઉપયોગ કરી નિક્ષક અને નવદ્યાથી પોતાના જ્ઞાનને 

સમૃદ્ધ કરી િકે છે, પોતાની સજજતા વધારી િકે છે. પાઠયપુસ્તકમાં સમાનવષ્ટ નવષયવસ્તુના વ્યાપની મયાસદાન ે

પુસ્તકાલયમાં રાખવામા ંઆવેલ નવષયવસ્તુ આધારરત સંદભસ પુસ્તકોની મદદથી દૂર કરી િકાય છે. પુસ્તકાલયનો 

નિક્ષક અને નવદ્યાથી મિતમ ઉપયોગ કરે તે જરૂરી છે. 

પુસ્તકાલયમાં પુસ્તકને નવષયવાર (સાક્ષરી નવષયો)/ધોરણવાર (ધો-૧ થી૮)/પ્રકારવાર (ટંૂકી વાતાસ, 

સંદભસપુસ્તકો, નવલકથા, િબ્દકોષો, નવષયકોષો વગેરે) ગોઠવવા જોઇએ, કે જથેી નિક્ષક કે નવદ્યાથીને જરૂરરયાત 

મુજબનંુ પુસ્તક સરળતાથી મળી રિે. પુસ્તકાલયમાં પસુ્તકોના વાંિન માટેની સુનવધા પણ િોવી જોઇએ, કે જથેી 
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નિક્ષક કે નવદ્યાથી િાળા સમય દરપમયાન પોતાની ફુરસતે પુસ્તકાલયમાં આવી પુસ્તકોનંુ વાંિન કરી િકે. િવે તો 

કેટલીક િાળાના સમયપત્રકમાં પુસ્તકાલય માટેનો તાસ રાખવામાં આવે છે, માટે પણ પુસ્તકાલયમાં પુસ્તકોના 

વાંિન માટેની સુનવધા િોવી જોઇએ. પુસ્તકાલયમાં લવેામાં આવતા નવા પુસ્તકોની નવગતો સમયાંતરે  નિક્ષક 

અને નવદ્યાથી સુધી પિોંિે તે જરૂરી છે. એટલું જ નિીં, પુસ્તકોની આપ-લે નંુ પણ વ્યવનસ્થત વ્યવસ્થાપન થાય 

તે જરૂરી છે. 

િવે પુસ્તકાલયમાં કમ્પપ્યૂટર અને ઇન્ટરનેટ િોવુ ંપણ અનનવાયસ બન્યું છે. પ્રવતસમાન સમયમા ંપુસ્તકોની 

ઇ-કોપી બનાવવાનંુ િલણ વધ્યું છે. પુસ્તકાલયમાં ઉપલબ્ધ િણાં પુસ્તકોની ઇ-કોપી,  સીડી/ડીવીડી સ્વરૂપે) 

બજારમાં ઉપલબ્ધ છે. જનંુે વાંિન કમ્પપ્યૂટરની મદદથી કરી િકાય છે. એટલું જ નિીં કમ્પપ્યૂટર પર નિક્ષણ સંબનધત 

િણાં પુસ્તકો ઇલેકટર ોનનક સ્વરૂપે મળે છે. જનેે ડાઉનલોડ કરી િકાય છે અને તનેો વાંિનમાં ઉપયોગ કરી િકાય 

છે. ખાસ કરીને નિક્ષણકે્ષત્રે થયેલ નાનવન્ય સંબનધત મારિતી ઇ-સ્વરૂપે ઇન્ટરનેટ પરથી પ્રાિ થાય છે. નિક્ષણકે્ષત્રે 

થયેલા સંિોધનની નવગત પણ ઇન્ટરનેટ પરથી પ્રાિ બની િકે છે. નવષયવસ્તુ સબંનધત ચિત્ર, નવડીયો એનનમેિન 

વગેરે પણ ઇન્ટરનેટ પરથી પ્રાપ્ય બને છે, જનેો નિક્ષક પોતાના નિક્ષણકાયસમાં ઉપયોગ કરી િકે અને નવદ્યાથીને 

આ ઇ-સારિત્ય સ્વ-અધ્યયન માટે ઉપયોગી બની રિે. ઇ-પુસ્તકની copy થતી િોય તેમજ ઇ-મેઇલ દ્વારા 

મોકલી િકાતા િોય, તેનંુ આદાનપ્રદાન સરળતા કરી િકાય છે. 

નીિેના જવેી કેટલીક વબેસાઈટ ઈ–લાયબ્રરેી તરીકે ઉપયોગી બની િકે તેમ છે. જો કે ઈ-લાયબ્રેરી તરીકેની 

સુનવધા પૂરી પાડતી કેટલીક વેબસાઈટમા ંતમારે રજીસ્ટરેિન કરી UserID અને પાસવડસ  મેળવવાની જરૂર રિે છે.   

1. www.dli.ernet.in 

2. https://iitkgp.ac.in 

3. www.nationallibrary.gov.in  

4. www.inflibnet.in  

6.6.2 Smart Class 

સ્માટસ  ક્લાસનો ઉપયોગ િાળા કક્ષાએ મુખ્યત્વ ેનિક્ષકો દ્વારા નવષયવસ્તુની રજૂઆત માટે, નવદ્યાથીઓ 

દ્વારા સ્વ-અધ્યયન અને નવષયવસ્તુના રઢીકરણ માટે કરવામા ંઆવે છે. સ્માટસ  ક્લાસમાં  કમ્પપ્યૂટર, મલ્ટીપમનડયા 

પ્રોજકેટ અને સ્માટસ  ક્લાસ (Electronics Screen} િોય છે. મોટેભાગે ધોરણ અને નવષયને ધ્યાને લઇને કમ્પપ્યટૂરમા ં

એક િૈક્ષનણક સોફ્ટવેર ઇન્સ્ટોલ કરેલું િોય છે. સોફ્ટવેરમાં સમાનવષ્ટ નવષયવસ્તુનો ઉપયોગ નિક્ષક 

નવષયવસ્તુની રજૂઆત માટે કરે છે. આ જ નવષયવસ્તુનો ઉપયોગ નવદ્યાથી રરઢકરણ માટે અને સ્વ-અધ્યયન 

માટે કરી િકે છે. એટલુ ંજ નિીં, ઇન્ટરનેટ પરથી મેળવેલ નવષયવસ્તુને અનુરૂપ એનનમેિન, નવડીયો, ઇમજેને 

પણ સ્માટસબોડસ  દ્વારા રજૂ કરી િકાય છે. બજારમાંથી મળેવેલ નવષયવસ્તુને અનુરૂપ CD કે DVDને પણ સ્માટસબોડસ  

દ્વારા રજૂ કરી િકાય છે. સ્માટસ  ક્લાસ દ્વારા નિક્ષક પોતાના નિક્ષણને સરળ ઝડપી અને અસરકારક બનાવી િકે 

છે. 

6.6.3 લેંગ્વજે લબે (Language Lab) 

ભાષા નિક્ષણ માટે Language Lab ઉપયોગી બની રિે છે. ખાસ કરીને માતૃભાષા ચસવાયની ભાષાના 

નિક્ષણ માટે Language Lab વધુ ઉપયોગી બની િકે. Language Lab દ્વારા નવદ્યાથીમાં ભાષાના િબ્દોના ઉચ્િારો, 

નવદ્યાથીનંુ વાંિન અને નવદ્યાથીમાં નવકસેલ ભાષા નવિનેી સમજને િકાસી િકાય છે. લેંગ્વેજ લેબના સોફ્ટવેરમા ં

આ માટેની સુનવધા િોય છે. 



62 
 

              Language Lab માં કમ્પપ્યૂટર, િેડફોન, વેબકેમ, મલ્ટીમીનડયા પ્રોજકેટ/ટીવી અને માસ્ટર કોન્સોલ 

િોય છે. તજજ્ઞ માસ્ટર કોન્સોલનો ઉપયોગ કરી નવદ્યાથીઓને સમુિમા ંકે વ્યનકતગત સૂિના આપી િકે છે. અને 

સૂિના અનુરૂપ નવદ્યાથીએ કરેલ કાયસને સમૂિમા ંકે વ્યનકતગત િકાસી િકે છે. (માસ્ટર કોન્સલની સ્ક્રીન પર 

એકબીજાને જોઇ િકાય છે અને વ્યનકતગત પણ વાતાસલાપ કરી િકાય છે Language Lab દ્વારા જ ેતે ભાષાની 

વાતિીત નવદ્યાથીને સંભળાવી િકાય, તજજ્ઞ દ્વારા થતું આદિસ વાંિન નવદ્યાથી સાભંળી િકે અને જ ેતે નવદ્યાથી 

દ્વારા થતુ વાંિન અને ભાષાના ઉચ્િારો તજજ્ઞ સાંભળી િકે અને જરૂર જણાય ત્યાં વ્યનકતગત સૂિનો પણ 

આપી િકે. લેંગ્વેજ લેબમાં પિેલેથી ઇન્સ્ટોલ સોફ્ટવેરની મદદથી નવદ્યાથીઓ પોતાના ભાષાના જ્ઞાનને સમદૃ્ધ 

કરી િકે છે.  

          આ ઉપરાંત NROER અને GROWER પણ સંસાધનના સ્રોત છે. જનેા નવિે આપ પ્રથમ વષસમાં મારિતી 

પ્રાિ કરી િુક્યા છો. 

તમારી પ્રગપત િકાસો: 

1. E-Libraryના મિતમ ઉપયોગ માટે તમે કઇ કઇ બાબતો ધ્યાનમાં રાખિો . 

2. લેગ્વેજ લેબનો રીસોસસ સેન્ટર તરીકેના ઉપયોગને મુલવો. 

3. સ્માટસ  કલાસ એ નિક્ષકની મયાસદા દૂર કરી િકે છે. - સમજાવો . 

નોંધ : આપના નજલ્લાના નજલ્લા નિક્ષણ અન ેતાલીમ ભવનની મલુાકાત લઇ ત્યા ંતયૈાર કરવામા ંઆવલેા જુદા 

જુદા સસંાધન કેન્રમા ંઉપલબ્ધ સનુવધાનો અભ્યાસ કરી અિેવાલ તયૈાર કરો. 

 

 

સ્વાધ્યાય 

 

1. સંસાધન કેન્ર એ િાળા કક્ષાએ ગુણવત્તાયુક્ત નિક્ષણ માટે અનનવાયસ બની રિે છે. – સમજાવો. 

2. સંસાધન કેન્રનો અથસ સ્પષ્ટ કરો. 

3. િાળા કક્ષાએ સંસાધન કેન્રનંુ મિત્ત્વ જણાવો. 

4. સંસાધન કેન્ર દ્વારા કઇ કઇ પ્રવૃનત્તઓને વેગ આપી િકાય? કેવી રીત ે? 

5. સ્માટસ  કલાસનો નિક્ષણમાં ઉપયોગ જણાવો. 

6. લેંગ્વેજ લેબ દ્વારા ભાષા નિક્ષણને કેવી રીતે અસરકારક બનાવી િકાય? 

7. અધ્યયન અને અધ્યાપન બંને પ્રનકયાના સમૃનદ્ધકરણમાં સંસાધન કેન્રનો ફાળો જણાવો. 

8. સ્વ-અધ્યયન માટે સંસાધન કેન્ર કેવી રીતે ઉપયોગી થઇ િકે સમજાવો. 

 

સદંભસ: 

• િૈક્ષનણક પ્રાદ્યાપગકી, ડૉ. દીપીકાબેન િાિ, યુનનવર્સસટી ગ્રંથ નનમાસણ બોડસ , અમદાવાદ 

• www2.hawaii.edu/chantiny/Digilib.html 

• Teacher Education Scheme Guideline -2012 
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પ્રકરણ – 7   
સાયબર સસક્યોરરટી 

7.1  પ્રસ્તાવના  

એકવીસમી સદી એ જ્ઞાન અને ટેકનોલોજીની સદી છે. વતતમાન સમયગાળામાાં શિક્ષણના કે્ષત્રમાાં  

ટેકનોલોજીનો વધુમાાં વધુાં ઉપયોગ થઇ રહ્યો છે. તમામ કક્ષાએ શવદ્યાથીઓ ઓનલાઇન શિક્ષણની પદ્ધતતથી 

પરરસિત થયા છે અને શિક્ષકો પણ શવશવધ પ્લેટફોર્મસતનો ઉપયોગ કરી ઓનલાઇન અધ્યાપન કરતાાં થયા છે.  

તમામ લોકો ઓનલાઇન શિક્ષણથી પરરસિત થયાાં એ હકારાત્મક લાભ સાથે એક નકારાત્મક ગેરલાભ પણ થયો. 

તે ગેરલાભ એ હતો કે બાળકો ઇન્ટરનેટનો બબનજરૂરી ઉપયોગ કરતાાં પણ થયાાં. ખાસ કરીને બાળકોમાાં ઓનલાઇન 

ગેર્મસ, િૅટીંગ, ય-ુટ્યુબ શવશિયો અને અન્ય સોશિયલ તમશિયાનો દૂરોપયોગ વધ્યો. આ સાંજોગોમાાં બાળકોના 

અપૂરતા જ્ઞાન અને અણઆવિતને કારણે બાળકો અને તેના વાલીઓની ઓનલાઇન સલામતીનો પ્રશ્ન પણ 

ઉપશસ્થત થયા છે. ઇન્ટરનેટના સાંભશવત દુષણોથી વાકેફ ન હોવાથી શવદ્યાથીઓ અને વાલીઓમાાં  ઓનલાઇન 

છેતરપીંિી, મારહતીનો દૂરોપયોગ છે, સાયબર ધમકી જવેા કેટલાાંય સાયબર અપરાધોનો ભોગ બનવાની 

સાંભાવનાનો ઉદય થયો છે. આ પરરશસ્થતતમાાં શિક્ષક, વાલી અને શવદ્યાથી દરેકે સાયબર સલામતી પ્રત્ય ેજાગૃત 

થવાની તાતી જરૂરરયાત ઉભી થઇ છે. શિક્ષક સાયબર સલામતી શવિ ેવાકેફ હોય તેમજ સાયબર ગુનાઓના તમામ 

પાસાાંઓનો જાણકાર હોય તો શવદ્યાથીઓ અને સમાજને તે માટે જાગૃત કરી િકે. આથી રાજ્યકક્ષાએથી અને 

રાષ્ટ્રકક્ષાએથી સરકારશ્રી તેમજ શવશવધ એજન્સીઓ દ્વારા સમાજને સાયબર સલામતીની જાણકારી આપી સાયબર 

અપરાધ પરત્વ ેજાગૃત કરવાના પ્રયત્નો થયાાં છે અને હજુ પણ આવા પ્રયત્નો થઇ રહ્યાાં છે. હવે જ્યારે શિક્ષકો અને 

શવદ્યાથીઓ ઓનલાઇન માધ્યમોનો ભરપૂર ઉપયોગ કરી રહ્યાાં છે ત્યારે ઈન્ટરનેટ બાબતે સલામતી એ દરેકની 

જવાબદારી બને છે તેમજ દરેકે સાયબર ક્રાઇમ અને સાયબર સલામતી શવિે જાગૃત થવુાં જરૂરી છે. આપણે આ 

તમામ બાબતોથી ક્રમિઃ પરરસિત થતાાં જઇએ. 

ઉદે્દિો: 

1. સાયબર અપરાધ શવષ ેજણાવી િકિે. 
2. સાયબર અપરાધના જુદા જુદા પ્રકારો શવષે જણાવી િકિે. 
3. ઓનલાઈન સલામત કઈ રીતે રહેવુાં  તે જણાવી િકિે. 
4. સાવિેતીપૂવતક  વેબબ્રાઉઝરનો ઉપયોગ કરી િકિે. 
5. સાવધાનીપૂવતક સોશિયલ નેટ વર્કકગ સાઈટનો ઉપયોગ કરી િકિે. 
6. સ્માટત  ફોનનો ઉપયોગ સાવધાનીપૂવતક કરી િકિે. 
7. ઈન્ટરનેટ સર્ચિગ સલામત રીતે કરી િકિે. 

7.2 સાયબર અપરાધ એટલ ેિુાં ? 

સાયબર અપરાધ એક એવો ગુનો છે જ ેસીધો કર્મપ્યૂટર, મોબાઇલ અને ઓનલાઈન ઈન્ટરનેટ નેટવકત  સાથે 

સાંબાંશધત છે. તેમાાં ગુનેગારો કર્મપ્યૂટર, મોબાઇલ અને ઈન્ટરનેટ નેટવકત  દ્વારા શવશવધ પ્રકારના ગેરકાયદે કૃત્યો કરે 

છે જનેાથી વ્યશક્ત, સાંસ્થા કે સમાજને આર્થથક, સામાશજક કે ભાવનાત્મક નુકિાન થાય છે. સાયબર ક્રાઇમમાાં 

ઓનલાઇન નાણાાંકીય િોરી, છેતરપપિી, સાયબર ગુાંિાગીરી (સાયબર સ્ટોકીંગ), અાંગત મારહતીની િોરી, કોઇને 
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બદનામ કરવાનુાં દુષ્કૃત્ય વગેરેનો સમાવેિ થાય છે. હાલમાાં ઇન્ટરનેટ દ્વારા કોઇની અાંગત મારહતીની િોરી કરી 

ખોટા હેતુઓ માટે બીજા કોઈને વેંિવી, ઓનલાઇન હેકકગ વાયરસ મોકલીને કોઇની નેટ બેકન્કગ, બેંકની સલામત 

શવગતોની મારહતી મેળવી નાણાાંકીય છેતરપીંિી કરવી, કોઇની વ્યશક્તગતનો ફોટો, તેની પ્રવૃશિઓ અને 

ગોપશનયતા ઓનલાઇન જાહેર કરવી, કોઈની અાંગત મારહતીની િોરી કરવી, સરકારી મારહતીની િોરી કરવી, 

કોઈનુાં સવતર અથવા સામાશજક ખાતુાં હેક કરવુાં, ખોટી મારહતી આપવી અથવા મારહતીનો નાિ કરવો, ગેરકાયદ ે

સોફ્ટવેર અથવા શફલ્મ િાઉનલોિ કરવી, કોઈને ઓનલાઇન ધમકી આપવી, જાતીય િોષણ વગેરે જવેા સાયબર 

ગુનાઓનો વ્યાપ વધી રહ્યો છે. 

7.3 સાયબર અપરાધના પ્રકારો 

હાલના સાંજોગોમાાં ઇન્ટરનેટ નો વપરાિ વધવાથી ઇન્ટરનેટ મારફતે ઘણાાં પ્રકારના સાયબર ગુનાઓ 

અશસ્તત્વમાાં આવેલા છે. જનેા માટે ભારતીય બાંધારણમાાં કાયદા હેઠળ સજા અને દાંિની જોગવાઈ છે.કેટલાક 

અપરાધો નીિ ેમુજબ છે.  

7.3.1 હેકકગ (Hacking) 

આજ ેટેક્નોલોજીની આ દુશનયામાાં મોટાભાગના સાયબર ગુનાઓ હેકકગ દ્વારા થઈ રહ્યાાં છે. હેકકગ એ એવી 

પદ્ધતત છે કે જનેા દ્વારા ગુનેગાર તમારી પરવાનગી વગર તમારી જાણ બહાર તમારી અાંગત મારહતી, તમારા 

કર્મપ્યૂટર કે મોબાઇલ પરથી િોરી લે છે. એ તમારી અાંગત મારહતીમાાં ફેરફાર કરે છે.જનેો ઉપયોગ તે તમને નુકસાન 

પહોંિાિવા અથવા તમારી મહત્વપૂણત મારહતી અન્યને વેિવા માટે કરે છે. આવા હેકર તમારા સોશિયલ મીશિયા 

એકાઉન્ટને વાયરસ અથવા સોફ્ટવેર દ્વારા હેક એટલ ેકે હસ્તગત કરે છે. 

7.3.2 સ્પામ ઇ-મઇેલ (Spam Email) 

સ્પામ ઇ-મેઇલ એટલે કોઇ સાયબર ગુનેગાર દ્વારા બનાવવામાાં આવેલ અજાણયુાં ઇ-મેઇલ એકાઉન્ટ કે 

જનેા પરથી તમારા ઇ-મેઇલ એકાઉન્ટમાાં કોઇ ઇ-મઇેલ આવે છે અને તેમાાં કેટલીક ફાઈલ જોિાયેલ હોય છે 

અથવા કલક આપવામાાં આવી હોય છે. તેના પર તમને શક્લક કરવાનુાં કહેવામાાં આવે છે. આ ફાઇલ અથવા કલક 

પર શક્લક કરતા તેમના દ્વારા મોકલવામાાં આવેલા માલવેર (Malware), સ્પાય વાયરસ (Spyware) અથવા 

ટર ોજન વાયરસ તમારા મોબાઇલ અથવા કર્મપ્યૂટર સસસ્ટમ પર પહોંિે છે. 

સ્પામ ઇ-મેઇલનો ઉપયોગ ઘણીવાર વ્યશક્તગત મારહતી એકતત્રત કરવા અને તમારી કર્મપ્યૂટર સસસ્ટમને 

હસ્તગત કરવા માટે થાય છે. જનેો ગુનેગારો દ્વારા દુરુપયોગ કરવામાાં આવે છે, જનેા કારણે તમારી અાંગત મારહતી 

િોરાઈ જાય છે. આ ઉપરાાંત તમારી સસસ્ટમ વારાંવાર બાંધ થઇ જાય કે અટકી જાય છે અને ક્ષતતગ્રસ્ત થાય છે અને 

તમારી મહત્વપૂણત ફાઇલોનો નાિ થવા લાગે છે. 

7.3.3  શફકિગ (Fishing) 

શફકિગ એ સાયબર ગુનાનુાં એવુાં માધ્યમ છે જ ેઓનલાઇન છેતરપપિી અને નાણાાંકીય છેતરપપિી સાથે 

સાંબાંશધત છે. જ ે રીતે માછલીને ફસાવવા માટે હૂાંક પાણીમાાં નાખવામાાં આવે છે તેમ સાયબર ગુનેગાર કોઇને 

ફસાવવા માટે નકલી ઇ-મઇેલ, સાંદેિાઓ કે કોલ્સ કરે છે. શફકિગ દ્વારા ગુનેગારો કોઇ િારીરરક પ્રયત્નો કયાત 

વગર તમારા બેંક ખાતામાાંથી ઓનલાઇન નાણાાં ઉપાિી લે છે અને તે માટે તમે જાતે જ તેમને માંજૂરી આપો છો. 

ઘણી વખત તમને આવા ઇ-મેઇલ્સ, સાંદેિાઓ અથવા કોલ્સ પણ મળ્ાાં હિે જમેાાં તમને લોટરી જીતવાની 

ઓફર કરવામાાં આવી હોય, મલ્ટી નેિનલ કાંપનીમાાં નોકરી અથવા તમારી મોટી લોન માંજૂરીની મોટી લાલિ 



65 

 

આપવામાાં આવી હોય. તનેા પ્રત્યુતરમાાં તમને બેંકની શવગતો સલુકાઇથી પૂછવામાાં આવે છે.તેમણે પૂછેલી 

શવગતો જણાવાની ભૂલ કરો તો તરત જ તમારા બેંક ખાતામાાંથી પૈસા ઉપાિી લવેામાાં આવ ેછે. આવા તમામ 

ગુનાઓ શફકિગ હેઠળ આવે છે. 

7.3.4 સોફ્ટવરે પાઈરસી 

જો કોઈ વ્યશક્ત જાણીતી મોટી કાંપનીના સોફ્ટવેરનુાં ગેરકાયદેસરનુાં વઝતન ઓનલાઈન અથવા બજારમાાં 

વેિે તો તે પણ સાઈબર ગુનો ગણાય છે. જો કોઇ વ્યશક્ત આમ કરતા પકિાય તો કાયદાકીય રીતે તમને ભારતીય 

સાયબર કાયદા હેઠળ સજા થઇ િકે છે. આ સાથે, કાંપની તરફથી ભારે દાંિ પણ થઈ િકે છે. 

7.3.5 સાયબર બકુલગ (Cyber Bullying) 

આજ ેસોશિયલ મીશિયા માટેના ઘણાાં પ્લેટફોમત ઉપલબ્ધ છે. અને તેનો વ્યાપ વધતો જાય છે. આજ ે

લગભગ વ્યશક્ત કોઇને કોઇ પ્રકારના સોશિયલ માધ્યમમાાં સશક્રય હોય છે. આવી શસ્થતતમાાં તમારા સોશિયલ 

માધ્યમના એકાઉન્ટની મારહતીના આધારે કોઈ વ્યશક્ત કોઈપણ છોકરા કે છોકરીને માનસસક રીતે પરેિાન કરે 

છે. જમે કે.. મારહતીનો દૂરોપયોગ, જાતીય િોષણ, ધમકી આપવી અથવા સોશિયલ મીશિયા પર કોઈની છબી 

ખરાબ કરવાનો પ્રયાસ કરવો. આ બધા ગુનાઓ સાયબર બુલીંગ હેઠળ આવે છે.  

7.3.6 સરકાર અથવા દિે શવરુદ્ધની સાયબર પ્રવશૃિઓ 

આ સૌથી ગાંભીર સાયબર અપરાધ હેઠળ આવે છે જનેે સાયબર આતાંકવાદ પણ કહેવાય છે. જો કોઈ 

વ્યશક્ત સરકાર શવરુદ્ધ ઝુાંબિે િલાવી રહી હોય અથવા સરકારી વેબસાઈટ હેક કરવાનો પ્રયાસ કરે અથવા દિે 

શવરોધી ઓનલાઇન પ્રવૃશિઓમાાં જોિાયેલો જોવા મળે છે અથવા આાંતરરાષ્ટ્ર ીય સ્તરે દેિની છબી ખરાબ કરવાનો 

પ્રયાસ કરે છે તો તેને સાયબર આતાંકવાદમાાં ગણવામાાં આવે છે. આવા સાયબર ગુનાઓ માટે ભારતીય કાયદામાાં 

આકરી સજા અને ભારે દાંિની જોગવાઈ છે. 

  7.3.7  ઓળખની િોરી  

તમારા નામ, સરનામાાં, ઈમેઈલ આઈિી વગેરે જવેી તમારી તમામ  અાંગત મારહતી કે જનેા દ્વારા તમારી 

ઓળખ કરી િકાય અને સાઈબર શવશ્વમાાં તમને ટરેક કરી િકાય તેને શિશજટલ દુશનયામાાં તમારી ઓળખ કહેવાય 

છે. મોબાઈલ, ઈન્ટરનેટ, ઈમેઈલ વગેરે બધુાં જ શિશજટલ દુશનયાનો રહસ્સો છે. તમે જ ેપણ ઉપકરણ/ટેકનોલોજી 

વાપરો છો, જનેાથી તમારુાં  જીવન સરળ બને છે તે બધુાં શિશજટલ દશુનયામાાં તમારી મારહતીને જોખમમાાં મૂકી િકે 

છે. તમારી અાંગત અથવા સામાશજક ઓળખી િકાય તેવી મારહતી જવેી કે નામ, ફોન નાંબર, સ્કૂલની શવગતો, 

ઈમેઈલ-આઈિી, જન્મ તારીખ, સરનામુાં, ઓળખ કાિત  નાંબર, આધાર કાિતની શવગતો, પાસપોટતની શવગતો, 

પ્રવાસની શવગતો, બેંક ખાતાની શવગતો, કફગરતપ્રન્્સ, વોઈસ સેર્મપલ વગેરેની િોરી અથવા દુરુપયોગ એ 

ઓળખની િોરી કહેવાય. 

ઓળખની િોરીનો ભોગ કોઈ પણ વ્યશક્ત કોઈપણ સમયે બની િકે. તેના ઘણા સ્વરૂપો હોય છે. તેનાથી 

તમને સાંભશવત હાશન થવા સાથે કરઠન પરરશ્રમથી કમાયેલ મૂિીનુાં નુકસાન પણ થઈ િકે છે. ભૌતતક દુશનયામાાં 

તો તમે હાંમેિા તમારી જાતનુાં રક્ષણ કરવા માટે સાવધ રહો છો. આવી જ સાવધાની તમારી જાતને સાઈબર 

દુશનયામાાં પણ રક્ષણ આપવા માટે જરૂરી છે. સાઈબર દુશનયા એ એક પ્રકારે ભૌતતક દુશનયા જવેી જ છે અને જરૂરી 

પગલાાં ન લેવાયા તો તેના જટેલી જ જોખમી પણ છે.  
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નીિે એવા કેટલાક સ્ત્રોતોનો ઉલે્લખ કરાયો છે કે જ્યાાંથી સાઈબર ગુનાખોરો વ્યશક્તની ઓળખની િોરી 

કરવા શવબભન્ન શકતમયાઓનો કરી મેળવેલ મારહતીનો દરુુપયોગ કરે છે. 

1. રેસ્ટોરાાંમાાં ભરાવેલા સવ ેફોમત, િોપપગ મોલ્સ/મૂવી થીએટસત ખાતે અપાયેલી લકી િર ો કૂપન કે જમેાાં 

અાંગત મારહતી માટે શવનાંતી કરાય છે. 

2. તમે ફોન પર સામાન્ય વાતિીતમાાં અથવા તો તમારા તમત્રો અને પરરવારજનો સાથે જાહેર સ્થળે તમારી 

અાંગત અને પારરવારરક બાબતો શવિે જ્યારે સીધે સીધી િિાત કરતા હોવ તે સમય ેઅજાણતા અપાયેલો 

િેટા, કે જનેો કોઈ ઠગબાજ સાક્ષી બનીને બધુાં સાાંભળી રહ્યાનો આપણને અહેસાસ પણ નથી હોતો અને 

પછીથી તે આ મારહતીનો સાયબર ક્રાઈમની પ્રવૃશિઓ માટે દુરુપયોગ કરે છે. 

3. સુપર માકેટ અને મેશિકલ સ્ટોસત તથા મોલ્સમાાં રરટેઈલ િેઈન્સ ખાતે ખરીદી બાદ એન્ટર કરાયેલો િેટા. 

4. ઈમેઈલ/વો્સએપ/એસએમએસ દ્વારા રોકિ ઈનામ/લોટરી/નોકરીની ઓફરના સ્વરૂપમાાં અમુક 

લાભનુાં વિન આપતા મેઈલ/મેસેજ દ્વારા એકત્ર કરેલો િેટા. તેઓ ઓરરશજનલ વબેસાઈટ જવેા જ લોગો 

સાથેના ઈમેઈલ મોકલે છે જનેાથી તે અશધકૃત જવેા જ લાગે છે. તેમાાં તમને કોઈ િોક્કસ કલક પર શક્લક 

કરવા જણાવાય છે જ ે તમને કોઈ બીજા વેબપેજ પર રરિાયરેક્ટ કરે છે, જ્યાાં તમને તમારી અાંગત 

સાંવેદનિીલ મારહતી જવેી કે પાસવિત , ઓટીપી વગેરે આપવા જણાવાય છે. 

5. ગુનાખોરો તો ઓનલાઈન િોપપગ પોટતલ, ઈ-કોમસત સાઈ્સ અને ઓનલાઈન બેંક ખાતામાાંથી પણ 

તમારી અાંગત મારહતી સધુી પહોંિ મેળવીને પછી આ મારહતીનો પોતાના લાભ માટે તમારી શવરુદ્ધ 

ઉપયોગ કરે છે. 

6. ઓળખની િોરી કરનારા સામાન્ય રીતે સોશિયલ મીશિયામાાં ફેક એકાઉન્ટ દ્વારા શવબભન્ન પ્રોફાઈલ જોતા 

રહે છે. તેઓ આ પ્રોફાઈલોનો અભ્યાસ કરીને તેમાાંથી હુમલો કરવા માટે ભોગ બની િકે તેવા ટાગે્સ 

િોધતા રહે છે. સાંબાંધોની િરૂઆત કરવા તેઓ ‘ફ્રેન્િ’ રરક્વેસ્ટ મોકલ ેછે અને િેરટાંગ દ્વારા તમારો શવશ્વાસ 

સાંપારદત કરવા પ્રયાસ કરે છે. શવશ્વાસ સાંપારદત કરી લીધા બાદ તેઓ સાંભશવત ટાગે્સ પાસેથી તેમની 

સાંવેદનિીલ અાંગત મારહતી મેળવી લે છે. 

7. સરકારી રશજસ્ટસત અથવા જાહેર રેકિતમાાંનો િેટા િોરી કરીને તેનો અયોગ્ય જગ્યાએ ઉપયોગ કરાય છે. 

8. ગુનેગારો એવા કર્મપ્યૂટર સવતરમાાંથી મારહતી પ્રાપ્ત કરવાનો પ્રયાસ કરે છે કે જનેે યોગ્ય રીતે સુરસક્ષત કરાયુાં 

નથી કે જનેી પર શનરીક્ષણ નથી. તેઓ અયોગ્ય રીત ેconfigure કરાયેલા અથવા અજાણતા ખોલી 

દેવાયેલા અથવા નબળો પાસવિત  ધરાવતા પો્સત દ્વારા રાઉટર સધુી પહોંિ મેળવે છે. જ્યાાંથી ઓળખની 

િોરી થવાનુાં પૂરેપૂરુાં  જોખમ છે. 

9. માલવેરને દ્વારા પણ અાંગત મારહતીની િોરી થઈ િકે છે. માલવેરને ઈમેઈલ/એસએમએસ/વો્સએપ 

કલક દ્વારા મોકલી િકાય છે. માલવેર એ વાઈરસ, સ્પાયવેર, રૂટશક્સ, રરમોટ એક્સેસ ટૂલ્સ વગેરે જવેા 

બભન્ન સ્વરૂપોમાાં હોઈ િકે છે. 

10. કે્રશિટ/િેબબટ અથવા અન્ય સ્માટત  પેમેન્ટ કાર્ડસત (જવેા કે િોપપગ, તગફ્ટ કાિત  વગેરે)માાંથી RFID (રેશિયો 

શફ્રક્વન્સી આઈિેશન્ટશફકેિન) દ્વારા અાંગત મારહતીની િોરી કાિત  સાથે ભૌતતક સાંપકતમાાં આવ્યા શવના 

પણ કરી િકાય છે. 
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7.3.8 ઑનલાઇન સ્કેર્મસ  

         ઑનલાઇન કૌભાાંિ એ પૈસા મેળવવા માટે તમને ફસાવવાનો પ્રયાસ છે જમેાાં નકલી નામો, નકલી ફોટાઓ, 

નકલી ઇમેઇલ્સ, બનાવટી દસ્તાવેજો, બનાવટી નોકરીની ઑફસત અને અન્ય ઘણાાં પ્રકારો સામેલ છે. સામાન્ય 

રીતે, તે તમારી વ્યશક્તગત શવગતો જમે કે ઑનલાઇન બેંકકગ શવગતો, કે્રશિટ કાિત  સહીતની શવગતોને નકલી ઇ-

મેઇલ મોકલીને મેળવવામાાં આવે છે. જ્યારે તમે ઑનલાઇન હરાજીમાાં ભાગ લેતા હોય ત્યારે કેટલીકવાર લોટરી 

કાંપનીઓ મારફત નકલી નોરટસવાળા ઇ-મેઇલ મોકલવામાાં આવ ેછે, અને નકલી ભેટ માટે ઈ-મેઈલ્સ પ્રાપ્ત કરો 

છો.ત્યારે સાઈબર ગુનેગારો ટેકનોલોજીથી ઓછા પરરસિત લોકોને ફસાવવા માટે સામાશજક મીશિયા પ્લેટફોમતનો 

ઉપયોગ કરે છે. 

7.3.9 લોટરી કૌભાાંિ 

કેટલીકવાર તમને એક ઇમઇેલ/એસએમએસ પ્રાપ્ત થાય છે જમે કે "તમ ેલોટરી જીતી લીધી છે.આવા 

પ્રકારનાાં મેઈલ/ SMS નો જવાબ આપીને મોટા પ્રમાણમાાં પૈસા ગુમાવવાનો વારો આવિે. કારણ કે આ ઈ- મઈેલ 

/SMS સાિા નથી હોતા, કૌભાાંિકતાત તમને મૂખત બનાવવાનો પ્રયત્ન કરે છે, અને પૈસા મેળવવા માટે તમને 

ફસાવવાનો પ્રયત્ન કરે છે. 

7.3.10  નકલી શક્વઝ સ્કેમ 

મૂવીઝ અથવા શવશિઓ ગેર્મસ દ્વારા પ્રેરરત પોસ્ટ અને શક્વઝ તમે જોયેલા જ હિે. મળૂભૂત રીતે, તમે કેટલાક 

પ્રશ્નોના જવાબ આપો છો અને પછી શક્વઝ તમને તમે કોઈ સેલીબ્રીટી,કલાકાર કે કોઈ અન્ય વ્યશક્તત્વ સાથેની 

મુલાકાત કરાવી આપવા જણાવે છે. ઘણીવાર, આ શક્વઝ ગોપનીયતા કૌભાાંિો માટેના મુખોટા હોય છે જ ેતમારા 

જવાબો એકતત્રત કરે છે અને પછી તેને અન્ય કોઈ પાટીને વેિી દે છે. આમાાંની ઘણી શક્વઝ  કરવા માટે "ફેસબુક 

સાથે લૉગ-ઈન કરો"ના બટન સાથે આવે છે. આમ, તમારી બધી મહત્વપૂણત મારહતી જવેી કે ઇ-મેઇલ્સ, સ્થાન, 

ભાષા, નોકરી વગેરે ઘણી બધી મારહતી વેબસાઈટ/ એશપ્લકેિનને આપે છે. 

7.3.11 ઓનલાઈન કર કૌભાાંિ 

   આ પ્રકારમાાં વ્યશક્તનો સાંપકત  કોઈ સરકારી એજન્સીના કમતિારી હોવાના ઓઠા હેઠળ કરવામાાં આવે છે જ ે

મુજબ કોઈ સરકારી કર બાકી હોવાનુાં અને ધરપકિ, દેિશનકાલ અથવા િર ાઇકવગ લાયસન્સ/પાસપોટત  રદ કરવાનુાં 

ટાળવા માટે તાત્કાશલક િકુવણી કરવાનુાં જણાવવામાાં આવ ેછે. તેમને કર ભરવા માટે મની ટર ાન્સફર મોકલવા 

અથવા તપ્ર-લોિ થયેલા િેબબટ કાિત  મારફત નાણા િકુવવાની સૂિના આપવામાાં આવ ેછે. ત્યારબાદ આપના 

નાણા ઓનલાઈન િોરી લ ેછે.સામાન્ય રીતે  કોઈ પણ સરકારી એજન્સીઓ બબલને મેઇલ કયાત વગર તાત્કાશલક 

િૂકવણી કરવા કહેતી નથી અને ફોન કરતી નથી 

7.3.12 નકલી તમત્રો દ્વારા એકાઉન્ટ શનરીક્ષણ  

સોશિયલ મીશિયામાાં તમારા એવા તમત્રો હોઈ િકે જમેની તમે ખરેખર ક્યારેય મુલાકાત લીધી નથી અને 

તેઓ કોણ છે તે તમે જાણતા નથી. ગુનાખોરો તમારી આ બેદરકારીના કારણે તમારા તમત્ર બની અને પછી મારહતી 

એકતત્રત કરવા અને તમે િુાં કરી રહ્યાાં છો તે જોવા માટે તમારા એકાઉન્ટનુાં શનરીક્ષણ કરી િકે છે. ખાસ કરીને, 

તેઓ તમારા ઘરની બહારના, િહેર અથવા દેિની બહાર વેકેિન ફોટાઓની િોધમાાં રહેિે, જનેો અથત છે કે તમારુાં  

ઘર સાંભવતઃ ખાલી છે અને તે િોરી કરવા માટે યોગ્ય છે. 
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7.3.13 મની શફ્લપપગ કૌભાાંિો 

આ પ્રકારના કૌભાાંિો ખાસ કરીને સોશિયલ એકાઉન્ટ પર જોવા મળ ે છે. મની શફ્લપપગ કૌભાાંિો 

વપરાિકતાતને પ્રારાં બભક રોકાણ તરીકે નાની રકમ જમા કરવા જણાવવામાાં આવ ેછે તેની સામ ેમોટા વળતરની 

લાલિ આપવામાાં આવે છે આ માટે તેઓ પૈસા જમા કરાવવા માટે સ્કેમર દ્વારા ફેક (જુઠ્ઠી,ખોટી ) કલક 

મોકલવામાાં આવ ેછે અને આ કલક દ્વારા રકમ જમા કરવાનુાં કહેવામાાં આવે છે.  આ પ્રકારને મની ફ્લીપીંગ  કૌભાાંિ 

તરીકે ઓળખવામાાં આવે છે. 

7.3.14 િરેરટી કૌભાાંિ 

તાજતેરમાાં બનેલ કોઈ ઘટના અથવા કટોકટી જવેા કે પૂર, િક્રવાત, અથવા કોઈ તાજતેરના વતતમાન 

અકસ્માતના પીશિતોને મદદ કરવા માટે કોઈ વ્યશક્તના અથવા કોઈ િોક્કસ ફેક(Fake)ખાતામાાં મની ટર ાન્સફર 

માટે ઇમેઇલ,કલક અથવા ફોન દ્વારા સાંપકત  કરવામાાં આવે છે. કાયદસેરના િેરરટી સાંગઠનો મની ટર ાન્સફર સર્વવસ 

દ્વારા કોઈ અાંગત વ્યશક્તને દાનની રકમ મોકલવા માટે ક્યારેય કહેિે નહીં. 

આમ ઉપર જણાવેલા દરેક સાયબર અપરાધ માટે દાંિ અને સજાની જોગવાઇ છે જ પરાં તુ આવા અપરાધ 

ઓનલાઇન થતા હોવાથી અપરાધીને પકિવાાં ખૂબ જ મુશ્કેલ છે તેમજ તે માટે વધુ સમય લાગી િકે છે. આથી 

એક જાગૃત નાગરરક તરીકે દરેકે આ ગુનાઓથી સિતે રહેવા અને બિવાની જરૂર છે. આપણી જાગૃતત અને 

સાવિેતી જ આપણને આવા સાયબર અપરાધોથી બિાવી િકે. ઈન્ટરનેટના સલામત ઉપયોગ માટે તમારા 

કર્મપ્યૂટરમાાં એન્ટીવાયરસ અને ફાયરવોલ સોફ્ટવરે નાાંખેલુાં હોય એટલુાં જ પુરતુાં નથી, એ સાથે તમે કર્મપ્યૂટરનો 

ઓનલાઈન ઉપયોગ કેવી સાવિેતીથી કરો છો તે પણ ખૂબ અગત્યનુાં છે.  

તમારી પ્રગતત િકાસો. 

• આપે ઉપરોક્ત અભ્યાસ કરેલ સસવાયના અન્ય સાયબર અપરાધોની યાદી તૈયાર કરી િિાત કરો  

7.4  ઓનલાઈન સલામત કેવી રીત ેરહેવુાં? 

લેપટોપ, મોબાઈલ ફોન, ટેબ્લેટ અથવા પસતનલ કર્મપ્યૂટર દ્વારા આપણે જગત સાથે જોિાયેલાાં રહીએ 

છીએ. આનાંદપ્રમોદ માટે, તમત્રો બનાવવા માટે, એકબીજાના સાંપકતમાાં રહેવા અને નવીન બાબતો િીખવા માટે 

ઈન્ટરનેટ મહત્વનુાં અને મૂલ્યવાન છે. પરાં તુ જો સાવિતેી બાબતે સભાનતા રાખ્યા વગર ઈન્ટરનેટનો ઉપયોગ 

કરીિુાં તો ગેરકાનૂની પ્રવૃશિ, છેતરપીંિી, ધાકધમકી અને એવા બીજા ગાંભીર અપરાધમાાં અજાણતા જ આપણે 

સપિાઈ જઈિુાં. સામાશજક માધ્યમો દ્વારા આપણે અજાણયા લોકોને મળીએ છીએ, જ ેઘણીવાર આપણ ેધારીએ 

છીએ એના કરતાાં બબલકુલ જુદા પ્રકારના હોઈ િકે છે. આથી ઓનલાઈન સલામત રહેવા નીિે જવેી કેટલીક 

બાબતો  પણ ધ્યાનમાાં રાખીએ. 

• સરનામુાં કે ફોન નાંબર જવેી અાંગત મારહતી અજાણયા વ્યશક્ત સાથે ઓનલાઈન િેઅર કરવી નરહ. 

• તમારા અાંગત ફોટા કે OTP કોઈનેય ક્યારેય િેઅર કરિો નહી. 

• અજાણી વ્યશક્તના ઈ-મેઈલ, લીંક કે અટેિમેન્ટ ખોલો નહીં. 

• અજાણયા વ્યશક્ત સાથે ઓનલાઈન અાંગત તમત્ર જવેો વ્યવહાર ન કરો. 

• અજાણયા ઓનલાઈન મળ્ા હોય, તેવી વ્યશક્તને રૂબરૂ મળવાનુાં ક્યારેય ન ગોઠવો. 
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• ઓનલાઈન કિુાંક જોઈ કે વાાંિીને તમને ચિતા થાય કે ભય લાગે તો પરરવારના સભ્યને જાણ કરો. 

આ ઉપરાાંત જ્યારે આપણ ેઇન્ટરનેટના માધ્યમથી ઓનલાઇન જોિાઇએ છે ત્યારે આપણે કર્મપ્યૂટર કે 

સેલફોનનો ઉપયોગ કરીએ છીએ. સાંદેિાઓ, ફોટોગ્રાફ્સ, ટૂાંકા શવિીયો કે શવિારોના આદાનપ્રદાન માટે શવશવધ 

સોશિયલ માધ્યમો અને વબેબ્રાઉઝરનો ઉપયોગ કરીએ છીએ. ઈન્ટરનેટનો ઉપયોગ કરીએ ત્યારે પણ કેટલીક 

સાવધાની રાખવી જરૂરી છે. 

7.5 વબે બ્રાઉઝરનાાં ઉપયોગમાાં જરૂરી સાવિતેી 

ઓનલાઈન કામગીરી કરવા માટે વેબ બાઉઝરનો ઉપયોગ ખૂબ સરળ છે, પણ તેમાાં આપણાાં કર્મપ્યૂટરને 

નુકસાન થવાની સાંભાવના રહેલી છે. આ નુકસાન એટલે સાંવેદનિીલ મારહતી જાહેર થઇ જવી તેમજ સ્પાયવેર 

અને એિવેર જવેા માલવેરનો બબનઅશધકૃત રીતે  આપણાાં કર્મપ્યૂટર કે સેલફોનમાાં પ્રવેિ વગેરે ઓનલાઈન 

જોખમોથી બિવા પુરતી સાવધાની રાખવી જોઇએ. કર્મપ્યૂટરમાાં યોગ્ય એન્ટીવાયરસ સોફ્ટવેર ઇન્સ્ટોલ કરો અને 

તેને અવારનવાર અપિેટ કરતાાં રહો. 

• તમારા ઈન્ટરનેટ બ્રાઉઝરને અપ-ટુ-િેટ રાખો,સમયાાંતરે અપિેટ કરતાાં રહો. 

• તમારા કર્મપ્યૂટરમાાં થતી િાંકાિીલ કે અજાણી  કામગીરી કે સમસ્યા બાબતે સાવધાન રહો. 

• તમારા કર્મપ્યૂટરમાાં ફાયરવૉલ ઇન્સ્ટોલ કરો અને તેને અપિેટ રાખો. 

• પોપ-અપ બ્લોકર જવેી સવલતો ધરાવતા આધુશનક બ્રાઉઝરનો ઉપયોગ કરો. 

• તમારા કર્મપ્યૂટરમાાં અમયાતરદત સમય સુધી કોઇ સાંવેદનિીલ શવગતો દાખલ કે સાંગ્રહ ન કરો. 

• સમયાાંતરે તમારા ઓનલાઇન એકાઉન્્સના પાસવિત  બદલતાાં રહો. 

• ઈન્સ્ટન્ટ મેસેકજગ અને ઈ-મેઈલ સાથે જોિાણ તરીકે આવતી કલકથી સાવધ રહો. 

7.6 સોશિયલ નટેવર્કકગ સાઈટ પર રાખવાની જરૂરી સાવધાની 

સોશિયલ નેટવર્કકગ એ તમત્રો અને સ્નેહીજનો સાથે મારહતી અને લાગણીઓનુાં અદાન પ્રદાન કરવા માટે 

નુાં અસરકારક માધ્યમ છે. સોશિયલ નેટવર્કકગ સાઇ્સની મદદથી આપણે  શવશ્વ સાથે જોિાઈ િકીએ છીએ,  

શવિારોને િેર કરી િકાય છે અને અન્યના શવિારોને જાણી િકાય છે.આવી સામાશજક સાઈ્સનો ઉપયોગ કરતી 

વખતે કેટલીક સાવિેતી રાખવી જરૂરી છે. જમે કે... 

1. સોશિયલ નેટવર્કકગ સાઇ્સ પર કોઈની શવનાંતી સ્વીકારતા પહેલાાં હાંમેિા વ્યશક્તની અશધકૃતતાની તપાસ 

કરો. 

2. સોશિયલ નેટવર્કકગ એકાઉન્ટમાાં એવા સેરટાંગ્સ રાખો કે જથેી તમારા ફોટા અને પ્રવૃશિઓ ફક્ત તમારા 

કુટુાંબીજનો અને જાણીતા તમત્રો સાથે િેર થઇ િકે. 

3. સોશિયલ નેટવર્કકગ સાઇટ પસાંદ કરતી વખતે ગોપનીયતા બાબતે કાળજી લો.કોઈ શવગતો પોસ્ટ કરવા, િટે 

કરવા, અપલોિ કરવા અથવા િાઉનલોિ કરતા પહેલાાં શવિારો. 

4. સોશિયલ નેટવર્કકગ સાઇટમાાં પરરિય થયો હોઈ તેવી કોઈ  વ્યશક્તને રૂબરૂ મળવા માાંગતા હોય, તો તમારા 

પરરવારના સભ્યોની પરવાનગી મેળવવી. જથેી તેઓ તમને કેટલાક સૂિનો આપી િકે અને તમે જ ેવ્યશક્તને 

મળી રહ્યા છો તેને જાણી િકાય. 

5.  તમારી સોશિયલ નેટવર્કકગ એકાઉન્ટની શવગતો સાથે િેિા થયાનુાં ધ્યાનમાાં આવ ે તો તમારી િાંકાને તરત જ 

નેટવર્કકગ સાઇટ સપોટત  ટીમને જાણ કરો. 



70 

 

6. તમારી પ્રોફાઇલ પર પોસ્ટ કરવામાાં આવતી સતામણી અથવા અપમાનજનક રટપ્પણીઓને ક્યારેય પ્રતતસાદ 

આપિો નહીં. 

7. સોિયલ સાઈટમાાં જોિાવવા માટે તમારી ઉાંમર યોગ્ય છે કે કેમ તેની ખાતરી કરો. 

8. સોશ્યલ સાઇટ પર તમારી પ્રોફાઈલમાાં તમામ અાંગત અને સાંવેદનિીલ શવગતો જાહેર ન કરો. 

9. જમેને તમે બબલકુલ ઓળખતા નથી એવા સાવ અજાણયા વ્યશક્તને ઓનલાઈન તમત્રો ન બનાવો. 

10. જમેાાં તમારા નામનો ઉલ્લેખ ન હોય તેવુાં  ઈ-મેઈલ એિરેસ રાખવુાં રહતાવહ છે. 

11.  તમારા શવશ્વાસુ તમત્રો જ તમારી પ્રોફાઇલ જોઈ િકે તનુેાં ધ્યાન રાખો. 

12. તમે જ ેફોટાઓ અને શવિીયો અપલોિ કરો છો એ તમારા તમત્રો સાથ ેઅન્ય લોકો સુધી પણ પહોંિિે,માટે 

િુાં અપલોિ કરવુાં એ બરાબર શવિારીને જ નક્કી કરો. 

13. ઓનલાઈન મારહતી િેર કરતી વખતે થોિા સાવધ રહો. જ ેખરેખર કાયદેસર નથી તેવા િાઉનલોિથી દૂર 

રહો. 

14. કર્મપ્યૂટરકે મોબાઈલમાાં તમારા બેંક એકાઉન્ટની શવગતો ,પાસવિત  કે અાંગત મારહતી સ્ટોર કરીને રાખવી નરહ 

7.7 સ્માટત  ફોનનાાં ઉપયોગમાાં રહેલ જોખમો અન ેસાવધાની: 

આપણા પરરવારજનો અને તમત્રો સાથે વાતિીત કરવા ઉપરાાંત સેલફોનનો બીજી ઘણી રીતે ઉપયોગ થતો 

હોય છે. ઈન્ટરનેટ બ્રાઉઝીંગ, બીલો ભરવા, બેન્કના ખાતામાાં થતી લેવિદેવિની મારહતી મેળવવા કે ઈ-મઈેલ 

મેળવવા તેમજ અનેક સામાશજક માધ્યમમાાં જોિાવા માટેની એપ્લીકેિન્સ જવેી સશુવધાઓ સ્માટતફોનમાાં હોય છે. 

થોિા વષો પહેલાાં જ ેઅાંગત મારહતી બીજાાં લોકો કર્મપ્યટૂર દ્વારા જાણી િકતા હતા તે આજ ેસ્માટતફોન દ્વારા થઇ 

િકે છે. આજ ેસ્માટતફોન બધા માટે હાથવગુાં સાધન છે સાથેસાથે તમારી અાંગત મારહતીને ખુલ્લુાં કરતુાં એક જોખમી 

સાધન પણ છે. તેના ઉપયોગથી કેટલાાંક જોખમોની િક્યતા છે.  

1. સ્માટતફોન ખોવાઈ જાય અથવા િોરાઈ જાય ત્યારે તેમાાંની તમામ મારહતી અન્ય વ્યશક્ત જાણી િકિે અને 

તેનો દૂરોપયોગ થવાની સાંભાવના રહેિે. 

2. ફોનમાાં તમે સાિવેલી ગુપ્ત મારહતી, ખાનગી ફોટાઓ કે શવિીયો, ઈ-મેઈલ, સાંદેિ, ટેક્સ્ટ મેસેજીસ અને 

દસ્તાવેજો અજાણયા માણસને મળી િકે છે. 

3. સ્માટતફોનમાાં નેટવકત  કનેશક્ટશવટીના શવકલ્પો હોય છે તેથી સાયબર અપરાધી પ્રતતબાંશધત નેટવકતમાાં પણ 

ઘૂસી િકે છે. આવી સુરસક્ષત કરાયેલી કોપોરેટ સસસ્ટમમાાં આ અપરાધી તમારા િોરાયેલા ફોનથી હુમલો 

કરી િકે છે. 

4. વાઈરસ, ટર ોજન હોસત, વોર્મસત જવેા ખતરનાક વાયરસ, છળ-કપટવાળા સોફ્ટવેરના માધ્યમથી આપણા 

સ્માટતફોનમાાં ઘૂસી િકે છે. 

સ્માટતફોનનો ઓનલાઇન ઉપયોગ કરવાથી આ બધી િક્યતાઓ રહેલી છે. માટે તનેા ઉપયોગમાાં કેટલીક      

સાવિેતી રાખવી પણ એટલી જ જરૂરી છે. જમે કે...  

1. નવો સ્માટતફોન ખરીદતી વેળાએ એના સસક્યરુીટી ફીિસત તપાસી લો, અને એ બરાબર કામ કરે છે કે નહીં 

તે જોઈ લો. 

2. સ્માટતફોનમાાં એન્ટીવાયરસ ઇન્સ્ટોલ કરો અને એને તેની જાળવણી કરતા રહો. 

3. અજાણયા મસેેજ કે કલકને ન અનુસરો. 
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4. તમારા સ્માટતફોનમાાં કઈ કઈ શવગતો સાિવી રાખવી છે તે સમજી શવિારીને નક્કી કરો. 

5. અજાણયા વાઈ-ફાઈ નેટવકતમાાં જોિાિો નહી. અસાલમત વાઈ-ફાઈ હોટસ્પોટનો ઉપયોગ કરિો નહીં. 

બ્લ્યુ ટૂથ, ઇન્ટરનેટ કે વાઈફાઈ જવેા ઇન્ટરફેઈસનો ઉપયોગ પૂરો થતા જ તેને બાંધ કરી દો. 

6. જૂના સ્માટતફોનનો ઉપયોગ બાંધ કરવાનો હોય તો તેમાાં તમે સાંગૃરહત કરેલી તમામ મારહતી રદ કરો. 

7. WhatsApp મારફત હાલમાાં જ WhatsApp Web િરૂ કરવામાાં આવ્યુાં છે. Mirroring services પસતનલ 

કર્મપ્યૂટર ઉપર કામ કરતી વખતે કામગીરી આસાન બનાવે છે. મોટાભાગના લોકો અજાણ છે કે તેમણ ે

ખરેખરી રીતે WhatsApp Web ઉપરથી તેમના મોબાઇલ મારફત કે બ્રાઉજર મારફત લૉગ-આઉટ થવુાં 

જરૂરી છે. WhatsApp Web ઉપરથી Log Out થવાનુાં યાદ રાખો 

તમારી પ્રગતત િકાસો. 

1. આપના સોશિયલ મીશિયા એકાઉન્ટમાાં  સાવિેતી અને સુરક્ષાના સેરટાંગને અનુસરો. 

2. સોશિયલ મીશિયામાાં તમને થયેલ ખરાબ અનુભવો અને તેમાાંથી બિાવ માટે તમ ેકરેલા પ્રયત્નોની િિાત 

કરો. 

7.8 સારા પાસવિતની જાળવણી અાંગનેી માગતદર્વિકા 

શવશવધ સોશિયલ નેટવર્કકગ એકાઉન્ટમાાં આપણે પાસવિત  દાખલ કરવાનો થતો હોય છે. યોગ્ય પાસવિત  

તમારા ઓનલાઇન એકાઉન્ટની સુરક્ષા શનશિત કરે છે. સારો પાસવિત  બનાવવા માટે કોઈ પેટનત નક્કી કરી, 

પાસવિત ને મજબૂત બનાવો જરૂરી છે. આ સાંદભે કેટલાક સૂિનો ધ્યાનમાાં લેવા જરૂરી છે. 

1. ઓછામાાં ઓછા ૮ અક્ષરો  કે તેનાથી વધારેથી પાસવિત  બનાવો. જટેલા વધારે આાંકિા/અક્ષરો હોય તેટલો 

વધારે મજબૂત આપણો પાસવિત  બને. 

2. મજબુત પાસવિત  માટે Lowercase, Uppercase, Numbers and Special characters ના સાંયોજનનો 

ઉપયોગ કરો. 

3. પાસવિત  માટે શિક્ષનરીમાાંના તૈયાર િબ્દોનો ઉપયોગ ન કરો કે આસપાસમાાં જોવા મળતી િીજવસ્તુઓના 

અથવા સામાન્ય નામનો અને તમરી અાંગત મારહતીનો (જન્મતારીખ,નામ,ગામનુાંનામ)ઉપયોગ ન કરો. 

આવા પાસવિત ને સરળતાથી તોિી િકાય છે. 

4. એવો પાસવિત  બનાવો કે જ ેજરટલ હોય તેમ છતાાં યાદ રાખી િકાય. પાસવિત  મોબાઇલ ફોનમાાં, વોલેટમાાં 

કે અન્યત્ર ક્યાાંક લખી રાખવો રહતાવહ નથી. 

5. પાસવિત નુાં  અનુમાન કરવુાં  મુશ્કેલ હોવુાં  જોઈએ. 

6. સમયાાંતરે પાસવિત  બદલતા રહો. અગાઉ ઉપયોગમાાં લીધેલો પાસવિત  બીજી વખત ઉપયોગમાાં ન લો. 

7. જયારે કોઈ તમારી બાજુમાાં બેઠુાં  હોય ત્યારે મોબાઇલ ફોન કે કર્મપ્યૂટરમાાં પાસવિત  દાખલ ન કરો. 

7.9 ઇન્ટરનટે એથથક્સ 

જ ેરીતે આપણા વ્યશક્તગત જીવનમાાં અને સામાશજક જીવનમાાં કેટલીક નીતતઓને અનુસરીએ છીએ, તે જ 

રીતે ઈન્ટરનેટના ઉપયોગ માટે કેટલીક નીતતઓને અનુસરવી જોઈએ. આ બાબતને ઈન્ટરનેટ એથથક્સ તરીકે 

ઓળખીએ છીએ. ઈન્ટરનેટ એથથક્સ એવા નૈતતક સસદ્ધાાંતોનો સમૂહ છે જ ે કોઈ કર્મપ્યૂટર અથવા કર્મપ્યટૂરનો 
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ઉપયોગ કરતી વખતે સ્વીકૃત વતતન બાબતે કોઈ વ્યશક્ત અથવા જૂથને સાંિાશલત કરે છે. આપણે જાણીએ છીએ 

તેમ, કર્મપ્યૂટર એક અસરકારક સાધન છે પરાં તુ તે અાંગત બાબતોમાાં દખલ, છેતરપપિી, ગોપનીયતાનો ભાંગ, 

સાયબર-ગુાંિાગીરી, સાયબર-સ્ટોકકગ, બદનામી, હુમલાખોરી અથવા સામાશજક જવાબદારી અને કૉતપરાઇટ 

કરેલી ઇલેક્ટર ોશનક સામગ્રી જવેી બૌશદ્ધક સાંપદાના હકો જવેી નૈતતક સમસ્યાઓ ઉભી કરે છે. ઇન્ટરનેટ 

વપરાિકતાતઓએ નીિે મુજબના કેટલાક શનયમોનુાં પાલન કરવુાં જરૂરી છે. 

1. અન્ય વપરાિકતાતઓને નુકસાન પહોંિાિવા માટે ઇન્ટરનેટનો ઉપયોગ કરવો નહી. 

2.  અન્યોની મારહતી િોરી કરવા ઇન્ટરનેટનો ઉપયોગ કરિો નહીં. 

3.  લેખકની પરવાનગી શવના તેના કૉતપરાઇટ સારહત્યની નકલ કરિો નહીં. 

4.  કૉતપરાઇટ કાયદાઓ અને નીતતઓનો હાંમેિા આદર કરો. 

5.   જમે તમે અન્ય લોકો પાસથેી અપેક્ષા રાખો છો તેમ અન્યની ગોપનીયતાનો આદર કરો,  

6.  પરવાનગી શવના અન્ય વપરાિકતાતના કર્મપ્યૂટર સાંસાધનોનો ઉપયોગ કરિો નહીં. 

7.  જો કોઈ ગેરકાયદે સાંિાર અને પ્રવૃશિઓ ધ્યાને આવે તો તે બાબતે ઇન્ટરનેટ સર્વવસ પ્રોવાઇિસત અને 

સ્થાશનક કાયદા અમલીકરણ અશધકારીઓને જાણ કરો. 

8.  વપરાિકતાતઓ તેમના યુઝર આઈિી અને પાસવિતની સુરક્ષા માટે જવાબદાર છે. યાદ રાખવા માટે તેઓએ 

પેપર પર અથવા બીજ ેક્યાાંય લખવુાં જોઈએ નહીં. 

9. વપરાિકતાતઓએ ઇરાદાપૂવતક અન્ય લોકોની મારહતી મેળવવા અથવા સાંિોશધત કરવા માટે કર્મપ્યુટસતનો 

ઉપયોગ કરવો જોઈએ નહી. 

10. કોઈ વ્યશક્ત કે કાંપનીએ શનમાતણ કરેલ સોફ્ટવેરની અનઅશધકૃત નકલ કરવી જોઈએ નરહ. 

7.10 પ્રકરણ સાર 

જમે જમે ટેકનોલોજી શવકસસત થઈ છે તેમ તેમ સાયબર ગુનાઓ કે ઓનલાઇન છેતરપીંિીનો ટરેન્િ પણ 

વધી રહ્યો છે. હવે શિક્ષણની પ્રશક્રયામાાં પણ ઓનલાઇન પ્લેટફોમતનો ઉપયોગ વધવા લાગ્યો છે તથા શવદ્યાથીઓ   

ઓનલાઇન માધ્યમોનો ઉપયોગ કરતા થયાાં છે ત્યારે જાણયે-અજાણય ેસાયબર ક્રાઇમનો ભોગ ન બને તે માટે 

શવદ્યાથીઓને સાયબર ગુનાઓ અને સાયબર સલામતી શવિે જાગૃત કરવા ખૂબ જરૂરી છે. ઇન્ટરનેટની દુશનયા 

શવિાળ છે. અધ્યયન-અધ્યાપન પ્રશક્રયામાાં તેના લાભદાયક ઉપયોગને નકારી િકાતો નથી. આપણી જરૂરરયાતને 

અનુલક્ષીને મારહતી પ્રાશપ્ત અને જ્ઞાનસાંવધતન અથે શિઝીટલ માધ્યમોનો ઉપયોગ કરીએ, પરાં તુ સાથેસાથે આ 

માધ્યમોનો ઉપયોગ કરવા સમયે સાવધાની પણ રાખીએ.  

 

તમારી પ્રગતત િકાસો.  

1. શિશજટલ વ્યવહારો કરતી વખતે કઈ કઈ બાબતોમાાં સાવિેતી રાખવી જોઈએ? યાદી બનાવો. 

2. ઈન્ટરનેટ સર્કફગ કરતી નૈતતકતાના સાંદભે કઈ બાબતોનુાં ધ્યાન રાખિો? 

3. વતતમાનપત્રોમાાં કે અન્ય માધ્યમોમાાં આવતા સાયબર ક્રાઈમને લગતી શવગતો એકત્ર કરી પ્રોજકે્ટ તૈયાર 

કરો.  
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સ્વાધ્યાય કાયત 
પ્રશ્ન-1  ટૂાંકમાાં જવાબ આપો 

1. સાયબર અપરાધ એટલે િુાં?  

2. સ્પામ ઇ-મેઇલથી કયા વાયરસ એટેકનો ખતરો છે? 

3. સાયબર બુકલગ એટલ ેિુાં?  

4. િેરરટી િીટીંગ કઈ રીતે કરવામાાં આવે છે? 

5. સારો પાસવિત  કઈ કઈ શવગતોથી બનાવી િકાય? 

6. વેબસાઈટ સુરસક્ષત છે તે કઈ રીતે જાણી િકાય? 

7. સાયબર બુલીંગ એટલ ેિુાં? 

પ્રશ્ન:2  નીિનેા પ્રશ્નોના ઉિરો સશવસ્તાર જણાવો. 

1. સાયબર અપરાધના પ્રકારોની શવગતે િિાત કરો? 

2. વેબ –બ્રાઉઝરના ઉપયોગ અાંગે કઈ સાવિેતી રાખવી જરૂરી છે? સશવસ્તાર જણાવો. 

3. સ્માટત  ફોનના ઉપયોગમાાં કઈ કઈ  સાવધાની રાખવી રહતાવહ છે? 

4. ઇન્ટરનેટ વપરાિકતાતઓ માટેના નૈતતક શનયમો જણાવો ? 
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પ્રકરણ-8 કોડિંગ પરરચય 
8.1 પ્રસ્તાવના 

રાષ્ટ્રના વવકાસનો આધાર રાષ્ટ્રની વિક્ષણ પ્રણાલી પર હોય છે. વિક્ષણને ગુણવત્તાયુક્ત લાભદાયી 

બનાવવા માટે વખતો વખત રાષ્ટ્રની વિક્ષણ નીતતમાાં બદલાવ આવતો હોય છે. છેલ્લ ેવર્ષ 2020માાં રાષ્ટ્ર ીય વિક્ષણ 

નીતત આપણી સમક્ષ મૂકવામાાં આવી. તેમાાં મારહતી અને પ્રત્યાયન તકવનકીનુાં વિક્ષણના દરેક તબકે્ક સાંકલન 

કરવાની ભલામણ કરવામાાં આવી છે. રાષ્ટ્ર ીય વિક્ષણનીતતમાાં વવદ્યાર્થીઓ િાલેય વિક્ષણ સાર્થે કોડિંગ પણ િીખે  

અને ખાસ કરીને ઉચ્ચ પ્રાર્થતમક િાળા કક્ષાએર્થી જ બાળકો કોડિંગ િીખવાની િરૂઆત કરિે તેવી વાત રજૂ 

કરવામાાં આવી છે. વવદ્યાર્થીઓને કોડિંગ િીખવવા માટે વિક્ષકે પણ તેનો પરરચય કેળવવો જરૂરી બનિે.આર્થી  

આ પ્રકરણમાાં કોડિંગની પાયાની સાંકલ્પના સ્પષ્ટ્ કરીિુાં તેમજ કોડિંગ િીખવા માટેના પ્લટેફોમષનો પરરચય 

કેળવીિુાં. 

ઉદે્દિો 

તાલીમાર્થીઓ ..... 

• કોડિંગનો અર્થષ સમજાવી િકિે. 

• કોડિંગનુાં મહત્ત્વ જણાવી િકિે. 

• કોડિંગ રચવા માટેના વવવવધ પ્લેટફોમષ વવિે જણાવી િકિે. 

8.2 કોડિંગની સાંકલ્પના 

રાષ્ટ્ર ીય વિક્ષણનીતતમાાં ઉલે્લખ ર્થયા બાદ કોડિંગ િબ્દ ઘણો પ્રચવલત બન્યો છે, ત્યારે ‘કોડિંગ એટલ ે

િુાં?’ એ પ્રશ્ન ર્થવો સ્વાભાવવક છે. સાવ સરળ િબ્દોમાાં કહેવુાં હોય તો કહી િકાય કે ‘કોડિંગ એ કમ્પપ્યૂટર સાર્થે 

વાતચીત કરવાની એક પદ્ધતત છે’, કમ્પપ્યૂટરમાાં ચોક્કસ કાયો કરવા માટે, કમ્પપ્યૂટર સમજી િકે તેવી ભાર્ામાાં 

ક્રમબદ્ધ સૂચનાઓ આપવી પિેં છે. કમ્પપ્યૂટર આપણી ભાર્ામાાં આ સૂચના સમજી િકતુાં નર્થી. કમ્પપ્યૂટરને આવી 

સૂચનાઓ કમ્પપ્યૂટર સમજ ેતેવી ભાર્ામાાં આપવાનુાં કાયષ કોડિંગ દ્વારા ર્થાય છે. આપણે જાણીએ છીએ, કે કમ્પપ્યૂટર 

એક વવજાણુ યાંત્ર છે. કમ્પપ્યૂટર અતત સરળતાર્થી ઘણી ગૂાંચવણભરી વવવવધ પ્રકારની સમસ્યાઓને ઉકેલે છે. 

કમ્પપ્યૂટર જાતે કોઇ સમસ્યાનો ઉકેલ લાવી િકતુાં નર્થી પણ તે સમસ્યાના ઉકેલમાાં મદદરૂપ ર્થાય છે. સમસ્યાના 

ઉકેલ માટે કમ્પપ્યૂટરને તાર્કકક સૂચનાઓનો સાંપૂણષ સમહૂ આપવો પિેં છે. આ સચૂનાઓ કમ્પપ્યૂટરને દરેક તબકે્ક 

િુાં કરવાનુાં છે, તે જણાવ ેછે. કોડિંગ એ સૂચનાઓ લખવાની પ્રવક્રયા છે, જ ેકમ્પપ્યૂટરને િુાં કરવુાં ત ેજણાવે છે.આર્થી 

કહી િકાય કે, કમ્પપ્યૂટર પ્રોગ્રામર ચોક્કસ કમ્પપ્યૂટર ભાર્ાઓનો ઉપયોગ કરીને સૂચનાઓ લખે છે અને આ 

સૂચનાઓ કમ્પપ્યૂટરને જરટલ પ્રોગ્રામ ચલાવવાનુાં રદિાસૂચન કરે છે.  

કમ્પપ્યૂટરને કોડિંગ દ્વારા અપાતી સૂચનાઓ લખવા માટે વવવવધ કમ્પપ્યૂટર ભાર્ાઓનો વવકાસ ર્થયો છે. 

કોડિંગ દ્વારા આપણે સોફ્ટવેર, વેબસાઇટ્સ, એવપ્લકેિન્સ અને વવવિંયો ગેમ્પસ વગેરે વનમાષણ કરી િકીએ છીએ.  

8.3 કમ્પપ્યટૂર કોડિંગનુાં મહત્ત્વ 

કોડિંગ િીખવુાં બાળકો માટે ઘણુાં મહત્ત્વપૂણષ છે, કારણ કે કોડિંગ એ કમ્પપ્યૂટર પ્રોગ્રામમગની સાર્થેસાર્થે 

તાર્કકક વ્યવસ્ર્થાપન, વવવેચનાત્મક ચચતન, સમસ્યાનુાં વનરાકરણ, સજષનાત્મકતા જવેા જીવનના કેટલાાંક 

મહત્ત્વપૂણષ કૌિલ્યો િીખવે છે. કમ્પપ્યૂટર કોડિંગનુાં મહત્વ આ મુજબ છે. 
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1. કોડિંગના મહાવરા દ્વારા બાળકો સમસ્યા ઉકેલ િીખ ેછે. 

સમસ્યા ઉકેલવાનુાં કૌિલ્ય રોજીાંદા જીવનમાાં ખૂબ ઉપયોગી છે. આપણે બધા ઇચ્છતા હોઇએ છીએ 

કે આપણાાં બાળકો ઉત્તમ સમસ્યા ઉકેલનાર બને, જરે્થી તેઓ જીવનમાાં કોઈપણ પ્રતતકૂળતાનો સામનો કરી 

િકે. કોડિંગનુાં અધ્યયન વવદ્યાર્થીઓને યુવાવસ્ર્થામાાં જ આ પ્રકારનુાં કૌિલ્ય વવકસાવવાની તક આપે છે, જ ે

આગળ જતાાં િેર્ જીવનમાાં ખૂબ મદદરૂપ ર્થઇ િકે છે.  

કમ્પપ્યૂટરને સમજવાર્થી અને કોડિંગની પાયાગત બાબતો િીખવાર્થી બાળકોમાાં વસ્તુઓ કેવી રીતે કાયષ 

કરે છે તેની સમજ વવકસે છે. કોડિંગ બાળકોને એ પણ િીખવે છે કે કેવી રીતે સોફ્ટવેર એવન્જવનયર તાર્કકક 

અને સજષનાત્મક રીતે સમસ્યાઓ ઉકેલવા માટે ગવણતનો ઉપયોગ કરે છે. જરે્થી ગવણત જવેા અધરા લગતા 

વવર્ય પ્રત્ય ેપણ વવદ્યાર્થીઓની રૂચી કેળવી િકાય છે. 

2. કમ્પપ્યટૂર કોડિંગ બાળકોન ેપિંકાર આપ ેછે અન ેતમેન ેલવચચકતા વવકસાવવામાાં મદદ કરે છે. 

જ્યારે બાળકો કોડિંગ કરવાનુાં િીખે છે, ત્યારે પ્રયત્ન અને ભૂલ દ્વારા અધ્યયન કરવાની ક્ષમતા 

વવકસાવે છે. તેઓ િીખે છે કે વનષ્ફળતા એ ખરાબ બાબત નર્થી, પરાંતુ હકીકતમાાં તે નવુાં િીખવાની તક પુરવાર 

ર્થઇ િકે છે. જ્યારે કોઇ વનષ્ફળ જાય છે અને પછી ફરી પ્રયાસ કરે છે ત્યારે ત ેપોતાની ભૂલોમાાંર્થી નવી બાબતો 

િીખી િકે છે. કોડિંગ બાળકોને જ્યાાં સુધી તેઓ સફળ ન ર્થાય અને જ ેપરરણામ િોધી રહ્ાાં હોય તે ન મળ ે

ત્યાાં સધુી તેઓને વારાંવાર પ્રયાસ કરવાની તક પૂરી પાિેં છે. આર્થી બાળકો ઝિંપર્થી િીખી જિે કે કોડિંગમાાંર્થી 

કેવી રીતે ભૂલ િોધી કાઢવી અને કેવી રીતે તેને સધુારવી. આમ, આ કાયષ ઘણુાં આનાંદદાયક હોય છે. 

3. કોડિંગ બાળકોન ેકેવી રીત ેવવચારવુાં ત ેિીખવ ેછે. 

કોડિંગ િીખવાર્થી બાળકો કેવી રીતે વવચારવુાં તે િીખે છે. કમ્પપ્યૂટર પ્રોગ્રામમગ દ્વારા કોિંની લાઇન કેવી 

રીતે ટાઇપ કરવી માત્ર તેટલુાં જ િીખવવાનુાં નર્થી, પરાં તુ બધાર્થી અલગ રીતે કેવી રીત ેવવચારવુાં, ખરેખર તે 

િીખવવાનુાં છે. કોડિંગ કરનાર પ્રોગ્રામર અસરકારક રીતે કોિં લખવા સક્ષમ હોવાર્થી તે તાર્કકક રીતે વવચારે 

છે. તેઓમાાં કોઇ મોટી સમસ્યાને જાણવા અને તેને અસરકારક રીતે હલ કરવા માટે નાનાાં ટુકિંાઓમાાં વવભાજીત 

કરવાનુાં કૌિલ્ય કેળવાય છે. કોડિંગ િીખતા બાળકોએ કોઇ જટીલ સમસ્યા ધ્યાને લઇ તેને કાંઈક અાંિે 

ઉકેલવાલાયક  બનાવવા માટે તેમની સજષનાત્મકતાનો ઉપયોગ કરવો પિંિે. જો પ્રર્થમ ઉકેલ કામ કરતો નર્થી, 

તો તેઓ બીજો પ્રયાસ કરે છે. જો બીજો ઉકેલ કામ કરતો નર્થી, તો જ્યાાં સધુી સમસ્યા હલ ન ર્થાય ત્યાાં સધુી 

તેઓ ફરી પ્રયાસ કરતા રહે છે. કોડિંગ આ પ્રકારની વવચારસરણી વવકસાવવામાાં મદદ કરે છે. 

4. બાળકોની સજષનાત્મકતા વવકસ ેછે. 

કમ્પપ્યૂટર પ્રોગ્રામમગ બાળકોને પ્રયોગ કરવાનુાં િીખવે છે અને સજષનાત્મક બનવાનો આત્મવવશ્વાસ 

આપે છે. તેમની પાસે એવી કોઈ એવી વસ્તુ વિંઝાઇન કરવાની તક હિે જ ે સાંપૂણષપણે તેમની પોતાની 

છે. બાળકો તેમને ગમતી વસ્તુ બનાવવાર્થી મળેલા પ્રતતસાદર્થી ખીલ ે છે. કોડિંગની ચકાસણી કરવાની 

પ્રવક્રયામાાં કાયષ કરતાાં કરતાાં જ તેનુાં પરરણામ જોવા મળે છે. જનેાર્થી બાળકોમાાં સજષન કયાષનો આત્મવવશ્વાસ 

તેમજ પરરણામ મળ્યાની ઉતેજના વધે છે.  

5. કમ્પપ્યટૂર પ્રોગ્રામમગ એ 21મી સદીનુાં કૌિલ્ય છે. 

અત્યારે ટેકનોલોજી ખૂબ જ ઝિંપર્થી વવકસી રહી છે.આ સમયે કોડિંગ એ એક અત્યાંત ઉપયોગી કૌિલ્ય 

છે. એવા વ્યવસાયોની સાંખ્યા વધી રહી છે જઓે માત્ર ટેક્નોલોજી પર જ નહીં પરાં તુ કમ્પપ્યૂટર કોિં પર આધાર 
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રાખે છે. તેર્થી જો બાળકો કોડિંગ િીખ ેતો ભવવષ્યમાાં કોઇપણ કે્ષત્રે તેમને રોજગારીની વધુ તકો સાર્થે જીવનમાાં 

ફાયદો ર્થિે.  

6. સોફ્ટવરે ઉદ્યોગમાાં કૌિલ્યોનો અભાવ છે. 

આજ ેઅનુભવી અને સારા કમ્પપ્યુટર પ્રોગ્રામરોની ખૂબ જ માાંગ છે અને ટેક્નોલોજીની પ્રગતત સાર્થે દરરોજ 

કારવકદીની તકો વધી રહી છે. જ ેપ્રોગ્રામરો અસરકારક કોડિંગ કરી િકે છે, તેનુાં ભવવષ્ય ઉજ્જવળ છે અને 

કોઈપણ ઉદ્યોગમાાં તેમની માાંગ  ખૂબ જ રહેિે. જો બાળકો નાની ઉાંમરે કોડિંગ કરવાનુાં િીખે છે, તો યુવા વયર્થી 

જ તેમનો અનુભવ િરૂ ર્થાય છે અને સોફ્ટવેર ઉદ્યોગમાાં તેઓની વવકસવાની િક્યતાઓ વધી જાય છે.  

7. કોડિંગ બાળકોન ેગમ્પમત સાર્થ ેગવણત િીખવામાાં મદદ કરે છે. 

કોડિંગ એ તકષ  અને ગવણતની ભાર્ા છે. પ્રોગ્રામ િીખવામાાં િેંટાને ગોઠવવા અને તેનુાં વવશ્લેર્ણ કરવા 

સરહતનાાં ઘણાાં કૌિલ્યોનો સમાવેિ ર્થાય છે. કોડિંગ કરતી વખતે ઇરાદાપૂવષક તેનો ખ્યાલ રાખ્યા વવના પણ 

બાળકો પોતાના ગાવણતતક કૌિલ્યનો વવકાસ કરી િકે છે. જ્યારે બાળકો પોતાનુાં કાંઈક સજષન કરે છે ત્યારે 

પોતાના તકષ  અને ગાવણતતક કૌિલ્યનો ઉપયોગ કરીને ગવણતને વધુ રસપ્રદ અને મનોરાંજક બનાવી િકે છે.  

8. કોડિંગ એ આનાંદ સાર્થ ેઅધ્યયનની પ્રવક્રયા છે. 

જો બાળકને આનાંદપ્રદ િૈક્ષવણક અનુભવ આપવા ઇચ્છતા હોય તો કોડિંગ િીખવવુાં એ એક સારી 

પસાંદગી છે. બાળકો કોડિંગ દ્વારા વવવવધ કૌિલ્યો િીખિે અને મહાવરો કરિે. સાર્થેસાર્થે કેટલાાંક મહત્ત્વના 

કૌિલ્યો પ્રાપ્ત કરિે, જ ેતેમને ઉપયોગી બનિે. જો કોડિંગના આનાંદ સાર્થે આ કાયષ ર્થઇ િકતુાં હોય, તો કોડિંગ 

િા માટે િીખવુાં નહીં? 

હાલના સમયમાાં આપણે કમ્પપ્યૂટર અને સ્માટષફોનનો ઉપયોગ કરી રહ્ાાં છીએ. સ્માટષફોન કે કમ્પપ્યૂટરમાાં 

વવવવધ કાયો કરવા માટે આપણે વવવવધ એપ્લીકેિન્સનો ઉપયોગ કરીએ છીએ. આ એપ્લીકેિનનુાં સજષન પણ 

વનયત કોિં દ્વારા ર્થયેલુાં હોય છે. આવી તમામ એપ્લીકેિન બનાવવા માટેના પ્રોગ્રામની રચના કરવા માટે વવવવધ 

કમ્પપ્યૂટર ભાર્ાઓનો ઉપયોગ ર્થાય છે. C, C++, C#, Java script, Visual Basic, Python, R language, FoxPro, 

HTML વગેરે આવી પ્રચવલત ભાર્ાઓ છે, જમેાાં વનયત કોિં લખીને કમ્પપ્યૂટર પ્રોગ્રામની રચના કરી િકાય છે. 

કોડિંગનુાં સરળ અને આધુવનક ગ્રાવફકલ સ્વરૂપ પણ હાલમાાં ઘણુાં પ્રચવલત બન્યુાં છે. આ સાંદભષમાાં કોડિંગ ભાર્ાને 

બે પ્રકારમાાં વવભાવજત કરી િકાય. (1) ટેક્ષ્ટ કોડિંગ અને (2) બ્લોક કોડિંગ. 

8.3.1 Text Coding (ટેક્ષ્ટ કોડિંગ) 

 આ પ્રકારના કોડિંગમાાં પ્રોગ્રામની રચના કરવા માટે લખવામાાં આવતી સૂચનાઓ ટેક્ષ્ટ કમાન્િં સ્વરૂપે 

હોય છે. તેમાાં વવવવધ કમાાંડ્સ તેના વનયત સ્વરૂપમાાં િબ્દો અને અાંકમાાં લખવાના હોય છે. C, C++, C#, Java 

script, Visual Basic, Python, R language, FoxPro, HTML જવેી કમ્પપ્યૂટર ભાર્ામાાં આ પ્રકારના કોડિંગ 

કમાન્િં લખવામાાં આવે છે. ઉદાહરણ તરીકે કમ્પપ્યૂટરમાાં દાખલ કરવામાાં આવતી બ ેસાંખ્યાઓનો સરવાળો કરવા 

તર્થા તેનો જવાબ આઉટપૂટ સ્વરૂપે મેળવવા માટે Foxpro કમ્પપ્યૂટર ભાર્ામાાં નીચ ેમુજબના કોિં લખાય છે. 

clear 

input “Enter A” to a 

input “Enter B” to b 

c=a+b 

? “Sum is”, c 
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તમે જ ેવેબસાઇટ જૂઓ છો તે પણ કોડિંગ દ્વારા રચાયેલ હોય છે. કોઇ એક વબેપેજના HTML ભાર્ામાાં 

લખાયેલા નમૂનારૂપ કોિં નીચે દિાષવ્યા છે.  

<!DOCTYPE html> 

<html class='v2' dir='ltr' xmlns='http://www.w3.org/1999/xhtml' 

xmlns:b='http://www.google.com/2005/gml/b' xmlns:data='http://www.google.com/2005/gml/data' 

xmlns:expr='http://www.google.com/2005/gml/expr'> 

<head> 

<link href='https://www.blogger.com/static/v1/widgets/2975350028-css_bundle_v2.css' 

rel='stylesheet' type='text/css'/> 

<meta content='width=1100' name='viewport'/> 

<meta content='text/html; charset=UTF-8' http-equiv='Content-Type'/> 

<meta content='blogger' name='generator'/> 

<link href='http://nileshchapaneri.blogspot.com/favicon.ico' rel='icon' type='image/x-icon'/> 

જુદી જુદી કમ્પપ્યૂટર ભાર્ામાાં લખાતા કોિંનુાં સ્વરૂપ જુદુાં જુદુાં હોય છે. તેર્થી, જ ેભાર્ામાાં કોડિંગ કરવુાં 

હોય તેના કમાન્િંના સ્વરૂપને સમજવુાં, િીખવુાં અને તાર્કકક ક્રમમાાં ગોઠવવુાં જરૂરી બને છે. 

8.3.2 Block Coding (બ્લોક કોડિંગ) 

 હાલ આ ખૂબ જ પ્રચવલત અને િીખવામાાં સરળ એવુાં કોડિંગ સ્વરૂપ છે. ટેક્ષ્ટ કોડિંગની જમે અહીં કોઇ 

કમાન્િં યાદ રાખવા પિંતા નર્થી કે ટેક્ષ્ટ સ્વરૂપમાાં લખવા પિંતા નર્થી. તેમાાં તૈયાર કોડિંગ બ્લોકને િંરેગ એન્િં 

િંર ોપ વક્રયાર્થી યોગ્ય તાર્કકક ક્રમમાાં ગોઠવી સમગ્ર પ્રવક્રયાની રચના કરવામાાં આવ ેછે. બ્લોક કોિંનો ઉપયોગ 

સોફ્ટવેર કોિં અર્થવા અલ્ગોરરધમને કોઈપણ ચોક્કસ સ્વરૂપમાાં રૂપાાંતરરત કરવા માટે ર્થાય છે, જરે્થી કોિંમાાં 

જો કોઈ ભૂલો હોય તો તેને ઘટાિંી િકાય. બ્લોક કોડિંગ એ બ્લોક આધારરત કોડિંગ કે વવઝ્યુઅલ કોડિંગ તરીકે 

પણ ઓળખાય છે.  

બ્લોક કોડિંગ બાળકો માટે પ્રોગ્રામમગને વધુ સરળ બનાવે છે. કોડિંગનો ઓછો અર્થવા કોઈ અનુભવ 

ન ધરાવતા બાળકો પણ બ્લોક કોડિંગ દ્વારા પ્રોગ્રામમગ કરી િકે છે. ટેક્ષ્ટ આધારરત પ્રોગ્રામમગ કરતાાં તે ઘણુાં 

સરળ છે અને કોડિંગમાાં ભૂલો ર્થવાની િક્યતા ઓછી હોય છે. બ્લોક કોડિંગ દ્વારા બાળકો સરળતાર્થી 

એવનમેિન કે િૈક્ષવણક ગેમ રચી િકે છે. વવર્યોની સાંકલ્પનાઓ સ્પષ્ટ્ કરવા આવી ગેમ ઘણી ઉપયોગી બની 

િકે છે.  

હાલમાાં ઇન્ટરનેટ પર એવી કેટલીક વેબસાઇટ તેમજ સોફ્ટવેર ઉપલબ્ધ છે, જમેાાં બ્લોક કોડિંગ દ્વારા 

પ્રોગ્રામ રચી વવવવધ એપ્લીકેિનનુાં વનમાષણ કરી િકાય છે. પ્રાર્થતમક કક્ષાના બાળકો પણ રસપૂવષક તે િીખી 

િકે છે અને નવુાં વનમાષણ કરી િકે છે. બ્લોક કોડિંગ વનમાષણ માટેનાાં આવા કેટલાાંક જાણીતા 

પ્લેટફોમષ/સોફ્ટવેરની યાદી નીચે આપેલી છે.  

• Code.org 
• Tynker 
• Scratch & Scratch Jr. 
• VEXcode VR 
• Birkly 
• Stencyl 
• Code for life 
• Game maker studio 
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મોટેભાગે દરેક પ્લેટફોમષમાાં બ્લોક કોડિંગ િીખવા માટેના ટ્યુટોરીયલ પણ ઉપલબ્ધ હોય છે. આ 

પ્લેટફોમષ કે સોફ્ટવેર પૈકી કેટલાાંક ઓપન સોસષ હોય છે, તો કેટલાાંકની ડકમત ચકૂવવી પિંતી હોય છે. જમે કે 

code.org  વેબસાઇટ કોડિંગ િીખવા માટેનુાં ઓપન સોસષ પ્લેટફોમષ છે, જ્યારે Scratch બ્લોક કોડિંગ માટેનુાં 

ઓનલાઇન પ્લેટફોમષ તેમજ ઓફલાઇન ઇન્સ્ટોલ ર્થઇ િકે તેવુાં સોફ્ટવેર છે. નીચ ેઆકૃતત 8.1 અને 8.2 માાં 

આ બાંને પ્લેટફોમષની વવન્િંોઝ દિાષવેલ છે. 

 
આકૃતત-8.1 Scratch Window 

 
આકૃતત-8.2 code.org Window 
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બ્લોક કોડિંગમાાં સામાન્ય વાતચીતની ભાર્ામાાં સમજી િકાય તેવા કમાન્િં ધરાવતા તૈયાર બ્લોકન ે

એકબીજા સાર્થ ેજોિંી પ્રોગ્રામ બનાવી િકાય છે. જુદા જુદા કાયો પ્રમાણ ેઅલગ-અલગ કેટેગરીમાાં વવભાજીત, 

ઘણાાં કોિં બ્લોક આપવામાાં આવેલા હોય છે. જનેે િંરેગ એન્િં િંર ોપ પ્રવક્રયાર્થી તાર્કકક રીત ેજોિંી કોઇ અર્થષપૂણષ 

પ્રોગ્રામ બનાવી િકાય છે અને કાયાષવન્વત કરી િકાય છે તેમજ સાંગ્રહ કરી િકાય છે. જમે કે, Scratch સોફ્ટવેરમાાં 

લખાયેલ નમૂનાનો એક પ્રોગ્રામ નીચે આકૃતત 8.3 માાં દિાષવેલ છે. 

  
આકૃતત - 8.3 

8.4 પ્રકરણ સાર 

રાષ્ટ્ર ીય વિક્ષણ નીતત-2020માાં બાળકોમાાં કોડિંગ દ્વારા વવવવધ કૌિલ્યોના વવકાસની રહમાયત કરવામાાં 

આવી છે. પ્રાર્થતમક વિક્ષણની િરૂઆતર્થી જ બાળકોને કોડિંગ િીખવી િકાય છે અને બાળકો સારી રીતે િીખી 

િકે છે. અહીં કોડિંગ વવિનેો માત્ર પ્રારાં ભભક પરરચય રજૂ કરવામાાં આવેલ છે. રદક્ષા પ્લેટફોમષ પર પણ કોડિંગ 

િીખવા માટે કોર્ષ ઉપલબ્ધ બનિે. આ ઉપરાાંત ઓનલાઇન પ્લેટફોમષ પર પણ કોડિંગ િીખવા માટેના વવવવધ 

વનિઃિૂલ્ક કોસષ ઉપલબ્ધ છે. આવા કોસષમાાં જોિંાઇ વવિેર્ અભ્યાસ કરી વનપૂણતા કેળવી િકાય તેમ છે. 

 

 

સ્વાધ્યાય 

નીચનેા પ્રશ્નોના જવાબો આપો. 

1. કોડિંગ એટલે િુાં? 

2. કોડિંગની સાંકલ્પના વવગતે સમજાવો. 

3. કોડિંગનુાં મહત્વ જણાવો. 

4. કોડિંગના બે પ્રકારો જાણવો. 

5. ટેક્ષ્ટ કોડિંગ અને બ્લોક કોડિંગ વચ્ચેનો તફાવત જણાવો. 

6. ‘કોડિંગર્થી બાળકોમાાં સજષનાત્મકતાનો વવકાસ ર્થાય છે.’ વવધાન સમજાવો. 
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પ્રાયોગિક કાયય 
 

નોંધ : આ પ્રાયોગિક કાયયના પ્રકરણો માત્ર પ્રાયોગિક કાયય તરીકે જ શીખવવાના રહેશ.ે સદૈ્ાાંગતક કાયય તરીકે લખેખત 

પરીક્ષામાાં પ્રશ્ન પછૂવાના રહેશ ેનહીં.  
 

1. OpenOffice 
1.1 પ્રસ્ તાવનાાઃ 

Windows ઓપરેટીંિ ખસસ્ ટમમાાં વ્ યાવસાયયક તેમજ શૈક્ષયણક કે્ષત્રે યવયવધ હેતુઓ માટે Microsoft Office 

પેકેજનો ઉપયોિ થાય છે, જ ેપૈકી વર્ય , એક્સેલ અને પાવરપોઇન્ટનો અભ્યાસ તમે પ્રથમ વર્યમાાં કરી ચૂક્યા છો. 

માઇક્રોસોફ્ટ ઓયિસ મૂલ્યવર્ધધત સેવા છે. પરાં તુ તેના જવેુાં જ કાયય કરતુાં ઓપન સોસય પેકેજ, ઓપન ઓયિસ 

(OpenOffice) પણ હાલ ઉપલબ્ધ છે, જ ે મૂળભૂત રીતે Ubuntu ઓપરેટીંિ ખસસ્ ટમનો ભાિ છે. પરાં તુ તેનુાં 

Windows ઓપરેટટાંિ સીસ્ટમમાાં ચાલી શકે તેવુાં  સ્વરૂપ પણ ઉપલબ્ ધ બન્યુાં છે. OpenOffice પેકેજમાાં તેના સભ્ ય 

એવા Word Processor, Spread Sheet Application અને Presentation એપ્લીકેશન્સનો સમાવેશ થાય છે. 

સમયાાંતરે OpenOfficeના યવયવધ વર્યન પણ ઉપલબ્ ધ બન્ યા છે. ઓપન ઓયિસ પેકેજની ઘણી લાક્ષયણક્તાઓ 

ખૂબ જ ઉપયોિી છે, તેથી તેનો અભ્ યાસ પણ એટલો જ અિત્ યનો છે. પ્રસ્તુત પ્રક૨ણમાાં Windows ઓપરેટીંિ 

ખસસ્ ટમમાાં ચાલી શકે તેવા OpenOffice પેકેજના સભ્ યો એવા Word Processor, Spread Sheet અને 

Presentation સોફ્ટવેરના ઉપયોિ યવશેની ચચાય ક૨વામાાં આવી છે.    

ઉદે્દશો  

1. OpenOfficeની લાક્ષયણક્તાઓ જણાવી શકશે. 

2. OpenOfficeની યવયવધ એપ્ લીકેશન્ સનો પટરચય આપી શકશે. 

3. OpenOfficeની યવયવધ એપ્ લીકેશન્ સનો શૈક્ષયણક ઉપયોિ કરી શકશે. 

4. OpenOfficeની યવયવધ એપ્ લીકેશન્ સનો વહીવટી ઉપયોિ કરી શકશે. 

 

1.2 OpenOfficeની લાક્ષયણક્તાઓ 

1. OpenOffice પેકેજ યનાઃશુલ્ ક ઉપલબ્ ધ છે.  

2. OpenOffice પેકેજ યવયવધ ઓપરેટીંિ ખસસ્ ટમ માટે ઉપલબ્ ધ છે. 

3. OpenOffice પેકેજમાાં Microsoft Officeની બધી જ િાઇલ (.doc, .docx, .xls, .xlsx, .ppt, .pptx વિેરે) 

ખુલી શકે છે. 

4. OpenOffice પેકેજમાાં બનતી મૂળભૂત િાઇલ Microsoft Officeમાાં ખૂલતી નથી.  

5. OpenOffice પેકેજમાાં બનતી િાઇલ (.odt, .ods, .odp વગેર ેએક્ષ્ટેન્શન ધરાવ ેછે.) પરંતુ આ ફાઈલન ે

save as કરીન ે Microsoft Officeમાાં ખૂલી શકે તેવા સ્ વરૂપમાાં (.doc, .xls, .ppt, વિેરે) સાંગ્રહી શકાય છે. 

6. OpenOffice પેકેજમાાં મળતી એપ્ લીકેશન્ સની મેનુ ખસસ્ ટમ અને તેના યવકલ્ પો Microsoft Office પેકેજની 

એપ્ લીકેશન્ સના મેનુ યવકલ્ પો જવેા જ હોય છે.  
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7. Microsoft Office પેકેજની એપ્ લીકેશન્ સ કરતાાં OpenOffice પેકેજમાાં મળતી એપ્ લીકેશન્ સમાાં ઘણી વધ ુ

સુયવધાઓ જોવા મળે છે. 

8. ઓપન ઓયિસ પેકેજનુાં પોટેબલ વર્યન પણ ઉપલબ્ ધ છે જનેો કમ્‍ પ્ યૂટરમાાં ઇન્ સ્ ટોલ કયાય ખસવાય ઉપયોિ 

કરી શકાય છે.  

યવન્ર્ોર્ ઓપરેટટાંિ સીસ્ટમમાાં Open office શરૂ કરવા માટે સૌ પ્રથમ તેને ર્ાઉનલોર્ કરી ઇનસ્ટોલ કરવુાં 

પર્શે.  

1.3 Open office ર્ાઉનલોર્  

1. સૌ પ્રથમ ઈન્ટરનેટ વેબ બ્રાઉર્રમાાં િૂિલ સચય એન્ીનમાાં www.openoffice.org સચય કરો.  

 
Figure 1 

2. આકૃગત-2 મુજબ સચય રીર્લ્ટ જોવા મળશે. જમેાાં પ્રથમ સ્થાને Apache Open Office  વેબસાઈટ જોવા 

મળશે. 

 
Figure 2 
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3. પ્રથમ સ્થાને જોવા મળતી વેબસાઈટ Official Download- Apache Open Office પર યક્લક કરો. આકૃગત-

3 મુજબની યવન્ર્ો ખુલશે.  

   
Figure 3       Figure 4 

4. I want to download Apache Open office યવકલ્પ પર યક્લક કરો. આકૃગત-4 મુજબની યવન્ર્ો જોવા 

મળશે. 

5. જમેાાં windows (.EXE) યવકલ્પ પસાંદ કરો. ભાર્ામાાં English તથા ઓપન ઓયિસની અદ્યતન આવૃગતની 

પસાંદિી કરો. 

  
Figure 5       Figure 6 

6. અાંતે Download full installation પર યક્લક કરો. એટલ ે.exe file download ર્ાયલોિ બોક્ષ ખુલશે. Save 

File બટન પર યક્લક કરો. .Exe િાઇલ ર્ાઉનલોર્ થવા લાિશે. 

 
Figure 7 
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7. તમારા કમ્‍પ્યૂટરના ર્ાઉનલોર્ િોલ્ર્રમાાં એક .exe િાઇલ સાંિૃટહત થઇ હશે. જનેે Run કરવાથી 

ઇન્સ્ટોલેશન શરૂ થશે. આ જ રીતે www.libreoffice.org  વેબસાઈટ પરથી libreoffice આવગૃત પણ 

ર્ાઉનલોર્ થઇ શકશે.  

1.4 Open office Installation:  

ApacheOpenOffice.exe કે Libreoffice.exe િાઇલ ર્ાઉનલોર્ કયાય બાદ તેને ઇન્સ્ટોલ કરવા માટે નીચ ે

મુજબના પિલાાં મુજબ ઇનસ્ટોલ કરીશુાં.  

1. તમારા કમ્‍પ્યૂટરના ર્ાઉનલોર્ િોલ્ર્રમાાં ર્ાઉનલોર્ થયેલ Libreoffice.exe િાઈલ પર ર્બલ યક્લક કરો. 

 
Figure 8 

2. આકૃગત-9 મુજબ ર્ાયલોિ બોક્ષ ખુલશે. 

 
Figure 9 
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3. Yes બટન પર યક્લક કરો. આકૃગત-10 મુજબનુાં OpenOffice setup યવર્ાર્ય  શરૂ થશે. જમેાાં Next બટન 

પર યક્લક કરો. 

    
Figure 10        Figure 11 

4. આકૃગત-11 મુજબ ર્ાયલોિ બોક્ષ જોવા મળશે. Install બટન પર યક્લક કરો . 

5. યવર્ાર્યના દરેક પિલાાંમાાં Next બટન પર યક્લક કરી આિળ વધતા રહો. ઇન્સ્ટોલેશન પ્રયક્રયા શરૂ થઇ 

જશે. છેલ્લા પિલાાંમાાં Finish બટન પર યક્લક કરો. ઇન્સ્ટોલેશન પ્રયક્રયા પૂણય થશે અને રે્સ્કટોપ પર ઓપન 

ઓયિસ આઇકોન જોવા મળશે. તેને પર ર્બલ યક્લક કરો. આકૃગત-12 મુજબ ર્ાયલોિ બોક્ષ જોવા મળશે. 

  
Figure 12       Figure 13 

6. Finish બટન પર યક્લક કરો. ઓપન ઓયિસ શરૂ થતુાં જોવા મળશે અને આકૃગત-13 મુજબની યવન્ર્ો જોવા 

મળશે. અહીં જોવા મળતા જુદા જુદા યવકલ્પો પર યક્લક કરી જ ેતે એયપ્લકેશન શરૂ કરી શકાય છે. 

 

7. આપણે સૌ પ્રથમ Open office Text Documentનો અભ્યાસ કરીએ. Text Document શરૂ કરવા માટે 

ઉપરની આકૃગત-13 માાં જોવા મળતા Text Document યવકલ્પ પર યક્લક કરો. Text Document શરૂ 

થશે અને આકૃગત-1.1.1 મુજબની યવન્ર્ો જોવા મળશે. 
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1.1 OpenOffice Text Document 
Text Documentમાાં MS-Wordની જમે જ Title Bar, Menu Bar, Standard Toolbar, Formatting 

Toolbar, Drawing toolbar, Horizontal scrollbar, Vertical scrollbar વિેરે ઘટકોનો સમાવેશ થાય છે.  

Figure 1.1.1 

આકૃગત-1.1.1 માાં દશાયવ્યા મુજબ સૌથી ઉપર Title bar જોવા મળ ેછે. જમેાાં િાઇલનુાં નામ Untitled-1 

તથા Applicationનુાં નામ OpenOffice Writer જોવા મળશે. Title bar નીચે Menu bar આવેલો છે. જમેાાં File, 

Edit, View, Insert, Format, Table, Tools, Windows અને Help જવેા મેનુઓ આવેલા છે. આ દરેક મેનુના યવયવધ 

યવકલ્પોના ઉપયોિો અત્રે ટૂાંકમાાં દશાયવ્યા છે. 

ગમત્રો, પ્રથમ વર્યમાાં માઈક્રોસોફ્ટ ઓયિસના પ્રકરણમાાં મોટાભાિના મેનુ યવકલ્પોની ચચાય કરેલ છે, જનેે અહીં 

પુનરાવર્તતત ન કરતા આ તબકે્ક આપણને ઉપયોિી થાય તેવા કમાન્ર્નો ઉપયોિ ટૂાંકમાાં જોઇશુાં. આ માટે નીચનેા 

પિલાઓ અનુસરો. 

1. ઉપર જણાવ્યા મુજબ નવુાં ટેક્સ્ટ ર્ોક્યુમેન્ટ શરૂ કરો. 

2. આકૃગત-1.1.1 માાં દશાયવેલ Document Areaમાાં માઉસ વરે્ યક્લક કરી નીચે મુજબનો િકરો ટાઇપ કરો. 

Dr. A. P. J. Abdul Kalam 

Dr. A. P. J. Abdul Kalam was an Indian scientist and administrator who served as 

the 11th President of India from 2002 to 2007. Kalam was born and raised in Rameswaram, Tamil 

Nadu. Kalam was elected as the President of India in 2002, defeating Lakshmi Sahgal and was 

supported by both the Indian National Congress and the Bharatiya Janata Party, the major political 

parties of India. Kalam advocated plans to develop India into a developed nation by 2020 in his 

book India 2020. Kalam was our great scientist as well as good leader too.  

3. File → Save પર યક્લક કરો. – અથવા – Ctrl + S પ્રસે કરો. આકૃગત–1.1.2 મુજબનુાં Save As ર્ાયલોિ 

બોક્ષ જોવા મળશે.  
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Figure 1.1.2 

4. તેમાાં જોવા મળતા File Name બોક્ષમાાં યોગ્ય નામ આપો. (અહીં આપણા અભ્યાસ પૂરતુ kalam નામ 

આપો. 

5. જ ેલોકેશન પર ર્ોક્યુમેન્ટનો સાંગ્રહ કરવો હોય તે Location પસાંદ કરો. 

6. Save બટન પર યક્લક કરો.  

સાંગ્રહ થયેલી આ િાઇલનુાં એક્સટેન્ શન .odt હોય છે. આ પ્રકારની િાઇલ િક્ત OpenOfficeમાાં ખુલે છે, 

MS Wordમાાં ખુલતી નથી. જ્યારે MS Wordની િાઇલ (.doc કે .docx) OpenOfficeના Text Documentમાાં ખુલે 

છે. 

7. હવે આ િાઇલને અન્ય લોકેશન પર કે અન્ય નામે Save કરીએ. તે માટે File → Save As પર યક્લક કરો. 

આકૃગત–1.1.2 મુજબનુાં ર્ાયલોિ બોક્ષ જોવા મળશે. તેમાાં બીજુ નામ આપો અથવા અન્ય લોકેશન પસાંદ 

કરો. (Save as પરથી િાઇલનો પ્રકાર પણ બદલી શકાય છે. અહીં .odt ને બદલે .doc સ્ વરૂપમાાં પણ 

િાઇલનો સાંગ્રહ થઇ શકશે, જ ેMS-Wordમાાં ખુલી શકશે.)   

8. Save બટન પર યક્લક કરો. આ િાઇલ નવા નામથી/બીજા લોકેશન પર/અન્ ય િોમેટમાાં save થશે. 

Export as PDF 

ગમત્રો, હવે તમારે તમારી બનાવેલી િાઇલ અન્ય જગ્યાએ મોકલવી છે. તે માટે તમારે તેને PDF (Portable 

Document Format) સ્વરૂપમાાં િેરવવી છે. કારણ કે PDF િાઇલ મૂળભૂત િાઇલ કરતા ઘણી ઓછી જગ્યા રોકે છે. 
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વળી, તેમાાં િોન્ટનો કોઇ પ્રશ્ન રહેતો નથી. આથી તે વધુ પ્રચયલત બનેલ છે. PDF સ્વરૂપની િાઇલ Acrobat Reader 

અથવા PDF િાઇલ વાાંચી શકતા અન્ય કોઇપણ સોફ્ટવેર દ્વારા વાાંચી શકાય છે. આવી િાઇલ સેલિોનમાાં પણ 

વાાંચી શકાય છે. Document િાઇલને PDF સ્વરૂપે િેરવવા માટે નીચેના પિલાઓ અનુસરો. 

1. File → Export as PDF પર યક્લક કરો. આકૃગત–1.1.3 મુજબનુાં ર્ાયલોિ બોક્ષ ખલુશે. 

 
Figure 1.1.3 

2. જરૂટરયાત મુજબના યવકલ્પો પસાંદ કરી Export Button પર યક્લક કરો.  

3. પસાંદ કરેલ જગ્યાએ આ િાઇલ .Pdf તરીકે સેવ કરી શકાશે.   

Print  

હવે તમારી િાઇલમાાં રહેલા લખાણને ગપ્રન્ટ કરવા માટે નીચેના પિલાઓ અનુસરો. 

1. File → Page Preview પર યક્લક કરી પહેલા પેજનો Preview જોઇ લો. 

2. File → Print પર યક્લક કરો. અથવા Ctrl + P પ્રસે કરો. આકૃગત–1.1.4 મુજબનુાં Print ર્ાયલોિ બોક્ષ 

ખુલશે.  

 
Figure 1.1.4 
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3. તેમાાં Range and Copies યવભાિમાાં All pages, Pages કે Selection  પૈકી યોગ્ય યવકલ્પ પસાંદ કરો. OK 

બટન પ્રેસ કરો. એકથી વધારે કોપી કાઢવા માટે Number of copies બોક્ષમાાં કોપીની સાંખ્યા આપો. 

4. તમારા અધ્ યાપક પાસેથી અહીં જોવા મળતા  Collate ચેકબોક્ષનો ઉપયોિ જાણો. 

િાઇલ બાંધ કરવીાઃ   

ઓપન કરેલી િાઇલને બાંધ કરવા માટે નીચેના પિાલાઓ અનુસરો.  

1. File → Close પર યક્લક કરો અથવા Ctrl + F4 અથવા Alt + F + C બટન પ્રેસ કરો.  

2. જ ેિાઇલ ખુલી હશે તે જ માત્ર બાંધ થશે. Word Processor Application શરૂ રહેશે. 

િાઇલ ઓપન કરવીાઃ  

ગમત્રો આપણે File Menuના ઉપયોિી કમાન્ ્ સ જોયા. હવે કેટલાક અન્ય કમાન્ ્ સનો ઉપયોિ સમજવા 

માટે અિાઉ બનાવવામાાં આવેલી િાઇલ kalam.odt ને ઓપન કરવા માટે  નીચનેા પિલાઓ અનુસરો.  

1. File → Open અથવા Ctrl + O બટન પ્રેસ કરો. આકૃગત-1.1.5 મુજબનુાં Open ર્ાયલોિ બોક્ષ ખુલશે. 

 
Figure 1.1.5 

2. તેમાાં તમે જ ેલોકેશન પર િાઇલ save કરી હોય તે લોકેશન પરથી િાઇલ પસાંદ કરો.  

3. Open બટન પર યક્લક કરો. િાઇલ ખુલી જશે. 

4. આ િાઇલની બધી Text ખસલેક્ટ કરવા માટે Edit → Select All અથવા Ctrl + A બટન પ્રસે કરો. 

ર્ોક્યુમેન્ટની બધી જ text ખસલેક્ટ થશે. (માટહતી કીબોર્યથી સીલેક્ટ કરવા Shift+Arrow keyનો ઉપયોિ 

કરવો. માટહતી Mouseથી સીલેક્ટ કરવા માટે માઉસ બટન દબાવી રાખીને માઉસ ર્રેિ કરવુાં.) 

5. Edit → Copy અથવા Ctrl + C બટન પ્રેસ કરો. 

6. Textની નીચે યક્લક કરો. Edit → Paste અથવા Ctrl + V બટન પ્રેસ કરો.  

7. પસાંદ કરેલી માટહતી બીી વાર લખાયેલી જોવા મળશે. (ખસલેક્ટ કરેલ માટહતીને એક જગ્ યાએથી Copy 

કરી અન્ય જગ્યાએ િરી લખવા માટે આ કમાન્ ર્ વપરાય છે.) 

8. હવે Ctrl+Z અથવા Edit → Undo પ્રેસ કરો. િરી િાઇલ મૂળ સ્વરૂપે જોવા મળશે. (છેલ્ લે કરેલ કાયયને રદ 

કરવા માટે આ કમાન્ ર્ વપરાય છે.) 
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9. હવે Ctrl+Y અથવા Edit → Redo પ્રેસ કરો. િાઇલ િરી પિલા-7 ના સ્વરૂપમાાં આવશે. (Undo દ્વારા રદ 

કરેલ કાયયને િરી લાવવા માટે આ કમાન્ ર્ વપરાય છે.) 

તમે Copy & Paste નો ઉપયોિ જોયો હવે આપણે Cut & Paste નો ઉપયોિ જોઇએ. 

1. િાઇલમાાં ટાઇપ કરેલા િિરાની પહેલી બે લીટી ખસલેક્ટ કરો.  

2. Edit → Cut અથવા Ctrl + X બટન પ્રેસ કરો 

3. Text ની નીચ ેયક્લક કરો. Edit → Paste અથવા Ctrl + V બટન પ્રેસ કરો.  

4. પસાંદ કરેલી માટહતી મૂળ સ્થાનેથી move થઇ બીજા સ્થાને ખસેલી જોવા મળશે. (ખસલેક્ટ કરેલ માટહતીન ે

એક જગ્ યાએથી ખસેર્ી અન્ય જગ્યાએ મુકવા માટે આ કમાન્ ર્ વપરાય છે.) 

5. મૂળ યસ્થગતમાાં પાછા િરવા માટે શુાં કરશો. ? 

Find & Replace 

Find & Replace Command ર્ોક્યુમેન્ટમાાં કોઇ અક્ષર, શબ્દ, વાક્ય કે અાંકો શોધવા માટે તથા તેને 

Replace કરી તેને બદલે અન્ય યવિત લખવા માટે થાય છે. આ માટે નીચેના પિલાઓ અનુસરો.  

1. Edit → Find & Replace પર યક્લક કરો. અથવા Ctrl + F બટન પ્રેસ કરો. આકૃગત-1.1.6 મુજબ Find & 

Replace ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.1.6 

2. Search for ટેક્સ્ટ બોક્ષમાાં Kalam ટાઇપ કરો. 

3. Find બટન પ્રેસ કરો. પહેલો Kalam શબ્દ હાઇલાઇટ થશે. વારાંવાર આ બટન પ્રસે કરતા એક પછી એક 

શબ્દ હાઇલાઇટ થતા જશે. 

4. Find All બટન પ્રસે કરતા આખા ર્ોક્યુમેન્ટમાાં એક સાથે બધા જ Kalam શબ્દ હાઇલાઇટ થશે. 

5. Replace With બોક્ષમાાં Dr. Kalam ટાઇપ કરો અને Replace All બટન પ્રસે કરો. જથેી આખા ર્ોક્યુમેન્ટમાાં 

Kalam ના સ્થાને Dr. Kalam લખાઇ જશે. આખા ર્ોક્યુમેન્ટમાાં એક સાથે સધુારો કરવા માટે આ ખૂબ જ 

ઉપયોિી સવલત છે.  
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ગમત્રો આપણે Text documentની ઘણી સવલતો સમજ્યા. હવ ે આ ર્ોક્યુમને્ટમાાં કેટલીક અન્ય યવિતો 

ઉમેરતા શીખીએ. સૌ પ્રથમ આપણે ખચત્ર ઉમેરીએ. આ માટે નીચેના પિલા અનુસરો. 

1. Insert → Picture → From File પર યક્લક કરો. આકૃગત–1.1.7 મુજબ Insert Picture ર્ાયલોિ બોક્ષ 

ખુલશે. 

 
Figure 1.1.7 

2. તમારા કમ્‍પ્યૂટરમાાં જ્યાાં કોઇ ખચત્ર રહેલુાં હોય તે લોકેશન પસાંદ કરો.  

3. Open બટન પ્રેસ કરો. 

4. જ્યાાં કસયર હોય ત્યાાં Picture દાખલ થઇ જશે. 

5. આ Picture પર યક્લક કરો. Format ટૂલ બાર જોવા મળશે. તેના યવકલ્પોનો ઉપયોિ કરી જુદી જુદી રીતે 

ગપક્ચર િોમેટ કરી શકાશે. આ માટે Format મેનુના યવકલ્પોનો પણ ઉપયોિ કરી શકાય છે.  

ર્ોક્યુમેન્ટની text કે ખચત્રોને અન્ય કોઇ િાઇલ સાથે જોર્ી શકાય છે. જનેે આપણે હાઇપરલલક તરીકે 

ઓળખીએ છીએ. હવે આપણે હાઇપરલલક કરતા શીખીશુાં. તે માટે નીચેના પિલાઓ અનુસરો. 

1. અિાઉ લખેલા િકરામાાંથી Dr. A. P. J. Abdul Kalam ખસલેક્ટ કરો.  

2. Insert → Hyperlink પર યક્લક કરો. Hyperlink ર્ાયલોિ બોક્ષ ખુલશે. તેમાાં Document આઇકોન 

પર યક્લક કરતા આકૃગત–1.1.8 મુજબ ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.1.8 
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3. Path ટેક્સ્ટ બોક્ષની સામ ેઆવેલા Open file આઇકોન પર યક્લક કરો. જથેી Open ર્ાયલોિ બોક્ષ 

ખૂલશે. 

4. તેમાાંથી જ ેિાઇલને લલક કરવી છે તે િાઇલનો path ખસલેક્ટ કરો. Open બટન પર યક્લક કરો. Apply 

બટન પર યક્લક કરો. Close બટન પર યક્લક કરો. પસાંદ કરેલી િાઇલ લલક થયેલી જોવા મળશે. 

ર્ોક્યુમેન્ટમાાં લખાયેલી ટેક્સ્ટને યવયવધ રીતે િોમેટ કરી શકાય છે. આ માટે Format મેનુના યવયવધ 

યવકલ્પો ઉપયોિી બનશે. Format મેનુના યવયવધ કમાન્્સના ઉપયોિો આ મુજબ છે.  

Character :  

તેમાાં Font બદલવા, તેની સ્ટાઇલ બદલવા કે તેની સાઇર્ બદલવા માટેના યવયવધ યવકલ્પો મળ ેછે. Format → 

Character પર યક્લક કરતા આકૃગત–1.1.9 મુજબ ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.1.9 

Paragraph : 

  
Figure 1.1.10 
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પેરેગ્રાિમાાં Indents, Line Spacing, Text Alignment, Text border, Drop cap વિેરેની િોઠવણી કરવા 

માટે આ યવકલ્પ ઉપયોિી છે. Format → Paragraph પર યક્લક કરતા આકૃગત-1.1.10 મુજબ ર્ાયલોિ બોક્ષ 

જોવા મળશે.  

Indents and Spacing ટેબના યવકલ્પો વરે્ ર્ોક્યુમેન્ ટમાાં લખાયેલ ટેક્સ્ટ પહેલાાં કે ટેક્સ્ટ પછી ઇન્ રે્ન્ ટ મૂકી શકાય 

છે તેમજ બે િકરા વચ્ ચે જગ્ યા તેમજ બે લાઇન વચ્ ચે જગ્ યા મૂકી શકાય છે. 

Alignment ટેબના યવકલ્પો વરે્ Textને Left, Right, Center એલાઇનમેન્ ટ અને Justified કરી શકાય છે. 

Outline & Numbering ટેબના યવકલ્પો વરે્ પેરેગ્રાિને જુદા જુદા પ્રકારના bullets અને numbering આપી શકાય 

છે. 

Drop Caps ટેબના યવકલ્પો વરે્ paragraphનો પ્રથમ અક્ષર મોટો કરવો હોય તો કરી શકાય છે.  

Border ટેબના યવકલ્પો વરે્ જુદી જુદી Page Border, Color, Line Style વિેરે આપી શકાય છે. 

Table 

હવ ેઆપણ ેર્ોક્યમુને્ટમાાં ટેબલ ઉમરેતા શીખીશુાં. આ માટે નીચનેા પિલા અનસુરો. 

1. મેનુબારમાાંથી Table → Insert → Table પર યક્લક કરો. અથવા Ctrl + F12 પ્રસે કરો. આકૃગત-1.1.11 

મુજબનુાં Insert table ર્ાયલોિ બોક્ષ ખુલશે..   

 
Figure 1.1.11 

2. Name બોક્ષમાાં ટેબલનુાં નામ આપો. કોલમની અને રૉ ની સાંખ્યા (6 x 5) આપો. OK બટન પ્રેસ કરો. તમ ે

આપેલા િોમેટ મુજબનુાં ટેબલ તેમજ Table ટૂલબાર જોવા મળશે. ટેબલમાાં આ મજુબની માટહતી દાખલ કરો. 

No. Name Science Maths English Total 

1 Nilesh 90 94 95  

2 Ketan 67 65 61  

3 Rakesh 71 70 69  

4 Dharmesh 65 68 71  
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3. ‘Total’ કોલમમાાં પહેલા સલેમાાં યક્લક કરો. Table ટૂલબારમાાં ખસગ્મા  બટન પર યક્લક કરો. આપમેળ ે

સરવાળો થઇ જશે. 

4. તે જ પ્રમાણે અન્ય હરોળ માટે પણ આ પ્રયક્રયા કરી જુઓ. તિાવતની નોંધ કરો. 

ગમત્રો હવે તમારે આ ટેબલમાાં વધુ રૉ (હરોળ) કે કોલમ (સ્તાંભ) ઉમેરવાની જરૂટરયાત ઉભી થાય તો તે કાયય 

પણ થઇ શકશે. 

1. ટેબલના છેલ્લા ખાના (સેલ)માાં કસયર મૂકી કી બોર્યમાાંથી Tab કી પ્રેસ કરતા છેલ્લે નવી હરોળ ઉમેરાશે. 

2. વચ્ચે નવી હરોળ ઉમેરવી હોય તો ટેબલમાાં કોઇ સેલમાાં કસયર મૂકી Table (મેનુ) → Insert → Rows પર 

યક્લક કરતા Insert Row ર્ાયલોિ બોક્ષ ખુલશે. 

3. તેમાાં જટેલી રો ઉમેરવી હોય તે સાંખ્યા તથા એક્ટીવ સેલની નીચે કે ઉપર ઉમેરવી છે તે યવકલ્પ પસાંદ કરો. 

OK બટન પ્રેસ કરો. નવી રૉ ઉમેરાઇ જશે. 

4. આ જ પ્રમાણે નવી કોલમ Table (મેનુ) → Insert → Columns મુજબ ઉમેરી શકાશે.  

આ જ રીતે તમારે આ ટેબલમાાંથી રો (હરોળ) કે કોલમ (સ્તાંભ) દૂર કરવાની જરૂટરયાત ઉભી થાય તો તે કાયય 

પણ થઇ શકે છે. આ માટે નીચેના પિલાઓ અનુસરો. 

1. જ ેરો/કોલમ દૂર કરવી છે તે ખસલેક્ટ કરો. 

2. Table (મેનુ) → Delete → Rows/Columns પર યક્લક કરો. 

આ ઉપરાાંત Table મેનુના નીચે મુજબના અન્ય યવકલ્પો પણ ઉપયોિી બનશે.  

• Merge Cells : ટેબલમાાં ખાનાઓ મજય (ભેિા) કરવા માટે  

• Split cell : મજય કરેલા ટેબલમાાં ખાનાઓ છૂટા પાર્વા માટે. 

• Split Table : ટેબલના ભાિ પાર્વા માટે.  

OpenOfficeના અન્ય મેનુઓ પણ ટૂાંકમાાં ઓળખી લઇએ. 

Window Menu : 

Windows મેનુમાાં New Window અને Close Window એમ બ ેપ્રકારના યવકલ્પો હોય છે તથા Recently 

જ ેઓપન િાઇલ હોય તે િાઇલનુાં નામ/Untitled-1 દશાયવે છે.  

Help Menu : 

Help મેનુ એ ઉપયોિકતાયને જરૂરી મદદ પૂરી પારે્ છે.  
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પ્રાયોગિક કાયય 

1. Word Processor શરૂ કરી એક િકરો ટાઇપ કરો અને તેમાાં નીચે મુજબના િેરિાર કરો. 

• પેરેગ્રાિની કોઇપણ લાઇનને Bold, Itallic કરો તેમજ Underline કરો. 

• િોન્ ટ સાઇર્ 16 કરો. 

• પેરેગ્રાિની પહેલી લાઇન Copy કરી પેરેગ્રાિની નીચે Paste કરો. 

• િોન્ ટનો કલર લાલ કરો. 

• બે લાઇન વચ્ ચેનુાં 1.5 કરો. 

• પેરેગ્રાિને Justified Alignment આપો. 

2. Word Processor માાં નીચ ેમુજબનુાં એક ટેબલ બનાવી કોઇપણ પાાંચ યવદ્યાથીના સાત યવર્યના િુણ 

દાખલ કરી તેનો સરવાળો અને તેની સરેરાશ (Mean) શોધો. 

Name 
Marks Obtained 

Total Mean 
Gujarati Maths Science Hindi English S.S. Sanskrit 
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1.2  OpenOffice.org SpreadSheet 
OpenOffice SpreadSheet એ Microsoft Excel જવેુાં જ કાયય કરતુાં તથા થોર્ી વધારે યવશેર્તા ધરાવતુાં 

ઉપયોિી સોિટવેર છે. SpreadSheetમાાં ટેબલ જવેુાં format જોવા મળે છે. તેમાાં જોવા મળતા Row (રૉ) અને 

Column (કોલમ)માાં જરૂરી માટહતી દાખલ કરી જરૂટરયાત મુજબ રે્ટા ટેબલ (રે્ટાબેર્) બનાવી શકાય છે.તમેજ 

તેના પર યવયવધ પ્રયક્રયા કરી કાયય સરળ બનાવી શકાય છે. 

OpenOffice.org SpreadSheet માાં રહેલ સયુવધાઓ 

• જરૂટરયાત મુજબ નવી SpreadSheet બનાવી શકાય છે અને તેનો સાંગ્રહ કરી શકાય છે. સાંગ્રહ કરેલ 

SpreadSheet ને જરૂટરયાત મુજબ િરીથી ખોલી શકાય છે અને તેમાાં સધુારા વધારા કરી શકાય છે. 

• બનાવેલ SpreadSheetની યોગ્ ય સ્ વરૂપમાાં ગપ્રન્ ટ લઇ શકાય છે. 

• દાખલ કરેલી માટહતી પર યવયવધ પ્રકારના function વરે્ યવયવધ પ્રયક્રયા થઇ શકે છે. જુદા જુદા functions 

માટે Help પણ મળ ેછે. 

• દાખલ કરેલી માટહતીને ક્રમમાાં િોઠવી શકાય છે તેમજ માટહતીને filter કરી શકાય છે. 

• આ સોિટવેર આપમેળે ઉપયોિકતાયના data ને અનુલક્ષીને graphic series નક્કી કરી આપે છે. આ 

સવલત MS-Excelમાાં જોવા મળતી નથી. 

• SpreadSheetને સીધી જ Pdf તરીકે રૂપાાંતટરત કરી શકાય છે. 

Spread Sheetમાાં કાયય કરવુાં 

ગમત્રો, ચાલો હવે આપણે OpenOffice SpreadSheet શરૂ કરી તેનો અભ્ યાસ કરીએ. આ નીચેના પિલા 

અનુસરીએ.. 

1. રે્સ્કટોપ પરના OpenOffice આઇકોન પર ર્બલ યક્લક કરો. ઉપરની આકૃગત-13 માાં જોવા મળતા 

Spreadsheet યવકલ્પ પર યક્લક કરો. Spreadsheet શરૂ થશે અને આકૃગત-1.2.1 મુજબની યવન્ર્ો જોવા 

મળશે. 

 
Figure 1.2.1 
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આકૃગત 1.2.1 માાં જોવા મળતા મુખ્ય ભાિને આપણે સ્પ્રેર્શીટ કે વકયશીટ કહીશુાં. 

આ વકયશીટમાાં OpenOffice Text Document ના યવયવધ ઘટકો જવેા જ ઘટકો ટાઇટલબાર, મેનુ બાર, 

સ્ ટાન્ ર્ર્ય  ટૂલબાર, િોમેટટાંિ બાર, િોમ્‍ યુયલા બાર, કોલમ હેલર્િ, રો હેલર્િ, શીટ ટેબ વિેરે જોવા મળે છે. કેટલાાંક નવા 

ઘટકો પણ જોવા મળે છે. જનેે આપણે ઓળખીએ. 

Formula bar : 

    Formating ટૂલ બારની નીચે િોમ્‍ યુયલા બાર જોવા મળે છે. જ ેત્રણ ભાિમાાં વહેંચાયેલ છે. ર્ાબી બાજુનો 

ભાિ reference area કે Name box તરીકે ઓળખાય  છે. જમેાાં Active Cellનુાં એર્રેસ જોવા મળે છે. Formula 

barના વચ્ ચેના ભાિમાાં function Wizardનુાં બટન છે. તેના પરથી function દાખલ કરી શકાય છે. જમણી 

બાજુનો ભાિ Active cellમાાં રહેલી માટહતી દશાયવે છે. 

Row/Column Headings : 

વકયશીટમાાં આવેલ કોલમને A,B,C,D . . . . હેર્ીંિ આપેલા છે. જનેે કોલમ હેર્ીંિ કહેવાય છે. જયારે દરેક 

Rowની ઓળખ માટે ર્ાબી બાજુ 1, 2, 3, 4….. વિેરે નાંબર આપેલા છે. જનેે રો હેર્ીંિ કહેવાય  છે. 

Column :  

          Column ને A,B,C,D . . . . .આલ્ િાબેટ વરે્ દશાયવાય છે. એક વકયશીટમાાં 1024 કોલમ  હોય છે. છેલ્ લી  કોલમ 

AMJ પર જવા માટે Ctrl +  (Right  arrow key) press કરવી પરે્. તમે પહેલી કોલમ પર કઇ કી પ્રસે કરશો? ………... 

Row :  

         દરેક Row ને 1, 2, 3, 4, …. નાંબરથી દશાયવાય છે. એક વકયશીટમાાં કુલ 1048576 (1024 x 1024) રો  હોય 

છે. છેલ્ લી Row પર જવા માટે   Ctrl +  (down arrow key) press કરવી પરે્. પહેલી row પર જવા માટે કઇ Key 

Press કરશો?તમે પહેલી row પર જવા માટે કઇ કી પ્રસે કરશો ? .............................. 

SpreadSheet   

Row અને Column થી બનતા ખાનાવાળા પત્રક, કે જમેાાં કાયય કરવાનુાં છે તે વચ્ચનેા ભાિને સ્પ્રેર્ શીટ કે 

વકય  શીટ તરીકે પણ ઓળખવામાાં આવે છે. તેમાાં રૉ અને કોલમના આાંતરછેદનથી બનતા નાના ખાનાઓ જોવા 

મળે છે. એક વકયબકુમાાં default રીત ેત્રણ શીટ જોવા મળે છે. જરૂટરયાત મુજબ નવી શીટ ઉમેરી કે દૂર કરી 
શકાય છે. 

Cell : 

       Row અને Column ના આાંતરછેદથી બનતા ખાનાને Cell કહે છે. દરેક Cellનુાં ચોક્કસ એર્રેસ હોય છે. દા.ત. 

A1 જયાાં A કોલમનુાં અને 1 Rowનુાં હેર્ીંિ દશાયવે છે. 

Sheet Tab : 

વકયશીટમાાં નીચેના ભાિમાાં Sheet1, Sheet2, Sheet3, ….. લખેલ જોવા મળ ેછે. જનેે Sheet tab કહે છે. 

જ ેતે tab પર યક્લક કરતાાં તે શીટ કાયયરત થશે. 

OpenOffice Spread sheet માાં કાયય કરવુાં : 

SpreadSheet માાં File, Edit, View, Insert, Format, Data, Tools, Windows, Help જવેા મેનુ જોવા મળ ે

છે. તેના મોટા ભાિના યવકલ્પોનો ઉપયોિ Word Processorના મેનુાં યવકલ્ પોના જવેો છે. કેટલાક યવકલ્ પો જુદા 

પરે્ છે, જનેો ઉપયોિ આપણે આિળ જોઇશુાં. અહીં આપણે જ ેમેનુ યવકલ્પો આિળ શીખી િયા છીએ તેનુાં 

પુનરાવતયન નહીં કરીએ. 

File Menu 

Print (ctrl  + P) 
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આ કમાાંર્ની મદદથી તમે બનાવેલી વકયશીટની ગપ્રન્ ટ લઇ શકાય છે. આ માટે file → print યવકલ્ પ પસાંદ 

કરો. આકૃગત-1.2.2 મુજબનુાં Print ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.2.2 

જમેાાં Print યવભાિમાાંથી યોગ્ ય યવકલ્ પ પસાંદ કરી એક્ટીવ શીટ, પસાંદ કરેલી શીટ, પસાંદ કરેલ સેલ કે 

આખી વકયબૂક ગપ્રન્ ટ કરી શકાય છે.  

Edit Menu 

Edit Menu માાં cut, copy, paste, find, replace, changes, fill, delete વિેરે જવેા યવકલ્ પો જોવા મળે છે. 

જમેાાંના કેટલાક નવા યવકલ્ પોના ઉપયોિો જોઇશુાં.  

Changes 

Edit menu ના આ યવકલ્ પની મદદથી એક્ટીવ શીટમાાં કરેલા િેરિાર highlight થાય છે. જ ેટરેક દ્વારા દશાયવાય છે.  

Fill 

Edit Menu ના આ યવકલ્ પની મદદથી સેલમાાં રે્ટા આપમેળે િીલ કરી શકાય છે, તેમજ રે્ટા સીરીજ પણ િીલ કરી 

શકાય છે. આવી સીરીજ બનાવવા માટે નીચેના પિલા અનુસરો. 

1. સૌ પ્રથમ એક સેલમાાં રે્ટા ટાઇપ કરો. 

2. જટેલા સેલમાાં સીરીર્ િીલ કરવાની છે તે સેલ ખસલેક્ટ કરો.  

3. Edit → Fill → Series પસાંદ કરો. જથેી આકૃગત-1.2.3 પ્રમાણે ર્ાયલોિ બોક્ષ જોવા મળશે.  
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Figure 1.2.3 

 4. Series type માાંથી જ ેપ્રમાણેની સીરીર્ િીલ કરવી હોય તે પ્રમાણે યોગ્ ય યવકલ્ પ પસાંદ કરો. 

5. Start Value, End Value અને Increment ની લકમતો દાખલ કરો. 

6. OK બટન પ્રેસ કરો, પસાંદ કરેલ સેલમાાં પસાંદિી મુજબની સીરીર્ િીલ થશે. 

તમારી પ્રિગત ચકાસો  

1. આ યવકલ્ પનો (Fill નો) ઉપયોિ કરી એક સેલમાાં ''Sunday" ટાઇપ કરી આખા અઠવાર્ીયાના બધા વારના 

નામ આપમેળે દાખલ કરો. 

2. આ યવકલ્ પનો ઉપયોિ કરી એક સેલમાાં ''January" ટાઇપ કરી આખા વર્યના મટહનાના નામ આપમેળ ે

દાખલ કરો. 

Delete Contents 

આ યવકલ્ પની મદદથી સલેમાાં રહેલી માટહતી દૂર કરી શકાય છે. Edit → Delete Content પર યક્લક કરો. 

આકૃગત-2.17  મુજબનુાં ર્ાયલોિ બોક્ષ મળશે. જ ેયવિત દૂર કરવી છે તે ચેક બોક્ષ પસાંદ કરો. અને OK બટન 

પ્રેસ કરો. પસાંદ કરેલા યવકલ્ પ મુજબની યવિત દૂર થશે.  

 
Figure 1.2.4 
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Delete Cells  

આ યવકલ્ પની મદદથી પસાંદ કરેલ સેલ, રો અથવા કોલમ દૂર કરી શકાય છે. 

View Menu 

Page Break Preview:  Edit → Page Break Preview યવકલ્ પ પસાંદ કરતા એકટીવ વકયશીટમાાં જટેલા સલેમાાં 

માટહતી ભરાયેલી હશે તેનો જ view જોવા મળશે તથા તેનુાં setting પણ કરી શકાશે.  

Zoom:  View → Zoom યવકલ્ પ પસાંદ કરતા આ યવકલ્પની મદદથી સ્ક્રીન પર જોવા મળતી વકયશીટ નાની મોટી 

સાઇર્માાં જોઇ શકાય છે. આ રીતે વકયશીટને ઓછામાાં ઓછી 20% અને વધુમાાં વધુ 400% zoom કરી શકાય છે. 

Insert Menu :  
Manual Break 

વકયશીટમાાં Column અથવા Row ને Manual Break આપી શકાય છે. તેનો ઉપયોિ ગપ્રન્ટીંિ માટે પેજને 

અલિ પર્વા માટે કરવા માટે કરવામાાં આવે છે.  

1. વકયશીટમાાં જયાાં Column અથવા Row ને Break  કરવો છે તે Cell  પર cursor લઇ જવુાં.  

2. Insert → Manual Break → Row Break અથવા Column Break પસાંદ કરો. વકયશીટમાાં જયાાં Break 

આપ્ યો હશે ત્ યાાં Blue line જોવા મળશે.  

3. જ્યાાંથી break આપ્યો છે તે સેલમાાં કસયર મૂકી Edit → Delet manual Break પર યક્લક કરવાથી 

Row/Column break દૂર થઇ જશે. 

Cell :  

Insert menu ના આ કમાન્ ર્ની મદદથી વકયશીટમાાં Row, Column, કે Cell ઉમેરી શકાય છે.  

• Row, Column, કે Cell ઉમરેવા માટે સેલ પર યક્લક કરો.  

• Insert → cell પર યક્લક કરો. Insert cell dialog box (આકૃગત- 2.18) ખુલશે.  

 
Figure 1.2.5 

• યોગ્ય યવકલ્પ પસાંદ કરો. તે મુજબ Row, Column, કે Cell ઉમેરાશે.  

Rows : 

           આ યવકલ્પ/કમાન્ ર્ની મદદથી નવી Rows ઉમરેી શકાય છે. 

Column: 

           આ યવકલ્પ/કમાન્ ર્ની મદદથી નવી column ઉમેરી શકાય છે. 
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યવચારો : 

1. નવી Row કઇ બાજુ ઉમેરાય છે ? તે ચકાસો.  ............................. 

2. નવી Column કઇ બાજુ ઉમરેાય છે ? તે ચકાસો.  ............................. 

3. Insert → Row યવકલ્પની મદદથી એક નવી row ઉમરેતા આ વકયશીટમાાં કુલ કેટલી row થશે ? 

4. Insert → column યવકલ્પથી એક નવી column ઉમેરતા આ વકયશીટમાાં કુલ કેટલી column થશે ?  

 

Functions 

Insert menuના આ યવકલ્પની મદદથી સેલમાાં પૂવય યનધાયટરત થયેલ િાંકશન દાખલ કરી િણતરી કરી શકાય 

છે. Excelમાાં Mathematical, Logical, Stastical જવેી યવયવધ કેટિરી હેઠળ યવયવધ િાંકશન્સ જોવા મળે છે. જનેી 

મદદથી િાયણગતક, તાર્ધકક કે અાંકશાસ્ત્રીય િણતરી કરી શકાય છે.  

ગમત્રો, યવયવધ િાંકશનોમાાંથી કેટલાક િાંકશન કે જનેો ઉપયોિ રોજબરોજના શાળાકીય કાયયમાાં કરવાનો હોય 

તેનો પટરચય મેળવીએ. આ માટે સૌ પ્રથમ નીચે મુજબની એક વકયશીટ તૈયાર કરીએ. 

 A B C D E F G 

1 No. Name Maths Science English Total Average 

2 1 Nilesh 82 63 95 240 80 

3 2 Manisha 52 63 77 192 64 

4 3 Nitya 78 87 90 255 85 

5 4 Sanket 77 72 82 231 77 

6 5 Diya 87 86 85 258 86 

Table 1.2.1 

1. ટેબલ 1.2.1 માાં દશાયવ્યા મજુબ વકયશીટમાાં માટહતી દાખલ કરો.  

2. જ ેસેલમાાં પટરણામ મેળવવુાં છે, તેના પર યક્લક કરો. 

3. Insert → Function પર યક્લક કરો. જથેી િાંકશન યવર્ાર્ય  શરૂ થશે. આકૃગત-1.2.6 મુજબનુાં ર્ાયલોિ બોક્ષ 

જોવા મળશે. 

 
Figure 1.2.6 
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4. Category લીસ્ટમાાંથી યોગ્ય કેટેિરી પસાંદ કરો, Function લીસ્ટમાાંથી જરૂરી િાંકશન (Average) પસાંદ કરો. 

Next બટન પ્રેસ કરો. આકૃગત-1.2.7  મુજબ ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.2.7 

5. Value બોક્ષમાાં અાંકો/સેલ એર્રેસ/સેલ રેન્જ દાખલ કરો. અને OK બટન પ્રેસ કરો. એક્ટીવ સેલમાાં 

પટરણામ જોવા મળશે. 

આ રીતે દરેક િાંકશન દાખલ કરી શકાય છે. િાંકશન મુજબ દાખલ કરવાની યવિતો જુદી જુદી હોઇ શકે છે 

પણ તેના પિલાઓ સમાન છે. િોમ્‍યુયલા બારના fx આઇકોન પર યક્લક કરીને પણ આ રીતે િાંકશન દાખલ 

કરી શકાય છે. દરેક િાંકશનની શરૂઆત = સાંકેતથી જ થાય છે. કેટલાક ઉદાહરણો અત્રે પ્રસ્તુત છે. 

1. AVERAGE : પસાંદ કરેલ સલેની લકમતોની સરેરાશ મેળવવા માટે આ િાંકશનનો ઉપયોિ થાય છે. 

• સતૂ્ર : =AVERAGE (number 1;  number 2; ……..)  અથવા =AVERAGE (cell range) 

 દા.ત.  =AVERAGE (11, 12, 13) અથવા =AVERAGE (A1 : A5) 

ઉદાહરણ : 

ટેબલ-1.2.1 માાં બનાવેલ sheetમાાં પહેલી રૉ (row)માાં રહેલા રે્ટાની સરેરાશ લકમત શોઘવી છે.  

સેલ G2 માાં સેલ C1 થી E1માાં રહેલા અાંકોની સરેરાશ મળેવવા નીચેના પિલાઓ અનુસરો. 

1. સેલ G2 પર યક્લક કરો. 

2. =AVERAGE (C1:E1) ટાઇપ કરો. 

3. એન્ટર કી દબાવો. 
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 સેલ G2 માાં પટરણામ 80 આવશે. આ સેલને drag કરી બાકીના સેલમાાં સમાન િાંકશન દાખલ કરી 

શકાશે. 

અથવા  

1. સેલ G2 પર યક્લક કરો. 

2. Insert → Function → (Catagogy) Statistical → (Functions) Average પસાંદ કરો. (આકૃગત-

1.2.7) 

3. Next બટન પ્રેસ કરો. આકૃગત-1.2.8 મુજબનુાં ર્ાયલોિ બોક્ષ મળશે. 

 
Figure 1.2.8 

4. સેલ રેન્જ દાખલ કરો. OK બટન દબાવો. 

 સેલ G2 માાં પટરણામ 80 આવશે. આ સેલને drag કરી બાકીના સેલમાાં સમાન િાંકશન દાખલ કરી 

શકાશે. 

2. SUM : પસાંદ કરેલ સેલની લકમતોનો સરવાળો મેળવવા માટે આ િાંકશનનો ઉપયોિ થાય છે. 

• સતૂ્ર : =Sum(number 1;  number 2; ……..)  અથવા =Sum(cell range) 

 દા.ત.  =Sum(11, 12, 13) અથવા  =Sum(C3 : E3) 

3. Maximum : 

આ િાંકશનની મદદથી પસાંદ કરેલ cell rangeમાાં જ ેસાંખ્યાઓ આપવામાાં આવી હોય તે સાંખ્યાઓમાાંથી 

સૌથી મોટી સાંખ્યા એટલે કે Maximum લકમત શોધે છે. 

• સતૂ્ર : =Max(number 1;  number 2; ……..)  અથવા =Max(cell range) 

 દા.ત.  =Max(11, 12, 13) અથવા  =Max(C3 : E3) 

4. Minimum : 

આ િાંકશનની મદદથી પસાંદ કરેલ cell rangeમાાં જ ેસાંખ્યાઓ આપવામાાં આવી હોય તે સાંખ્યાઓમાાંથી 

સૌથી નાની સાંખ્યા એટલે કે Minimum લકમત શોધે છે. 
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• સતૂ્ર : =Min(number 1;  number 2; ……..)  અથવા =Min(cell range) 

 દા.ત.  =Min(11, 12, 13) અથવા =Min(C3 : E3) 

5. SQRT : 

આ  િાંકશનથી આપેલ Number/પસાંદ કરેલ સેલમાાંની સાંખ્ યાનુાં ધન વિયમૂળ મળશે. 

• સતૂ્ર : =Sqrt(number)  અથવા =Sqrt(cell address) 

 દા.ત.  =Sqrt(25) અથવા  =Sqrt(C3) 

6. IF  Function :  

  આ Functionનો ઉપયોિ તાર્ધકક ચકાસણી (logical test) કરવા માટે થાય છે. આ ખૂબ જ ઉપયોિી એવુાં 

િાંકશન છે.   

• સતૂ્ર : =If(Test; Then_value; otherwise_value) 

જ્યાાં Test એ કોઇ પણ શરતી યવધાન (conditional Expression) હશે, જ ેસાચુાં (True) અથવા ખોટુાં  (False) 

પર્ી શકે. Then_Value તરીકે આપેલ લકમત / ટેક્સ્ટ પટરણામ તરીકે ત્યારે દશાયવશે જયારે logical_test સાચો 

હશે. Otherwise_Value તરીકે આપેલ લકમત / ટેક્સ્ટ પટરણામ તરીકે ત્યારે દશાયવશે જયારે logical_test ખોટો 

હશે.  

દા.ત. =If(A1>5; 100; “Too Small”) 

અહીં આપેલ Cell A1માાંની લકમત જો 5 કરતાાં વધ ુ હશે તો logical test સાચી પર્શે અને 100 

(Then_value) display થશે. એટલે કે જવાબમાાં 100 દશાયવશે. પરાં તુ  A1 માાં લકમત 5 કરતાાં ઓછી હશે તો  

logical_test ખોટી પર્શે અને આ કારણે  પટરણામમાાં “Too Small” મળશે. 

Chart : 

આ યવકલ્પની મદદથી વકયશીટમાાં ચાટય  બનાવી શકાય છે. આ માટે નીચેના પિલાાં અનુસરો.  

1. Insert → Chart પસાંદ કરતા અથવા સ્ટાન્ર્ર્ય  ટૂલ બારમાાંથી ચાટય  બટન પર યક્લક કરો. આકૃગત-1.2.9 

મુજબ ચાટય  યવર્ાર્ય  શરૂ થશે.  

 
Figure 1.2.9 
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2. Choose Chart Type બોક્ષમાાંથી રે્ટાના સાંદભયમાાં જરૂટરયાત મુજબનો ચાટય  પસાંદ કરો. (બાજુના preview 

બોક્ષમાાં તેનુાં ખચત્ર જોવા મળશે.) Next બટન પ્રેસ કરો. આકૃગત-1.2.10 મુજબનુાં ર્ાયલોિ બોક્ષ જોવા 

મળશે. 

 
Figure 1.2.10 

3. Data range બોક્ષમાાં સેલ રેન્જ દાખલ કરો અથવા વકયશીટના રે્ટા સીલેક્ટ કરો. Next બટન પ્રેસ કરો. 

આકૃગત-1.2.11 મુજબનુાં ર્ાયલોિ બોક્ષ જોવા મળશે. 

 
Figure 1.2.11 

4. જરૂરી યવિતો દાખલ કરો. Next બટન પ્રેસ કરો. આકૃગત-1.2.12 મુજબનુાં ર્ાયલોિ બોક્ષ જોવા મળશે. 
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Figure 1.2.12 

5. અહીં Title, Subtitle, Grid, Legend વિેરે સેટીંગ્સ કરો. Finish બટન દબાવો. તમારી યવિતોની પસાંદિી 

અનુસારનો આલેખ તૈયાર થઇ જશે. 

Fomat Menu 

Default Formatting: આ યવકલ્પની મદદથી વકયશીટમાાં કરેલ િેરિારો (િોમેટીંિ) દૂર થઇ જાય છે અને મૂળભૂત 

સેટીંિ પાછુાં  મેળવી શકાય છે. 

Cell: આ યવકલ્પની મદદથી વકયશીટમાાં પસાંદ કરેલ સેલ માટે Alignment, Number, Fonts, Background, 

Borders, cell protection વિેરે બાબતોનુાં Setting થઇ શકે છે. 

Row/Column: આ યવકલ્પની મદદથી રો/કોલમની Height/Width બદલી શકાય છે. તેમજ રો/કોલમ hide કે 

show કરી શકાય છે.  

Sheet: આ યવકલ્પની મદદથી select કરેલ શીટનુાં નામ બદલી શકાય છે. તેમજ શીટ hide કે show કરી શકાય 

છે. 

Merge Cell: આ યવકલ્પની મદદથી પસાંદ કરેલ સેલને merge (ભેિા) કરી શકાય છે. મજય થયેલ સેલને પાછા 

છુટા પાર્ી શકાય છે. આ પ્રયક્રયા િોમેટીંિના ટૂલ બારમાાંના Merge Cells બટનથી પણ થઇ શકે છે. 

Data Menu 

Sort: આ યવકલ્પની મદદથી વકયશીટમાાં બનાવેલ ટેબલની માટહતીને કોઇ કોલમના સાંદભયમાાં ચર્તા કે ઉતરતા 

ક્રમમાાં િોઠવી શકાય છે. 

Exercise 

1. વકયશીટમાાં નીચે મુજબનુાં ટેબલ બનાવો. યોગ્ય િોમુયલાનો ઉપયોિ કરી ટેબલ પૂણય કરો.  

SR. 

NO. 
NAME 

SUBJECT MARK 

OBT. 

PER 

OBT. 

Min Max 

GUJ HINDI ENG 

1. Nilesh 75 85 70 230    

2. Manisha 70 60 80 210    

3. Nitya 80 80 70 230    



106 

 

2. વકયશીટમાાં નીચે મુજબનુાં ટેબલ બનાવો અને Percentage તથા Averageની િણતરી કરો.  

SR. NO. 
NAME 

SUBJECT MARK 

OBT. 

PERCENTAGE 

 

AVERAGE 

GUJ HINDI ENG 

1. Rakesh 45 46 47    

2. Minal 42 43 45    

3. Sanket 43 46 48    

4. Yashvi 44 41 45    

 

3. વકયશીટમાાં નીચે મુજબનુાં ટેબલ બનાવો અને યોગ્ ય ગ્રાિ બનાવો.  

SR. NO. 
NAME 

SUBJECT MARK 

OBT. 

PERCENTAGE 

 

AVERAGE 

GUJ HINDI ENG 

1. Ketan 45 46 47    

2. Aarti 42 43 45    

3. Rutvik 43 46 48    

4. Diya 41 42 45    

4. નીચેના રે્ટા સ્પ્રેર્શીટમાાં એન્ટ૨ કરી િોમુયલાનો ઉપયોિ કરી ટેબલ પૂણય કરો. 

SR. NO. 
NAME GUJ HINDI ENG 

MARK 

OBT. 

PER 

OBT. 

1. Falguni  75 85 70 230  

2. Dharmesh 70 60 80 210  

3. Vedansh  80 80 70 230  

4. Priyanshu 78 84 81 243  

• NAME ને ચર્તા ક્રમમાાં િોઠવો, NAME ને ઉતરતા ક્રમમાાં િોઠવો. 

• Hindi ચર્તા ક્રમમાાં િોઠવો. 

• Mark Obt. ને ચર્તા ક્રમમાાં િોઠવો. 

• Per Obt, ને ચર્તા ક્રમમાાં િોઠવો. 

5. નીચે મુજબની સ્પ્રેર્શીટ બનાવી તમારા સ્ટાિના પિારબીલની િણતરી િોમ્‍યુયલા મકૂી કરો.  
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1.3   OpenOffice Presentation  
OpenOffice Presentation એ Microsoft PowerPointની સમકક્ષનુાં અને તેથી વધુ યવશેર્તા ધરાવતુાં ખુબ 

જ સહેલાઈથી ઉ૫યોિમાાં લઈ શકાય તેવુાં OpenOffice નુાં પ્રેર્ન્ટેશન સોફ્ટવેર છે. OpenOffice ના યવયવધ વર્યન 

ઉપલબ્ધ છે. નવા વર્યનમાાં તેને Impress (ઇમ્‍પ્રેસ) તરીકે પણ ઓળખવામાાં આવે છે. આ સોફ્ટવેરમાાં શૈક્ષયણક 

કે વ્યાવસાયયક સ્લાઇર્ શો તૈયાર કરી શકાય છે. સ્લાઇર્ શો બનાવવા માટે ચાટય , ખચત્રો, લખાણ, ભૌગમગતક 

આકારો, મલ્ટીમીયર્યા જવેા ઘણા બધા માધ્યમોનો ઉ૫યોિ કરી શકાય છે. OpenOffice Presentation સોફ્ટવેરમાાં 

Microsoft PowerPointની િાઇલ ખોલી શકાય છે અને તેમાાં સુધારો પણ કરી શકાય છે. પ્રેર્ન્ટેશનને વધુ આકર્યક 

બનાવવા માટે સ્લાઇર્ શોમાાં એનીમેશન તથા સ્લાઇર્ ટર ાન્ર્ીશન ઇિેક્ટ ઉમરેી શકાય છે અને પ્રેર્ન્ટેશન 

અસરકારક બનાવી શકાય છે. 

OpenOffice Presentation ની યવશરે્તાઓ અન ેઉ૫યોિોાઃ 

• OpenOffice Presentation અલિ અલિ view તેમજ pages દશાયવે છે. જનેી મદદથી presentation 

design કેવી લાિે છે તેમજ modification આ૫તાાં view કેવા લાિશે તે ૫ણ thumbnail form અથવા 

Handout pageમાાં જોવા મળશે. 

• Rehearse timingની મદદથી presentationનો Slide Show જોવા મળી શકે છે. જ ે ઓયિસોમાાં, 

સેમીનારમાાં, ગમટીંિોમાાં, પ્રદશયનો વિેરેમાાં મોટા પ્રમાણમાાં જોવા મળે છે. 

• Presentationની સ્ લાઇર્ને સ્ ક્રીન પર, હેન્ ર્આઉટ તરીકે કે HTML ર્ોક્યુમેટ સ્વરૂપે પયબ્લશ કરી શકાય 

છે. 

• Presentation ઉપયોિકતાય સાંચાયલત અથવા સ્ વયાં સાંચાયલત એમ બાંને રીત ેદશાયવી શકાય છે. 

• OpenOffice Presentationમાાં રે્ટાને આલેખ સ્ વરૂપમાાં ૫ણ દશાયવી શકાય છે. જનેી વાાંચન સરળ બને છે. 

Presentation શરૂ ક૨વાની રીત :  

1. રે્સ્કટોપ પરના OpenOffice આઇકોન પર ર્બલ યક્લક કરો. હવે જ ેડાયલોગ બોક્ષ ખુલે તેમાાં જોવા 

મળતા Presentation યવકલ્પ પર યક્લક કરો. Presentation શરૂ થશે અને આકૃગત-1.3.1 મુજબનુાં 

ર્ાયલોિ બોક્ષ જોવા મળશે. જમેાાં પ્રેર્ન્ટેશનનાાં યવયવધ પ્રકા૨ જોવા મળશે. જ ેપૈકી કોઇ એક યવકલ્પ 

પસાંદ કરી શકાય છે. 

 
Figure 1.3.1 
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પ્રરે્ન્ટેશનનાાં પ્રકા૨ (Presentation Type) : 

▪ Empty Presentation :  

આ યવકલ્પનો ઉપયોિ નવુાં Blank presentation બનાવવા માટે થાય છે. આ યવકલ્પ પસાંદ ક૨તાાં જ 

Presentation Wizard ખુલશે. ક્રમશાઃ તેના પિલાઓ પ્રમાણે આિળ વધતા અને યોગ્ય યવકલ્પો (બકેગ્રાઉન્ર્, 

સ્લાઇર્ ટર ાન્સીશન ઇિેક્ટ) પસાંદ કરતા જઇએ તેમ ચોક્કસ ર્ીર્ાઇનવાળુાં એક સ્લાઇર્નુાં પ્રેર્ન્ટેશન તૈયાર થશે. 

તેમાાં યોગ્ય િેરિારો કરી એક અસરકારક પ્રેર્ન્ટેશન બનાવી શકાય છે.  

▪ From Template : 

From Template ક૨તાાં જ Presentation Wizard (Introducing a New Product) ખુલશે. ક્રમશાઃ તેના 

પિલાઓ પ્રમાણે આિળ વધતા અને યોગ્ય યવકલ્પો (બેકગ્રાઉન્ર્, સ્લાઇર્ ટર ાન્સીશન ઇિેક્ટ) પસાંદ કરતા જઇએ 

તેમ ચોક્કસ યવર્ય પરનુાં એક યનશ્વિત યવિતો સાથેનુાં તૈયાર પ્રેર્ન્ટેશન મળશે. તેમાાં યોગ્ય િેરિારો અને સધુારા 

વધારા કરી એક અસરકારક પ્રેર્ન્ટેશન બનાવી શકાય છે.  

▪ Open Existing Presentation : 

અિાઉ બનાવેલ પ્રેર્ન્ટેશનને open ક૨વા માટે આ યવકલ્પ દશાયવેલ છે. જયાાં Open Existing 

Presentation → Open યક્લક ક૨તાાં યોગ્ય path પસાંદ કરી અિાઉ બનાવેલ પ્રેર્ન્ટેશનને જોઇ શકાય છે. 

Empty Presentation પસાંદિી પૂણય કરતાાં આકૃગત-1.3.2 મુજબ Presentation window જોવા મળશે. 

તેમાાં જોવા મળતા યવયવધ ઘટકો આકૃગતમાાં દશાયવેલ છે. 

 

 

 
Figure 1.3.2 

Title Bar Menu Bar Slide Task Pane 
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o line & Filling :  

સ્ટાન્ર્ર્ય  ટૂલબારની નીચે Line & Filling ટૂલબાર જોવા મળશે. જમેાાં Line, Line style & Formatting, Line 

width, Line colour, Area, Area style, filling shadow જવેા toolsનો સમાવેશ થાય છે. 

o Presentation : 

આ ટૂલબાર એ સ્ટાન્ર્ર્ય  ટૂલબારની બાજુમાાં જોવા મળશે. જમેાાં slide design, slide show જવેા tools જોવા 

મળે છે. 

o Task pane : 

Normal Viewમાાં સ્ક્રીનની જમણી બાજુ જોવા મળતી Taskpane window માાં master pages, custom 

animation, slide transition, slides માટેના layouts જવેા યવકલ્પો જોવા મળ ેછે. 

▪ Master pagesમાાં used in this presentation, recently used, available for use જવેા તૈયાર સ્લાઇર્ 

ર્ીર્ાઇન મેળવવા માટેના યવકલ્પો જોવા મળે છે. 

▪ Layouts માાં અલિ અલિ પ્રકા૨ની સ્લાઇર્ માટેના 25 layouts દશાયવેલ છે. જ ે layout પસાંદ ક૨વામાાં 

આવે તે layout પ્રમાણ ેslide બનશે. અલિ અલિ slides માટે અલિ અલિ layout પણ પસાંદ કરી શકાય 

છે.  

▪ Table Design યવકલ્પની મદદથી જુદા જુદા િોમેટવાળા જરૂટરયાત મુજબના ટેબલ્સ સ્લાઇર્માાં ઉમેરી 

શકાય છે. 

o Slide pane : 

▪ સ્ક્રીનની ર્ાબી બાજુ જોવા મળતી Slides Paneમાાં Thumbnail સ્વરૂપમાાં current slides નો view જોવા 

મળશે. 

o Drawing Toolbar :  

સ્ક્રીનમાાં સ્લાઇર્ની નીચે આવેલો ટૂલબાર Drawing toolbar છે. જમેાાં drawing માટેના Tool જવેા કે  Lines, 

Line with Aroow (Arrow line),  rectangle, ellipse, connector, Basic shape, callouts…etc જવેા ઘણા બધા 

tools જોવા મળ ેછે. 

➢ Slide ના અલિ-અલિ View : 

• Normal  

Normal viewમાાં slide સામાન્ય રીત ે 33% જટેલી જોવા મળે છે. સાથ ે Slides paneમાાં બનાવેલી 

સ્લાઇ્સનો Thumbnail view જોવા મળ ેછે. 

• Outline View 

Outline Viewમાાં બનાવેલ તમામ સ્લાઇ્સ listing પ્રમાણે આવે છે. સાથે slides Paneમાાં Thumbnail 

view ૫ણ જોવા મળશે. આ viewમાાં સ્લાઇર્ની ટાઇટલ ટેક્સ્ટ સ્લાઇર્ ખોલ્યા વિર જ દાખલ કરી શકાય છે. 

• Notes: 

Slides યવશેની નોંધ લખવા માટે આ viewમાાં અલિથી notes (નોંધ)નો યવભાિ દશાયવેલ છે. જમેાાં દરેક 

સ્ લાઇર્ માટે અલિ નોંધ લખી શકાય છે. 

• Handout : 

આ Viewમાાં header, footer, date/times, page no., Area વિેરે જોવા મળ ે છે. Handoutમાાં slideનુાં 

outlook (દેખાવ) જોવા મળે છે. 

• Slide Sorter : 
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Slide Sorter viewની મદદથી બનાવેલ તમામ slides એક સાથે એક પેજમાાં thumbnail સ્વરૂપે જોવા મળ ે

છે. આ ઉપરાાંત સ્લાઇર્માાં આપેલ એનીમેશન, timing વિેરેની યવિતોનો ખ્ યાલ આવે છે. Slide sorter viewની 

મદદથી સ્લાઇર્ના ક્રમ સ૨ળતાથી બદલી શકાય છે.  

OpenOffice Presentation Window નો પ્રારાં ભભક પટરચય તો તમે મેળવ્યો. હવે તમે તૈયા૨ હશો તમારાં  

પ્રથમ પ્રેર્ન્ટેશન બનાવવા માટે. તો ચાલો, આ૫ણે જુદા જુદા પ્રકા૨ની સ્લાઈ્સ તૈયા૨ કરીન ે પ્રેર્ન્ટેશન 

બનાવતા શીખીએ. ઉદાહ૨ણ માટે આ૫ણ ે‘યવજ્ઞાન’ યવર્યના મુદ્દો ‘આહા૨ અને આરોગ્ય’ લઈશુાં. 

 

પ્રથમ સ્લાઈર્ બનાવવી 

પ્રથમ સ્લાઈર્ બનાવવા માટે નીચેનાાં પિલાઓ અનુસરોાઃ 

1. OpenOffice Presentation (પ્રેર્ન્ટેશન) શરૂ કરો. પ્રરે્ન્ટેશન શરૂ થતા Slide areaમાાં Blank Slide જોવા 

મળશે. જુઓ આકૃગત–1.3.2 

2. બાજુની ટાસ્કપેનમાાંથી Slide Layoutમાાંથી બીજા ક્રમની સ્ લાઇર્ (Title Slide) પસાંદ કરો. 

3. Title Slideમાાં ટાઈટલ ઉમે૨વા માટે ‘Click and add title’ ૫૨ યક્લક કરો . 

4. તમને તે box માાં કસય૨ જોવા મળશે. ત્યાાં “ યવર્ય : યવજ્ઞાન ” ટાઈ૫ કરો . 

5. હવ ેsub title ઉમે૨વા માટે ‘Click to add Text’ લખેલ બોક્ષ ૫૨ યક્લક કરો . 

6. તે બોક્ષમાાં તમને કસય૨ જોવા મળશે. ત્યાાં “આહા૨ અને આરોગ્ય” ટાઈ૫ કરો . 

7. બોક્ષની બહા૨ િમે ત્યાાં યક્લક કરો . 

અહીં તમારી ૫હેલી સ્લાઈર્ જોવા માટે તયૈા૨ થઈ િઈ. કેટલુાં સ૨ળ છે. તો, ચાલો િરી એક નવી Slide 

બનાવવાનો પ્રયત્ન કરીએ. 

નવી Slide બનાવવી 

જમે OpenOffice word processor માાં Page હોય તેમ OpenOffice Presentationમાાં Slide હોય છે. નવી 

Slide ઉમે૨વા માટે નીચેના પિલાઓ ઘ્યાનમાાં રાખો.  

1. Insert મેનુમાાંથી Slide ખસલકે્ટ કરો. અથવા Presentation Toolbar માાંથી સ્લાઇર્ બટન પર યક્લક કરો. 

નવી સ્લાઇર્ ઉમેરાશે. તે ર્ાબી બાજુની Slide Paneમાાં હાઇલાઇટ થયેલી જોવા મળશે. તેનો Layout પહેલી 

સ્લાઇર્ જવેો જ હશે. 

2. જમણી બાજુ જોવા મળતા Task Pane → Slide Layout માાંથી Title, Text સ્લાઈર્ ખસલેક્ટ કરો. 

3. હવ ે‘Click to Add Title’ બોક્ષમાાં યક્લક કરી ત્યાાં “સમતોલ આહા૨” ટાઈ૫ કરો.  

4. ‘Click to add outline’ બોક્ષમાાં યક્લક કરી ત્યાાં “શરી૨ની જરૂટરયાત મુજબ યોગ્ય કેલરીયુકત સપ્રમાણ 

પોર્ક ઘટકો મળી ૨હે તેવા દૈયનક આહા૨ને સમતોલ આહા૨ કહે છે.” ટાઈ૫ કરો.  

5. Enter પ્રેસ કરો.  

6. ત્યાાં તમને બીજુાં Bullet જોવા મળશે. 

7. ત્યાાં “કાબોટદત, પ્રોટીન, ચ૨બી, યવટામીન, ખયનજ દ્રવ્યો પોર્ક ઘટકો છે.” ટાઈ૫ કરો.  

8. બોક્ષની બહા૨ િમે ત્યાાં યક્લક કરો. 

જુઓ કેટલી સ૨ળતાથી તમારી બીી સ્લાઈર્ તૈયા૨ થઈ િઈ. 

ટેબલવાળી સ્લાઈર્ તયૈા૨ ક૨વી. 



111 

 

 હવ ેએક નવી સ્લાઈર્ બનાવીએ, જમેાાં “પોર્ક ઘટકો, અને તેની જરૂટરયાત” ટેબલ મૂકીએ. આ માટે નીચ ે

મુજબના પિલાઓ ઘ્યાનમાાં રાખો.  

1. ‘Title Only’ layout સાથે નવી સ્લાઈર્ બનાવો.  

2. તેમાાં ‘Click to Add Title’ બોક્ષમાાં યક્લક કરી ત્યાાં “પોર્ક ઘટકો, અને તેની જરૂટરયાત” ટાઈ૫ કરો.  

3. હવે Insert → Table પર યક્લક કરો અથવા સ્ટાન્ર્ર્ય  ટૂલબારના Table આઇકોન/બટન પર યક્લક કરો. 

આકૃગત-1.3.3 મુજબનુાં Insert Table ર્ાયલોિ બોક્ષ જોવા મળશે.  

 
Figure 1.3.3 

4. જમેાાં જરૂટરયાત મુજબ Column અને Row ની સાંખ્યા આપો. (આ સ્લાઈર્ માટે 2 Column અને 6 Row 

આપો.) 

5. Ok બટન પ્રેસ કરો. 

6. જથેી નીચે મુજબની સ્લાઈર્ જોવા મળશે. સાથોસાથ Table ટૂલબાર પણ જોવા મળશે. તેના યવયવધ 

ટૂલ્સની મદદથી દાખલ કરેલ ટેબલની Properties બદલી શકાય છે.  

  
Figure 1.3.4 

1. આ સ્લાઈર્માાં ‘Click to add title’ ૫૨ યક્લક કરી ‘પોર્ક ઘટકોની જરૂટરયાત’ ટાઈ૫ કરો. 

2. ટેબલની ૫હેલી Row અને ૫હેલી Column માાં યક્લક કરો. ત્યાાં કસય૨ જોવા મળશે. 

3. તેમાાં ‘પોર્ક ઘટકો’ ટાઈ૫ કરો. 

4. Tab કી પ્રેસ કરી બીી કોલમમાાં આવો તેમાાં ‘જરૂટરયાત’ ટાઈ૫ કરો. 
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5. Tab કી પ્રેસ કરી અન્ ય Row અને Columnમાાં આકૃગત-1.3.5 મુજબની યવિતો ટાઈ૫ કરો. (એરો કી વરે્ 

૫ણ કસય૨નુાં સ્થાન બદલી શકાય છે.) 

 
Figure 1.3.5 

આમ, ટેબલવાળી સ્લાઈર્ તયૈા૨ થશે. આ ઉ૫રાાંત Word processor કે Spreadsheet બનાવેલુાં ટેબલ ૫ણ 

સીધુાં સ્લાઈર્માાં લઈ શકાય. જ ેમાટે નીચેના પિલાઓ ઘ્યાનમાાં રાખો.  

1. Inser → Slide → Blank Slide ૫સાંદ કરો. 

2. Word processor ના જ ેDocumentમાાં કે Spreadsheetમાાંથી ટેબલ લેવુાં છે તે Open કરો. 

3. ટેબલ ખસલેક્ટ કરી કોપી કરો. 

4. Presentationમાાં પાછા આવી જાવ. (Alt+Tab કીનો ઉ૫યોિ જાણો છે?) 

5. Presentationની સ્લાઈર્માાં Edit → Paste કરો. 

6. જરૂટરયાત મુજબ ટેબલને drag કરી Resize કરો.  

Picture સાથેની Slide બનાવવી. 

ચાલો, હવ ેતમને મનિમતા Picture/Clipartવાળી સ્લાઈર્ બનાવીએ. આ Slide બનાવવા માટે નીચેના 

પિલાઓ ઘ્યાનમાાં રાખો.  

1. Title and 4 content લે-આઉટ સાથે નવી સ્લાઈર્ બનાવો. 

2. નવી સ્લાઈર્ આકૃગત-1.3.6 મુજબ જોવા મળશે. 

3. Click to add title ૫૨ યક્લક કરી “કાબોટદતના સ્રોત” ટાઈ૫ કરો. 

4. દરેક પ્લેસ હોલ્ર્રમાાં કે જ્યાાં ‘Click to add Text’ લખેલુાં છે, તેમાાં નીચે જોવા મળતા Inser Picture 

આઈકોન ૫૨ યક્લક કરો. (તમ ેInsert → Picture → From file ૫૨ યક્લક કરીન ે૫ણ Picture ઉમેરી શકો 

છો). આકૃગત 1.3.7 મુજબ Insert picture ર્ાયલોિ બોક્ષ જોવા મળશે. 
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Figure 1.3.6 

5. યોગ્ય Path પસાંદ કરી જરૂટરયાત મુજબનુાં ખચત્ર પસાંદ કરી Open બટન પ્રેસ કરતા પસાંદ કરેલુાં ખચત્ર 

સ્લાઈર્માાં ઉમેરાઈ જશે.  

6. આ જ પ્રમાણે એક પછી એક એમ ચાર ખચત્ર ઉમેરો. આમ, ચા૨ Picture ઈનસટય  ક૨તાાં તયૈાર થયેલી 

સ્લાઈર્ સ્ક્રીન ૫૨ જોવા મળશે. 

 
Figure 1.3.7 
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આ જ પ્રમાણ ેTools → Gallery પર યક્લક કરી િેલેરીમાાંથી પણ Drag & Drop દ્વારા ખચત્રો ઉમરેી શકાય 

છે. તમ ેઉમેરેલા ખચત્રની નીચે ૫ણ Drawing toolbar માાંથી Text box ઉમરેી અને લખાણ લખી શકો છો. તેમજ text 

box ની જમે જ Line, Rectangle વિેરે ટૂલ્સનો ઉ૫યોિ કરી ભૌગમગતક આકારો દોરી શકો  છો. આ માટે નીચેનાાં 

પિલાઓ અનુસરો.  

1. જો Drawing Toolbar ન જોવા મળતુાં હોય તો View → Toolbar → Drawing ૫૨ યક્લક ક૨તાાં આકૃગત-

1.3.8 મુજબ Drawing toolbar જોવા મળશે. તેમાાંથી Text આઇકોન પર યક્લક કરો. 

 
Figure 1.3.8 

2. માઉસથી સ્લાઈર્ ૫૨ જયાાં ટેક્સ્ટ લખવી છે ત્યાાં Drag કરી ટેક્સ્ટ બોક્ષ બનાવો. 

3. જરૂરી યવિત ટાઈ૫ કરો. 

4. આ જ રીત ેર્ર ોઈંિ ટૂલબા૨ના અન્ય ટૂલ્સનો ઉ૫યોિ કરી શકશો. 

સ્લાઈર્માાં ચાટય  ઉમે૨વા. 

સ્લાઈર્માાં ચાટય  ઉમે૨વા માટેના પિલાઓ પણ ઘણા સરળ છે. 

1. Insert → Slide માાંથી Title, Chart કે Title, Text, Chart લે-આઉટવાળી સ્લાઈર્ ૫સાંદ કરો. 

2. આકૃગત-1.3.9 મુજબની સ્ક્રીન જોવા મળશે. જમેાાં એક આલેખ બનેલો જ હશે. 

 
Figure 1.3.9 

 
Figure 1.3.10 
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3. આલેખમાાં જરૂરી િેરિાર કરવા માટે આલેખ પર ર્બલ યક્લક કરો. માત્ર આલેખ દશાયવતી એક જ સ્લાઇર્ 

જોવા મળશે.  

4. આ આલેખ પર કોઇપણ જગ્યાએ માઉસની રાઇટ યક્લક કરો. તેમાાં જોવા મળતા શોટયકટ મેનુમાાંથી Chart 

Data Table યવકલ્પ ૫ર યક્લક કરો. આકૃગત-1.3.11 મુજબ Data Table યવન્ર્ો ખૂલશે. જમેાાં રે્ટાશીટ 

જોવા મળશે. 

 
Figure 1.3.11 

5. આ રે્ટાશીટમાાં તમારી જરૂટરયાતની text તથા આાંકર્ાઓ મૂકો. જોવા મળતી સીરીર્માાં િેરિારો કરી શકાશે. 

જરૂટરયાત મુજબ િેરિારો આ યવન્ર્ોમાાંના આઇકોન્સની મદદથી કરો. તમને ચાટય  તૈયા૨ થયેલ જોવા મળશે.  

6. Data Table યવન્ર્ો બાંધ કરો. આલેખની બહારના ભાિમાાં કોઈ૫ણ જગ્યાએ યક્લક કરો. 

7. તમારી ચાટયવાળી Slide હવ ેતૈયા૨ છે.  

ચાટયમાાં ઘ્વયન (Sound) મૂકવો. 

તમ ેબનાવેલી કોઈ૫ણ સ્લાઈર્માાં કોઈ૫ણ અવાજ, સ્પીચ કે િીત ઉમેરી શકાય છે. જ ેસ્લાઇર્ શો વખત ે

સાાંભળવા મળે છે. સ્લાઇર્માાં સાઉન્ર્ ઉમે૨વા માટે નીચેના પિલા ઘ્યાનમાાં રાખો.  

1. Insert મેનુ → Movies and Sounds ૫૨ યક્લક કરો. તથેી આકૃગત-1.3.12 મુજબનુાં insert Movies and 

Sound ર્ાયલોિ બોક્ષ ખુલશે.  

 
Figure 1.3.12 
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2. તેમાાંથી Recording કરેલ કે ર્ાઉનલોર્ કરેલ કે Cut કરેલ સાઉન્ર્ કે મુવી યક્લપ માટેનો પાથ પસાંદ કરો.  

3. Open બટન ૫૨ યક્લક કરો. 

4. સ્લાઈર્ ૫૨ સાઉન્ર્ Icon જોવા મળશે. Slide Show શરૂ થતા જ સાઉન્ર્ સાાંભળી શકાશે કે યવર્ીયો શરૂ 

થઇ જશે.  

 ઉ૫૨ મુજબનાાં બધાાં પિલાઓ અનુસરીને તમ ેપાાંચ-છ સ્લાઈર્ ધરાવતુાં તમારાં  ૫હેલુાં પ્રેર્ન્ટેશન તૈયા૨ 

કરી લીધુાં હશે. હવ ેઆ પ્રેર્ન્ટેશનનો સાંગ્રહ ક૨વો જોઈએ. Word Processorમાાં િાઈલને સાંગ્રહ ક૨વાના પિલાઓ 

શીખી જ િયા છો. જથેી તેની યવશેર્ ચચાય ક૨તાાં નથી. અહીં પ્રેર્ન્ટેશન સ્લાઈર્ .odp એક્સટેન્શન સાથે સાંગ્રહીત 

થશે. દા.ત. Nilesh.odp 

પ્રરે્ન્ટેશન Run ક૨વુાં. 

ઉ૫૨ મુજબનુાં પ્રેર્ન્ટેશન તૈયા૨ કયાય બાદ એ સ્ક્રીન ૫૨ કેવુાં દેખાશે એ જાણવાની તમને ઉત્સુકતા હોય જ. 

તો ચાલો, પ્રેર્ન્ટેશનને સ્ ક્રીન પર જોવા માટેના પિલાઓ જાણીએ. તે માટે ઘણા બધા યવકલ્પો ઉપલબ્ધ છે. બધા 

જ યવકલ્પો જોઈએ. 

1. View મેનુમાાંથી Slide Show ૫૨ યક્લક કરો. - અથવા - 
2. Slide Show મેનુમાાંથી Slide Show ૫૨ યક્લક કરો. - અથવા - 
3. Keyboard નુાં F5 બટન પ્રેસ કરો. - અથવા - 
4. Presentation ટૂલબારમાાંથી Slide Show બટન પ્રેસ કરો. સ્ક્રીન ૫૨ સ્લાઈર્ Full Screen માાં જોવા મળશે. 

5. ૫છીની Slide ૫૨ જવા માટે માઉસનુાં લેફ્ટ બટન યક્લક કરો - અથવા  - કી બોર્ય  પરથી Enter પ્રેસ કરો. - 
અથવા - Page Down બટન પ્રેસ કરો – અથવા- Space bar કી પ્રસે કરો – અથવા - Down arrow key 

પ્રેસ કરો.  
6. એક ૫છી એક સ્લાઈર્ જોવા માટે આ મુજબ આિળ વધો. 

 

યવચારોાઃ 

• તૈયાર કરેલ પ્રેર્ન્ટેશનમાાંની કોઇપણ ક્રમની સ્લાઇર્થી જ Slideshow કેમ શરૂ ક૨શો? 

• સ્લાઇર્ શો જોતી વખત ેPrevious slide માાં જવા માટે શુાં ક૨શો? 

સ્લાઇર્માાં યવયવધ ઈિેક્ટ આ૫વી. 

જયારે પ્રેર્ન્ટેશનનો Slide Show જોઈએ ત્યારે તમામ સ્લાઇર્ વારાિ૨તી Full Screen ૫૨ જોવા મળ ેછે. 

૫રાંતુ સ્લાઇ્સ ને માત્ર કલ૨િુલ બનાવતા તે એકદમ અસ૨કા૨ક બનતી નથી. જો સ્લાઇ્સમાાં યવયવધ ઈિેક્ટ 

આ૫વામાાં આવે તો સ્લાઇર્ શો અસ૨કા૨ક બને છે. પ્રરે્ન્ટેશન સ્લાઈર્માાં બે પ્રકા૨ની ઈિેક્ટ આપી શકાય છે. 

1. Animation Effect :   

સ્લાઇર્ માાં ૨હેલ Text, Graphics, Sound, Movie અને Object ને Animation Effect આપી શકાય છે. 

જથેી મહત્ત્વના મુદ્દાઓ, માટહતી વિેરે સારી રીત ે૨જૂ કરી શકાય. દરેક મુદ્દાને સ્વતાંત્રપણે  એકબીજાથી જુદા પાર્ી 

શકાય તથા એક ૫છી એક Object જોવા મળ ેતે રીત ેSet કરી શકાય. Objectને આપેલ એનીમેશનના ક્રમ તથા 

પ્રકાર બદલી શકાય છે અને બધી ઇિેક્ટ માઉસ યક્લક વિ૨ આપમેળે જોવા મળ ેતે રીત ેસેટ કરી શકાય છે. આવી 

ઈિેક્ટને built in effect ૫ણ કહેવાય છે. 

2. Transition Effect :   
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આ ઈિેક્ટ સ્લાઈર્ને અપાતી એયનમેશન ઈિેક્ટ છે. સ્લાઈર્ શો દ૨ગમયાન સ્લાઈર્ બદલે ત્યારે સ્લાઈર્ 

Overlapping થાય, વચ્ચેથી Display થાય, Scroll થાય વિેરે ઘણી બધી જુદી જુદી ઈિેક્ટ સ્લાઈર્ને આપી શકાય 

છે. આવી ઈિેક્ટને ટર ાયન્ર્શન ઈિેક્ટ કહે છે. આ ઈિેક્ટથી સ્લાઇર્ ૫ણ ઓટોમેટટક ટાઈમ સેટટાંિ કરી બદલી શકાય 

છે.  

 તો ચાલો હવ ેતમારા પ્રેર્ન્ટેશનને Animation Effect આપીએ. તૈયા૨ છો ને? 

Animation Effect આ૫વી. 

સૌ પ્રથમ તમ ેબનાવેલુાં પ્રેર્ન્ટેશન ખોલો. તેમાાં પ્રથમ સ્લાઈર્ Title Slide છે. આ સ્લાઈર્માાં Title ઉ૫૨થી 

આવે અને Sub Title નીચેથી આવે તેવી ઈિેક્ટ આપીએ. તેના માટે નીચેના પિલા ઘ્યાનમાાં રાખો.  

1. ૫હેલી સ્લાઇર્ ખસલેક્ટ કરો. 

2. Title text ખસલેક્ટ કરો. 

3. Slide show મેનુમાાંથી અથવા Task Pane માાંથી Custom Animation ખસલેક્ટ કરો. જથેી આકૃગત-1.3.13 

મુજબ Task pane જોવા મળશે. 

4. તેમાાં Add → Entrance → Fly in ઈિેક્ટ ખસલેક્ટ કરો. OK બટન પ્રેસ કરો. 

5. Direction ર્ર ો૫ ર્ાઉન બોક્ષ From Top ખસલેક્ટ કરો. Speed બોક્ષમાાંથી medium ખસલેક્ટ કરો. 

 
Figure 1.3.13 
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6. હવ ેSub Title ખસલેક્ટ કરી પિલુાં 4 પુનરાવતીત કરો. 

7. Direction ર્ર ો૫ ર્ાઉન બોક્ષ From Bottom ખસલેક્ટ કરો. Speed બોક્ષમાાંથી medium ખસલેક્ટ કરો. 

8. TaskPaneમાાં આવેલા Play બટનથી Slide Show Preview ચેક કરી લો.  

અહીં Effect આપેલ Objectના ક્રમમાાં સુધારો કરી શકાય છે. તે માટે TaskPaneમાાં એયનમેશન ઈિેક્ટનુાં List 

જોવા મળ ે છે. તે Objectને drag & drop ૫દ્ગતથી અથવા Change Order બટનથી ક્રમ બદલી શકાય છે. 

એયનમેશન ઈિેક્ટ યલસ્ટમાાં ઓબ્જકેટ પર Right Click કરી Timing યવકલ્પ ખસલેક્ટ ક૨તાાં Annimation ને  Timing 

ઈિેક્ટ ૫ણ આપી શકાય છે.  

જોવા મળતા અન્ય યવકલ્પોનો ઉપયોિ કરીને પણ તેની અસર ચકાસો. આ જ પ્રમાણ ે તમારા 

પ્રેર્ન્ટેશનની બધી જ સ્લાઇર્ને જુદી જુદી Animation ઈિેક્ટ આપી આકર્યક બનાવો.  

આકૃગત 1.3.13માાં તમે Motion paths ટેબ જોઈ શકશો. Motion Paths ટેબ પર યક્લક કરી તમ ે

મેન્યુઅલી એયનમેશન આપી શકશો. 

ટર ાયન્ર્શન ઈિેક્ટ આ૫વી. 

Transition Effectમાાં સ્લાઈર્ બદલાય ત્યારે જુદી જુદી ઈિેક્ટ જોવા મળે છે. આ ઈિેક્ટ ઉમે૨વા માટે નીચેનાાં 

પિલાઓ ઘ્યાનમાાં રાખો.  

1. જો દરેક સ્લાઈર્ને જુદી જુદી ઈિેક્ટ આ૫વી હોય તો સ્ક્રીનમાાં ર્ાબી બાજુ જોવા મળતી Slides paneમાાં જોવા 

મળતી Slides પર Right click કરી જોવા મળતા યવકલ્પોમાાંથી Slide Transition યવકલ્પ પસાંદ કરો. 

2. Slide Show મેનુાંમાાંથી Slide Transition ૫સાંદ કરો અથવા Task Pane → Slide Transition Pane ૫સાંદ 

કરો.  

3. જોવા મળતા Transition listમાાંથી યોગ્ય ઇિેક્ટ પસાંદ કરો. (એકથી વધ ુજુદી જુદી સ્લાઇર્ ખસલેક્ટ ક૨વા 

માટે Mouse+ctrl કીનો ઉ૫યોિ કરો.) જુદી જુદી ઇિેક્ટ ૫૨ યક્લક ક૨તાાં તમને preview ૫ણ જોવા મળશે.  

4. Modify Transition યવકલ્પમાાંથી Transition Speed અને Sound લીસ્ટમાાંથી સાઉન્ર્ સેટ કરો. 

5. Advance Slide યવકલ્પમાાંથી transition આપમેળે કે મેન્યુઅલ ક૨વુાં છે તે set કરો. 

6. Play બટન પ્રેસ કરી Preview ચકાસી લો. 

7. જો બધી જ સ્લાઇર્માાં સ૨ખી ઈિેક્ટ આ૫વી હોય તો TaskPane→ Apply to All Slides બટન પ્રસે કરો. 

8. જુદી જુદી Slides ને જુદી જુદી ઈિેક્ટ આ૫વા માટે પિલાઓ 1 થી 7 રીપીટ કરો. 

પ્રરે્ન્ટેશનની અન્ય સવલતોાઃ 

મોટા સમુહ સમક્ષ ૨જુઆત ક૨વા માટે આ અસ૨કા૨ક માઘ્યમ છે. વળી, OpenOffice Presentationની 

સવલતો તેને વધુ અસ૨કા૨ક બનાવે છે. કેટલીક અન્ ય સવલતો નીચ ેમુજબ છે. 

Rehearse Timings  

આ યવકલ્પ કોઈ૫ણ Presentation ચાલતુાં જાય તેમ ઓટોમેટટક ટાઈમમિ આપી શકાય તે માટે ખુબ જ 

અિત્યનો છે. સ્ લાઇર્ શોને ઓટોમેટટક ટાઇમીંિ આપવા માટે Slide Show મેનુમાાંથી Rehearse Timing યવકલ્પ 

ખસલેક્ટ કરો. જથેી Screen ૫૨ Slide Show જોવા મળશે. Object અને સ્લાઈ્સ માટે જરૂરી ટાઈમમિ રાખી Slide 

Show આિળ વધા૨તા જાવ. Slide Show નો ટાઈમમિ આપોઆ૫ set થઈ જશે. 
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Interface with other package (Hyperlink) 

Presentation માટે Hyperlink ખુબ જ અિત્યની સવલત છે. OpenOffice Presentation સ્લાઇર્માાં 

સ્ લાઇર્, ર્ોક્યુમેન્ ટ, સ્ પ્રેર્શીટ, સાઉન્ ર્ િાઇલ કે અન્ય કોઈ૫ણ પ્રકારની િાઈલને Hyperlink કરી શકાય છે. તેની 

મદદથી સ્લાઈર્ શો સમય ે OpenOffice Presentation સ્લાઇર્માાંથી અન્ય િાઈલમાાં જઈ શકાય છે. આ રીત ે

hyperlink ક૨વા માટે નીચે મુજબના પિલા ઘ્યાનમાાં લો.  

1. તમ ેઅિાઉ બનાવેલી પ્રથમ સ્લાઇર્ જવેી એક સ્લાઈર્ બનાવો. 

2. તેમાાં Title box માાં ‘Solar System’ ટાઈ૫ કરો. 

3. લખેલી Text માઉસ drag કરીને પસાંદ કરો.  

4. Insert મેનુમાાં જઈ hyperlink યવકલ્પ ૫૨ યક્લક કરો. આકૃગત-1.3.14  મુજબની સ્ક્રીન જોવા મળશે. 

 
Figure 1.3.14 

5. તેમાાં Document યવકલ્પ પસાંદ કરો. Path ર્ર ોપ ર્ાઉન લીસ્ટ સામ ેઆવેલ Open બટન પર યક્લક કરી જ ે

િાઇલને હાઇપરલલક કરવી છે તેનો Path નક્કી કરો.  

6. Apply અને Close બટન પ્રસે ક૨તા તે િાઈલ hyperlink થઈ જશે. 

7. સ્લાઇર્ શો સમયે આ Text ૫૨ માઉસ પોઈન્ટ૨ લઈ જતાાં પોઈન્ટ૨નો આકા૨ બદલાઈને હાથ જવેો () 

જોવા મળ ેછે.  

8. તેના ૫૨ યક્લક ક૨તા link થયેલ િાઈલ ખુલશે. 

આ જ રીત ેઅન્ય િાઈલ સાથે, Text, Object કે ચાટય  વિેરે link કરી શકાય છે. આ ઉ૫રાાંત Presentationની 

એક સ્લાઈર્ને અન્ય સ્લાઈર્ સાથે link કરી શકાય છે. 

પ્રેર્ન્ટેશનમાાં હાઇપરલલક કરવાની સિવર્થી ઘણાાં પ્રકારના આકર્યક અને રસપ્રદ પ્રેર્ન્ટેશન તૈયાર કરી 

શકાય છે. પ્રેર્ન્ટેશન યવદ્યાથીઓની ીજ્ઞાસા વધારવા, આાંતરયક્રયા વધારવા અને રજૂઆતને રસપ્રદ બનાવવાનુાં 

ખૂબ અસરકારક માધ્યમ છે. 
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સ્વાધ્યાય 

1. કોઇ એક એકમ માટે ઓછામાાં ઓછી ૫ સ્ લાઇર્ તૈયાર કરો. 

• એક સ્ લાઇર્માાં ખચત્ર ઇન્ સટય  કરો. 

• એક સ્ લાઇર્માાં મુવી ઇન્ સટય  કરો . 

• એક સ્ લાઇર્માાં ટેબલ ઇન્ સટય  કરો . 

• એક સ્ લાઇર્માાં હાલપરલલક આપો . 

• તમામ સ્ લાઇર્ માટે ર્ીર્ાઇન ટેમ્‍ પ્ લેટમાાંથી કોઇ એક ર્ીર્ાઇન પસાંદ કરો . 

• તમામ સ્લાઇર્ને એયનમેશન આપો. 

 

2. હાઇપરલલકની મદદથી ‘કૌન બનેિા કરોર્પગત’ જવેી યક્વર્ િેમ બનાવો.  
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ICT Practical Task 

પ્રાયોગિક કાયય 

OpenOffice કુલ પ્રાયોગિક સમય - 9 કલાક 

 

❖ OpenOffice Text Document  ( 3 કલાક ) 

Text Document એયપ્લકેશનને શરૂ કરવા, બાંધ કરવાનો મહાવરો   
Home, Insert, Page Layout Optionsના યવયવધ યવભાિોનો મહાવરો. 

60  ગમયનટ 

િુજરાતી કે અાંગ્રેી માાં આપેલ િકરાન ેટાઇપ કરી તેમાાં editing અને formatting ના યવયવધ  

optionsનો ઉપયોિ કરવો. બાયોરે્ટા તયૈાર કરવો , અહેવાલ લખવો વિેરેનો મહાવરો કરવો. 
60  ગમયનટ 

Text Documentની િાઇલમાાં table insertની મદદથી  ટેબલની રચના કરવી તથા િોમ્‍યુયલાનો  
ઉપયોિ કરવો.જમે કે પટરણામપત્રક બનાવવુાં 

60  ગમયનટ 

❖ OpenOffice Spreadsheet ( 3 કલાક ) 

Spreadsheet એયપ્લકેશનને શરૂ કરવા, બાંધ કરવાનો મહાવરો  
Home, Insert, Page Layout, Formulas, Data Optionsના  યવયવધ  યવભાિોની  માટહતી  અને  

મહાવરો. 
60  ગમયનટ 

યવયવધ  િાયણતીક  િોમુયલાનો  ઉપયોિ  કરી  િણતરી  કરવી. સરાસરી  કાઢવી, ટકા  કાઢવા, ગ્રરે્  

કાઢવો, if િાંકશનનો ઉપયોિ વિેરેનો મહાવરો કરવો 
60  ગમયનટ 

આપેલ આાંકર્ાકીય માટહતીનો આલેખ બનાવવો. સ્તાંભ આલેખ , પાઇ ચાટયની રચના કરવી 60  ગમયનટ 

❖ OpenOffice Presentation ( 3 કલાક )       

Main Menuના યવયવધ Tabsનો ઉપયોિ કરવો . 60  ગમયનટ 

સ્લાઇર્માાં Text, Picture, Video તેમજ Audio મૂકવાનો મહાવરો કરવો 60  ગમયનટ 

કોઇપણ  એક  ધોરણમાાં  એક  યવર્ય  પસાંદ  કરી  તેના  કોઇપણ  એક  યવર્યાાંિને  લઇ  પ્રેર્ન્ટેશન  

બનાવો .જમેાાં ઉપરોક્ત મહાવરાનો ઉપયોિ કરવો. 
60  ગમયનટ 

 

નોંધાઃ  અધ્યાપક  તેમજ  લેબ  ઇન્સ્ટરક્ટરે  ઉપરોક્ત  પ્રાયોગિક  કાયયની  યવિત  મુજબ   તાલીમાથીઓ  પાસે  મહાવરો 

કરાવવાનો  રહેશે. અહીં  આપેલ  સમયમયાયદા  માિયદશયન  માટે  છે. જરૂર  જણાય  ત્યાાં  તાલીમાથીની  જરૂટરયાત  મુજબ 

તેમાાં િેરિાર કરી શકાય છે . મહાવરા માટે આપસૂર્થી   પ્રાયોગિક સ્વાધ્યાય કાયય આપવુાં.  

પ્રાયોગિક પરીક્ષાનુાં માળખુાં 

Text Document 15 િુણ 

Spreadsheet 15 િુણ 

Presentation 20 િુણ 

કુલ િુણ 50 િુણ 

  

નોંધ : ઉપરોક્ત િણુભાર પ્રાયોગિક પરીક્ષાના સાંદભ ેછે. પરીક્ષક જયારે પરીક્ષા લવેા જાય ત્યારે ઉપરોક્ત િણુભાર 

પ્રમાણનેુાં પ્રાયોગિક કાયય લવેુાં. 

 

 


